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Safety Precautions and Warnings 
 
 
 
High Voltage Warning! High voltages are present in the Voyage Data Recorder. Only Rutter 
Technologies Certified Technicians should undertake work on the VDR-100G2/G2S. 
 
 
 
GENERAL 
Only a Rutter Technologies Inc. Certified Technician should access the interior components of 
the VDR-100G2/G2S equipment. 
 
To ensure compliance with the IMO standards, installation of the VDR-100G2/G2S must be 
performed by a Rutter Technologies Inc. approved installation technician. 
 
The following precautions and warnings are general safety measures that personnel should 
understand and apply during installation, operation, and maintenance of all VDR-100G2/G2S 
system equipment. 
 
Wear proper safety attire and use the proper equipment while handling the VDR during transport 
and installation.  
 
 
GROUNDING 
All cable shields must be grounded to avoid interference from AC wiring, fluorescent lights, or 
other high magnetic or RF fields. 
 
NMEA data cables should be grounded at the source. All other cables should be grounded at 
both ends. The equipment in the VDR-100G2/G2S Data Processing Unit (DPU) and Data 
Acquisition Unit (DAU) is grounded to the rack. All other peripheral equipment should be 
grounded. 
 
 
CABLING 
The cable sizes and types recommended for use with the VDR-100G2/G2S must be utilized to 
ensure its proper operation. 
 
 
POWER SUPPLY 
Prior to connecting the power supply of the VDR-100G2/G2S to the emergency ship power, 
ensure the emergency ship power breaker is switched off. Always shut down the system and turn 
off the power before removing or installing any equipment. 
 
 
LIFTING 
Some VDR components are heavy; ensure you carry out proper lifting procedures while changing 
or transporting components.



 

 

Electrostatic Discharge 
 
 
Digital devices are susceptible to damage from electrostatic discharge (ESD); certain precautions 
must be taken when handling circuit cards, integrated circuits (ICs), and other sensitive devices.  
 
The maintenance technician should conform to the following guidelines when handling ESD 
sensitive devices: 
 

1. Always wear a static protection wristband prior to contact with any electrostatic 
sensitive device; 

2. Ensure that the wristband cable clip is firmly attached to a grounding point; 
3. Keep all sensitive components in their protective pouches until required. 
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List of Abbreviations 
The following abbreviations may be in common use throughout this document: 
 
ADPCM – Adaptive Differential Pulse-Code Modulation 
AIS – Automatic Identification Systems 
 
BNC – Bayonet Neil-Concelman (or sometimes British Naval Connector) 
 
CD-ROM – Compact Disc-Read Only Memory 
COTS – Commercial Off-the-Shelf 
CPU – Central Processing Unit 
 
dB – Decibels  
DAU – Data Acquisition Unit 
DMM – Data Management Module 
DPU – Data Processing Unit 
 
ECDIS – Electronic Chart Display and Information System 
ECS – Electronic Chart System 
EPIRB – Emergency Positioning Indicating Radio Beacon 
 
FRM – Final Recording Medium 
 
g – Grams  
GB – Gigabyte  
GMT – Greenwich Mean Time 
GPS – Geographical Positioning System 
 
HBS – Horizontal Back Sync 
HVR – Hardened Voyage Recorder 
Hz - Hertz 
 
IBS – Integrated Bridge System 
IDEA – International Data Encryption Algorithm 
IEC – International Electrotechnical Commission 
IMO – International Maritime Organisation 
 
kg – Kilogram 
 
LCD – Liquid Crystal Display 
LED – Light Emitting Diode 
 
m – Metres 
mA – milliamps 
MB – Megabyte 
mm – Millimetres 
MMSI – Maritime Mobile Service Identity 
 
NMEA – National Marine Electronics Association 
 
OAU – Operation & Alarm Unit 
O/S – Operating System 
oz – Ounces  
 
PC – Personal Computer 
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PMC – Protective Memory Capsule 
 
QA – Quality Assurance 
 
RGB – Red, Green, Blue 
RMS – Root-Mean-Square 
RPM – Revolutions Per Minute 
ROV – Remotely Operated Vehicle 
RSM – Remote Storage Module 
 
SFRM – Simplified Final Recording Medium 
SOLAS – International Convention for the Safety of Life at Sea 
STP – Shielded Twisted Pair 
SVDR – Simplified Voyage Data Recorder 
 
TCP/IP – Transmission Control Protocol/Internet Protocol 
TJB – Terminal Junction Box 
 
UHF – Ultra High Frequency 
UPS – Uninterruptible Power Supply 
UTC – Coordinated universal Time 
 
V – Volts  
Vac – Volts AC 
VDC – Volts DC 
VDR – Voyage Data Recorder 
VHF – Very High Frequency 
 
 

Specifications 
 
IEC 61996:1999 Ship borne Voyage Data Recorder – Performance requirements – methods of 
testing and required test results. 
 
IEC 60945:1996 Maritime navigation and radio communication equipment and systems – General 
requirements – methods of testing and required results 
 
IEC 61162 Maritime navigation and radio communication equipment and systems – Digital 
interfaces 
 
IEC 61996-2 Shipborne voyage data recorder (VDR) - Part 2:- Simplified voyage data recorder 
(S-VDR) Performance requirements - methods of testing and required test results 
 
 

Dimensions 
Dimensions in this document are shown in mm (millimeters) unless otherwise stated.  
 
 

Software Note! 
Software procedures in this manual are based upon a PC running a Windows XP operating 
system.  There may be minor differences depending on the operating system and configuration in 
use on the Client PC. 
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1 SYSTEM OVERVIEW 
 

1.1 VDR-100G2 System Components 
The VDR-100G2 is a modular, Ethernet-based data acquisition and storage system. It is 
designed to collect and maintain a secure, retrievable record of information related to the position, 
movement, physical status, and command & control of a marine vessel.  
 
While this manual references the VDR-100G2, it is also applicable to the Simplified Voyage Data 
Recorder (VDR-100G2S) unless otherwise stated.  
 
There are three (3) types of information recorded by a Voyage Data Recorder (VDR):  
 

1. Audio data acquired from microphones mounted in the immediate vicinity of a vessel’s 
main bridge workstations and a primary VHF radio is required to be recorded.  The 
VDR-100G2 has the capability to record public address systems, internal 
communications, additional radios, or other areas of the ship if necessary. 

2. Video data can be captured at 15 second intervals from one (1) complete radar video 
frame screen via a dedicated buffered output port of the radar.  The VDR-100G2 can 
record images captured from multiple Radars, electronic chart, or CCTV displays at 
various capture intervals.  An SVDR is not required to capture video data. 

3. ASCII serial data related to the position, heading, speed, wind, water depth, hull 
openings, bulkhead doors, alarm status, maneuvering commands, and responses can 
be recorded with the VDR-100G2.  The standard format for this data is defined in the 
NMEA 0183/IEC 61162 standards; through the implementation of an interface module, 
non-standard data can be converted to this format. 

 
For a complete list of data items to be recorded, refer to IEC 61996. 
 
The VDR-100G2 is a fully IMO compliant VDR. The base system consists of the following 
components: 
 

1. Data Processing Unit (DPU), consisting of: 
 Data Management Module (DMM) 
 Power Supply Module 
 Power Control Module 
 2 x 28Ah 12V batteries 
 Cooling Fan with thermostat 
 4-Port Ethernet switch 
 4GB Memory Stick 

 
2. Data Acquisition Unit (DAU) *, consisting of: 

 4-Channel Audio Module 
 1-Channel Video Module 
 8-Channel NMEA Module 

 
* The DAU is an optional component with the VDR-100G2S. 
 

3. Operation & Alarm Unit (OAU) 
 

4. Final Recording Medium (FRM) 
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Internal and External MicrophoneOptionally, the VDR-100G2 can also be supplied with the 
following components: 
 

1. 2 or 4 additional audio channels (to a maximum of 16 inputs) 
2. 1, 2, or 3 additional video channels (to a maximum of 4) 
3. 8 or 16 NMEA channels 
4. Remote Storage Module (RSM) (implemented for long term archiving and/or additional 

data backup storage retrieval) 
5. Data Interfaces (implemented for the conversion of non-standard signals to NMEA 

format). Interfaces include: 
 

 DataAnalog 
 DataDiscrete 
 DataSynchro 
 DataGyro 
 DataProtocol 

 
 

UNIT
ACQUISITION

DATA

UNIT
PROCESSING 
DATA

 
Figure 1-1 - VDR-100G2 Block Diagram 

 
 
The VDR-100G2S has many similar components to the VDR-100G2, with the following 
differences: 
 

 The Video Module is only required if the vessel’s radar has an available COTS 
(commercial off-the-shelf) interface.  Therefore, the recording of video data may not be 
applicable in some VDR-100G2S installations 
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 The VDR-100G2S has an accompanying Simplified FRM (SFRM) capsule, as 
referenced in Section Error! Reference source not found. - Error! Reference source 
not found.. 

1.1.1 Data Processing Unit (DPU) 
The Data Processing Unit (DPU) receives and processes information provided from the various 
Audio, Video, and NMEA Input Modules.  This information is processed in the Data Management 
Module (DMM) for archiving on the DMM’s internal hard drive, the Final Recording Medium 
(FRM), and the optional Remote Storage Module (RSM).  
 
The VDR-100G2 power system is housed in the DPU, and accepts universal AC or 24VDC from 
the ship’s emergency power while providing 24VDC to the VDR-100G2 modules.  The power 
system includes batteries to provide uninterrupted power to the audio recording system in the 
event of a blackout. 
 
The DPU also contains an Ethernet switch (hub) which provides the ability to combine video and 
NMEA data into a single Ethernet link. 
 

 
Figure 1-2 - Data Processing Unit 

 
 

1.1.1.1 Data Management Module 
The Data Management Module (DMM) is a rugged, small form factor Pentium computer. It is 
equipped with four (4) Ethernet input ports, two (2) serial ports, two (2) USB ports, a high capacity 
hard disk drive, and a compact flash card containing an embedded Windows XP operating 
system.  
 
The module compresses and stores data received from the acquisition modules and, 
simultaneously, outputs processed data to the FRM, optional Remote Storage Module (RSM), 
and optional Download/Playback PC (as described below).  
 



Chapter 1: System Overview 

 
VDR-100G2/G2S Installation Manual  4  
RUT-TD-02-001, Rev 2.1 

Communication with the Operation and Alarm Unit (OAU) and Power Control Module (PCM) 
occurs via the serial ports.  Additionally, the DMM can be configured to provide data for real-time 
display via an Ethernet connection. 
 
In addition to the most current data set, the base model DMM can store numerous previously 
recorded full data sets in a secure location.  This secure location prevents previously recorded 
data sets from being overwritten.  
 

 
Figure 1-3 - Data Management Module (Rear View) 

 
 

1.1.1.2 Power Supply Module 
The VDR-100G2 has the option of being powered by either AC or DC supply (must be chosen at 
time of order as it is not field configurable): 
 

 The AC input range is 85-264V, 47-63Hz. 
 The DC input range is 19-28V. 
 The output of both supplies is 27.6VDC, which is the normal operating voltage of the 

VDR. 
 
The power supply also acts as a battery charger for re-charging low batteries or maintaining a full 
charge.  The battery input is reverse polarity protected by a crossbar diode and a replaceable 
fuse.  
 
There are two versions of the AC Power Supply Module (PSM) (as illustrated below).  Version 2 
is applicable from VDR Serial Number 20107XX0900 forward. There remains only one version 
(Verison 1) of the DC PSM. 
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Figure 1-4 - Power Supply Module (Version 1 – AC and DC) 

 
Figure 1-5 - Power Supply Module (Version 2 – AC Only) 

 
 
 

Note!  Changes to both the Power Control Module (PCM) and Power Supply 
Module (PSM) as described in this manual are only applicable to the AC power 
version of the VDR.  The PCM and PSM in the DC power version are Version 
1. 

 
 
 

1.1.1.3 Power Control Module 
The Power Control Module (PCM) monitors the power system and communicates the power 
system status information to the DMM.  It also controls the switching circuitry to transfer the load 
from the power supply to the batteries. 
 
There are two versions of the AC PCM (as illustrated below).  Version 2 is applicable from VDR 
Serial Number 20107XX0900 forward.  There remains only one version (Version 1) of the DC 
PCM. 
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Figure 1-6 - Power Control Module (Version 1 – AC and DC) 

 
 

 
Figure 1-7 - Power Control Module (Version 2 – AC Only) 

 
 

1.1.2 Data Acquisition Unit (DAU) 
The Data Acquisition Unit (DAU) is an optional component that can house up to four (4) main 
data acquisition modules: 
 

 Audio Module 
 Video Module 
 (2) NMEA Modules 

 
These modules are used to capture ship information and output this acquired data through an 
Ethernet port, transmitting it to the DPU for processing and storage. 
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Figure 1-8 - Data Acquisition Unit 

 

1.1.2.1 Audio Module 
The Audio Module receives audio information from bridge microphones and vessel radios in 
accordance with the IEC 61996 standard.  All audio data is routed to the DMM for processing, 
storage, and eventual retrieval.  This module also controls the test buzzers used to verify the 
functionality of all microphones connected to the VDR-100G2. 
 
The standard Audio Module is an autonomous audio capture and broadcast device with 8 input 
ports for capturing audio data from a combination of microphones or line level inputs.  An 
example combination may be: 
 

 6 microphones 
 Transmitted and received signals from the primary VHF radio. 

 
The module combines pairs of input signals, digitizes the combined audio channels, and outputs 
the audio data through an Ethernet port.  Twelve or sixteen input Audio Module units are also 
available for capturing audio data from additional microphones or other sources. 
 
Additional specifications: 
 

 The audio inputs are transformer coupled and can be configured on site as either 
microphone or line level connections. 

 The 8, 12, or 16 audio inputs are mixed 2:1 (either LEFT/RIGHT for microphones, or 
TX/RX for VHF) to produce 4, 6, or 8 single-ended digital signal streams respectively. 

 Separate level control potentiometers are located on the PCB, and can be adjusted using 
a screwdriver.  These levels are preset during manufacturing. 

 The audio signals are sampled to 12-bit resolution.  The resulting digitized data stream is 
broadcast across an Ethernet cable for storage. 

 The Audio Module Ethernet output is connected to a dedicated Ethernet port on the 
DMM. 
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 Figure 1-9 – 12-Input (6-Channel) Audio Module 

 
 
There are 2 types of microphones available with the VDR-100G2: 
 
 The indoor microphones are condenser style boundary microphones, ordinarily mounted to 

the ceiling in the bridge area, with a junction box mounted above the ceiling for cable 
connection; 

 The outdoor (external) microphone has an externally mounted wiring junction box; and 
 Both microphone assemblies include a microphone test buzzer. 
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Figure 1-10 - Indoor Microphone 

 
 

 
Figure 1-11 - Outdoor Microphone 
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1.1.2.2 Video Module 
The Video Module is an autonomous video capture and broadcast device.  It has 1 input port for 
capturing images from a dedicated buffered output port of the primary radar.  The module 
digitizes the video signals and outputs the video data through an Ethernet port. Video modules 
with up to 4 inputs are also available for capturing images from additional video displays. 
 
The module provides periodic updates of RGB images.  For maximum flexibility, the board holds 
sufficient memory to accommodate 1600 x 1200 x 24-bit colour images and refresh rates up to 
85Hz.  For maximum capability, the A/D samples at up to 170MHz, with a clock inversion option 
that allows larger images to be sampled by interleaving 2 consecutive frames. 
  
The Data Management Module (DMM) initiates the capture of video information and specifies its 
configuration.  This includes:  
 

 The video channel to be digitized. 
 The sources of the vertical and horizontal syncs. 
 The coefficients for the PLL-generated pixel clock (or selection of an external clock). 
 The dimensions (number of samples and lines) of the captured frame. 

 

 

 
Figure 1-12 - Video Module 
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1.1.2.3 NMEA Input Modules 
The NMEA Input Modules provide connection to all IMO-required data items in both NMEA 
0183/IEC 61162 and limited ASCII data formats.  NMEA modules multiplex up to 8 NMEA-0183 
data streams from shipboard systems onto a single RS-232/422 serial data channel, and 
simultaneously on an Ethernet connection (UDP).  Captured data is sent to the DMM via an 
Ethernet connection for storage and eventual retrieval. 
 
These modules use embedded microprocessor technology with real-time buffer storage to handle 
simultaneous arrival of data on multiple channels without conflict.  Additionally: 
 

 An efficient anti-collision algorithm preserves the integrity of the data even at high 
incoming data rates. 

 Data is handled on a first-in-first-out basis, assembled, and then transmitted via the serial 
output port to the receiving computer or data logger.  

 

 

 
Figure 1-13 – NMEA Input Module 

 
 



Chapter 1: System Overview 

 
VDR-100G2/G2S Installation Manual  12  
RUT-TD-02-001, Rev 2.1 

1.1.3 Operation & Alarm Unit (OAU) 
The Operation & Alarm Unit (OAU) provides a visible and audible alarm in the event of a VDR-
100G2 error condition.  Using an output connection to a vessel’s central bridge alarm system, the 
OAU alerts an Integrated Bridge System (IBS) of any VDR-100G2 system failures or error 
conditions.  The alarm unit is also used to initiate an IMO required download operation on the 
VDR-100G2. 
 
The OAU has 3 primary functions: 
 

 Alert the ship’s officer on watch of any detected failure within the VDR-100G2.  
 Allow a user to secure recorded data.  This action must be taken within 24 hours of any 

incident to prevent the recording of the incident from being overwritten. 
 Allow a user to copy current or secured data to the USB Memory Stick (applicable only to 

VDR-100G2 version 4.05.00 and later). 
 Allow a user to connect or disconnect, as well as copy secured data, to the optional RSM. 

 
The unit has a simple menu interface which allows a user to secure the recorded data and enable 
or disable the optional RSM.  It is equipped with: 
 

 Audible and visual alarm indicators 
 A 12-button keypad 
 A 4 x 20 character LED 
 An output for monitoring in a central alarm system 

 

 
Figure 1-14 - Operation & Alarm Unit 

 

1.1.4 Final Recording Medium (FRM/SFRM) 
The Final Recording Medium (FRM/SFRM) is a solid-state storage unit capable of storing 12 
hours of VDR-100G2 data in compliance with IMO resolution A.861(20.). 
 
Additional information: 

 The primary function of the FRM/SFRM is to provide a protective capsule for the IMO 
required data acquired by the VDR.  This data will be used, in the event of an incident, by 
an accident investigation team. 

 The FRM/SFRM is mounted on the exterior deck of the ship and connected to the DMM. 
 The FRM/SFRM receives data from the VDR via an Ethernet link. 
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1.1.4.1 L3 HVR/SVR Fixed FRM/SFRM Capsule 
 
The L3 HVR/SVR Fixed FRM/SFRM Capsules contains non-volatile memory (Flash), intended to 
store ship parameters in real time. The storage memory will continually store the last 12 hours 
(minimum) of received data. The L3 HVR-01 Fixed FRM Capsule and the L3 SVR-01 Fixed 
SFRM Capsule contain 1.75 GB of non-volatile memory. The L3 HVR-02 Fixed FRM Capsule and 
the L3 SVR-02 Fixed SFRM Capsule contain 2 GB of non-volatile memory. 
 
The interface between the VDR-100G2S and the memory capsule is a standard 10/100 Base-T 
Ethernet connection using TCP/IP standard protocol.  
 

 
Figure 1-15 – VDR-100G2 – L3 HVR-01 Fixed FRM Capsule 
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Figure 1-16 - VDR-100G2 – L3 HVR-02 Fixed FRM Capsule 

 
 

 
Figure 1-17 - VDR-100G2S – L3 SVR-01 Fixed SFRM Capsule 
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Figure 1-18 - VDR-100G2S - L3 SVR-02 Fixed SFRM Capsule 

 
 

1.1.4.2  JoTron Float-Free SFRM Capsule 
The JoTron Float-Free SFRM Capsule is a combined SFRM and Cospas-Sarsat EPIRB 
(Emergency Positioning Indicating Radio Beacon), approved for use with the VDR-100G2S. 
 
The capsule contains a memory module with a standard 1.75 GB storage capacity and 10Mb 
Ethernet with TCP/IP interface.   The capsule will store 12 hours of captured data.  In a situation 
where a ship may be sinking, the capsule will float free while transmitting both its position and 
MMSI for at least seven (7) days. 
 

 
Figure 1-19 - Jotron Float-Free SFRM Capsule 
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1.1.4.3 Rutter-ACR Float-Free SFRM Capsule 
The Rutter-ACR Float-Free SFRM Capsule contains non-volatile memory (Flash), intended to 
store ship parameters in real time. The storage memory will continually store the last 12 hours 
(minimum) of received data. 
 
The capsule contains a memory module with 4 GB of storage capacity. The interface between the 
VDR-100G2S and the memory capsule is a standard 10/100 Base-T Ethernet connection using 
TCP/IP standard protocol.  Power for the capsule is provided over the same Ethernet cable using 
PoE (Power Over Ethernet).  This feature has the advantage in that a separate power cable is not 
required. 
 
In a situation where a ship may be sinking, the capsule will float free while transmitting both its 
position and MMSI for at least 7 days. 
 

 
 

Figure 1-20 - Rutter-ACR Float-Free SFRM Capsule 
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1.1.4.4 Rutter FRM (RUT-02447) Fixed Capsule 
 

 
 

Figure 1-21 - The Rutter FRM (RUT-02447) Capsule 

 
The Rutter FRM (RUT-02447) Fixed Capsule contains non-volatile memory (Flash), intended to 
store ship parameters in real time. The storage memory will continually store the last 12 hours 
(minimum) of received data. 
 
The capsule contains a memory module with 4GB of storage capacity. The interface between the 
VDR-100G2S and the memory capsule is a standard 10/100 Base-T Ethernet connection using 
TCP/IP standard protocol.  
 

1.1.5 Remote Storage Module (RSM) 
The Remote Storage Module (RSM) is an optional data storage device which provides the ability 
to archive longer periods of recorded data, or a means to transport copies of recorded data.  
 
The module: 
 

 Has an Ethernet interface to accept data from the VDR and a USB2.0 port which allows 
the stored data to be retrieved and/or reviewed on any modern PC. 

 Sufficient to archive 250GB of data, or can be used to retrieve several previously secured 
data sets. 

 
When the RSM is supplied as a data retrieval device, a universal AC adapter is included.  When 
supplied with the extended archiving software module, universal AC and 24VDC power supplies 
are included. 
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The RSM is similar to the FRM, except: 
 

 It is not designed to survive extreme conditions. 
 It has a much larger storage capacity. 
 It is small and easy to transport. 

 

 
Figure 1-22 - Remote Storage Module 

 

1.1.6 External Data Interfaces 
The External Data Interfaces, used to sense data signals from ship’s equipment in order to 
provide 61162/NMEA0183 compliant data sentences, are recorded via the NMEA Modules 
described earlier in this documentation.  Non-compliant data can be recorded using one (1) of the 
following interfaces: 
 
DataAnalog 
The DataAnalog Input Module monitors the status of eight (8) analog input signals and indicates 
the voltage or current which corresponds to the equipment setting on each input channel via an 
NMEA-0183/IEC 61162 format data sentence transmitted once per second.  The DataAnalog 
interface has eight (8) channels and can simultaneously monitor signals from four (4) separate 
systems while maintaining isolation between them.  This interface is ideally suited to measure the 
electrical indications for order and response from four (4) shipboard systems (i.e., Rudder 
Order/Response, ME RPM Order/Response, Pitch Order/Response, Bow Thruster Order and 
Response). 
 
DataDiscrete 
Discrete inputs can be monitored via Rutter Technologies’ DataDiscrete interface unit.  Discrete 
inputs are data items recorded simply as open/closed or on/off.  These discrete inputs reflect their 
status by the presence or absence of discrete voltage levels or by the closure of a set of relay 
contacts.  The DataDiscrete input module monitors discrete input points and outputs an NMEA-
0183/IEC 61162 format data sentence to represent them.  This output is connected to the VDR-
100G2 through a NMEA input channel on the NMEA Module.  The DataDiscrete interface is a 
microprocessor-based unit that incorporates 24 opto-isolated inputs arranged in four (4) banks of 
six (6) (with each bank having its own common return). 
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Additional Interfaces 
A number of additional Rutter Technologies interfacing devices, including the DataGyro, 
DataProtocol, DataSplitter, and DataSynchro can be supplied to convert data from shipboard 
systems to an output sentence in compliance with the IEC 61162/NMEA0183 format.  For further 
details, contact Rutter Technologies Inc. or an authorized Rutter dealer. 
 
See Appendix C – Data Interface Documentation for further details. 
 
 

1.2 Client / Playback PC 
An optional Client PC connected to the DMM via an Ethernet connection may be used for two (2) 
purposes: 
 

 Downloading data from the VDR 
 Data playback 

 
When the Client / Playback PC is connected to the VDR-100G2 via an Ethernet connection, 
previously recorded data may be downloaded at any time during normal system operation without 
interrupting the VDR-100G2 recording process.  This downloaded data may then be replayed via 
the playback software.  
 
The playback software presents radar video and IEC 61162 data on the PC display and outputs 
the audio through the system sound card.  The audio channels may be mixed on playback or 
played back separately, permitting localization of sound sources.  During playback, all the primary 
navigation data required for operating an electronic chart system or an electronic chart display 
and information system is available via the serial port on the playback PC.  Software associated 
with the optional Client PC is described in Section Error! Reference source not found. - Error! 
Reference source not found. below. 
 

1.2.1.1 Minimum Requirements 
 Pentium III or higher processor 
 256 MB of memory 
 SVGA Video port and monitor (it is recommended that the monitor be 15” or  

larger and supports a non-scrollable resolution of 1024x768 or greater) 
 Audio hardware with PC speakers or headphones 
 100 Base-TX Ethernet Interface 
 USB 2.0 Port 
 Serial data port (if external ECDIS display support is required) 
 16X DVD-R/DVD-RW drive 
 80 GB or larger internal Hard Disk Drive 
 USB, AT or PS/2 mouse and keyboard 
 Power Supply: Dual Input Voltage: 115V at 60 Hz; or 220V at 50 Hz 
 English O/S Edition: Windows 2000 or Windows XP (recommended). 



Chapter 1: System Overview 

 
VDR-100G2/G2S Installation Manual  20  
RUT-TD-02-001, Rev 2.1 

1.3 System Overview Drawings 
 

 
Figure 1-23 - System Overview (with DAU) 
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Figure 1-24 - System Overview (without DAU)
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2 VDR-100G2 TECHNICAL SPECIFICATIONS 
 
The following tables contain a summary of the technical specifications for the Rutter VDR-100G2 
system components: 
 

Power Consumption 

AC Power (220VAC) 
Units prior to Serial Number 20107XX0900 

Normal Operating Current (approx): 1.0 A @ 220VAC (approx. 220 Watts) 
Max Operating Current (approx): 2.9 A @ 220 VAC (during battery charge) 
Recommended Ship Main Breaker: 10 A @ 220VAC 

AC Power (120VAC) 
Units prior to Serial Number 20107XX0900 

Normal Operating Current (approx): 2.0 A @ 120VAC (approx. 220 Watts) 
Max Operating Current (approx): 5.3 A @ 120 VAC (during battery charge) 
Recommended Ship Main Breaker: 15 A @ 120VAC 

AC Power (220VAC) 
Units after (and including) Serial Number 
20107XX0900 

Normal Operating Current (approx): 1.0 A @ 220VAC (approx. 220 Watts) 
Max Operating Current (approx): 2.0 A @ 220 VAC (during battery charge) 
Recommended Ship Main Breaker: 10 A @ 220VAC 

AC Power (120VAC) 
Units after (and including) Serial Number 
20107XX0900 

Normal Operating Current (approx): 2.0 A @ 120VAC (approx. 220 Watts) 
Max Operating Current (approx): 4.0 A @ 120 VAC (during battery charge) 
Recommended Ship Main Breaker: 15 A @ 120VAC 

DC Power (24 VDC) 
Normal Operating Current (approx): 9 A @ 24VDC 
Max Operating Current (approx): 26.7 A @ 24VDC 
Recommended Ship Main Breaker: 30 A @ 24VDC 

 
 

DPU Specifications 

Weight 43.2Kg 

Dimensions 350 x 400 x 400mm (H x W x D) 

Input Power 85 -264 VAC 50-60Hz (optional 24VDC) 

Output Power 24VDC to FRM, optional DAU, Alarm Module, optional Remote Storage 
and optional interfaces 

 
Data Ports Ethernet input from Audio, Video, and NMEA Modules 

Ethernet Output to FRM 
Ethernet Output to Optional Remote Storage and/or Download PC 
RS232 Input/Output for Alarm Module 
RS232 Input/Output for Power Control Module 

Battery Backup Power 2 Hrs @ -15 Deg C for Audio system, Alarm Module, DMM, and FRM 

 
Data Storage Capacity 24 hours of most current data 

(Units prior to S/N: 20105020037, with the exception of S/N: 
20105020034, have a standard storage capacity of 12 hours of current 
data) 
Plus multiple secured data sets and 30 days extended NMEA 
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DAU Specifications (the DAU Cabinet is optional and not applicable to VDR-100G2S) 

Weight 16.8Kg 

Dimensions 400 x 600 x 150mm (H x W x D) 

Input Power 24VDC from DPU 

Output Power 24VDC to remote interfaces (Max 6A) 

Audio Input Capacity 8, 12, or 16 Audio inputs 
Flexible Microphone and VHF/Line level combinations 

 
Video Input Capacity 

Up to 4 video input ports 
170MHz pixel rate with 2   

 
Data Input Capacity 8 or 16 NMEA 0183/IEC61162 Data Input ports.  

Interfaces for converting non-standard signal formats are to be DIN rail 
mounted as close to the signal source as practical. The following 
interfaces are available for remote mounting: 
 

 DataAnalog analog signals interface 
 DataDiscrete contact signal interface 
 DataGyro gyrocompass interface 
 DataSynchro synchro type gyrocompass interface 
 DataSplitter NMEA splitter interface 
 DataProtocol protocol conversion interface 

 
 

FRM/SFRM Specifications 

Weight 

 

L3 HVR-02 Fixed FRM Capsule: 10.9kg;  
 

L3 SVR-02 Fixed SFRM Capsule: 10.4kg;  
 

Jotron Float-Free SFRM Capsule: 3.5kg;  
 

Rutter-ACR Float-Free SFRM Capsule (EPIRB Only): 1.021kg;  
 

Rutter FRM (RUT-02447) Capsule: 18kg 
 
Dimensions L3 HVR-02 Fixed FRM Capsule: 

Height: 218.3mm, Diameter: 206.5mm, Base Width: 182.39mm 
 

L3 SVR-02 Fixed SFRM Capsule: 
Height: 215.17mm, Diameter: 206.5mm, Base Width: 182.39mm 
 

JoTron Float-Free SFRM Capsule: 
Height: 695mm, Depth: 226mm, Width: 205mm 
 

Rutter-ACR Float-Free SFRM Capsule (EPIRB Only): 
Height: 178mm, Depth: 108mm, Width: 92mm 
 

Rutter FRM (RUT-02447) Capsule: 
Height: 350mm, Diameter: 220mm 

Input Power 24VDC 

Memory Type 

 
L3 HVR-02 Fixed FRM Capsule: Solid State 
 

L3 SVR-02 Fixed SFRM Capsule: Solid State 
 

Rutter FRM (RUT-02447) Capsule: Solid State  
 

Jotron Float-Free SFRM Capsule: Solid State 
 

Rutter-ACR Float-Free SFRM Capsule: Solid State  
 

Capacity 12-hour minimum ( 1.75GB ) 
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OAU Specifications 

Weight 1.4Kg 

Dimensions 

 
With front mounting plate: 144 x 144 x 52.3mm 
Without front mounting plate: 136.6 x 136.6 x 50mm 
 

Input Power 24VDC 

Audible Alarm 60dBA 

 
 
 
 

Indoor Microphone Assembly Specifications 

Weight 0.95Kg 

Dimensions Mic: 64 x 92 x 31mm / Box: 80 x 149.1 x 56.5mm 

Input Power Phantom Power 

 
 

Optional Outdoor Microphone Specifications 

Weight 1.17Kg 

Dimensions Mic: 64 x 92 x 31mm / Box: 85.1 x 129.9 x 65.7mm 

Input Power Phantom Power 

 
 

Optional RSM Specifications 

Weight 1.36Kg 

Dimensions 35 x 127 x 214mm 

Input Power 24VDC or Universal AC with external power supply 

Capacity 250GB 

 
 

Optional RSM 24VDC Power Supply Specifications 

Weight 1.0Kg 

Dimensions 138 x 166.2 x 50mm 

Input Power 24VDC 
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3 PLANNING 
 
In order to successfully complete a VDR-100G2 installation, it is recommended that adequate 
time be allotted for an installation planning stage.  This section provides information on required 
tools, cabling specifications, compass safe distances, and power requirements.  
 
Additionally, dimensional information is provided below for VDR-100G2 components, including 
the DAU, DPU, FRM, OAU, external interfaces such as the DataDiscrete, DataAnalog, and 
DataProtocol, and bridge microphones. 

3.1 Required Tools 
At minimum, the following tools are required for a VDR-100G2 installation: 

 Multi-meter 
 Wire Ferrule Crimper 
 No. 2 Phillips 
 Socket Wrench with 15” extension 

and 13mm Deep Well Socket 
 Diagonal Cutters 
 RG6/11 Coax Crimper 

 RJ45 Crimper 
 Wire Stripper 
 Terminal Screwdriver 
 No. 30 Torx Screwdriver 
 Set Allen Keys (Metric) 
 Laptop with 10/100 base-T Ethernet 

Interface 

3.2 Cabling Specification 
Recommended cable types for the VDR-100G2 are specified in Table 3-1 - Cabling 
Specifications.  Cables must be marine grade.  Exact cable types will vary due to ship type and 
various regulatory agency requirements.  Please consult the agency responsible for the ship in 
question. 
 
Data Type Specification Description 

NMEA 0183 / IEC61162 
 
2x2x0.5 
 

Twisted pair with an overall shield. Individual 
conductors are stranded. Two pair per cable 

OAU 
 
3x2x0.5 
 

Twisted pair with an overall shield. Individual 
conductors are stranded. Three pair per cable 

Audio, VHF Recording 
and Buzzer Activation 

 
2x2x0.5 
 

Twisted pair with an overall shield. Individual 
conductors are stranded. Three pair per cable 

Radar Video Recording 

 
RG6 A/U < 30m  
RG11 A/U > 30m 
 

75 Ohm Coaxial Cable. The actual number of 
cables will vary depending on the type of 
video source. 

TCP/IP for Download / 
Playback Computer and 
Final Recording Medium 

Category 5e FTP 
The Ethernet interface is a 10/100base–FTP 
(shielded twisted pair), category 5e with 
flammability per IEC 95. 

Power for Final 
Recording Medium 

 
3x1.5 
 

Power consumption is assumed to be 7 
Watts. The maximum cable length should be 
75 meters or less.  

Power for Main Cabinet 
 
3x1.5 
 

90-264Vac - 50/60Hz (Optional 19-28VDC) 

Power for Interfaces 2x0.5 24VDC 
Table 3-1 - Cabling Specifications
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Note! Rutter Technologies recommends the above specifications. Alternate cables 
may be suitable for particular installations. Contact Rutter Technologies for 
verification prior to using cabling other than that specified in the table above. 

 
 
 

3.2.1 Additional Cable Information 
In addition to the above specifications, the information provided below may be useful: 

3.2.1.1 Data Cables 
0.5mm² cable - 2 twisted pair 
Reference: TX®(I) 2X2X0.5 
Type: Marine Grade – Low Smoke, Halogen Free, Fire Retardant 
Approval: ABS, BV, DNV, GL, LRS or RINA 
 
0.5mm² cable - 4 twisted pair 
Reference: TX®(I) 4X2X0.5 
Type: Marine Grade – Low Smoke, Halogen Free, Fire Retardant 
Approval: ABS, BV, DNV, GL, LRS or RINA 
 
0.75mm² cable - 2 twisted pair 
Reference: TX®(I) 2X2X0.75 
Type: Marine Grade – Low Smoke, Halogen Free, Fire Retardant 
Approval: ABS, BV, DNV, GL, LRS or RINA 
 
0.75mm² cable - 4 twisted pair 
Reference: TX®(I) 4X2X0.75 
Type: Marine Grade – Low Smoke, Halogen Free, Fire Retardant 
Approval: ABS, BV, DNV, GL, LRS or RINA 

3.2.1.2 Power Supply Cable 
3x1.5mm² cable 
Reference: MPRX® 3x1.5 
Type: Marine Grade– Low Smoke, Halogen Free, Fire Retardant 
Approval: ABS, BV, DNV, GL, LRS or RINA 

3.2.1.3 Video Cable 
75 ohm Coaxial cable - RG11 for cable lengths > 30m 
Reference: FLAMEX RG11AU 
Type: Marine Grade – Low Smoke, Halogen Free, Fire Retardant 
 
75 ohm Coaxial cable – RG6 for cable lengths < 30m 
Reference: FLAMEX RG11AU 
Type: Marine Grade – Low Smoke, Halogen Free, Fire Retardant 
Approval: ABS, BV, DNV, GL, LRS or RINA 

3.2.1.4 FRM Cable 
FTP Category 5e cable 
Reference: LSZH 4PR 24AWG FF5100 021807 M OF45264 
Type: Marine Grade – Low Smoke, Halogen Free, Fire Retardant 
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Approval: ABS, BV, DNV, GL, LRS or RINA 
 
 

3.3 Power Requirements 
The VDR-100G2 has the option of being powered by either AC or DC voltage (specified at the 
time of order as it is not field configurable): 
 
 The AC input range is 85-264V @ 47-63Hz 
 The DC input range is 19-28V 
 The output of both power supplies is 27.6VDC @ 18.5A MAX, which is the normal operating 

voltage of the VDR.  If a battery test is executed by the power controller, then the power 
supply output will drop to 21.5V for duration of 30min. 

 
The power supply also acts as a battery charger, either charging low batteries (bulk) or keeping 
them fully charged (trickle).  The battery input is reverse polarity protected by a crossbar diode 
and a replaceable fuse.  
 
 

3.4 Data Processing Unit (DPU) 
The DPU’s cable entry system is a combination of cable plate and grommets.  In this system, 
both the plate and the grommets are split. This allows the cable entry plate to be opened, and 
cables with molded or pre-wired connectors to be inserted without any modifications.  The use of 
a metal coating, in addition to grommets with conductive tape, help discharge unwanted 
interferences from the cable sheaths.  The DPU is also equipped with a fan and intake vent for 
cooling. 
 
The DPU measures 400mm x 400mm x 350mm (W x H x D) and is designed to be deck 
mounted. 
 

RT - 2700
Data Processing Unit
VDR100G2

 
Figure 3-1 - DPU Dimensions 
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3.5 Data Acquisition Unit (DAU) 
The DAU is an optional EMC shielded enclosure with a bolt on cover.  Similar to the DPU, the 
DAU’s cable entry system is a combination of cable plate and grommets.  In this system, both the 
plate and the grommets are split, allowing the cable entry plate to be opened, and cables with 
molded or pre-wired connectors to be inserted without any modifications.  The use of a metal 
coating, in addition to grommets with conductive tape, help discharge unwanted interferences 
from the cable sheaths.  Coaxial cable used for video signals are easily connected with BNC 
connectors. 
 
The DAU measures 600mm x 400mm x 150mm and is designed to be bulkhead mounted. 
 

VDR100G2
Data Acquisition Unit

RT - 2600

 
Figure 3-2 - DAU Dimensions 

 
 

3.6 Operation & Alarm Unit (OAU) 
The OAU can be surface or flush mounted: 

 It is normally installed in the main conning console but can be placed in any convenient 
location on the bridge. 

 It should be installed on the bridge where it will be easily accessible to the operator. 
 
Figure 3-3 - OAU Dimensions illustrates the original OAU, shipped with all VDR-100G2 units prior 
to serial number 20105050061. 
 
Figure 3-4 - OAU Dimensions (Revised Unit) illustrates the revised OAU.  This revised OAU is 
applicable to all VDR-100G2 units shipped from serial number 20105050061 and forward. 
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Figure 3-3 - OAU Dimensions 
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Figure 3-4 - OAU Dimensions (Revised Unit) 
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3.7 Remote Storage Module (RSM) 
This module should be mounted in close proximity to the alarm module, where it is easily 
accessible. 
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Figure 3-5 - RSM Dimensions 

 

 
Figure 3-6 - 24 VDC RSM Dimensions 
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3.8 Bridge Microphones 
The placement of microphones and audio test sources on the bridge is critical to ensure that all 
required areas on the bridge that require audio recording are monitored.  The areas to be covered 
are defined in IEC 61996 including: 
 

 Conning stations 
 Radar displays 
 Chart tables 
 All other bridge workstations 

 
The microphones should be installed such that the audio from intercoms, PA systems, and bridge 
alarms are recorded as far as is practicable. 
 
The bridge is divided, for recording purposes, into physical areas called zones.  The number of 
microphones required to cover the bridge determines the number of zones.  In the following 
diagram, the areas enclosed by clouds represent zones for audio recording.  The boxed areas 
indicate bridge panels or workstations. 
 
Figure 3-7 - Typical Microphone Zoning (6 Microphones) illustrates a bridge zoning arrangement 
for the base VDR-100G2 system, complete with six (6) microphones. The zoning on this system 
provides three (3) zones with two (2) microphones in each zone. 
 

 
Figure 3-7 - Typical Microphone Zoning (6 Microphones) 

 
 
Audio testing is performed simultaneously across each zone. The audio test sources for like-
numbered microphones (i.e., microphone number two (2) from each zone) are simultaneously 
activated during testing. For further explanation of microphone installation and testing (including a 
description of zoning), see Section 9 - AUDIO TEST SOURCE SETUP. 
 
It is very important that careful consideration be given to the placement of microphones and the 
zoning of the bridge, to ensure the bridge audio recording meets the IEC 61996 standard. 
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3.8.1 Coverage Patterns 
Care must be taken to avoid over-coverage due to the ambient bridge noise.  The external and 
internal microphone(s): 
 

 have a pickup angle (-3 dB) of 130º, 
 have a coverage area of approximately 3m from the front of the microphone, 
 should be installed in front of and above the area to be monitored. They can also be 

installed in front of and below the area to be monitored, depending on the physical 
configuration of the area.  

 
During the installation of microphones, consider the following: 
 

 All areas are monitored and have adequate coverage. 
 Individual microphones should be installed at a distance of at least 4m apart to 

guarantee there is no over-coverage of an area. Over-coverage will create problems 
when trying to determine the location of the source when replaying the recorded 
audio. 

 Exterior microphones should be positioned such that they are shielded from the 
direct exposure to sea spray and precipitation. 

 

 
Figure 3-8 - Sound Direction Pick-Up 
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3.9 Final Recording Medium (FRM/SFRM) 
The FRM/SFRM protective capsule shall be sited near the bridge on the external deck area of the 
vessel to maximize the probability of its survival and recovery following an incident. As outlined in 
IEC 61996, the capsule shall be positioned clear of rigging and other potential obstructions and 
as near to the centerline of the ship as practically possible.  
 
Criteria to be considered when assessing the optimum position shall include but not be limited to 
the following: 
 

1. Separation from fuel or other potential fire sources. 
2. Separation from probable sources of mechanical damage. 
3. Operational environment for continued serviceability. 
4. Accessibility for copying of recorded data and for routine maintenance. 
5. Facilitation of underwater removal and retrieval by both divers and ROVs. There shall be 

a clear unobstructed space near the capsule to allow an ROV or diver to work. 
 
The FRM/SFRM is supplied with an interconnect cable. This cable must connect to the VDR-
100G2 through a junction box (not provided with VDR-100G2). The Rutter–ACR Float-Free 
SFRM Capsule, which is supplied with a PoE Ethernet connect box (PS-100),  does not require a 
junction box for connectivity. 
 
The junction box must be shielded and connected to the hull of the vessel. The junction box is 
normally mounted on the exterior deck and located near the FRM/SFRM and positioned within 
range of the interconnect cable. All hull penetrations for cables must be fitted with waterproof 
glands (not provided with VDR-100G2). 
 

 
Figure 3-9 –L3 HVR-01Fixed FRM Capsule 
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Figure 3-10 - L3 HVR-02 Fixed FRM Capsule 

 
 

 
Figure 3-11 - L3 SVR-01 Fixed SFRM Capsule 
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Figure 3-12 - L3 SVR-02 Fixed SFRM Capsule 

 
 

 
Figure 3-13 - VDR-100G2S – Jotron Float-Free SFRM Capsule 
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Figure 3-14 - Rutter FRM (RUT-02447) Capsule 

 

 
Figure 3-15 - Rutter-ACR Float-Free SFRM Capsule 

 
 

Note! The mounting pattern provided in Figure 3-11 - L3 SVR-01 Fixed SFRM, 
Figure 3-12 - L3 SVR-02 Fixed SFRM Capsule, Figure 3-13 - VDR-100G2S – 
Jotron Float-Free SFRM Capsule and Figure 3-15 - Rutter-ACR Float-Free 
SFRM Capsule above, is applicable to the VDR-100G2S Simplified FRM only.  
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Compass Safe Distance 
Compass safe distance (CSD), as stated in IEC 60945 Section 11.2, determines the distances 
above which any onboard equipment will not cause an unacceptable deviation of the ship’s 
standard and steering compasses. The table below provides CSD information for the DPU, DAU, 
OAU, RSM, NMEA Module, and Video Module. 
 
Equipment Safe Distance to: Reduced Safe Distance to: 

 Standard Magnetic 
Compass 

Steering Magnetic 
Compass 

Standard Magnetic 
Compass 

Steering Magnetic 
Compass 

DPU 3,80m 2,40m 2,30m 1,45m 

DAU 3,90m 2,60m 2,35m 1,60m 

OAU 1,15m 0,70m 0,70m 0,50m 

RSM 0,85m 0,55m 0,55m 0,35m 

NMEA Module 0,30m 0,30m 0,30m 0,30m 

Video Module 1,75m 1,05m 1,05m 0,65m 

Audio Module 1,75m 1,05m 1,05m 0,65m 

FRM 0,60m 0,40m 0,40m 0,30m 

Microphone(s) 0,30m 0,30m 0,30m 0,30m 

Outside Microphone(s) 0,30m 0,30m 0,30m 0,30m 

Table 3-2 - VDR-100G2 Component Compass Safe Distance (CSD) 

 

3.10 Documentation 
The final planning requirement for a VDR-100G2 installation is to prepare the installation 
documentation. This documentation should contain detailed interconnect drawings that include: 
 

 Connection points in the VDR-100G2 DPU terminal block, external interfaces, and 
shipboard systems. 

 Sufficient detail to allow the installation technician to complete the interconnection of 
all components. 

 Cable types and sizes. 
 Cable numbers which will allow an installation technician to label cables after they 

are installed. 
 Other information relevant to the installation. 
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4 MOUNTING  
 

4.1 Unit Mounting Locations 

4.1.1 Installing the DPU and DAU 

4.1.1.1 Mounting the DPU 
The Data Processing Unit (DPU) cabinet is installed on the prepared base as shown in Figure 4-1 
– DPU Mounting. 
  

NOTE: In is important to note that the DPU cabinet must be mounted 
so that it opens like a lap-top computer with the base affixed to a 
horizontal surface, the front of the unit facing out towards the operator, 
the top hatch opening up and folding back away from the operator.

 

 
Figure 4-1 – DPU Mounting 

 
After the plinth is installed on the base mount, the DPU cabinet is installed on the plinth. There 
should be a minimum clearance of: 
 200mm from the left side (cable entry) of the cabinet to allow for easy access to the fan and 

cable entry plate. 
 A minimum of 100mm of clearance from all other sides of the cabinet to allow for proper 

ventilation and maintenance. 
 The top hatch will require 400mm of clearance to fully open. 
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4.1.1.2 Mounting the DAU 
The Data Acquisition Unit (DAU) is designed to be bulkhead mounted.  It requires a clearance of 
at least 400mm from the bottom of the unit to the deck to allow for adequate cable entry spacing. 
All other sides of the unit should have a minimum of 100mm clearance to allow for proper 
ventilation and maintenance. 
 

 
Figure 4-2 - DAU Mounting 

 
 

4.1.2 Mounting the Operation & Alarm Unit (OAU) 
There are 2 versions of the OAU.  Figure 4-3 - Operation & Alarm Unit illustrates the original unit 
(shipped prior to Serial Number: 20105050061), while Figure 4-4 - Operation & Alarm Unit 
(Revised Unit) illustrates the revised unit (shipped after and including Serial Number: 
20105050061). 
 
The original version of the OAU can be either surface or flush mounted. The positioning of 
mounting hardware will depend on the how the unit will be mounted. 
 
 To surface mount the original OAU, reposition the module’s side tabs to the rear of the unit 

and mount. 
 To flush mount the original OAU, the side tabs must remain at the same level as 

display/keypad face. 
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Figure 4-3 - Operation & Alarm Unit 

 
 
The revised version of the OAU can be either surface or flush mounted. 
 
 To surface mount the revised OAU, the mounting bracket and bracket screws must be 

removed. The unit can then be mounted using the two (2) vacant screw holes at the rear of 
the unit. 

 To flush mount the revised OAU, an appropriately sized hole must be cut in the console, the 
mounting bracket positioned against the inside of the hole, and the unit mounted and 
tightened to the bracket via the two (2) bolts at the rear of the unit. 

 

 
Figure 4-4 - Operation & Alarm Unit (Revised Unit) 
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4.1.2.1 Installing the OAU with Mounting Bracket 
The steps below provide a procedure for mounting the revised version of the OAU (also refer to 
Figure 4-5 - OAU Mounting Assembly): 
 

1. Remove the back plate of the OAU. 
2. Remove the glands located at the bottom of the unit and the silver hole-caps located 

on back cover plate of the unit. Reinstall the glands in the back plate holes and the 
silver hole-caps in the holes at the bottom of the unit. 

3. Install the two 35mm hex screws (long bolts) through the two visible screw holes in the 
back cover.  They should extend out through the back cover of the OAU. 

4. Secure each screw to the back plate with a double nut. 
5. Complete the wiring of the OAU to the VDR. 
6. Re-install the back cover. 
7. Insert the OAU through the mounting hole cut in the bridge console. 
8. Install the rear mounting bracket over the long bolts.  The rear mounting bracket must 

be installed so that its lip pieces touch the underside of the bridge console. 
9. Install washers and nuts on each bolt and tighten to secure the OAU. DO NOT over-

tighten, as this will bend the back cover. 
 

 
Figure 4-5 - OAU Mounting Assembly 
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4.1.3 VDR Data Port 
The VDR Data Port is a standard RJ45 wall jack. It should be mounted in a position on the bridge 
where a PC can be easily connected using a straight-through Ethernet cable. 
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Figure 4-6 - RJ45 Wall Jack 

 
 
To mount the Data Port, remove the wall jack top cover and screw into position. 
 
 

4.1.4 Remote Storage Module (RSM) 
The RSM (see Figure 3-5 - RSM Dimensions for unit dimensions) is accompanied with a 24VDC 
Power Supply and AC adapter. 
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Figure 4-7 - RSM Power Supply 

 
 

 
Figure 4-8 - RSM Power Supply - Internal View 
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If the RSM is to be mounted on the bridge of the ship, it must be done using the industrial 
strength Velcro-type fastening material attached to the four (4) corners at the bottom of the unit. 
 
 

4.1.5 External Interface Modules 
The external interface modules are supplied for mounting on 35mm “Top Hat” style DIN Rail. The 
DIN Rail is mounted in the location desired and the external interface unit is mounted on the rail. 
DIN Rail is not supplied with the external interface units. 
 
Figure 4-9 - DIN Rail shows the typical dimensions of the DIN Rail required for mounting an 
external interface. It is acceptable to use DIN Rail that is deeper than 7.5mm (15mm deep DIN 
rail is commonly available), as long as the 35mm width is maintained. 

 
Figure 4-9 - DIN Rail 

 
 

Note!  The Audio Module, when not installed in the DAU, must be grounded to the 
ship’s hull. 

 
 

4.1.6 Internal Microphones and Audio Junction Boxes 
The microphone locations are determined during the installation planning stage (see Section 3.8 - 
Bridge Microphones). 
 
The dimensions of the indoor microphone and audio junction box are shown in Figure 4-10 – 
Internal Microphone with Audio Junction Box.  
 
The audio junction box must be installed within the 2m cable length to the microphone and 
audio test source location.  The provided cable, attached to the devices, should not be 
changed. 
 
Audio coverage from the external microphone is omni-directional.  Therefore, the assembly 
should be installed in a manner which allows the coverage range to encompass the area to be 
recorded (the area behind the microphone will not be covered.) 
 
 
 

NOTE! The Audio Junction Box is normally installed behind the ceiling panels. 
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4.1.6.1 Internal Microphone Mounting 
 
The internal microphone is installed with an integrated audio test source and internally mounted 
wiring junction box.  See Figure 4-10 – Internal Microphone and Audio Junction Box. 
 

NOTE: It is important that the surface on which any microphone is to be mounted is 
clean, dry and smooth.  The Mushroom-Lock fastener’s adhesive must make 
complete contact with the mounting surface or the adhesive may fail to adhere. Clean 
the surface thoroughly and remove any loose material, such as paint flakes and 
labels. 

 
The microphone may be mounted to an existing surface or it may be mounted on the microphone 
junction box. If it is mounted on the junction box then the microphone junction box must be 
installed in a location that ensures the microphone will provide the required coverage area. 
 
If these surface conditions cannot be met, then, as an alternative, the microphone can be secured 
with hardware supplied by the installer. The choice of hardware depends on the surface where 
the microphone is to be installed and the style of mounting selected by the installer. 
 
To mount the microphone with additional hardware:  

1. Temporarily remove the microphone cover;  
2. Carefully drill the mounting holes in the sides of the microphone PCB or assembly to 

match the mounting hardware;   
 

 
NOTE: Do not over tighten the hardware or the microphone base may crack or split.  
 

 
3. Mount the microphone with the selected hardware; and  
4. Replace the microphone cover. 

 

 
Figure 4-10 – Internal Microphone with Audio Junction Box 
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4.1.7 External Microphone and Audio Junction Box 
The external microphone is installed with an integrated audio test source and externally mounted 
wiring junction box.  Figure 4-11 - External Microphone and Junction Box illustrates the 
microphone and junction box. 
 

NOTE 1: It is important that the surface on which any microphone is to be mounted is 
clean, dry and smooth.  The Mushroom-Lock fastener’s adhesive must make 
complete contact with the mounting surface or the adhesive may fail to adhere. Clean 
the surface thoroughly and remove any loose material, such as paint flakes and 
labels. 
 
NOTE 2: It is important that all externally mounted microphones are installed in 
protected locations.  Ideally, the microphone should be installed as to allow for 
minimum exposure to sea spray and rain.  It is recommended to mount the unit 
with the microphone facing downward. 

 
The microphone may be mounted to an existing surface or it may be mounted on the microphone 
junction box. If it is mounted on the junction box then the microphone junction box must be 
installed in a location that ensures the microphone will provide the required coverage area. 
 
If these surface conditions cannot be met, then, as an alternative, the microphone can be secured 
with hardware supplied by the installer. The choice of hardware depends on the surface where 
the microphone is to be installed and the style of mounting selected by the installer. 
 
To mount the microphone with additional hardware:  

1. Temporarily remove the microphone cover;  
2. Carefully drill the mounting holes in the sides of the microphone PCB or assembly to 

match the mounting hardware;   
 

NOTE: Do not over tighten the hardware or the microphone base may crack or split.  
 

3. Mount the microphone with the selected hardware; and  
4. Replace the microphone cover. 

 

 
Figure 4-11 - External Microphone and Junction Box 
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Audio coverage from the external microphone is uni-directional.  Therefore, the assembly should 
be installed in a manner which allows the coverage range to encompass the area to be recorded 
(the area behind the microphone will not be covered.)  
 

4.2 Final Recording Medium 
Refer to Sections 3.9 - Final Recording Medium (FRM/SFRM) and 5.7 - 
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Final Recording Medium for information regarding the mounting of the FRM. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

 
VDR-100G2/G2S Installation Manual  51  
RUT-TD-02-001, Rev 2.1 

 

5 CABLING AND INTERCONNECTIONS 
 
This section provides essential cabling and interconnection information. 
 
 

Note! All cabling should be clearly labeled at all connection points to allow for 
easier identification, particularly at all VDR-100G2 entry points. 

 
 

5.1 Ethernet Interconnection 
 

 
Figure 5-1 - DMM Port Connections 

 
 
The Audio Module output is connected directly to the DMM via a crossover Ethernet cable, 
which is plugged into LAN Port 4 of the DMM. 
 
The FRM is connected directly to the DMM via a crossover Ethernet cable, which is plugged into 
LAN Port 3 of the DMM. 
 
The Video Module output is connected via a straight through Ethernet cable to the HUB located 
in the DPU.  The NMEA Module Ethernet output is also connected via a straight through Ethernet 
cable to this same HUB.  The Hub is connected directly to the DMM via a straight through 
Ethernet cable into LAN Port 2.  
 
A DPU hub is connected to LAN Port 1 of the DMM directly via a straight through Ethernet cable.  
This hub can be used to connect a Download PC, RSM, Maintenance PC, or a secondary 
FRM. 
 
If a combination of the Download PC, RSM, Maintenance PC, or a secondary FRM are to be 
connected to LAN Port 1 simultaneously, it is required that each device be plugged into the Hub 
located in the DPU via a straight through Ethernet cable. 
 
Refer to Figure 1-1 - VDR-100G2 Block Diagram for additional information on component 
interconnections. 
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5.1.1 DMM / Data Module IP Address 
The IP Address for each of the data modules and associated DMM ports is listed below. 
 

Port / Module IP Address 

DMM Download Port (1) 200.200.200.200 

Download PC 200.200.200.XXX 

DMM Video/NMEA Port (2) 192.168.199.1 

Video Module 192.168.199.228 

DMM FRM Port (3) 192.168.0.189 

FRM 192.168.0.X 

DMM Audio Port (4) 192.168.200.189 

Audio Module 192.168.200.228 

Table 5-1 - DMM / Data Module IP Address 

5.2 Power Distribution 
The DPU contains a set of 14 terminal block connections.  With the exception of Terminal Block 
Position 15, these connections host the power supplied to the various interfaces and modules 
that constitute the VDR-100 G2 system. 
 

Note! Terminal Block Position 15 is reserved for OAU Serial Data connections. 
 
 
The DPU terminal block wiring is indicated in Table 5-2 - DPU Terminal Block Wiring Plan below: 
 

Devices  C B A Term  

Utility (Ship’s Emergency Power) 
AC = 85-264V @ 47-63Hz 

 
GND Neutral Hot 

Utility (Ship’s Emergency Power) 
DC = 19-28V 

 
GND Ret - + 

21  

Final Recording Medium (FRM)  GND Ret - 24+ 20 EP* 

Remote Storage Module (RSM)  GND Ret - 24+ 19 EP* 

Hub (Optional)  GND Ret - 24+ 18 EP* 

Audio Module  GND Ret - 24+ 17 EP* 

Operation & Alarm Unit (OAU)  GND Ret - 24+ 16 EP* 

OAU Data  COM GND RX TX 15  

Video Module  GND Ret - 24+ 14  

NMEA Module 1  GND Ret - 24+ 13  

NMEA Module 2  GND Ret - 24+ 12  

NMEA Module 3  GND Ret - 24+ 11  

Hub  GND Ret - 24+ 10  

Interface 1  GND Ret - 24+ 9  

Interface 1  GND Ret - 24+ 8  
Optional Final Recording Medium (FRM) #2 
(terminal to be installed by technician during 
installation) 

 
GND Ret - 24+ 7  

Table 5-2 - DPU Terminal Block Wiring Plan 

* EP = Essential Power 
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The DAU, when available, contains 6 total terminal block connections, broken into 2 physical 
blocks: 
 

Devices  C B A Term  

Video  GND Ret - 24+ 25  

Hub  GND Ret - 24+ 24  

NMEA  GND Ret - 24+ 23  

Audio  GND Ret - 24+ 22 EP 

Table 5-3 - DAU Terminal Block (One) 

 
Devices  C B A Term 

Interface 1  GND Ret - 24+ 27 

Interface 1  GND Ret - 24+ 26 

Table 5-4 - DAU Terminal Block (Two) 

 
 
 
 



Chapter 5: Cabling and Interconnections 

 
VDR-100G2/G2S Installation Manual  54  
RUT-TD-02-001, Rev 2.1 

 
Figure 5-2 - DPU Power Overview 
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Figure 5-3 - DAU Power Overview 

DAU Terminal 
Block (One) 

DAU Terminal 
Block (Two) 

DPU Terminal 
Block 
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Figure 5-4 - Terminal Block Letter Labeling 

 
 

5.3 Cable Entry System 
The VDR-100G2 is equipped with cable entry panels, similar to that illustrated in Figure 5-5 - 10-
Hole Cable Entry Plate below. 
 

Tel.:07191/4820
MP-Systemtechnik KDL 2/10

 
Figure 5-5 - 10-Hole Cable Entry Plate 

 
To install the appropriate cables using a cable entry plate, follow the instructions below: 
 

1. Remove the entry plate from its cut-out position. 
2. Select the split grommets to suit the various cable sizes. 
3. Open the entry gland by removing the hexagon screws. 
4. Remove the cable insulation, in order to reveal the metal screen; the metal screen 

should then be grounded to the internal ground bolt. 
5. Position the grommets over the cable and affix cable ties if required. 
6. Insert the assembled grommets into the entry plate. 
7. Place blank grommets into the entries not used. 
8. Close and screw up the entry plate. 
9. Screw the entry plate to its original cut-out position. 
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5.4 Video Input Connections 
The video inputs are connected via the female BNC bulkhead connectors located at the bottom of 
the DAU.  All video data is connected to the DAU using RG-11, RG-6, or other approved coaxial 
cable.  Additionally, the number of cables used is dependant upon the video source: 
 

 A composite video source may have a single video cable (with video and sync 
combined). 

 A colour radar source may have five (5) video cables (red, green, blue, H-sync, and V-
sync). 

 
 
 
 

 
Figure 5-6 - DAU Video Input Connections 

 
 
Coaxial video cables from the vessel’s video source must be fitted with male BNC connectors, 
which are in then connected to the appropriate BNC female bulkhead connectors.  If the video 
feed occurs over multiple cables, it is important to ensure that all video cables are connected to 
the bulkhead connectors that correspond to proper signal type (i.e., red=red, green=green, 
blue=blue, etc.) 
 

Channel 4 

Channel 3 

Channel 2 

Channel 1 

R (Red) G (Green) B (Blue) H (Horiz) V (Vert) 
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5.5 Audio Connections 
 
The microphones, buzzers, and corresponding junction boxes are connected to the VDR-100G2 
via the Audio Module: 
 

 The microphone junction box is wired to the VDR-100G2 Audio Module using a two-pair 
shielded cable; 

 The microphone junction box connects to the microphone and buzzer; 
 The microphone is connected to the terminal blocks in the audio junction box; and 
 The buzzer is connected to the terminal blocks in the audio junction box. 

 
 

Note!  The Audio Module, when installed externally (no DAU), must be grounded 
to the ship’s hull. 

 
 

5.5.1 Audio Module Inputs 
The basic Audio Module has 4 channels with 2 inputs each for a total of 8 inputs. Optionally the 
Audio Module may be supplied with 6 or 8 channels (12 or 16 inputs respectively).  
 
Inputs to the Audio Module are field configurable and can change to customize a particular 
installation.  Only the primary VHF being recorded is connected to Channel 1. Once all 
microphones have been connected, any additional VHFs can be connected to the first available 
free channels.  
 
Example 1:  If the primary VHF and 4 microphones have been connected and there are no other 
microphones to connect then any additional VHF may be connected to Channel 4 
Example 2: If the primary VHF and 6 microphones have been connected and there are no other 
microphones to connect then any additional VHF may be connected to Channel 5. 
 
The table below illustrates a typical configuration for the basic and the expanded module.  
 

Input 1 VHF Tx/Rx or VHF Tx Channel 1 
Input 2 VHF Rx 
Input 3 Internal Mic #1 Channel 2 
Input 4 Internal Mic #2 
Input 5 Internal Mic #3 Channel 3 
Input 6 Internal Mic #4 
Input 7 External Mic #1 

Base - 8 Input Module 

Channel 4 
Input 8 External Mic #2 
Input 9  VHF(2)Tx/Rx or VHF (2)Tx Channel 5 
Input 10 VHF(3) Tx/Rx or VHF(2) Rx 
Input 11 Internal Mic #5 

Optional - 12-Input Module 

Channel 6 
Input 12 Internal Mic #6 
Input 13 Internal Mic #7 Channel 7 
Input 14 Internal Mic #8 
Input 15 Internal Mic #9 

Optional - 16-Input Module 

Channel 8 
Input 16 Internal Mic #10 

Table 5-5- Audio Module Configuration  

Note! It is highly recommended that there not be more than 1 VHF connection 
on the first eight (8) inputs of the Audio Module. 
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Note! It is highly recommended to connect internal microphones in groups (i.e., if 
a vessel has four (4) internal microphones and two (2) external microphones, the 
internals should be connected to Input 3-4, and Input 5-6 with the two (2) externals 
connected to Input 7-8). 

 

BUZZ 2BUZZ 1

BUZZ 2

-

+BUZZ 1

 
Figure 5-7 – 12-Input (6-Channel) Audio Module 

 
For ease of installation it is recommended to organize the audio cabling from left to right following 
the input configuration of the Audio Module. 
 
 

Note! When preparing the cables for connecting to the Audio Module, it is 
important to leave an adequate amount of wire pigtails to make the necessary 
connections to both the microphone and associated buzzer (located on the right 
hand side of the Audio Module) input connection points. 

5.5.2 Buzzer Connections 
When connecting microphone buzzers to the rear of the Audio Module, refer to the Figure below 
for an illustration of the buzzer connectors and their associated channel inputs: 
 

 
Figure 5-8 – Audio Module Buzzer Connections 

 
 
For example, an inside microphone connected to Input 1 (Channel 3) would connect to buzzer 
connection point #1 (positive and negative). An inside microphone connected to Input 4 (Channel 
3) would connect to the sixth buzzer connection. 
 

Buzzer Block 1 Buzzer Block 2 
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If the Audio Module has 16 Channels, it will be necessary to connect two (2) microphone buzzer 
connections to one (1) buzzer connection point. For example, Input 14 and 16 can both be 
connected to buzzer connection point #10, while Input 13 and 15 can both be connected to 
buzzer connection point #5. 

 
 
Note!  The Audio Module must be grounded to the ship if installed outside of the 
DAU. 
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5.5.3 Internal Microphone and Buzzer 
 

 
Figure 5-9 - Internal Microphone Terminal Block 

 
Note! The conductor marked “SHLD”, “S”, or “Audio Channel Shield” should not be 
grounded to the internal ground bolt of the DPU. It should be connected directly to 
the SHLD input at the rear of the Audio Module. 

 

 
Figure 5-10 - Audio Module - Individual Channel Connections 

 
To minimize wiring from the audio junction boxes to the VDR-100G2, it is possible to connect the 
VDR-100G2 cable from all the audio junction boxes to a central junction box and run a single 
multi-lead cable back to the VDR-100G2.  This central junction box is not provided with the VDR-
100G2. 
 
Each internal microphone/buzzer unit is connected, via the audio junction box, to the Audio 
Module.  If applicable, the cables connecting these microphones will be routed to the cable entry 
point location on the left hand side of the DAU. 
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5.5.4 External Microphone Assembly 
The external microphone assembly contains the outside microphone, audio test source, and 
wiring junction box. See Figure 4-11 - External Microphone and Junction Box for an illustration of 
the microphone and junction box. 
 
The interconnections required for the external microphone assembly are similar to the internal 
microphone as described in Sections 5.5 - 
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Audio Connections, 5.5.1 - Audio Module Inputs, and 5.5.2 - Buzzer Connections above. 
 
 

 
Figure 5-11 - External Microphone Terminal Block 

 
 

5.5.5 VHF Audio Connection 
Connection between the Audio Module and a VHF source is dependant on the type of VHF 
source: 
 

 A Simplex VHF source will connect to Input 1 (Channel 1). 
 A Duplex VHF source will connect to Inputs 1 and 2 (Channel 1). 
 There is no buzzer connection when connecting a VHF source. 
 Line level output will connect to the +, - terminals of the Audio Module. 

 
The interconnections required for the VHF are similar to those described in Section 5.5 - 
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Audio Connections above. 
 
 

5.6 Operation & Alarm Unit 
The OAU provides a VDR alarm output via a 24 VDC signal, active upon a VDR alarm. The unit 
connects to the bridge alarm panel via a one-pair cable. If the bridge alarm panel requires a dry-
contact connection then a relay must be installed to change the 24VDC output to a dry-contact. 
 
The unit connects to the DPU using a three-pair cable. 
 
The original version of the OAU, illustrated in Figure 5-12 - Bottom View of OAU, connects via 
two (2) cable entry glands located at the bottom of the unit. The revised version of the OAU, 
illustrated in Figure 5-13 - Bottom View of OAU (Revised Unit) and Figure 5-14 - Rear View of 
OAU (Revised Unit), can be connected via two (2) cable entry glands located at the bottom of the 
unit or, optionally, through 2 cable entry points located at the rear of the unit. 
 
 

 
Figure 5-12 - Bottom View of OAU 

 
 

 
Figure 5-13 - Bottom View of OAU (Revised Unit) 
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Figure 5-14 - Rear View of OAU (Revised Unit) 

 
 

Note:
The Normally Open and Normally Closed connection points are dry contacts.  The connection to the Bridge Alarm System will be dependant upon the 
requirements of a particular system.  The dashed lines indicate possible connections.

OAU Terminal Block Legend:

Op = Normally Open

Cl = Normally Closed

In = Common

Gnd = Ground

Tx = Transmit

Rx = Receive

 
Figure 5-15 - OAU to DPU Terminal Block Connections. VDR Serial No 20XXXXX1150 and forward. 
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Figure 5-16 - OAU to DPU Terminal Block Connections (w/ optional relay). All units prior to VDR Serial No 

20XXXXX1150. 

 
 
 
 

Note! Communications between the DPU and OAU are via a crossover 
connection. 
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5.7 Final Recording Medium 
The FRM is connected to the VDR-100G2 via a DC power cable and an Ethernet interface cable. 
The Ethernet cable is a 10-base-T/STP (shielded twisted pair), Category 5e with flammability per 
IEC 95: 
 

 The DC power cable connects to the terminal block in the DPU terminal block 24 VDC 
supply. 

 The Ethernet connection is via a RJ45 connector. This is connected to Ethernet port 3 on 
the DMM. 

 The connection between the DMM and the FRM is a crossover cable. 
 
The wiring of the connections between the RJ45 connector (illustrated in Figure 5-18 - RJ45 
Connector) and the FRM is illustrated in Figure 5-17 - FRM Connections to L3 HVR-02 Fixed 
FRM Capsule (Revised Unit).  However, the connections shown pertain only to the L3 HVR-02 
Fixed FRM Capsule.  Refer to the FRM manufacturer’s installation manual to confirm all FRM 
installation information. 
 
 

 
Figure 5-17 - FRM Connections to L3 HVR-02 Fixed FRM Capsule (Revised Unit) 

 
 

 
Note! The wiring shown in Figure 5-17 - FRM Connections to L3 HVR-02 Fixed 
FRM Capsule (Revised Unit) is a crossover connection. Care must be taken to 
ensure there is only 1) crossover. 2 crossover connections have the same affect as 
a straight-through connection.  

 
 
 
The junction box adjacent to the FRM on the vessel’s outside deck is not supplied with the VDR-
100G2.  It connects the cables provided with the FRM to the cables connecting to the VDR-
100G2.   
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This junction box can be located inside, but must be located within the cable distance of the FRM 
cables. It must also be fully screened and connected to the vessel’s hull. If mounted outside, it 
must also be waterproof.  
 

 
Figure 5-18 - RJ45 Connector 

 
 

Note! It is highly recommended that cabling connecting the FRM to the VDR-
100G2 is installed through a gooseneck conduit (see Figure 5-19 - Sample VDR-
100G2S SFRM Installation for a sample FRM installation.) 
 
 

 
Figure 5-19 - Sample VDR-100G2S SFRM Installation 

Fixed Capsule 

Gooseneck Conduit 
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5.8 Remote Storage Module 
The optional RSM is powered by a 24VDC power cable (included). 
 
Data is transferred via a straight-through Category 5e Ethernet cable. 
 

 
Figure 5-20 - RSM Connection Points 

 
The power cable: 

 Enters the DPU via the terminal block access point. 
 Connects to the terminal block as specified in Table 5-2 - DPU Terminal Block Wiring 

Plan. 
The Ethernet cable: 

 Enters the DPU via the DMM access point. 
 Requires a shielded RJ45 connector. 
 Is terminated at the hub located in the DPU. 

5.9 External Interface Modules 
It is recommended that the external systems to which the installer is connecting have the power 
removed until the connections are finished. If this is not possible, care must be taken to ensure 
that the systems are not damaged.  
 
If it is necessary to connect to a live system, the connections on the VDR-100G2 external 
interface module should be complete first. Continuously monitor the vessel’s system to ensure 
the connections to the external interface modules do not affect their operation. 
 

Power Input 

Ethernet Port 

USB Port 

Power Switch 
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6 INITIAL POWER-UP 
 

6.1 Software Modules  
While recording, the Data Management Unit (DMM) is required to carry out the following functions 
simultaneously: 
 

 Capture video through the Video Module. 
 Record bridge audio and radio communications audio through the Audio Module. 
 Record serial data through the NMEA 0183/IEC 61162 NMEA Module. 
 Synchronize time to UTC/GMT through a GPS receiver feed or other time references via 

a NMEA Module input. 
 Monitor the status of Power Supply and backup battery from the Power Control Module 

through a serial communications port. 
 Provide Server Services to download client(s) in a Fast Ethernet LAN configuration. 
 Store all data to a Final Storage Medium and allow user-initiated backups to a redundant 

removable storage system, while still allowing this data to be downloaded via the LAN for 
playback purposes. 

 Generate an alarm if an error condition develops in the VDR-100G2. 
 
The DMM system software is a Windows XP application program.  The program is designed to 
support a multi-threaded operation, providing optimum CPU utilization for simultaneous data 
acquisition, synchronization, and compression of multiple data streams.  The following section 
describes the system software operation. 
 
 

6.2 Power On 
Once the unit has been mounted for operation, it is necessary to power on the VDR-100G2 
system.  The VDR is designed for continuous operation and once connected to ship’s power 
should remain on during the remainder of the installation process.  This procedure will also serve 
as a functional test of the unit.  
 
The Power Control Module will switch to the backup battery for energy in the event of a power 
interruption.  If a power interruption is scheduled for more than 2 hours, the VDR-100G2 may be 
shut down to preserve battery life.  If necessary during a VDR installation, a shut down can be 
initiated from the Windows XP desktop prior to turning off the DMM.  
 
The following steps provide a procedure for powering on the VDR-100G2: 
 

1. Open the cover of the DPU. 
2. Ensure the 4 2A breakers are off. The secondary FRM configuration will 

have 5 2A breakers. 
3. Close the 20A circuit breaker. 
4. Apply ship’s power to the VDR-100G2. 
5. Close the 4 2A breakers one at a time to ensure that each applicable 

component is receiving power. The secondary FRM configuration will have 5 
2A breakers. 

6. Connect either the required PC peripherals (mouse, keyboard, etc.) or a PC 
client via an Ethernet connection to establish remote desktop connection to 
the DMM (see Section 7 - CONNECTING TO THE DPU for more 
information on establishing a remote desktop connection with the DMM.) 
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7 CONNECTING TO THE DPU 
 
When accessing the internal O/S of the DMM, it will be first necessary to connect either a 
keyboard/mouse/monitor, or use a remote desktop connection established from a maintenance 
computer. 
 
Follow the applicable procedures provided below to access the DMM’s O/S. 
 

7.1 Using a Keyboard, Mouse, and Monitor 
 

1. Open the top hatch of the DPU. 
2. Connect the keyboard, mouse, and monitor to the DMM front panel. 

 

 
Figure 7-1 - Data Management Module Input Ports 

 
3. Once the monitor has been turned on, the record application (VDR_Record) should be 

visible. Shut down this application to terminate the recording process (a password is 
required.) 

4. Once the record application has been terminated, log off the current user account and log 
in as an Administrator (will require an Administrator password.) 

5. Once in administrative mode, effect any changes necessary. Software can be loaded to 
the DMM via USB memory sticks. 

6. All changes to DMM software and/or operating system MUST be committed to the flash 
memory of the DMM in order for them to take effect. To do so: 

 Locate and double-click the commit.exe icon on the desktop. 
 

 
Figure 7-2 - commit.exe Icon 

 
7. Restart the DMM via Start > Shut Down. 
8. The DMM will reboot and all record application software will restart. 
9. Verify that all applicable applications have restarted and are performing correctly. 
10. Unplug the keyboard, mouse, and monitor. 
11. Close and lock the top hatch of the DPU. 
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7.2 Using Remote Desktop 
To utilize a remote desktop when accessing the DMM’s operating system, a technician must 
ensure that the connecting PC has, at minimum, the following features/settings: 
 

 XP Professional Operating System or higher. 
 HVR Download Utility. 
 Computer name must not be “VDR”. 
 Within the IP range of 200.200.200.x (where ‘x’ can be any IP other than 200.) 

 

 
Figure 7-3 - IP Range 

 
 

1. Open the top hatch of the DPU. 
2. Connect the Remote Desktop PC to the VDR via one of the following methods: 

 Download (LAN1) port at the rear of the DMM. 
 The download hub located within the DPU. 
 The exterior VDR Data Port. 

 
3. It is now possible to connect via the Remote Desktop. Go to Start > All Programs > 

Accessories > Communications > Remote Desktop Connection. 
4. In the “Remote Desktop Connection” dialog window, click “Options >>” and enter the 

following settings: 
 

Computer: 200.200.200.200 
User name: MyUser 
Password: Rutter 
Domain: WORKGROUP 
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Figure 7-4 - Logon Settings 

 
 

5. Click the “Connect” button. 
6. The DMM operating system desktop will display and the record application 

(VDR_Record) should be visible. 
7. Select the Watchdog application located in the task bar (adjacent to the “Start” button).  

In the Watchdog window, select the “Cancel” button and enter VDR when prompted to 
enter a password. 

8. Once the Watchdog application has been shut down, shut down the VDR Record 
application to terminate the recording process (a password is required.) 

9. Log off the MyUser account via Start > Log Off. 
 

 
Figure 7-5 - MyUser Logoff 

 
 

10. Reconnect to the VDR-100G2 via the Remote Desktop using the following settings: 
 

Computer: 200.200.200.200 
User name: Administrator 
Password: [Enter applicable administrative password here] 
Domain: WORKGROUP 
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11. To browse the network in order to obtain software from a shared folder on the remote PC, 
click Start > Run… Enter the name of the remote PC in the “Run…” dialog window (for 
example, \\RemotePC and click “OK”. 

12. Note that Remote Desktop software is also available for technicians using Windows 2000 
software.  To obtain this software, please contact the Rutter Technologies Support 
Department. 

13. All changes to DMM software and/or operating system MUST be committed to the flash 
memory of the DMM in order for them to take effect. To do so: 

 Locate and double-click the commit.exe icon located on the desktop (see Figure 
7-2 - commit.exe Icon). Accept the automated restart. 

 
 

Note! If necessary to log on using an administrator account after restart, wait 
approximately 2 minutes. 
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8 VDR RECORD OPERATING INSTRUCTIONS 
 
 
The VDR_Record application must be operated only by a Rutter Technologies Inc 
representative or other authorized service personnel.  
 
During normal operation, the VDR_Record application is neither visible nor accessible to the 
user.  However, during installation, commissioning and servicing there are several features within 
the VDR_Record application that are used for testing and configuration purposes.  These 
features, along with several of the standard Windows applications features, are found in the menu 
bar as outlined below. 
 

8.1 File Menu 
 

 
Figure 8-1 - File Menu 

 
Save – Saves the selected window to the VDRapps folder on the internal drive. The video 
capture shall be saved as a bitmap. 
 
Save As – Allows the option to choose the folder to which the selected file will be saved.  
 
Change Password – Allows a user to change the Record application password. 
 
Exit – Closes the VDR_Record application. The application cannot close if any of the test modes 
are selected. 
 
 

8.2 View Menu 
 

 
Figure 8-2 - View Menu 
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Status Bar – Activates the Status bar at the bottom of the application. The default for this option 
is enabled. 
 
Video Data – Selects the video data window to be displayed.  
 
Audio Data – Selects the audio data window to be displayed. 
 
Log Window – Selects the Log window to be displayed. 
 

8.3 Tests Menu 
 

 
Figure 8-3 - Tests Menu 

 
 

Note! Only 1 test mode may be operated at a time. 
 
 
 
Video Test – Activates the VDR Video test mode. In this mode it will perform video captures and 
display the resultant image in the Video Data window.  The file size of the captured image, the 
time of capture and the channel on which the image was captured will be displayed in the Log 
Window as defined in the VDRPARAMS.INI file.  
 
Audio Test – Activates the VDR Audio Test mode.  In this mode the bridge audio levels and VHF 
signals will be displayed in the Audio Data window and the calculated RMS levels for each zone 
will be displayed in the Log Window as defined in the VDRPARAMS.INI file. 
 
NMEA Test – Activates the VDR NMEA Test mode.  In this mode all the NMEA data, as it is 
received, will be displayed in the Log Window as defined in the VDRPARAMS.INI file. 
 
Record – Activates the VDR record mode.  In this mode the record status and errors will be 
reported in the Log Window. Video, audio, or NMEA data will not be displayed. 
 
Alarm – Performs a one-time communications test with the OAU.  A successful test will display 
the message Storage error in the Log Window and the OAU will display Status: Storage Error and 
sound the audible alarm for two (2) seconds. 
 
Secure current dataset – Secures and timestamps the most recent 24 hours of captured data.  
 
Enable Real Time Display – Enables the Real Time Display software option for a period of three 
(3) hours.  A message will appear in the Log Window indicating that the option has been turned 
on.  The time remaining will display if the option is selected while the software option is enabled.  
If the Real Time Display software option has been purchased, this option is not available. 
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8.4 Audio A/D Menu 
 

 
Figure 8-4 - Audio A/D Menu 

 
 
Enabled – Default is set to Enabled.  Enables the audio capture by the VDR audio subsystem 
and stores the audio data to the DPU during recording. 
 
Status – Displays the current status of the Audio A/D module in the Log Window. 
 
Compression – Default is set to enabled.  Enables the ADPCM compression of the Audio during 
recording. 
 
Enable filter – Default is set to enabled.  Enables the low pass filtering for the audio ports during 
recording. 
 
Test Mic 1 – Activates audio test source # 1 in each of the audio channels.  The VDR_Record 
application must be in either Audio test or Record mode for this test to be conducted.  The results 
of the test will be displayed in the Log Window.  If the test is performed in Audio Test mode the 
chirp from the test source may be observed as a spike in the Audio Data window. 
 
Test Mic 2 – Activates test source # 2 in each of the audio channels.  See Test Mic 1 for 
additional details.  
 
Perform Full Test – Activates the microphone self test procedure immediately.  The test will use 
the settings in the VDRPARAMS.INI file and the results will be displayed in the Log Window.  The 
VDR_Record application must be in either Audio Test or Record mode to conduct this test. 
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8.5 Video A/D Menu 
 

 
Figure 8-5 - Video A/D menu 

 
 
Enabled – Default is set to enabled.  Enables the video capture by the VDR video subsystem and 
stores the video data to the DMM during recording. 
 
Status – Displays the status of the Video A/D module in the Log Window. 
 
 

8.6 NMEA A/D Menu 
 

 
Figure 8-6 - NMEA A/D menu 

 
 
Enabled – Default is set to enabled.  Enables the NMEA capture by the VDR video subsystem 
and stores the NMEA data to the DMM during recording. 
 
Status – Displays the current status of the NMEA A/D module in the Log Window. 
 
 

8.7 Storage Menu 
 

 
Figure 8-7 - Storage Menu 

 
 
Module Status – Displays the current status of the overall Storage module and the four (4) 
individual modules (Video, Audio, NMEA and Hardened) in the Log Window. 
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Drive Status – Displays the current status of the DMM. 
 
System Contents – Displays the start and end time of the NMEA, Audio and Video data sets 
currently recorded on the DMM internal drive. 
 
Properties – This menu will not be available if the VDR_Record application is in record mode.  
There are two (2) additional items under the Properties menu: 
 

 Location – Displays the location of where the primary data set will be saved.  
Enables mirroring of the data set to another location. 

 Advanced Controls – Sets the number of data blocks to be packaged into one 
file. 

 
Changes to these settings will take place immediately in the recording but will not be written to 
the VDRPARAMS.INI until the VDR_Record application is closed. 
 
Reset Contents – Deletes the recorded data set on the internal DMM drive. 
 
 

8.8 Window Menu 
 

 
Figure 8-8 - Window Menu 

 
 
Tile – Arranges all open windows so they are displayed on the screen simultaneously. 
 

1. Video Data – Selects the Video Data as the active window. 
2. Audio Data – Selects the Audio Data as the active window. 
3. Log Window – Selects the Log Window as the active window. 

 
 

8.9 Help Menu 
 

 
Figure 8-9 - Help Menu 

 
 
About – Display the version number of the Serial Number and Product Key applicable to each 
VDR Record application. 
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Figure 8-10 - Help Menu 'About' Dialog Box 

 
 
The Serial Number and Product Key listed in the “About” dialog box will differ between each VDR 
unit.  These numbers are used to enable special features and can be important when 
troubleshooting potential software issues.
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9 AUDIO TEST SOURCE SETUP 
 
 
The microphone locations are determined during the installation planning phase.  A maximum of 
8 independent audio channels is supported.  Each channel supports a maximum of 2 inputs.  
Typically the sources are either 2 inside microphones, 2 outside microphones, or a transmit (Tx) 
and receive (Rx) VHF radio line. 
 
Channels with similar sources can be mixed in software to form a zone.  Up to 4 microphones or 
2 radios can be assigned to a zone.  A zone is referred to in the vdrparams.ini file as an 
OutputChannel.  The zoning of audio recording allows for simultaneous activation of buzzers, 
which are used as a test source for microphone operation.  Buzzers are paired with the 
microphones and can be connected to 1 of 2 independent controls (BuzzRef1 or BuzzRef2). 
  
In the case where a ship will have 12 microphones installed on the bridge there will be 3 zones.  
The microphones should be installed starting on the port side of the bridge and continuing to the 
starboard side.  
 
 

9.1 Understanding Zones 
A Zone is determined by the number of channels placed in individual OutPutChannelX fields in 
the vdrparams.ini.  For example, consider a vessel that has 12 internal bridge microphones and 1 
VHF source.  The VHF source will occupy the 2 inputs on Channel 1, leaving the following 
microphone connection arrangement: 
 

 Mics 1 & 2 = Channel 2 
 Mics 3 & 4 = Channel 3 
 Mics 5 & 6 = Channel 4 
 Mics 7 & 8 = Channel 5 
 Mics 9 & 10 = Channel 6 
 Mics 11 & 12 = Channel 7 

 
The channels entered into the first four (4) OutPutChannelX fields of the VDRPARAMS.INI file 
are communicated to the FRM.  Two (2) channels can be entered per OutPutChannelX field (with 
the exception of a VHF channel which must have a dedicated OutPutChannelX field).  Using the 
12 microphone example provided above, the OutPutChannelX fields would be similar to the 
following: 
 

 OutPutChannel1 = 1 
 OutPutChannel2 = 2, 3 
 OutPutChannel3 = 4, 5 
 OutPutChannel4 = 6, 7 

 
This installation configuration allows all 12 of the bridge microphones (and the single VHF) to be 
recorded to the FRM.  In this configuration there are three (3) microphone zones: 
 

 Zone 1 = Channel 2 & 3 
 Zone 2 = Channel 4 & 5 
 Zone 3 = Channel 6 & 7 

 
Since a maximum of 2 channels can be mixed per OutPutChannelX field, a maximum of 4 inputs 
can be placed in 1 zone.
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A zone, wherever possible, must contain microphones recording similar information.  For 
example, since you cannot mix an internal microphone channel with an external microphone 
channel, external microphones must be contained within their own zone. See Sections 9.4.1 - 
Microphone Installation - Sample One and 9.4.2 - 
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Microphone Installation – Sample Two for more detailed examples of configuring the microphone 
parameters and zones. 
 
 

9.2 Audio Setup 
The Audio Diagnostics application will allow a user to auto-configure the audio section of the 
VDRPARAMS.INI file. 
 
Alternatively, the audio information can also be manually set-up and adjusted.  In either case, the 
Detection Threshold will need to be manually configured. 
 

9.2.1 Audio Diagnostics (AudioConfigSuite) Application 
The Audio Diagnostics (ADi) application is used to capture and configure audio data from bridge 
microphones, externally mounted microphones, and VHF radio sources where applicable. 
 
There are two (2) methods available for starting the application: 
 
 Via the Start menu (Start > All Programs > Utilities > AudioConfigSuite). 
 The application’s executable file is located in the C:\VDRApps folder. Double-click the 

AudioConfigSuite.exe icon to open the application.  
 
 

Note! It is also recommended to copy the AudioConfigSuite.exe and 
RutterACS.dll files to the D:\ drive and operate the application from that 
destination in order to avoid any potential virtual memory problems. Note that the 
Start menu should not be used if attempting to run the application from the D:\ 
drive.  

 
 
Prior to operating the ADi application, the VDR_Record application must be stopped and closed.  
 

 
Figure 9-1 - Taskbar Menu 

 
 
Once started, the ADi application will place an icon (Rutter Technologies symbol) in the desktop 
task bar. The icon can be used to: 
 
 Initiate the capture of audio (Capture Audio) 
 Analyze the amplitude of captured audio (Analyze Audio) 
 Playback captured audio in real time (Live Playback) 
 Store configured audio settings to the VDRPARAMS.INI file (Configure VDR) 
 Minimize the application interface and/or menu (Hide) 
 Exit the application (Terminate) 
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9.2.1.1 Configure VDRPARAMS.INI 
The ADi application can also be used to properly configure the audio section of the 
VDRPARAMS.INI file. The steps provided below outline the procedure for configuring the INI file: 
 

1. Right-click the ADi icon in the taskbar and select ‘Configure VDR’. 
2. In the VHF Channel dialog box, indicate which channels are reserved for VHF. For 

example, if channels 1 and 5 are connected for VHF, enter 1 and 5 in the text fields. Or if 
there is only a single VHF, connected to channel 1, enter “1” in the VHF1 text field and 
“0” in the VHF2 text field. Once the channels have been entered press “OK”. 

 

 
Figure 9-2 - VHF Channel Dialog Box 

 
 

3. Once the VHF channels have been entered, the Audio Configuration dialog box will 
appear. This dialog box will be used to input specific information about microphone 
connections and audio channel mixing. 

 

 
Figure 9-3 - Audio Configuration Dialog Box 
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4. Start by selecting the number of microphones on each channel (located in the ‘Mic 
Section’ of the dialog box.) Channels that have been specified for VHF 
connections will be unavailable (grayed out.) If there are two (2) microphones on a 
channel, select only the “2 Mic” selection box. 

5. Once the number of microphones per channel has been entered, choose which 
channels to mix using the “Audio Module Channels” section located at the top of 
the dialog box. The first four (4) DMM rows (DMM1 – DMM4) indicate the four (4) 
channels which will communicate to the FRM for final recording medium storage. 

6. The settings from a previous VDRPARAMS.INI file can be loaded into the Audio 
Configuration dialog box by pressing the “Load” button. However, ensure all items 
are unchecked when attempting to load previous settings. 

7. To save settings, press the “OK” button. 
 

 
Figure 9-4 - Audio Configuration Dialog Box Example 

 
 
Using Figure 9-4 - Audio Configuration Dialog Box Example as an example entry: 
 

 DMM1 (FRM) selection box 1 has been selected. This indicates that information from 
Channel 1 will be stored to the FRM and not mixed with any other audio channels. Note 
that since Channel 1 has been specified as being a VHF connection, it cannot be mixed 
with other channels. 

 DMM2 (FRM) selection boxes 2 and 3 have been selected. This indicates that audio 
information from Channels 2 and 3 will be mixed and stored to the FRM. A maximum of 
two (2) channels can be mixed. Once two (2) channels are selected the other selection 
boxes in that row will be unavailable. 

 DMM3 (FRM) selection boxes 4 and 6 have been selected. This indicates that audio 
information from Channels 4 and 6 will be mixed and stored to the FRM. Selection box 5 
could not be selected for mixing as it is connected to a VHF source. 
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The following sections detail VDRPARAMS.INI file and audio configuration information for use 
when manually configuring audio (i.e., without using the Audio Diagnostics application.) 
 

9.2.1.2 Initiate Audio Capture 
To initiate the capture of audio data, complete the steps provided below: 
 

1. Right-click the Rutter icon in the desktop task bar and select ‘Capture Audio’ from the 
pop-up list. 

2. Right-click the Rutter icon in the desktop task bar and select ‘Live Playback’ from the 
pop-up list. 

3. In the “Channel Selection Dialog” box, select the channel(s) to be analyzed. By 
default, all channels are grayed. There are three (3) options available: 

 
 Grey Checkbox: An amplitude readout (2 second delay) with no live audible 

playback (default).  
 White Checkbox w/ Black Check: An audible playback (10 second delay) 

through connected speakers in addition to an amplitude readout (2 second 
delay). 

 Empty White Checkbox: No playback (either audible or readout) for associated 
non-checked channel.  

 

 
Figure 9-5 - Audio Channel Selection Dialog Box 

 
4. Once the correct audio channels and playback option has been selected, press “OK”. 

 

9.2.1.3 Analyze Captured Audio 
Once the desired channels are selected, their RMS values may be analyzed. To open the Audio 
Analysis window, right-click the ADi icon in the taskbar and select ‘Analyze Audio’ from the 
selections available. See Figure 9-1 - Taskbar Menu for an illustration of the ADi menu. 
 
 
 

Note! If the Channel 2 checkbox is the first audio channel selected in the Channel 
Selection Dialog box, the RMS value for Channel 2 will appear for RMS Value #1 in 
the Audio Analysis window. 
 
For example, a user has selected Channels 2, 3, and 4 in the Channel Selection 
Dialog box and each has a RMS value of 1.54, 8.34, and 1.04 respectively. 
Therefore, 1.54 (Channel 2) will appear under RMS value field 1, 8.34 (Channel 3) 
will appear under RMS value field 2, and 1.04 (Channel 4) will appear under RMS 
value field 3. 

 
 
 



Chapter 9: Audio Test Source Setup 

 
VDR-100G2/G2S Installation Manual  88  
RUT-TD-02-001, Rev 2.1 

 
Figure 9-6 - RMS Value Readout 

 
 

1. To test the microphones, open the Test menu, select “Buzzer 1”, and note the RMS 
Values for the microphones associated with that buzzer. Repeat for Buzzer 2. 

 

 
Figure 9-7 - Audio Analysis Test Menu 

 
 

Note! Although there are four (4) buzzer options available in the Test menu, only 
Buzzer 1 and Buzzer 2 are applicable to the VDR-100G2 audio set-up. 

 
 

2. The chirp length associated with the buzzer tests can also be set using the “Chirp 
Length” option in the Test menu. By selecting this option, a value bar will appear allowing 
for a chirp length user adjustment of 0 to 255 milliseconds. 

 
 

Note! To complete the audio installation, a technician must still calculate 
Detection Threshold levels. To calculate the Detection Threshold, see Section 
9.2.3 - Detection Threshold. 
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Figure 9-8 - Chirp Length Selector 

 
 

9.2.2 Manual Audio Configuration 
While the Audio Diagnostics application offers the most effective means of configuring the VDR’s 
audio information, it can also be manually configured. 
 

9.2.2.1 VDRPARAMS.INI File 
Several entries in the AUDIO section of the VDRPARAMS.INI file reflect the number of bridge 
audio channels and radio channels to be recorded. The VDRPARAMS.INI file is located in the 
C:\WINDOWS directory of the DMM internal hard drive and may be accessed via the shortcut on 
the desktop.  

 
 MikesOnMixer reflects the number of microphones on each channel. 
 numVHFChannels reflects the number of channels connected to record radios, PA 

systems, bridge telephone, etc. 
 VHF-ChannelX indicates the channel(s) on which the radio(s) are being recorded.  
 ChannelEnabledX reflects if the applicable channel is enabled or disabled.  
 MikeRetryInterval reflects the wait period for the retrial of a failed mic test. 

 
The number of channels sampled by the VDR-100G2 is set in the NumOutputChannels field of 
the INI file. The system will activate the first N input channels for which the ChannelEnabled field 
is set to 1. The gain for each channel is set at the factory. The factory default setup is: 
 

1. VHF audio on inputs 1, 2, 9, and 10. 
2. Bridge audio (inside microphones) on inputs 3, 4, 5, 6, 11, 12, 13, and 14.  
3. Outside microphones on inputs 7, 8, 15, and 16. 

 

9.2.2.2 Testing Microphones 
For the bridge audio self-testing, the system will generate a tone on the audio test source, receive 
it on the microphone, and detect this tone in the captured data block. Numerous entries in the INI 
file are used to configure this process.  
 
The VDR-100G2 can perform self-testing of all microphone ports. For each two (2) channel 
microphone port a “chirp” test will be performed on all buzzer block 1 microphones (channel 
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inputs 3, 5, 7, 9, 11, 13, 15) followed by a test of the buzzer block 2 microphones (channel inputs 
4, 6, 8, 10, 12, 14, 16). 
 
The number of microphones to test on each channel is set in the INI file using the Audio 
Diagnostics Application. One (1) microphone on each channel is tested simultaneously. Each 
channel has its own detection threshold, which is loaded from the INI file via the 
DetectionThreshold1, DetectionThreshold2, and DetectionThreshold3 fields. 
 
To calculate the Detection Threshold, see Section 9.2.3 - Detection Threshold,  
 
 

9.2.3 Detection Threshold 
The Detection Threshold level is used only as a test value and does not have an affect on the 
level of the audio recorded. It is used as a baseline for two (2) measurements during the audio 
self-test. The first measurement will determine the average noise level in order to establish if 
there is a sufficient lack of background noise (too much background noise will not allow the test to 
conduct properly). The second measurement will determine the chirp level which will allow the 
VDR to check for abrupt changes in audio registering above the detection threshold. 
 

9.2.3.1 Record Application – Log Window 
It is important to note, prior to beginning the audio self-test, that the Channel numbers listed in the 
VDR Record application Log Window are associated with the ChannelEnabled fields in the 
VDRPARAMS.INI file. The Log Window only numbers channels that are “turned on” (equal 1) in 
the INI file. 
 
Consider the two (2) following examples: 
 
Example 1 
The Audio Module has the following connections: 
 
Channel 1 = VHF 
Channel 2 = Mic 1, Mic 2 
Channel 3 = Mic 3, Mic 4 
Channel 4 = Mic 5, Mic 6 
Channel 5 = VHF 2 
Channel 6 = Mic 7, Mic 8 
Channel 7 = Empty 
Channel 8 = Empty 
 
For example, an INI file contains the following ChannelEnabled fields: 
 
ChannelEnabled1=1 
ChannelEnabled2=1 
ChannelEnabled3=1 
ChannelEnabled4=1 
ChannelEnabled5=1 
ChannelEnabled6=1 
ChannelEnabled7=0 
ChannelEnabled8=0 
 
During a buzzer/audio test, the Log Window will read similar to the following: 
 
Mike 1 test – chirp detected on channel 2 – 669.459 (159.906) 
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Mike 1 test – chirp detected on channel 3 – 669.459 (159.906) 
Mike 1 test – chirp detected on channel 4 – 669.459 (159.906) 
Mike 1 test – chirp detected on channel 6 – 669.459 (159.906) 
 
 
Example 2 
The Audio Module has the following connections: 
 
Channel 1 = VHF 
Channel 2 = Mic1, Mic2 
Channel 3 = Empty 
Channel 4 = Mic 3, Mic4 
Channel 5 = Empty 
Channel 6 = Mic 5, Mic 6 
Channel 7 = Mic 7 
Channel 8 = Empty 
 
For example, an INI file contains the following ChannelEnabled fields: 
 
ChannelEnabled1=1 
ChannelEnabled2=1 
ChannelEnabled3=0 
ChannelEnabled4=1 
ChannelEnabled5=0 
ChannelEnabled6=1 
ChannelEnabled7=1 
ChannelEnabled8=0 
 
During a buzzer/audio test, the Log Window will read similar to the following: 
 
Mike 1 test – chirp detected on channel 2 – 669.459 (159.906) 
Mike 1 test – chirp detected on channel 3 – 669.459 (159.906) 
Mike 1 test – chirp detected on channel 4 – 669.459 (159.906) 
Mike 1 test – chirp detected on channel 5 – 669.459 (159.906) 
 
 
If a ChannelEnabled field is not enabled, the Log Window sequentially numbers the next enabled 
channel. This is illustrated in Example 2. In that example, ChannelEnabled1 is a VHF connection 
and therefore does not register a chirp in the Log Window; ChannelEnabled2 has its RMS values 
listed as channel 2; however, because the ChannelEnabled3 field equals 0, the Log Window lists 
the RMS values for ChannelEnabled4 as channel 3. 
 

9.2.3.2 Microphone Self-Test and Detection Threshold Calculation Procedure 
The microphone self-test is performed as follows: 
 

1. The speaker for one (1) mic on each channel is turned on for the period specified in the 
INI file – the ChirpLength field (ChirpLength is specified in milliseconds: default is 30). 

2. The RMS for the entire data record (one (1) second) is computed. 
3. If the RMS value is greater than 0.707 * detection threshold, the test is aborted. If this 

happens the background noise level is assumed to be too high to reliably pick out the 
speaker chirp. 

4. If the test is not aborted, an RMS value is computed for each sub-interval; each sub-
interval is half the ChirpLength duration. 

5. If the RMS for any sub-interval exceeds the detection threshold, the chirp is declared 
detected and the microphone operational. 
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6. Once the test source on each channel has been activated, the detection results are 
reviewed. Any mic that has failed the test will be retried. The VDR-100G2 will wait for the 
period specified in the INI file (the MikeRetryInterval field) before retrying the test. The 
test will be retried a maximum number of times (as specified in the INI file – the 
MaxMikeRetrys field.) If any mic fails all self-test attempts, an alarm will be generated. 
The alarm will not clear until all mics have been successfully tested. 

 
To configure the audio testing: 
 
1. Ensure the VDR_Record application is running in the Audio Test mode. See Section 8.3 - 

Tests Menu. 
2. The test is performed by starting and stopping the mic test in rapid succession. Select 

“Test Mic 1” from the “Audio A/D” menu and immediately deselect the audio test (Tests > 
Audio Test). Figure 9-9 - Channel 1, Mic 1 Test displays the result of the tone generated 
from the audio test source.  

 
The audio histogram will be divided into equal sections. The number of sections will 
depend upon the OutPutChannel fields, set in the INI file. Each section represents one 
(1) second of audio for each OutPutChannel field. An audio “spike” will be observed for 
each mic that is connected to the Buzzer 1 connection block (see Figure 5-8 – Audio 
Module Buzzer Connections) on the Audio Module. 
 

 

 
Figure 9-9 - Channel 1, Mic 1 Test 

 
3. Review the test results in the Log Window as illustrated in Figure 9-10 - Microphone Test 

Results. The first number listed is the RMS value computed for a sub-interval. The 
number in parentheses “( )” is the RMS for the entire data record (1 second). A 
successful test should show results similar to the following: 

 
 
 

Note! The audio spikes shown in the audio histogram are related to the audio 
module channels after they have been mixed via the OutPutChannel fields of the 
INI file (output audio). 
 
However, the mic (mike) test values, shown in the Log Window, are associated 
with the input audio (audio as it is captured via the module’s audio channels before 
it is mixed). 

 

Buzzer 1 Chirp Buzzer 1 Chirp Buzzer 1 Chirp 
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a. Mike 1 test – chirp detected on channel 1 – 669.459 (159.906) 
b. Mike 1 test – chirp detected on channel 2 – 601.567 (104.807) 
c. Mike 1 test – chirp detected on channel 3 – 624.567 (124.707) 

 

 
Figure 9-10 - Microphone Test Results 

 
 

4. Make note of the values displayed. 
5. Select the Audio test mode again and repeat steps 2 through 4 for “Test Mic 2”. This will 

test all mics connected to the Buzzer 2 connection block on the Audio Module. 
 
 

Note! If a test was aborted or a microphone is not detected, the test must be 
repeated. The values displayed for each test will vary depending on the amount of 
noise on the bridge at the time the audio test was performed. A chirp not detected 
on channel X will be displayed even if there is no microphone installed for that 
channel. This is a result of each channel being tested for a microphone during the 
test, this will not display an error during the audio testing while in record mode.  

 
 

6. For information on determining the proper detection threshold, see Section 9.2.3.3 - 
Sample Calculation of Detection Thresholds below.  

 
 

Note! If the DetectionThreshold is set too high, the chirp from the test source will 
not be detected and the test will fail. If the DetectionThreshold is set too low the 
microphone test will be aborted. This will not create a failure but the microphone 
testing will not be valid. 

 
The Detection Threshold Calculations are meant as a guide to place the values 
within an operating range. It may be necessary to set the Detection Threshold 
levels lower than the calculated value to ensure reliable testing.  

 
 

7. Repeat the steps taken to determine the threshold value for Channel 1 for each available 
channel as necessary. 

 
 

Note! The audio testing procedure and calculation of the detection threshold for 
each channel should be repeated several times to ensure the audio testing is 
correctly configured. 

 

RMS Sub-Interval Value 

RMS Value 
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8. Open the VDR_PARAMS.INI file from the Windows desktop. 
9. Scroll to the [AUDIO] section and edit the following settings for bridge audio testing 

configuration. 
 

a. DetectionThreshold1 
b. DetectionThreshold2 

 
10. Save the changes and close the VDR_PARAMS.INI file. 
11. Select “Record” under the Test menu and conduct the audio test. The VDR should pass 

the audio test within one (1) hour of recording. If the bridge is extremely noisy, the test 
may not pass until after multiple retries. 

 

9.2.3.3 Sample Calculation of Detection Thresholds 
This section provides an example for calculating Channel Detection thresholds Below is an 
example of how to calculate Channel Detection Thresholds.  Please note that this example 
calculates the threshold for Channel 1 only.  In order to correctly calculate all available channel 
detection thresholds, the steps provided below must be completed for each of the channels.   
 
Also note that although Channel 1 is usually reserved for VHF connection, the below example is 
configured as if a microphone is connected to Channel 1. 

 
1. Conduct an audio test for each available microphone and record the results (it is common 

for each microphone to produce more than one (1) result). 
 

a. Mike 1 test – chirp detected on channel 1   – 971.378 (300.967) 
a. Mike 1 test – chirp detected on channel 1 – 1081.232 (300.967) 
b. Mike 1 test – chirp detected on channel 2 –   903.644 (261.255) 
b. Mike 1 test – chirp detected on channel 2 –   943.323 (261.255) 
c. Mike 1 test – chirp detected on channel 3 –   990.313 (316.459) 
c. Mike 1 test – chirp detected on channel 3 –   922.433 (316.459) 
a. Mike 2 test – chirp detected on channel 1 –   998.937 (321.623) 
a. Mike 2 test – chirp detected on channel 1 – 1067.232 (321.623) 
b. Mike 2 test – chirp detected on channel 2 –   956.135 (290.967) 
b. Mike 2 test – chirp detected on channel 2 –   982.204 (290.967) 
c. Mike 2 test – chirp detected on channel 3 – 1010.550 (324.374) 
c. Mike 2 test – chirp detected on channel 3 – 1211.322 (324.374) 

 
To make the necessary calculations easier, organize each of the audio results in channel groups 
(as below): 
 
                                     RMS Sub- Interval / RMS Value 
 
 

a. Mike 1 test – chirp detected on channel 1 –   971.378 (300.967) 
a. Mike 1 test – chirp detected on channel 1 – 1081.232 (300.967) 
a. Mike 2 test – chirp detected on channel 1 –   998.937 (321.623) 
a. Mike 2 test – chirp detected on channel 1 – 1067.232 (321.623) 
 
b. Mike 1 test – chirp detected on channel 2 –   903.644 (261.255) 
b. Mike 1 test – chirp detected on channel 2 –   943.323 (261.255) 
b. Mike 2 test – chirp detected on channel 2 –   956.135 (290.967) 
b. Mike 2 test – chirp detected on channel 2 –   982.204 (290.967) 
 
c. Mike 2 test – chirp detected on channel 3 – 1010.550 (324.374) 
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c. Mike 2 test – chirp detected on channel 3 – 1211.322 (324.374) 
c. Mike 1 test – chirp detected on channel 3 –   990.313 (316.459) 
c. Mike 1 test – chirp detected on channel 3 –   922.433 (316.459) 

 
2. Once each of the channels has been grouped together, use the RMS values to determine 

the highest value received for each channel.  
 
                                      RMS Sub- Interval / RMS Value 
 
 

a. Mike 1 test – chirp detected on channel 1 –   971.378 (300.967) 
a. Mike 1 test – chirp detected on channel 1 – 1081.232 (300.967) 
a. Mike 2 test – chirp detected on channel 1 –   998.937 (321.623) 
a. Mike 2 test – chirp detected on channel 1 – 1067.232 (321.623) 

 
For Channel 1, the highest RMS value is from mike 2 (321.623) 
 

Using the highest available RMS value, complete the following calculation to obtain the 
Detection Threshold: 
 
Highest RMS Value / 0.707 = Threshold for Channel X 

 
321.623 / 0.707 = 454.912 

 
3. Next, make note of the lowest RMS Sub-Intervals for each channel: 

 
                                      RMS Sub- Interval / RMS Value 
 
 

a. Mike 1 test – chirp detected on channel 1 –   971.378 (300.967) 
a. Mike 1 test – chirp detected on channel 1 – 1081.232 (300.967) 
a. Mike 2 test – chirp detected on channel 1 –   998.937 (321.623) 
a. Mike 2 test – chirp detected on channel 1 – 1067.232 (321.623) 

 
For Channel 1, the lowest RMS sub-interval is from mike 1 (971.378) 
 

The lowest sub-interval should be higher than the calculated Channel Detection Threshold.  
 
In the above example, because the lowest RMS sub-interval of channel 1 (971.378) is a higher 
value than the calculated Channel Detection Threshold (425.696), the calculated value is good to 
use as your Detection Threshold for Channel 1.  
 
If the calculated values do not meet the above-mentioned requirements, it will be necessary to 
restart the Detection Threshold calculation process. It is important to remember that the bridge 
must be quiet when performing a microphone test, as a noisy bridge will produce undesired 
results. 
 

9.2.3.4 Test Bridge Audio 
To test the Bridge Audio, a short audio test must be completed. When recording bridge audio, it is 
important to speak clearly and in a normal voice tone within a normal distance to each 
microphone. A normal voice procedure includes the words “Testing Microphone 1 on 
OutputChannel 1” followed by a voice count from 1 to 5 (or 10), a reverse count back to 1, ending 
with the words “Test Out”. The procedure for testing Bridge Audio is as follows: 
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1. Start the VDR_Record application. 
2. Ensure the VDR_Record application is operating in record mode. 
3. Conduct the voice test as described above, repeating for each microphone. 
4. Note the start and finish time of each test. 
5. Wait one minute in order to allow the system to complete the writing of the audio block. 
6. Use the download computer to download a small data set containing voice audio tests 

(see Section 16 - DATA RETRIEVAL for download instructions). 
7. Play back the data to ensure bridge audio was recorded properly. 

 
It is preferable to conduct the Bridge Audio test during a quiet time on the bridge in order to 
prevent the interference of unnecessary noise with the voice recording. The presence of 
unnecessary noise may create a sound environment not normal to the bridge and, as a result, 
invalidate the test. 
 

9.2.3.5 Test VHF Radios 
To test the VHF Audio, a short broadcast must be completed. When broadcasting on VHF, 
ensure that no transmissions are made that could be confused with anything other than a test 
transmission. A normal voice procedure is to say the word “Test” followed by a voice count from 1 
to 5 (or 10) and reverse the count back to 1, finishing the transmission with words “Test Out”. The 
procedure for testing VHF is as follows: 
 

1. Check the VHF wire connection to the VDR to ensure it is correct. 
2. Start the VDR_Record application. 
3. Ensure the VDR_Record application is operating in record mode. 
4. Transmit the voice test as described above. When transmitting, ensure that the VHF is 

switched to a channel that cannot be confused with any local distress or working 
frequencies. 

5. Make note of time of test. 
6. Use a second VHF radio (not connected to VDR) to broadcast a second test on the same 

frequency to ensure that the audio received is recorded correctly. Again note the time of 
the broadcast and receipt test. 

7. Download a small data set (using the Download PC) containing transmit and receive VHF 
audio tests (see Section 16 - DATA RETRIEVAL for download instructions). 

8. Playback the data to ensure both transmit and receive data is recorded properly. 
9. Repeat steps 1 to 8 for any additional radios connected to the VDR. 

 
 

9.3 Audio Module Internal Processing Board 
The Audio Module’s internal processing board may need to be adjusted to meet distinctions 
particular to each audio installation. 
 
IMPORTANT!  When attempting to open the Audio Module, DO NOT remove the rear (channel 
and buzzer) plate.  Access to the internal processing board should only be attempted by 
removing the front plate.  The front plate must be removed first, followed by the removal of the 
black (top) casing, which slides away from the silver (bottom) casing. 
 
DO NOT attempt to pull the internal processing board away from the silver (bottom) casing. 
 
 

Note! Before beginning any physical adjustments to the internal processing board, 
power must be removed from the Audio Module unit. 
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Figure 9-11 - Audio Module Internal Processing Board 

 
 

9.3.1 Setting Line/Mic Input 
Line input is selected for VHF connections, while a Mic input is selected for a microphone 
connection. 
 
To select Line input, the jumpers for the associated input must be adjusted to OFF. To do so, the 
two (2) clips must cover the top four (4) pins. 
 

 
 
 

Note! When this document refers to the top four (4) jumper setting pins, it is 
referring to the four (4) pins farthest from the phoenix connectors (located at the 
rear of the unit). Similarly, when referring to the bottom four (4) pins, it is 
referencing the four (4) pins closest to the connectors. See Figure 9-11 - Audio 
Module Internal Processing Board above. 

 
 
 
To select Mic input, the jumpers for the associated input must also be switched to ON. To do so, 
the two (2) clips must cover the bottom four (4) pins. 
 

 
 

Potentiometers (Pots) 
Line/Mic Input 
Jumpers 

Phantom Voltage Phoenix 
Connectors 

REAR FRONT 
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The table below provides information pertaining to Jumper numbers and their associated Input 
numbers. 
 

Jumper Input Factory Default 

JP 1,2 Input 1 OFF 

JP 3,4 Input 2 OFF 

JP 5,6 Input 3 ON 

JP 7,8 Input 4 ON 

JP 9,10 Input 5 ON 

JP 11,12 Input 6 ON 

JP 13,14 Input 7 ON 

JP 15,16 Input 8 ON 

JP 17,18 Input 9 OFF 

JP 19,20 Input 10 OFF 

JP 21,22 Input 11 ON 

JP 23,24 Input 12 ON 

JP 25,26 Input 13 ON 

JP 27,28 Input 14 ON 

JP 29,30 Input 15 ON 

JP 31,32 Input 16 ON 

Table 9-1 - Jumper to Audio Module Input Associations 

 
 

 
Figure 9-12 - Jumpers 

 
 

Jumper
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Figure 9-13 - Jumper Close-Up (in OFF position) 

 
 

9.3.2 Adjusting Phantom Voltage 
Phantom voltage is used to power the preamplifier of a condenser-type microphone.  The 
following table details the different models of microphones, their type, and phantom voltage 
status. 
 
Part Part No Type Phantom Voltage 

Outdoor Microphone (New) RUT-01018-AA Condenser ON 

Outdoor Microphone (Old) RT-930 & RT-930A Dynamic OFF 

Indoor Microphone (Old & 
New) RT-2100 / RUT-01019-AA Condenser ON 

VHF N/A N/A OFF 

Table 9-2 - Phantom Voltage Status 

 
 

Note! Phantom voltage is adjusted differently depending on the Revision Number 
of the Audio Module.  The Revision Number of the Module can be determined by 
its Serial Number, which is located at the bottom of the unit.  See Sections below 
for more information. 

 
 
 

9.3.2.1 Adjusting Phantom Voltage on Audio Module (Rev.3) 
The phantom voltage in Revision 3 Audio Modules (Serial Number AMX011168 and higher 
(except AMX011170 and AMX011195)) is adjusted via DIP-Switches S2 – S5 (as shown in 
Figure 9-14 - Phantom Voltage DIP-Switches (Revised Unit)) and must be: 
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Figure 9-14 - Phantom Voltage DIP-Switches (Revised Unit) 

 
 
See the table below for the Phantom Voltage Block, DIP-Switch, and Audio Module Input 
associations. 
 

Phantom Voltage Block Switch Input Factory 
Default 

S5 4 Input 1 OFF 

S5 3 Input 2 OFF 

S5 2 Input 3 ON 

S5 1 Input 4 ON 

S4 4 Input 5 ON 

S4 3 Input 6 ON 

S4 2 Input 7 OFF 

S4 1 Input 8 OFF 

S3 4 Input 9 OFF 

S3 3 Input 10 OFF 

S3 2 Input 11 ON 

S3 1 Input 12 ON 

S2 4 Input 13 ON 

S2 3 Input 14 ON 

S2 2 Input 15 OFF 

S2 1 Input 16 OFF 

Table 9-3 - Phantom Voltage to Audio Module Input Associations (Revised Unit) 

 
 
 
 
 
 
 
 
 

OFF 
ON 
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9.3.2.2 Adjusting Phantom Voltage on Audio Module (Rev.2 & Earlier) 
The phantom voltage in Revision 2 (and earlier) Audio Modules (Serial Number AMX011168 
and earlier (but including AMX011170 and AMX011195)) is adjusted via DIP-Switches S2 – 
S5. 
 

 
Figure 9-15 - Phantom Voltage DIP-Switches (Rev2 and Earlier) 

 
 
See the table below for the Phantom Voltage Block, DIP-Switch, and Audio Module Input 
associations. 
 

Phantom Voltage Block Switch Input Factory 
Default 

S5 1 Input 1 OFF 

S5 2 Input 2 OFF 

S5 3 Input 3 ON 

S5 4 Input 4 ON 

S4 1 Input 5 ON 

S4 2 Input 6 ON 

S4 3 Input 7 OFF 

S4 4 Input 8 OFF 

S3 1 Input 9 OFF 

S3 2 Input 10 OFF 

S3 3 Input 11 ON 

S3 4 Input 12 ON 

S2 1 Input 13 ON 

S2 2 Input 14 ON 

S2 3 Input 15 OFF 

S2 4 Input 16 OFF 

Table 9-4 - Phantom Voltage to Audio Module Input Associations (Original Unit) 

ON 

OFF 
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9.3.3 Adjusting the Gain 
If the volume of the audio captured is either too low or too high, it will be necessary to adjust the 
gain (adjust the resistance value).  To adjust the gain a technician must tune the potentiometers 
(pots).  A multimeter, which provides an Ohm reading, is required for this process. 
 
Before adjusting the gain, it is necessary to understand which pots correspond to which input.  
Figure 9-16 - Pot/Input Relation below illustrates the pot/input relation. 
 
 
 
 
 
 
 

 
 
 
 

 
Figure 9-16 - Pot/Input Relation 

 
 
To receive a resistance reading, first remove power to the module.  Contact the two (2) 
multimeter probes to the two (2) pot leads. See Table 9-5 - Recommended Resistance Readings 
below for recommended resistance readings.  Please note that the resistance readings do not 
have to exactly match these numbers.  They are provided here only as recommendations. 
 

Recommended Resistance Reading 

Internal Microphones (Old & New) 45k Ohms 

Outdoor Microphones (Old - RT-930) 200k Ohms 

Outdoor Microphones (New - RUT-
01018-AA) 45k Ohms 

VHF Dependant upon VHF 
manufacturer. 

Table 9-5 - Recommended Resistance Readings 

 
 

Note! There are 3) leads for each pot. Only 2 of these leads are used to receive a 
resistance reading. In the case of the Rutter Technologies’ Audio Module, Lead 1 
and Lead 2 are the 2 leads which must be utilized. 

 

1          4           5                 8            9                   12         13                16 

2          3           6                 7          10                   11         14               15 

FRONT

BACK
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Figure 9-17 - Pot Leads 

 
 

 
Figure 9-18 - Pot Lead Resistance Reading 

 
 
To increase the gain of the selected input, the Gain Adjustment Screw located at the top of the 
pot must be turned clockwise. 
 
 

9.4 Audio Installation Examples 
Provided below are two (2) examples for adjusting the VDRPARAMS.INI file to properly represent 
the microphone installation. 
 
It is important to remember that only the channels specified in the first four (4) OutputChannel 
fields (OutputChannel1, OutputChannel2, OutputChannel3, and OutputChannel4) of the 
VDRPARAMS.INI file are secured to the FRM. A user can enter a maximum of two (2) channels 
in one OutputChannel field. For example, OutputChannel2 may mix Channel 2 and Channel 3. 
Since the first OutputChannel field must be used for the VHF, this allows information from a 
maximum of 12 microphones to be secured to the FRM. 
 
 
 

Lead One 

Lead Two 

Gain Adjustment 
Screw
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9.4.1 Microphone Installation - Sample One 
Ship Example 1 has five (5) Internal Microphones and two (2) External Microphones installed on 
the bridge. There is a single VHF source. 
 
Note in Figure 9-20 - Sample Audio Module Connections for Ship Example 1 below that Mics 1 
and 2 are connected to Channel 2, Mics 3 and 4 are connected to Channel 3, and Mic 5 is 
connected to the top input of Channel 4. The two (2) exterior mics (6 and 7) are connected to 
Channel 5. An external microphone must not be placed on the same channel as an internal 
microphone. 
 

Stbd Bridge 
Wing

Port Bridge 
Wing

Microphone 3

Microphone6 Microphone1
Microphone7

Microphone5

Microphone4
2 Microphone

 
Figure 9-19 - Sample Mic Layout for Ship Example 1 

 
 

 
Figure 9-20 - Sample Audio Module Connections for Ship Example 1 

 
 
 
 

Note! In this example, the vessel has only one (1) VHF. As microphones are 
shown to be connected to Audio Module Channel #5, that channel must be 
reconfigured for internal microphones. This requires accessing the internal 
processing board. The Phantom Voltage DIP-Switch and Jumper setting must be 
set to ON, and the resistance value of the associated potentiometers (pots) must 
be adjusted down. 

 
 

2. Open the VDRPARAMS.INI file from the Windows desktop 
3. Scroll to the [AUDIO] section and edit the following settings to reflect the ship 

configuration: 
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Parameter Typical 
Value Remarks 

NumChannels 5  
ChannelEnabled1 1 0 = disabled, 1 = enabled 
ChannelEnabled2 1 0 = disabled, 1 = enabled 
ChannelEnabled3 1 0 = disabled, 1 = enabled 
ChannelEnabled4 1 0 = disabled, 1 = enabled 
ChannelEnabled5 1 0 = disabled, 1 = enabled 
ChannelEnabled6 0 0 = disabled, 1 = enabled 
ChannelEnabled7 0 0 = disabled, 1 = enabled 
ChannelEnabled8 0 0 = disabled, 1 = enabled 

NumOutputChannels 4 Software mixing - provide list of channels to mix (max. 2 per 
channel) 

OutputChannel1 1  
OutputChannel2 2  
OutputChannel3 3,4  
OutputChannel4 5  

OutputChannel5 5 Because NumOuputChannels field is 4, anything beyond 
the OutPutChannel4 field is ignored 

OutputChannel6 6  
OutputChannel7 7  
OutputChannel8 8  
numVHFChannels 1 Default is 1 
VHF-Channel1 1  
VHF-Channel2 0  
MikesOnMixer1 2 0 to 2; refers to 1st mic channel. Here it is Channel 2. 
MikesOnMixer2 2  
MikesOnMixer3 1  
MikesOnMixer4 2  
MikesOnMixer5 0  
MikesOnMixer6 0  
MikesOnMixer7 0  
MikesOnMixer8 0  

DetectionThreshold1 300 Test signal RMS must exceed value before detected 
DetectionThreshold2 300  
DetectionThreshold3 300  
DetectionThreshold4 300  
DetectionThreshold5 300  
DetectionThreshold6 300  
DetectionThreshold7 300  
DetectionThreshold8 300  
ChirpLength 50 Mic self-test signal length, in ms (100 ms max) 
MikeRetryInterval 3600 In seconds 
MaxMikeRetrys 11 Retry this many times before declaring failure 
ControlMode 2 1 = hold 1 of 3 bits high ; default is 1 

2=set bits 1 and 2 to binary count and hold bit 3 high 
Table 9-6 - AUDIO Parameter Typical Values: Example 1 
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4. Save the changes and close the VDR_PARAMS.INI file 
5. If the VDR_Record application is recording, it must be stopped and recording restarted 

for the changes to take effect. 
 

In the example above, Audio Module Channels 3 and 4 (containing input connections for 
microphones 3, 4, and 5) are mixed on OutPutChannel3. 
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9.4.2 Microphone Installation – Sample Two 
Ship Example 2 has nine (9) Internal Microphones installed on the bridge and four (4) Internal 
Microphones installed in the engine room. There is one (1) VHF source. 
 
Note in Figure 9-22 - Sample Audio Module Connections for Ship Example 2 below that Mics 1 
and 2 are connected to Channel 2, Mics 3 and 4 are connected to Channel 3, and Mics 5 and 6 
are connected to Channel 4, Mics 7 and 8 are connected to Channel 5, and Mic 9 is connected to 
the top input of Channel 6. The four (4) interior mics located in the engine room (10, 11, 12, and 
13) are connected to Channels 7 and 8. Since the four (4) engine room mics are located in a 
separate section of the ship from the nine (9) Bridge mics, they are not placed on the same 
channel as the Bridge mics. 
 

Microphone9
Microphone1

2 Microphone

Microphone3
Microphone4 Microphone5

Microphone6

Microphone7

Microphone8

Microphone10 Microphone12

Microphone11
Microphone13

 
Figure 9-21 - Sample Mic Layout for Ship Example 2 

 

 
Figure 9-22 - Sample Audio Module Connections for Ship Example 2 

 
1. Open the <vdrparams.ini> file from the Windows desktop 
 
2. Scroll to the [AUDIO] section and edit the following settings to reflect the ship 

configuration: 
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Parameter Typical 
Value Remarks 

NumChannels 8  
ChannelEnabled1 1 0 = disabled, 1 = enabled 
ChannelEnabled2 1 0 = disabled, 1 = enabled 
ChannelEnabled3 1 0 = disabled, 1 = enabled 
ChannelEnabled4 1 0 = disabled, 1 = enabled 
ChannelEnabled5 1 0 = disabled, 1 = enabled 
ChannelEnabled6 1 0 = disabled, 1 = enabled 
ChannelEnabled7 1 0 = disabled, 1 = enabled 
ChannelEnabled8 1 0 = disabled, 1 = enabled 

NumOutputChannels 6 Software mixing: provide list of mix channels (max. 2 per 
channel) 

OutputChannel1 1  
OutputChannel2 2,3  
OutputChannel3 4  
OutputChannel4 5,6  
OutputChannel5 7  
OutputChannel6 8  
OutputChannel7 7  
OutputChannel8 8  
numVHFChannels 1 Default is 1 
VHF-Channel1 1  
VHF-Channel2 0  
MikesOnMixer1 2 0 to 2; Refers to 1st mic channel. Here it is Channel 2. 
MikesOnMixer2 2  
MikesOnMixer3 2  
MikesOnMixer4 2  
MikesOnMixer5 1  
MikesOnMixer6 2  
MikesOnMixer7 2  
MikesOnMixer8 0  
DetectionThreshold1 300 Test signal RMS must exceed this to be declared detected 
DetectionThreshold2 300  
DetectionThreshold3 300  
DetectionThreshold4 300  
DetectionThreshold5 300  
DetectionThreshold6 300  
DetectionThreshold7 300  
DetectionThreshold8 300  
ChirpLength 50 Mic self-test signal length, in ms (100 ms max) 
MikeRetryInterval 3600 In seconds 
MaxMikeRetrys 11 Retry this many times before declaring failure 
ControlMode 2 1 = hold 1 of 3 bits high ; default is 1 

2 = set bits 1 and 2 to binary count and hold bit 3 high 
Table 9-7 - AUDIO Parameter Typical Value Settings: Example 2 
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3. Save the changes and close the vdr_params.ini file 
4. If the VDR_Record application is recording, it must be stopped and recording restarted 

for the changes to take effect. 
 

In the example above, Audio Module Channels 2 and 3 (containing input connections for 
microphones 1, 2, 3, and 4) are mixed on OutPutChannel2. Audio Module Channels 4 and 5 
(containing input connections for microphones 5, 6, 7, and 8) are mixed on OutPutChannel3. 
Audio Module Channel 6 is mixed on OutPutChannel4. This arrangement allows all bridge 
microphones to be recorded to the FRM. 
 
 

Note! The NumOutputChannels field must equal the number of OutPutChannelX 
fields that are in use. 
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10 VIDEO SETUP 
 
 
The Video Module performs video capture, digitization, and storage of RGB, RGBHV, 
Monochrome, and composite video display signals from a radar, ECDIS, or other video source. 
Normally only the primary radar is recorded; however, VDR-100G2 can capture and record 
images from up to three (3) additional different video sources. During installation, the video 
system must be configured to accept each source’s video resolution, interlacing, refresh rate, etc.  
 
The normal capture interval is 15 seconds, or four (4) images per minute for each video source. 
When the capture interval elapses, the system first determines the format of the input signal. 
Information is gathered from the VidChan*.INI file (dependant upon the VIDEOFORMAT entry.) If 
more than one (1) source is specified by the MAXSOURCES entry, signals present on the Control 
Input/Output connector are used to indicate the currently active source. The video signal 
configuration is then read and a new image is captured. If the system is configured for two (2) or 
more video channels, the next channel in the sequence is selected. 
 
If the video module fails to capture an image due to absent video signals (i.e., radar is OFF), an 
entry is made in the error log. However, this failure will not generate a system alarm. A system 
alarm is only triggered when a failure is detected in the video capture hardware. 
 
To configure the VDR-100G2 video capture: 
 

1. Edit the VDRPARAMS.INI file to set up basic video information. 
2. For each video source, edit the VidChan*.INI file to set up the video format and 

configuration. 
3. Test input sources. 
 
 

10.1 Edit [VIDEO] Parameters 
The vdrparams.ini file, located in the C:\WINDOWS directory on the DMM, must be edited to 
reflect the ship’s video configuration. This file contains numerous fields used to indicate these 
settings. The following steps outline how to edit the file to reflect a ship configuration: 
 

1. Close the VDR_Record software. 
2. Open the vdrparams.ini file from the Windows desktop. 
3. Scroll to the [VIDEO] section and edit the following settings to reflect ship configuration: 

a. numSources – the number of video sources to be captured (1 - 4). 
b. transferRate – time, in milliseconds, between captures (15000 for one (1) video 

source, 7500 for two (2) video sources, 5000 for three (3) video sources, 3750 for 
four (4) video sources); 

c. blocks – images to be stored in each one (1) minute block (4 * numSources); 
 

4. Save and close the vdrparams.ini file. 
5. Restart the VDR_Record application. 
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The following table provides video parameter settings for the Video section of the 
<vdrparams.ini> file: 
 
Parameter Typical Value Remarks 
Blocks 8 Number of capture intervals per file. 

numSources 2 1 to 4. Video sources must be connected in 
sequential order.  

enhancedCompression 0 0=disabled; 1=enabled  

maxColors 256 Maximum number of colours in output image 
(ignored if enhancedCompression is enabled) 

noiseClipping 0 

1= Enabled (default) 
 
Computes the black threshold and clips the 10 
lowest intensity values. Ignored if enhanced 
compression is disabled or if the video format is not 
RADAR. 

Table 10-1 - video parameter settings for [VIDEO] section of <vdrparams.ini> file 

10.2 Edit VIDCHAN*.INI Files 
Included with the VDR are several sample INI files which can be used for the majority of available 
video signals. Selection of the proper VIDCHAN*.INI file is determined after consideration of the 
following 3 items: 

1. HSYNC and Pixel Clock timing (Clock and Syncs Parameters). 
2. Video voltage level (Video Parameters). 
3. Optimization of video quality (Video Parameters). 

Each video channel has a separate INI file: VidChan1.INI, VidChan2.INI, VidChan3.INI, and 
VidChan4.INI. VIDCHAN*.INI files are located in the C:\VDRApps directory. 

10.2.1 CLOCK Parameters 
 
Parameter Typical Value Remarks 
HsRate1       80.0 HSYNC rate in kHz for default source 

Pclk1 135.0 The exact pixel clock frequency (in MHz)for the 
system (as specified by the display’s manufacturer)  

VCO1 2 
Normally set based on the pixel clock rate (0=12-
37MHz, 1=37-74MHz, 2=74-140MHz, 3=140-
170MHz). 

CPmp1 6 0 to 7. Normally set based on values reported from 
VideoConfigSuite.exe. 

N1 0 If set to zero, defaults to PClk1*1000/HsRate1 

Phase1 0 0 to 31: Sharpens the image by accommodating for 
delays due to cable length and stray capacitance. 

XDim1 1288 
Sets the captured width. It's recommended to set the 
XDimension 8 larger that the desired image, since 
the X-offset is adjustable only in multiples of 8. 

XOffset1 300 Shifts the image to remove black pixels at left edge. 
YDim1 1024 Sets the captured height. 
YOffset1 40 Shifts the image to remove black lines from top. 

Table 10-2 - CLOCK Parameter Typical Value Settings 
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10.2.2 SYNCS Parameters 
 
Parameter Typical Value Remarks 

HPOL1  1 

0, or 1. HSYNC Polarity. Changing this value will 
increase the margin at the left of the image. Choose 
the value which produces the widest margin, then 
adjust with XDim1. 

VPOL1 1 0 or 1. VSYNC Polarity. Captured images will not be 
rectangular if the incorrect value is chosen.  

XCLAMPPOL1 -1 -1=Internal, 0= Negative, or 1= Positive.  
XCOASTPOL1 1 -1=Internal, 0= Negative, or 1= Positive.  

PreCoast1 0 0 to 255. Number of clock synchronization pulses to 
skip prior to COAST signal 

PostCoast1 0 0 to 255. Number of clock synchronization pulses to 
skip after COAST signal 

SyncThreshold1  0 to 255. For composite signals only, used to 
differentiate a VSYNC from a HSYNC. 

VCO1 2 Must be present and must be same value as in 
[CLOCK] section 

CPmp1 6 Must be present and must be same value as in 
[CLOCK] section 

N1 0 Must be present and must be same value as in 
[CLOCK] section 

Table 10-3 SYNCS Parameter Typical Value Settings 

10.2.3 VIDEO Parameters 
 
Parameter Typical Value Remarks 
RGain1  75 0 to 255. Specifies A/D range for the red video line. 

GGain1 75 0 to 255. Specifies A/D range for the green video 
line. 

BGain1 75 0 to 255. Specifies A/D range for the blue video line. 
ROff1 128 0 to 255. Specifies DC offset for the red video line. 
GOff1 0 0 to 255. Specifies DC offset for the green video line. 
BOff1 0 0 to 255. Specifies DC offset for the blue video line. 
CVolt1 0 0 = clamp to min voltage. 1 = clamp to midscale. 

CPlace1 8 Specifies when clamp occurs in pixel clocks from 
trailing edge of HSYNC. 

CLength1 20 Specifies number of black pixels that participate in 
the DC restore clamp circuitry. 

VideoFormat1 1 RADAR = 1, CHART = 2 
Table 10-4 - VIDEO Parameter Typical Value Settings 
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10.2.4 Customize Entries in the VIDCHAN*.INI Files 
Each entry in the VIDCHAN*.INI file indicates the voltage level, timing, and signal characteristics 
of the video source. The values generated by VideoConfigSuite.exe are based on VESA and 
Industry Standards and are adequate in order to capture initial images.  
 
If video capture does not initiate, the most likely reason is an incorrect state of the VPOL1 field. If 
provided with a channel number, VideoConfigSuite.exe will capture and save a sample image to 
verify the proper state of the VPOL1 field. The image will be saved to the filename 
TestImage.bmp. The image will be annotated with a calibration grid to verify the proper alignment 
of the video. 
 
In certain cases it may be necessary to optimize the video in order to correct the colour balance. 
 
 

10.3 Video Diagnostics (VideoConfigSuite) Application 
The Video Diagnostics (VDi) application is used to capture and properly adjust images from a 
ship’s radar source(s). 
 
There are two (2) methods available for starting the application: 
 
 Via the Start menu (Start > All Programs > Utilities > VideoConfigSuite) 
 The application’s executable file is located in the C:\VDRApps folder. Double-click the 

VideoConfigSuite.exe icon to open the application.  
 
 

Note! It is also recommended to copy the VideoConfigSuite.exe and 
RutterVCS.dll files to the D:\ drive and operate the application from that 
destination in order to avoid any potential virtual memory problems. Note that the 
Start menu should not be used if attempting to run the application from the D:\ 
drive. 

 
 
Prior to operating the VDi application, the VDR_Record application must be stopped and closed.  
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Figure 10-1 - Video Diagnostics User Interface 

 
 
Once started, the VDi application will place an icon (Rutter Technologies symbol) in the desktop 
task bar. This icon can be used to: 
 
 Initiate the capture of video (Capture Video) 
 View captured video (View Video) 
 Save configured settings (Save Settings) 
 Minimize the application interface (Hide) 
 Exit the application (Terminate) 

 

 
Figure 10-2 - Taskbar Menu 

 
 
Additional information: 
 
 Maximum image height is 4095 pixels and maximum width is 2047 pixels. 
 Maximum image size is 2062500 samples, which can accommodate images up to 

1650x1250. 
 
 

10.3.1 Initiate Video Capture 
To initiate the capture of video, complete the steps provided below: 
 

1. Right-click the Rutter icon in the desktop task bar and select ‘Capture Video’ from the 
pop-up list. 
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2. In the Channel Selection box, select the radio button corresponding to the video 
channel to capture and press “OK”. 

 
If the channel uses Composite Syncs, select the “Composite” check box and indicate, 
via the associated radio buttons, if the composite sync is on a separate TTL output or 
encoded in the input on the video channel. 
 

 
Figure 10-3 - Channel Selection Dialog Box 

 
 

3. An Auto-Detection window will now appear containing the following information: 
 
 
 

UDP Message: 
Video Card IP Address (/I) 
Video Card Port (/P) in hexadecimal 
VSync (/V) in hexadecimal 
HSync (/H) in hexadecimal 

 

 
Figure 10-4 - Auto-Detection Information Box 

 
 

VSYNC Information: 
Frequency (Hz) 
Polarity 
Pulse Length 
 
HSYNC Information: 
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Frequency (Hz) 
Polarity 
Pulse Length 

 
 

Note! It is important to write down both the Frequency and Polarity of the HSYNC 
and VSYNC for later use. 

 
 
 

Mode: 
The information available in the Mode text box indicates the detected mode of the 
capture. For example, a recognized VESA mode at 60Hz could read VV60 (VGA 
640x480). 

 
4. If auto-detection fails (is unable to detect video mode), an “Auto Detection Failed” 

dialog box will appear requesting the manual input of the VSync and HSync rates. 
 

 
Figure 10-5 - Auto-Detection Failure 

 
 

5. To choose a default video mode configuration, press the “NON-VESA Support” 
button. In the file selection window, select the D:\VideoConfigSuite folder and select 
‘INI Files [*.ini]’ in the “Files of type:” dropdown box. Choose the applicable default INI 
file and press the “Open” button. 

 

 
Figure 10-6 - Selecting a Default .INI File 
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6. Select ‘View Video’ from the task bar menu to view the VDi user interface. There may 
be a short delay (approximately 5 seconds) while the application is capturing the 
image.  

 
 

10.3.1.1 Interlaced Image 
A video source may provide an interlaced image upon capture. An interlaced image will appear 
similar to the image shown in Figure 10-7 - VDi User Interface with Interlaced Image Capture with 
the captured image appearing vertically two (2) or three (3) times within the VDi Capture Window. 
If capturing an interlaced image, complete the steps provided below to adjust the video capture: 
 

 
Figure 10-7 - VDi User Interface with Interlaced Image Capture 

 
 

1. Open Parameter > VPOL and ensure it is set to the same setting (negative or 
positive) as indicated in the Auto-Detection Information Box. Repeat for the HPOL 
setting (Parameter > HPOL). If either is different, change them to the setting 
indicated in the Auto-Detection Information Box (for example, if the Auto-Detection 
indicated the VPOL is negative use the Parameter > VPOL menu item to ensure it is 
set to negative once the image has been captured.) 

 
2. If the image(s) captured are not both entirely visible, the image height must be 

adjusted. Notice in Figure 10-7 - VDi User Interface with Interlaced Image Capture 
that the bottom portion of the lower image is not visible in the VDi Capture Window. 
Therefore the image height must be increased to make this lower portion visible. 
Select Parameter > Dimensions > Image Height and adjust the height as necessary. 

 

Upper Image 

Lower Image 
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Figure 10-8 - Adjusting Image Height 

 
 

3. In the examples illustrated in Figure 10-8 - Adjusting Image Height and Figure 10-9 - 
Image Height Adjusted, the image height was adjusted from 712 to 772, allowing the 
upper and lower images to fit correctly into the VDi Capture Window. 

 

 
Figure 10-9 - Image Height Adjusted 

 
 

4. Once the image(s) are both entirely visible, ensure a small amount of black space 
still appears at the top of the VDi Capture Window. This space will allow for further 
necessary adjustments. To increase the amount of black space, decrease the Y-
Offset (Parameter > Dimensions >Y Offset) setting. In most cases, this setting will 
only need to be decreased slightly (for example, if the setting is 24 adjust to 16.) 

 
5. Zoom in on the upper image (using, for example, a 4X zoom) and find its uppermost 

pixel. Once that pixel has been located, right-click to acquire its x and y coordinates 
(see Figure 10-10 - Uppermost Pixel Coordinates – Upper Image.) 
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Figure 10-10 - Uppermost Pixel Coordinates – Upper Image 

 
6. Once these coordinates have been found, scroll down to the lower image and find 

its uppermost pixel (see Figure 10-11 - Uppermost Pixel Coordinates - Lower 
Image.) 

 

 
Figure 10-11 - Uppermost Pixel Coordinates - Lower Image 

 
 

7. Open the Dimensions dialog box (Parameter > Dimension). Select the “Interlaced” 
check box. Enter the y coordinate of the uppermost pixel (upper image) in the “Line 
0 Start” text box and the y coordinate of the uppermost pixel (lower image) in the 
“Line 1 Start” text box. Press “OK”. 

 

Uppermost 
Pixel of 
Upper Image 

Uppermost 
Pixel of 
Lower Image 
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Figure 10-12 - Entering Interlacing Coordinates 

 
 

8. Once the pixel coordinates have been entered the image will appear corrected (see 
Figure 10-14 - Corrected Interlaced Image for an example.) If the image does not 
appear corrected, it is highly likely that the wrong pixel coordinates were entered in 
Step 6 above. Looking at numbers that appear in the image give a good indication 
of the quality of the corrected image (see Figure 10-13 - Incorrect Interlacing for an 
example.) If the image has been interlaced incorrectly, enter the coordinates used 
prior to Step 6 and repeat Steps 4 to 7. 

  

 
Figure 10-13 - Incorrect Interlacing 

 
 
9. Once the image has been properly interlaced, complete Section 10.3.2 - Adjusting 

the Captured Image to finish correcting the image. 
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Figure 10-14 - Corrected Interlaced Image 

 
 
 

10.3.1.2 Interleaved Image 
If the image being captured has a resolution of 1600 x 1200 pixels or greater, it may appear 
repeated within the VDi Capture Window.  In order to correct this image, complete the following 
steps: 
 

1. Open Parameters > Dimensions and, in the Dimensions dialog box, use the X and 
Y Offset fields to move the image as close to the top left hand corner of the 
Capture Window as possible. Note that it may be more efficient to use the View > 
Zoom option to ensure the corner of the image is placed as close to the top left of 
the Capture Window as possible. 

 
2. With the image in place, and using the ‘Zoom’ option again, determine the Y-

coordinates at the top edge of both images (the x and y coordinates can be 
obtained by placing the cursor over the top edge of each image and right-clicking 
the mouse button). 

 
3. Open the Dimensions dialog box again (Parameters > Dimensions) and click the 

‘Interleaved’ check box.  The ‘Line 0’ and ‘Line 1’ fields will activate. Enter the Y-
coordinates, obtained during the prior step, in these fields with ‘Line 0’ accepting 
the top image Y-coordinate and ‘Line 1’ accepting the bottom image Y-coordinate. 
Click OK. 

 
4. If the bottom or top edge of the newly combined single image is cut off by the top or 

bottom of the screen,  use the ‘Image Height’ option in the Dimensions dialog box 
(Parameters > Dimensions) to ensure the entire image is visible. 

 
5. For further fine tuning, zoom the new image and use available Sharpness options 

(Parameters > Sharpness) to improve it. 
 
 

Variable Range 
Marker (VRM) 
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10.3.2 Adjusting the Captured Image 
Once the image has been captured (or adjusted in the case of an interlaced image), it must be 
corrected to ensure a proper capture. A proper capture should fill the VDi Capture Window while 
maintaining the visibility of all four (4) image edges. Follow the steps provided below to properly 
adjust the captured image: 
 
 

Note! It is recommended to write down all settings before making any changes as 
it may become necessary to revert back to previous information. 

 
 

1. Once the image has been captured to the VDi Capture Window, ensure the proper 
VPOL and HPOL information is set. 

 
 Open the ‘Parameter’ menu item, select ‘HPOL’ and note which setting is 

currently selected. Ensure it is the same (negative or positive) as indicated in the 
Auto-Detection Information Box during initial capture. Repeat for VPOL. 

 
 Example: The Auto-Detection Information Box indicated a negative HPOL 

setting. Open Parameter > HPOL and ensure ‘Neg’ is selected. 
 
 

2. Locate a circle on screen. A circle will allow a user to determine if the image requires 
recalibration. If the circle appears more in the shape of an oval than circular, it will be 
necessary to recalibrate the image to ensure a proper aspect ratio. 

 
 A Variable Range Marker (VRM) or Range Rings, available on most radar 

images, will provide an effective circular image that can be used for recalibration. 
See Figure 10-14 - Corrected Interlaced Image for an example of a VRM. 

 
 Once a circle has been found, use the cursor to find coordinates for the top, 

bottom, left, and right edges (see Figure 10-15 - Circle Coordinates - Top & 
Bottom and Figure 10-16 - Circle Coordinates - Left & Right). 

 

 
Figure 10-15 - Circle Coordinates - Top & Bottom 
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Figure 10-16 - Circle Coordinates - Left & Right 

 
 

 Open the Parameter > Sharpness > Recalibrate. In the Recalibration dialog box, 
note the number currently displayed in the ‘PLL Multiplier’ text                    
field (for example, in Figure 10-17 - Enter Recalibration Coordinates the ‘PLL 
Multiplier’ number is ‘800’.) 

 
 Enter the top edge y coordinate in the Y1 field, the bottom edge y coordinate in 

the Y2 field, the left edge x coordinate in the X1 field, and the right edge x 
coordinate in the X2 field. Press “Recalibrate”, followed by “OK”. 

 
 If the resultant image has improved but appears to need further recalibration, find 

the coordinates for the four (4) edges of the improved circle. If the resultant 
image appears to have worsened with the changes, open Parameter > 
Sharpness > Recalibrate, enter the previously noted ‘PLL Multiplier’ number 
(‘800’ in the example above), press ”OK”, and attempt to find the edge 
coordinates again. 

 

 
Figure 10-17 - Enter Recalibration Coordinates 

 
 

3. Next, the position of the image within the VDi Capture Window will need to be 
adjusted. Using the mouse, position the “cross-hair” over the upper left corner of the 
image and left-click to obtain the current x, y coordinates. 
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 With many radar images, it may be difficult to determine the true upper left corner 

of the captured image. Using an image similar to that shown in the Figures 
above, a user will likely have to adjust the image’s position a number of times to 
ensure it is as close as possible to the top left corner without losing any part of 
the image. 

 

 
Figure 10-18 - Image Corner 

 
 

 Via the ‘Parameter’ menu (Parameters > Dimensions), open the ‘Dimensions’ 
dialog box. 

 

 
Figure 10-19 - Dimension Dialog Box 

 
 

 Enter the x coordinate into the “X Offset” field and the y coordinate into the “Y 
Offset” field. Both width and “X Offset” coordinates will be rounded down to a 
multiple of eight (8). It is recommended to leave a small amount of black space to 
help determine RGB settings. 

 
 Increasing the “Y Offset” will move the image upward, while increasing the “X 

Offset” will move the image leftward. 
 

 If the entire image is not being captured in the VDi Capture Window once it has 
been moved to the upper left corner, it may be necessary to adjust the image 
height and/or width. 

 
 Example: Right-clicking the corner of the image provides 250 (x) and 34 (y) 

coordinates. Open the ‘Dimensions’ dialog box. Enter 34 in the “Y Offset” field. 
Enter 248 in the “X Offset” field (although the x coordinate was 250, entering 248 
allows a small amount of black space to remain and is a multiple of eight (8)). 
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4. Once the image position has been adjusted properly, the user may need to adjust the 
image phase in order to reduce any visible noise, banding, and/or soft edges. 

 
 Open Parameter > Sharpness > Phase, move the slider bar to a number 

between 0 and 31, and press the “OK” button. Notice if the image quality has 
improved and make further adjustments accordingly. 

 
 Example: The image has a great deal of visible noise (pixilation) at its left edge. 

Open the ‘Phase’ control slider, adjust to 16, and press “OK”. The left edge of the 
image is now much clearer and uniform. Reopen the ‘Phase’ control slider, adjust 
to 14, and press “OK”. The left edge of the image is now sharp. 

 
 

5. Once the image phase has been sharpened, if minor oscillation still appears in the 
image it may be necessary to adjust the image CPMP. 

 
 Open Parameter > Sharpness > CPMP, move the slider bar to a number 

between 0 and 3, and press the “OK” button. Notice if the image quality has 
improved and make further adjustments accordingly. 

 
 Example: The image has varied individual lines of oscillation at its left edge. 

Open the ‘CPMP’ control slider, adjust to 1, and press “OK”. The left edge of the 
image is now much clearer and uniform. Reopen the ‘Phase’ control slider, adjust 
to 2, and press “OK”. The left edge of the image is now sharp. 

 
 

6. Once the image has been adjusted correctly, right-click the Rutter VDi icon in the 
taskbar and select “Save Settings”. 

 
 

Important! It is not mandatory to adjust the captured image so that it completely 
fills the entire capture window. It is more important to maintain the original aspect 
ratio as closely as possible. 
 
The image should be adjusted so that it is as close as possible to the top and left 
edges of the capture window. The goal is to obtain the least amount of black space 
on the right and bottom of the capture window while maintaining the original aspect 
ratio.  

 
 
 

10.4 VDi Menu Overview 
This section provides an overview of the menu items available in the Video Diagnostics 
application. 
 

10.4.1 View Menu 
The ‘View’ menu provides two (2) options: 
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Figure 10-20 - Zoom Menu 

 

10.4.1.1 Load Bitmap 
Selecting this option opens a file selection window from which a user must choose a saved 
bitmap file to load to the Image window for viewing. 
 

10.4.1.2 Zoom 
Selecting one of the available numbers will zoom the image currently in the Image window to that 
chosen extent (i.e., selecting ‘8’ zooms the image 8X its original extent). ‘Fit’ will cause the image 
the edges of the image to fill to the edges of the Image window. 
 
 

10.4.2 Parameter Menu 
The ‘Parameter’ menu provides seven (7) options: 
 

 
Figure 10-21 - Parameter Menu 

 

10.4.2.1 Gain/Offset 
Fine-tuning the gain and/or offset helps to create a more uniform image by adjusting the signal 
response of each pixel. 
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Figure 10-22 - Gain / Offset Menu 

 
 
 Master Gain Adjust: This option adjusts the gain of the entire image, rather than that of the 

individual RGB values. Adjusting the gain stretches the image vertically in the capture 
window. The range available for adjustment is 0 to 255. 

 
 Master Offset Adjust: This option adjusts the offset of the entire image, rather than that of the 

individual RGB values. Adjusting the offset shifts the image up and down in the capture 
window. The range available for adjustment is 0 to 255. 

 
 Red, Green, Blue: It is possible to set the gain and offset for each colour. The range available 

for adjustment is 0 to 255. 
 
 

10.4.2.2 HPOL (Horizontal Polarization) 
HPOL is used to establish the truest amount of black space available in the captured image. 
Complete the following steps to establish the correct HPOL setting: 
 

1. Upon capture of the image, select Parameter > HPOL > Pos and note how much black 
space is visible on the left side of the image in the Image window. 

2. Select Parameter > HPOL > Neg and note if the amount of black space has increased 
(widened). 

3. If the black space has increased, Neg is the correct setting. If the black space has 
decreased, Pos is the correct setting. 

 

 
Figure 10-23 - HPOL Menu 
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10.4.2.3 Dimensions 
When selecting the ‘Dimensions’ menu item, a ‘Specify Dimensions’ dialog box will appear. It is 
possible to enter the following information: 
 
 X/Y Offset: These entries allow the user to set the location of the top left corner of the 

captured image. Left-clicking on the top left corner of the captured image in the Image 
window will provide the current X/Y coordinates of that point. To move it to a different X/Y 
coordinate location, enter the desired coordinates in the X/Y Offset fields of this dialog box. 

 
 Image Width/Height: To adjust the width and height of the captured image as it is displayed 

in the Image window, enter the desired dimensions into the appropriate text boxes. 
 
 Interleaved: Converts two consecutive 800x1200 sub-sampled images into a fully sampled 

1600x1200 image. 
 
 Interlaced: Used to adjust interlaced images using specific coordinates taken from the 

captured image. 
 
 

10.4.2.4 Sharpness 
There are three (3) options available to help create a sharper image: 
 

 
Figure 10-24 - Sharpness Menu 

 
 
 Phase: Adjusting the phase allows for the reduction of noise and/or soft edges that may be 

apparent in objects visible in the captured image. The range available for adjustment is 0 to 
31. 

 
 VCO (Voltage Controlled Oscillators): The range available for adjustment is 0 (default) to 3. 

The VCO setting should not be adjusted unless the captured image is severely distorted. 
VCO range can be selected in accordance with the following chart: 
 

Pixel Rate Range (MHz) 
Lower Upper 

VCORNGE Setting VCO Gain, KVCO (MHz/V) 

Min 37 OO 150 
37 74 O1 150 
74 140 1O 150 

140 Max 11 180 

Table 10-5 - VCO Range Chart 
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 CPMP (Charge Pump): Adjusting this option allows a user to repair the appearance of 
oscillation (wavering) that may be visible in the image. Oscillation, if it exists, will be most 
apparent at either the top of the image or near straight black lines. 

 
 Recalibrate: Allows a user to adjust the calibration of a captured image. To effectively 

recalibrate an image, a user should locate a circle within the captured image and record the x 
and y coordinates of each of the circle’s four (4) axis points (0, 90, 180, 270). When 
recalibrating an image, a user should always note the ‘PLL Multiplier’ number as it may be 
necessary to revert to a previous calibration (entering a previous PLL Multiplier number will 
revert the image back to the associated previous calibration.) 

 
 

10.4.2.5 VPOL (Vertical Polarization) 
VPOL is used to correct skewed images. Upon initial capture, the image should appear in a 
perfect 4:3 ratio (similar to image #1 below). If it is vertically skewed (similar to image #2 below), 
VPOL must be adjusted. 
 

   
 
 
Complete the following steps to establish the correct VPOL setting: 
 

1. Upon capture of the image, if it appears skewed select Parameter > VPOL > Pos. 
2. If the skewing is not corrected, select Parameter > VPOL > Neg. 
3. Note which setting establishes a correct 4:3 ratio. 

 
 

10.4.2.6 Clamp 
In the absence of an HSYNC signal, it may be necessary for the circuitry to “clamp” onto the 
VSYNC signal. 
 

#1 #2
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Figure 10-25 - Clamp Menu 

 
 
 Use HSYNC: In the absence of a VSYNC signal, the video capture circuitry will use the 

HSYNC signal. This is the default setting 
 
 Pos & Neg: The Pos setting overrides the usage of the HSYNC signal and, effectively, 

disables the “Clamp” command. The Neg setting is unavailable (disabled). 
 
 Placement & Duration: Only applicable if set to HSYNC. When set to HSYNC, these items 

allow for the sampling of video to determine voltage corresponding to the image’s black 
levels. 

 
 

10.4.2.7 Coast 
In the absence of a VSYNC signal, it may be necessary for the circuitry to obtain the HSYNC 
signal. 
 

 
Figure 10-26 - Coast Menu 

 
 Use HSYNC: In the absence of an HSYNC signal, the video capture circuitry will use the 

VSYNC signal. This is the default setting. 
 
 Pos & Neg: The Pos setting overrides the usage of the VSYNC signal and, effectively, 

disables the “Coast” command. The Neg setting is unavailable (disabled). 
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10.5 Sync-on-Green (SOG) 
If a video source transmits via Sync-on-Green (SOG), the associated VIDCHAN*.INI file (located 
in the C:\VDRApps directory) must be adjusted to include the following parameters: 
 
[CLOCK] 
HsRate1=xx.xxx 
XDim1=512 
YDim1=800 
 
[SYNCS] 
Source1=AD9887 
N1=yyyy 
 
The HSYNC value (HsRate1=xx.xxx) can be obtained from the VideoConfigSuite application. The 
overall x dimension (N1=yyyy) is selected based upon the following: 
 

 For HSync < 50: Set to 1200 
 For HSync between 50 to 70: Set to 1400 
 For HSync > 70: Set to 1600 

 
It is recommended to use actual HSync value from the manufacturer’s radar (for example, the 
STN Atlas 6900 radar has a HSync of 37.5000 KHz). If HSync information is not immediately 
available from the radar manufacturer, complete the following procedure: 
 

1. Open the VideoConfigurationSuite application. 
2. Right-click the Rutter icon in the desktop task bar and select ‘Capture Video’ from the 

pop-up list. 
3. In the Channel Selection box, select the radio button corresponding to the video channel 

to capture, the “Composite” checkbox, and the “SOG” radio button. Press “OK”. 
4. The HSync and VSync values will appear in the subsequent Auto-Detection window. 

Record the HSync value and its polarity. Press “Cancel”. 
5. Press “Cancel” in the AUTO_DETECTION_FAILED window. 
6. Enter the HSync information and parameter information discussed at the beginning of this 

section into the applicable VIDCHAN*.INI file and save the file. 
7. Right-click the Rutter icon in the desktop task bar and select ‘Capture Video’ from the 

pop-up list. 
8. In the Channel Selection box, select the radio button corresponding to the video channel 

to capture, the “Composite” checkbox, and the “SOG” radio button. Press “OK”. 
9. Press “Cancel” in the Auto-Detection window. 
10. In the AUTO_DETECTION_FAILED window, press “NON-VESA Support”. 
11. In the Windows file selection window, choose the VIDCHAN*.INI file which was altered 

and saved in Step 5 above. 
12. Right-click the Rutter icon in the desktop task bar and select ‘View Video’ form the pop-

up list. 
 
The above procedure will provide an image in the VideoConfigSuite application that can be 
properly configured in accordance with Section 10.3 - Video Diagnostics (VideoConfigSuite) 
Application. 
 
If the HSync value was obtained via the VideoConfigSuite application, it is recommended to 
carefully check that the VCO, CPMP, and Phase are correct for the captured image. 
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10.6 Test Video Inputs 
1. Start the VDR_Record application. 
2. Deselect ‘Record’ from the ‘Tests’ menu. 
3. Select ‘Video Test’ from the ‘Tests’ menu. 
4. Maximize the Video Data window. 
5. Ensure the video is captured correctly (entire screen, correct colour presentation and 

brightness/contrast and sharpness). 
6. Once the settings are correct, place the VDR_Record application in record mode for 

several minutes. 
7. Download the new data from the VDR on the playback station and play back the video 

data. Refer to Section 16 - DATA RETRIEVAL and Section Error! Reference source not 
found. - Error! Reference source not found. for download and playback instructions: 

a. Ensure the video is presented correctly. If not, stop recording and make the 
necessary changes to the configuration. 

b. If the top edge of the image capture is not captured correctly, edit the 
VIDCHAN*.INI file and increase the value assigned to CPMP1 field. 

c. If a colour is not presented correctly on each capture, edit the VDRPARAMS.INI 
file video section so that the enhancedCompression field is set to 0; 

d. If the captured image has a primarily black background and noise is present at 
the low end of the captured signal, this noise can be removed by editing the 
VDRPARAMS.INI file video section so that the noiseClipping field is set to 1. 

 
 
Note! This setting must be used with care, as it may set most of the image to black 
if there is no noise near the black level. This setting is only used if enhanced 
compression is enabled. 

 
 

8. Repeat steps 1 through 7 until the video presentation is correct. 
 

10.7 Set-Up Laptop for Video Module Connection 
In certain limited situations, it may be necessary to connect to the Video Module via a laptop PC. 
To make this connection, complete the steps below: 
 

1. Connect the laptop to the Ethernet port (labeled “Output”) located at the front of the Video 
Module. 

2. On the laptop’s desktop screen, open the Control Panel (Start > Control Panel). 
3. Double-click the ‘Network Connections’ icon, right-click the now visible ‘Local Area 

Connection’ icon, and select ‘Properties’ from the right-click menu. 
4. Select “Internet Protocol (TCP/IP)” in the connection pane and press the ‘Properties’ 

button. 
5. Select the ‘Use the following IP address’ radio button, enter 192.168.199.1 in the ‘IP 

address’ field and 255.255.255.0 in the ‘Subnet mask’ field. Press ‘OK’. 
6. Select the ‘Advanced’ tab and press the ‘Settings’ button in the ‘Windows Firewall’ 

section. 
7. Select the ‘Advanced’ tab and press the ‘Settings’ button in the ‘Network Connection 

Settings’ section. 
8. Press the ‘Add’ button and in the “Service Settings” window: 

 Enter Video TCP in the ‘Description of service’ field. 
 Enter 192.168.199.228 in the ‘Name or IP address’ field. 
 Enter 3659 in the ‘External Port number for this service’ field. 
 Enter 3659 in the ‘Internal Port number for this service’ field. 
 Select the TCP radio button. 
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 Press ‘OK’. 
 

9. Press the ‘Add’ button and in the “Service Settings” window: 
 Enter Video UDP in the ‘Description of service’ field. 
 Enter 192.168.199.228 in the ‘Name or IP address’ field. 
 Enter 2649 in the ‘External Port number for this service’ field. 
 Enter 2649 in the ‘Internal Port number for this service’ field. 
 Select the UDP radio button. 
 Press ‘OK’. 

 
10. Press ‘OK’ in the “Advanced Settings” and “Windows Firewall” windows. Press ‘Close’ in 

the “Local Area Connection Properties” window. 
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11 NMEA SETUP 
 
The VDR-100G2 base system is composed of 1 Navigation Sensor Multiplexor (otherwise 
referred to as a NMEA Input Module) for the capture of 8 NMEA 0183/IEC 61162 compatible 
inputs.  A 4 input version and a 4 with VHW (water speed and heading) version is also available. 
 
In some situations shipboard data sources either have no serial data or generate serial data that 
does not meet the IEC 61162 standard. To access these data sources, analog, and digital signal 
interface units may need to be utilized. These interfaces convert the information from non-
standard data sources into the IEC 61162 data format. The converted data source can then be 
connected to any of the serial inputs of multiplexor interface for recording. Refer to Appendix C – 
Data Interface Documentation. 
 
The NMEA Module is configured using the NMEAModuleConfig.exe configuration utility via an 
Ethernet connection.   
 
 

11.1 Checking the NMEA Module Configuration 
To check the current NMEA Module configuration, complete the following steps:  
 

1. Ensure that only one (1) NMEA Module is connected at one time.  ALL inputs must 
be disconnected as each Module must be configured individually. 

 
2. Ensure a crossover Ethernet cable is connected directly from the Module to the 

technician PC (or DMM if configuring from the DMM). 
 

3. Start the NMEAModuleConfig.exe configuration utility. 
 

 
Figure 11-1 - NMEA Module Configuration Utility
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4. In the Number of NMEA Channels section, select the radio button that corresponds to 

the applicable Module (4 Channels, 8 Channels, or 4 Channel w/VHW) being 
configured. 

 
5. Click the “Load Configuration” button, located at the bottom of the configuration utility 

window. 
 
 

Note! A dialog box will appear asking the user to cycle power on the Module.  
DO NOT click ‘OK’ at this point. 

 
 
6. Disconnect and reconnect the power connection.  

 
7. Click ‘OK’.  The configuration will be broadcast for five (5) seconds after the Module is 

powered on and will appear in the text box at the bottom of the utility and in the 
selection boxes. 

 
 

11.2 Configuring the NMEA Module 
To configure the NMEA Module, complete the following steps:  
 

1. Ensure that only one (1) NMEA Module is connected at one time.  ALL inputs must 
be disconnected as each Module must be configured individually. 

 
2. Disconnect power from the NMEA Module. 

 
3. Ensure a crossover Ethernet cable is connected directly from the Module to the 

technician PC (or DMM if configuring from the DMM). 
 

4. Start the NMEAModuleConfig.exe configuration utility. 
 

5. In the Number of NMEA Channels section, select the radio button that corresponds to 
the applicable Module (4 Channels, 8 Channels, or 4 Channel w/VHW) being 
configured. 

 
6. Choose the desired Baud Rate, Bits, and Parity for each port.  Any channel not in use 

should be left at its 4800-8-N1. 
 
 

Note!  If any of the input channels are set to a baud rate of 38, 400, the RS232 
and RS422 outputs will be disabled. 

 
 

7. Press “Configure Module”. 
 
 

Note!  A warning will appear if a combined data input rate larger than the data 
output rate is selected, but these settings can still be programmed.  If these 
settings are programmed, it is the responsibility of the technician to verify that 
data from the RS232 and RS422 outputs will not be corrupted. 
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8. A message box will appear stating “Ensure that only ONE module is connected to the 

system”.  Click ‘OK’. 
 
9. Apply power to the NMEA Module. 

 
10. Once power is applied to the NMEA Module a reboot sequence will be displayed on the 

LEDs.  If the NMEA Module is the 8-Channel or 4-Channel w/VHW version: 
 

 The last five (5) LEDs will illuminate for approximately five (5) seconds and turn 
off.  The first three (3) LEDs will flash twice then illuminate for approximately five 
(5) seconds and turn off. 

 
If the NMEA Module is the 4-Channel version: 

 
 The first four (4) LEDs will flash. 

 
If the three (3) LEDs (8-Ch or 4-Ch w/VHW) or four (4) LEDs (4-Ch) remained 
illuminated for the full duration of the programming or the reset sequence, the 
programming was unsuccessful; if it was unsuccessful, cycle power to the unit. 
 
 
 

Note! While the NMEA Module is performing its reboot sequence, a series of X’s 
will appear in the text window.  Once the sequence is complete and the 
programming starts, the X’s will be replaced by a series of dots (…….. ) to 
indicate that programming is occurring correctly.  The image below shows a 
correct programming sequence.  If the software is unable to connect, a series of 
exclamation points will be visible in the text window. 

 

 
Figure 11-2 - Configuration Utility Reboot Sequence 
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11. Press the “Stop” button at the bottom of the Configuration window once the first 3 
LEDs are no longer illuminated. 

 
 
Note!  Once the NMEA Module configuration is complete, it is recommended to 
verify that the settings have been programmed correctly by completing the 
‘Checking the NMEA Module Configuration’ procedure located at the beginning 
of this document. 
 

11.3 NMEA Module ID – DIP Switch Settings 
The NMEA Module ID (MUX ID) is jumper configured.  To configure the MUX ID, locate Switch 
S1.  There is a four (4) position jumper switch, with the first three (3) positions used for MUX ID. 
 

Switch 1 Switch 2 Switch 3 MUX ID 
ON ON ON MUX ID 0 

OFF ON ON MUX ID 1 

ON OFF ON MUX ID 2 

OFF OFF ON MUX ID 3 

ON ON OFF MUX ID 4 

OFF ON OFF MUX ID 5 

ON OFF OFF MUX ID 6 

OFF OFF OFF MUX ID 7 

Table 11-1 - Switch Settings - MUX ID 
 
 
Note that if the MUX ID = 0, no channel or MUX identifiers are included in the output string. 
 
 

11.4 AIS Connection 
The NMEA Module is capable of accepting AIS data.  Note that if an AIS is connected, there must 
be an AISMuxID entry added to the NMEA section of the VDRPARAMS.INI file (see Section 11.5 
- Edit [NMEA] Parameters for further information). 
 
 

Note! AIS data must be connected on Channel 1. 
 
 
 

 Channel 1 is the only channel available that accepts 38, 400 baud at high data. 
 Channels 2 and 3 accept 38, 400 baud at normal data. 
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11.5 Edit [NMEA] Parameters 
 
Parameter Typical Value Remarks 

TimeString ZDA NMEA String to use for time (ZDA, GGA, GLL 
or RMA) or PC for failsafe 

TimeMuxID 12 Mux ID where time data is input 

AISLocation 3 Location where AIS data is input; default is 3 

AISMuxID 11 Mux ID where AIS data is input 
Table 11-2 - NMEA Parameter Typical Values 

For the base system, a single NMEA Module is configured via DIP-switch settings as described in 
Appendix C – Data Interface Documentation.  The RootInputMUXChannelCount field allows for 
cascading additional NMEA devices, but this field is ignored for the base VDR. 
 

11.5.1 AIS Data Parsing 
If recording AIS data, there is an option to not record it to the FRM.  If this option is chosen, AIS 
data will only be stored to the internal hard discs of the VDR. 
 
To not record AIS data to the FRM, the EnableAISParsing string in the NMEA section of the 
VDRPARAMS.INI file must be set to 1.  For example: 
 
EnableAISParsing = 1 
 
The default value for this string is 0. 
 
A sample AIS string may read: 
 
11!AIVDM,1,1,,B,139Kcl002W0TMVvPK@bGlV;N0HKO,0*7B 
 
In the above sample, the “11” header indicates that the AIS data is being received on the first (1) 
channel of the first (1) NMEA Module (Mux).   
 
Another sample AIS string may read: 
 
1323!AIVDM,1,1,,B,139Kcl002W0TMVvPK@bGlV;N0HKO,0*7B 
 
In this sample, there are two cascading NMEA Modules.  The “1323” header indicates that the 
AIS data is being received from the AIS on the third (3) channel of the second (2) NMEA Module 
(Mux), then input through the third (3) channel of the first (1) NMEA Module (Mux). 
 
 



Chapter 11: NMEA Setup 

 
VDR-100G2/G2S Installation Manual  139  
RUT-TD-02-001, Rev 2.1 

11.6 Test NMEA Sources 
To ensure compliance with IMO regulations, information from each NMEA source must be 
verified and validated using the methods in the following sections.  Begin each test by following 
the steps provided below: 
 

1. Start the VDR_Record application. 
2. Deselect record under the ‘Tests’ menu. 
3. Select ‘NMEA Test’. 
4. Observe data from the time source is present in the NMEA data window.  The $GPZDA 

and $GPGLL NMEA strings must be present, however other strings may be observed as 
well. 

 
Note! If data is not present, reverse the polarity of the connection and try again.  If 
the data is scrolling too fast to distinguish the data, stop the NMEA test and scroll 
up the window until the source is found. 

 
 

5. Observe with each NMEA source that data is presented in the NMEA data window.  
6. Make note in the configuration file of the identity of the NMEA source and the relevance 

of the information.  For more information on editing the configuration file refer to Section 
17 - SYSTEM CONFIGURATION FILE. 

 

11.7 NMEA Error Codes 
 
The error codes in the NMEA data from the NMEA Module identify the NMEA module and it’s port 
that has the error. These errors occur when either the data format or speed does not match the 
received data, or the received data is corrupted.  
 
The error message is in the format NerrorXX, where N is the NMEA ID and XX is the code as 
listed below.   
 

Code 8-Port NMEA Module 4-Port NMEA Module 
A 232/422 Output 232/422 Output 
B 422 Input 422 Input 
C Input 1 Input 1 
D Input 2 Input 2 
E Input 3 Input 3 
F Slave/Master Link Input 4 
SA Output to Slave NA 
SB Input Port 4 NA 
SC Input Port 5 NA 
SD Input Port 6 NA 
SE Input Port 7 NA 
SF Input Port 8 NA 

Table 11-3 - NMEA Error Codes 

 
For example, error message 1errorSD on an 8 Channel NMEA Module would indicate that the 
data on input Port 6 has the wrong data format or speed or is corrupt. 
 
 
 



Chapter 11: NMEA Setup 

 
VDR-100G2/G2S Installation Manual  140  
RUT-TD-02-001, Rev 2.1 

11.8 Test Analog Sources 
 

1. Prior to connecting the inputs to the Analog device, the source voltage levels should be 
verified: 

 
a. Maximize the source level (i.e., place a 100% order to Stbd on the bow 

thrusters). 
b. Measure the source level and make note of the Analog value at 100%. 

 
2. Connect the inputs to the interface.  Ensure that correct polarity is maintained so that a 

positive order or response from the source will display a positive result on the VDR. 
3. Make note of the digital value displayed in the Log Window for the particular source and 

edit the configuration file to reflect this.  These values are necessary for playback and 
data recovery in the event of an incident. 

 
 

Note! Refer to Appendix C – Data Interface Documentation for additional 
information regarding Analog output string format. 

 
 
4. Reduce the source level to approximately 75%; (ex., place a 100% order to Port on the 

bow thrusters). 
5. Repeat step 3. 
6. Adjust the source level to the midpoint (i.e., place a 0% order to on the bow thrusters). 
7. Repeat step 3. 
8. Repeat steps 1 through 7 for the remaining analog sources. 

 
 

11.9 Test Discrete Inputs (Dry/Hot Contacts, Relays, Etc) 
 

1. Contact connections should be verified. 
2. Make note of which contact is connected to which point, identify the normal 

state of the contact and edit the configuration file accordingly. 
 

 
 
Note! Refer to Appendix C – Data Interface Documentation for additional 
information regarding Discrete output string format. 

 
 

3. Repeat steps 1 and 2 for the remaining Discrete inputs. 
 



 

 
VDR-100G2/G2S Installation Manual  141  
RUT-TD-02-001, Rev 2.1 

This page is intentionally blank.



 

 
VDR-100G2/G2S Installation Manual  142  
RUT-TD-02-001, Rev 2.1 

12 OPERATION & ALARM UNIT TEST 
 
The OAU has 2 main purposes: 
 

 It provides a visible and audible alarm in the event that it receives an error message 
from the VDR-100G2, and 

 It is used to initiate the copying of data from the VDR to the DMM internal hard drive.  
 
The functionality of these features shall be verified during installation. 
 

1. The VDR_Record application should be loaded and in the record mode. 
2. Pull the power input to the DPU. 
3. Observe a “Power Failure” message is reported on the LCD and audible alarm is 

sounded. 
4. Push the ‘Mute’ button to silence the audible alarm. 
5. Perform a download to the DMM internal drive (see Section 14.1 - Securing Data):  

a. Observe a download progression message (for example, “20% Complete”). 
b. Allow the download to complete displayed on the alarm panel. 
c. Push the ‘Enter’ button to acknowledge the completed download. 

 
6. Plug the power input back into the DPU. 
7. Observe the “Power Failure” message is cleared on the OAU. 
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13 FINAL RECORDING MEDIUM SETUP 

13.1 FRM System Overview 
The Final Recording Medium (FRM) is a solid-state storage unit capable of storing a minimum 
of 12 hours of VDR-100G2/S data in compliance with IMO resolution A.861(20.). The difference 
between a FRM and SFRM are: FRM can only be a fixed capsule; SFRM may be supplied as 
float-free or fixed. The SFRM does not have to meet the penetration factor.  
 
The primary function of the FRM/SFRM is to provide a protective capsule for the IMO required 
data acquired by the VDR.  This data will be used, in the event of an incident, by an accident 
investigation team. 

 The FRM/SFRM is mounted on the exterior deck of the ship and connected to the DMM. 
 The FRM/SFRM receives data from the VDR via an Ethernet link. 
 The SFRM is available in two types: float free and fixed.   

 
Capsule Specifications: The FRM is required to meet the following specifications 

 Pin Penetration:   
o 100 mm pin diameter, 
o 250 kg dropped from 3 meters 

 Fire Protection:  50,000 BTU/sq foot/hour  
o 60 minutes at 1100° 
o 10 hours at 260°C 

 Shock:   IEC 68-2-27 50g’s, 11ms, half-sine shock 
 Immersion:   6,000 meters depth 

 
 

 
Figure 13-1 - Sample VDR-100G2S FRM Installation 

 
The SFRM is required to meet the Fire Protection, Shock, and Immersion specifications but IS 
NOT required to meet the Pin Penetration specs. 
 
The VDR-100G2 supports the use of single or dual capsules in a fixed or Float-free configuration.  
Each FRM or SFRM has unique setup properties and the following sections should be consulted 
prior to setting up the FRM.

FRM Capsule 

Gooseneck Conduit 
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Note! An FRM Configuration Sheet is available in Appendix A – FRM Maintenance 
Sheet and should always be completed during an FRM set-up. In the event of an 
incident this information must be available in order to retrieve data from the FRM. 

13.1.1 General Setup 
To configure an S/FRM for recording, the S/FRM must be enabled in the <vdrparams.ini> file. 
 
To open the <vdrparams.ini> file : 

1. Log on as administrator; 
2. Open <vdrparams.ini > on desktop screen; 
3. Locate the [STORAGE] section in the <vdrparams.ini> file;  
4. Edit the following lines in the [Storage] section: 

 
[STORAGE] 
 
hardenedStorage = 1  // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 1  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5=Rutter Fixed 
secondaryHardenedFormat = 4  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5=Rutter Fixed 
 
 
The following tables provide explanations/details on each of the lines from the [Storage] section 
 

hardenedStorage 

The ‘hardenedStorage’ line enables recording to the FRM and is used to indicate whether it is 
used in a single or double FRM configuration.  The default value is 0 which specifies that no FRM 
is used with the system.   
hardenedStorage = 0 Indicates that no FRM is connected to the system. 

hardenedStorage = 1 Indicates that an FRM is connected to the system in a single FRM 
configuration 

hardenedStorage = 2 Indicates that the VDR is operating in dual FRM mode.  In this 
configuration, the fixed capsule must be configured as the primary 
and the Float-free FRM is configured as the secondary FRM. 

Table 13-1 - 'hardenedStorage' enables recording to the FRM. 

 

hardenedFormat 

The ‘hardenedFormat’ line is used to indicate the manufacturer of the primary FRM in use. If a 
fixed FRM capsule is used in dual FRM mode with a Float-free SFRM capsule, the fixed FRM 
capsule is always set as the primary FRM.  

hardenedFormat = 1 Indicates that either the L3 HVR Fixed FRM Capsule or L3 SVR 
Fixed SFRM Capsule is used as the primary (or only) FRM. 

hardenedFormat = 2 Indicates that the Litton PMC Fixed FRM Capsule is in use as the 
primary (or only) FRM. 

hardenedFormat = 3 Indicates that the JoTron Float-free SFRM Capsule is in use as the 
primary (or only) FRM. 

hardenedFormat = 4 Indicates that the Rutter-ACR Float-free SFRM Capsule is in use as 
the primary (or only) FRM. 

hardenedFormat = 5 Indicates that the Rutter FRM (RUT-02447) Fixed Capsule is in use 
as the primary (or only) FRM. 
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Table 13-2 - 'hardenedFormat' indicates the manufacturer of the primary FRM. 

 

secondaryHardenedFormat 

The ‘secondaryHardenedFormat’ line is used to indicate the manufacturer of the secondary FRM 
in use. If a fixed FRM capsule is used in dual FRM mode with a Float-free SFRM capsule, the 
fixed FRM capsule is always set as the primary FRM.  If the VDR is operating in a single FRM 
configuration, this value is ignored.  

secondaryHardenedFormat = 3 Indicates that the JoTron Float-free SFRM Capsule is in 
use as the secondary FRM. 

secondaryHardenedFormat = 4 Indicates that the Rutter-ACR Float-free SFRM Capsule is 
in use as the secondary FRM. 

Table 13-3 – ‘secondaryHardenedFormat' showing secondary FRM manufacturer. 

 
Example 1:  Shows an L3 HVR-01/02 Fixed FRM Capsule (or L3 SVR-01/02 Fixed SFRM 
Capsule) in single FRM mode. The secondary format will be ignored in this case. 
 
[STORAGE] 
 
hardenedStorage = 1  // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 1  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5= Rutter Fixed 
secondaryHardenedFormat = 4  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5= Rutter Fixed 
 
Example 2:  Shows a JoTron Float-free SFRM Capsule in single FRM mode.  The secondary 
format will be ignored in this case. 
 
[STORAGE] 
 
hardenedStorage = 1  // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 3  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5=Rutter Fixed 
secondaryHardenedFormat = 4  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5= Rutter Fixed 
 
Example 3:  Shows a Rutter FRM (RUT-02447) Capsule as primary with a Rutter-ACR Float-free 
SFRM Capsule as secondary operating in dual FRM mode.   
 
[STORAGE] 
 
hardenedStorage = 2  // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 5  // 5=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5=Rutter Fixed 
secondaryHardenedFormat = 4  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5=Rutter Fixed 
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13.2  Fixed Capsules 
Fixed capsules are designed to be mounted externally on the bridge top of the ship and are 
designed to ensure that critical VDR data can survive the following environmental conditions: 

 Impact shock: 50 half sine-wave pulse for 11 milliseconds;  
 Fire Exposure: 1,100 degrees centigrade for one hour and 26 degrees centigrade for 10 

hours; 
 Deep Sea Pressure: 30 days under water at MPa (equivalent to 6,000 m depth).   

 
Fixed capsules can be supplied with either a VDR as an FRM or as an. In the case of fixed FRMs 
for VDRs, the fixed capsule must additionally meet the penetration standard of SVDR which is 
250 kg mass dropped 3 metres impacting with 100 mm diameter pin; 

13.2.1 Rutter Fixed FRM Capsule 
 

 
 

Figure 13-2- Rutter FRM (RUT-02447) Fixed Capsule 

 
The Rutter FRM (RUT-02447) Fixed Capsule is an armoured stainless steel (A316) capsule. It is 
coloured bright orange for ease of location in the event of an incident.  
 
The Rutter FRM (RUT-02447) Fixed Capsule is designed to be mounted externally close to the 
bridge—typically on the bridge top—and is fitted with an acoustic beacon to aid underwater 
recovery by a Remotely Operated Vehicle (ROV) or diver in the event of an incident. The 
protected memory is stored in the retrievable capsule and is connected by a quick-release cable-
connector assembly to the deckmount which contains the server-central processing unit. 
 
The Rutter FRM (RUT-02447) Fixed Capsule has the capacity to store audio, radar video and 
other data for 12 hours with a 4 GB storage capacity. The Rutter FRM (RUT-02447) Capsule will 
retain the data for more then 10 years when the power supply is removed.  
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The Rutter FRM (RUT-02447) Capsule has a release mechanism to facilitate underwater 
recovery both by a diver or a ROV. Suitable handles are provided to ensure that the capsule may 
be retrieved safely after release. 
 
The manufacturer should be contacted to extract the data, when the Rutter FRM (RUT-02447) 
Capsule has been damaged after an incident, e.g. the capsule was exposed to fire or the ship 
has sunk. Alternatively, authorities may apply to the manufacturer for instructions on how to 
retrieve the recorded data. 
 

13.2.1.1 Planning for the Rutter FRM (RUT-02447) Fixed Capsule 
The Rutter FRM (RUT-02447) Capsule is supplied with interconnect cables. These cables must 
connect to the VDR-100G2/S through a junction box (not provided with VDR-100G2/S). The 
junction box is normally mounted on the exterior deck and located near the FRM and positioned 
within range of the interconnect cable. All hull penetrations for cables must be fitted with 
waterproof glands (not provided with VDR-100G2/S). 
 
Plan to mount the Rutter FRM (RUT-02447) Capsule near the bridge on the external deck to 
increase the probability of its survival and recovery after an incident. The capsule must be 
positioned clear of rigging and other potential obstructions and as near to the centreline of the 
ship as practically possible. Criteria to be considered when assessing the optimum position 
shall include but not be limited to the following: 

1. Separation from fuel or other potential fire sources; 
2. Separation from probable sources of mechanical damage; 
3. Operational environment for continued serviceability; 
4. Accessibility for copying of recorded data and for routine maintenance; 
5. Facilitation of underwater removal and retrieval by both divers and ROVs;  
6. Clear unobstructed space around the capsule to allow an ROV or diver to work; and  
7. Mounted away from sound absorbing materials such as honeycomb structure, tarpaulin 

fabrics, clothing, cargo, etc to ensure that the Rutter FRM (RUT-02447) Capsule beacon 
operates correctly.  

 

13.2.1.2 Mounting the Rutter FRM (RUT-02447) Capsule 
 
The selection of a mounting location should provide for convenient access during inspection 
intervals. The mounting location should also provide clearance for removing the beacon from its 
mounting cradle. 
 
The Rutter FRM (RUT-02447) Capsule is supplied with an interconnect cable (3 meters of 
Ethernet cable). This cable must connect to the VDR-100G2/S through a junction box (not 
provided with VDR-100G2/S). The junction box must be shielded and connected to the hull of the 
vessel.  
 
The Rutter FRM (RUT-02447) Capsule and deckmount are delivered completely assembled and 
sealed. DO NOT open the capsule at the time of installation. Simply mount the capsule on the 
deck and connect the cables to the junction box to complete the installation. Two methods may 
be used to affix the deckmount to the deck; 
 

1. Standard: Weld the supplied mild/steel (or aluminium when specifically ordered with the –
A option of the installation package) deckplate to the deck and subsequently fastening 
the Rutter Fixed FRM deckmount to it by means of the 5 x M12 bolts supplied. To avoid 
corrosion issues, the isolation sleeves as well as the neoprene rubber insulating 
plate should always be used. 

 



Chapter 13: Final Recording Medium Setup 
 

 
VDR-100G2/G2S Installation Manual  149  
RUT-TD-02-001, Rev 2.1 

2. Alternatively (when welding is impossible): drill 5 holes into or through the deck, 
optionally tapping M12 holes, and fixing  the Rutter Fixed FRM capsule by means of the 
bolts provided. To avoid corrosion issues, the isolation sleeves as well as the 
neoprene rubber insulating plate should always be used. 

 

 
Figure 13-3- Fastening the deckmount assembly to the deck. 

 

 
Figure 13-4 - When feeding the cables (through the deck) from the bottom, alternative  
cable entries may be used by interchanging the cable glands and blind plates. 
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13.2.1.3 Connecting the Rutter FRM (RUT-02447) Fixed Capsule 
The wiring of the connections between the VDR-100G2 and the selected FRM is via the RJ45 
connector (illustrated in Figure 13-5 - RJ45 Connector). 
 
The junction box adjacent to the FRM on the vessel’s outside deck is not supplied with the VDR-
100G2/S.  It connects the cables provided with the FRM to the cables connecting to the VDR-
100G2/S.   
 
This junction box can be located inside, but must be located within the cable distance of the 
FRM cables. It must also be fully screened and connected to the vessel’s hull. If mounted outside, 
it must also be waterproof. 

 
Figure 13-5 - RJ45 Connector 

Rutter uses the 568B standard for all straight-thru Ethernet cables.  
Rutter uses the crossover standard noted below for all cross-over Ethernet cables. 
 

Straight through 568B 
Connector 1 Connector 2 

1 Tx+ white/orange 1 Tx+ white/orange 
2 Tx- orange 2 Tx- orange 
3 Rx+ white/green 3 Rx+ white/green 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- green 
7 N/A 7 N/A 
8 N/A 8 N/A 
  
Table 13-4 Straight-through Ethernet cable set ups 

 
Crossover 

Connector 1 Connector 2 
1 Tx+ white/orange 1 Tx+ white/green 
2 Tx- orange 2 Tx- green 
3 Rx+ white/green 3 Rx+ white/orange 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- orange 
7 N/A 7 N/A 
8 N/A 8 N/A 
  
Table 13-5 – Cross-over Ethernet cable set ups 

 
Note! It is highly recommended that cabling connecting the Rutter FRM (RUT-
02447) Capsule to the VDR-100G2/S is installed through a gooseneck conduit (see 
Figure 5-19 - Sample VDR-100G2S SFRM Installation for a sample FRM 
installation.) 
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13.2.1.4 Testing Rutter FRM (RUT-02447) Fixed Capsule Physical Connection 
1. Confirm that the cable connections between the Rutter FRM (RUT-02447) Capsule and 

the VDR are correct; 
2. Open the Command Prompt from: Start menu>All Programs>Accessories>Command 

Prompt on the VDR; 
3. The Command Prompt window will open; 
4. At the C:\> prompt, type ping 192.168.0.50; 
5. Select the Enter button on the keyboard; 
6. Observe that 4 replies are received from the Rutter FRM (RUT-02447) Capsule;  
 

 
Figure 13-6 - Pinging the Rutter FRM (RUT-02447) Capsule 

7. Once communications has been verified, close the Command Prompt window. 
 

NOTE: If the request times out, check the Rutter FRM (RUT-02447) Capsule cable connections. 
 

13.2.1.5 Set FRM Port’s IP Address—Rutter FRM (RUT-02447) Fixed Capsule 
 

The default IP address of the Rutter FRM (RUT-02447) Fixed Capsule is 192.168.0.50.  The 
VDR’s factory configuration for the FRM Ethernet port IP address is 192.168.0.189. If this 
address is not correctly set, communication between the VDR and the Rutter FRM (RUT-02447) 
Capsule will not be possible. The FRM port must be in the same range as the Rutter FRM (RUT-
02447) Capsule, with the last segment different than the VDR (as shown below.).  
 
To change the IP segment of the VDR’s FRM Ethernet port: 

1. Select the Start menu; 
2. Open the Control Panel;  
3. Double-click the Network Connections icon; 
4. Right-click on the SFRM icon; 
5. Select Properties from the pop-up menu. 
6. In the Local Area Connection Properties window, highlight “Internet Protocol (TCP/IP)”; 
7. Select the “Properties” button directly under the available options; 
8. The “Internet Protocol (TCP/IP) Properties” window will open;  
9. Select the “Use the following IP address” radio button;  
10. Enter 192.168.0.189 (the last number can be any number from 2 to 254, except 50.) 
11. Select the “OK” button in the Internet Protocol (TCP/IP) Properties; 
12. Select the “OK” button in the Local Area Connection Properties; and  
13. The connection should now be established. 
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13.2.1.6 Configuring the Rutter FRM (RUT-02447) Capsule 
To begin setting up the Rutter FRM (RUT-02447) Capsule support:  
1. Log on as administrator 
2. Locate the <vdrparams.ini> file on the desktop; 
3. Open the file;   
4. Locate the [STORAGE] section of the open file; and   
5. Ensure entries are set as shown below: 
 
[STORAGE] 
 
hardenedStorage = 1 // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 5 // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5=Rutter Fixed 
secondaryHardenedFormat = 4  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5= Rutter Fixed 
 
RutterFixed-compressNMEA = 0  // 0 = disable, 1=enable;  default is 0  
 
 

Note: The Rutter FRM (RUT-02447) Fixed Capsule does not need to be 
partitioned. 
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13.2.2 L3 HVR/SVR Fixed FRM/SFRM Capsules 
 
The externally mounted L3 HVR/SVR Fixed FRM/SFRM Capsules are certified to meet or exceed 
requirements for the environmental qualification categories of IEC 60945, and the survivability 
requirements of IEC 61996-2. 
 
The L3 HVR/SVR Fixed FRM/SFRM Capsules are designed specifically for the Voyage Data 
Recorder (VDR) and Simplified Voyage Data Recorder (S-VDR) as required in IEC 61996.2.and 
the MSC.163(78) performance standards and includes an expandable  2 GB solid state memory  
with a storage capacity of more than 12 hours of voyage data including radar, audio, and sensor. 
 

13.2.2.1 Planning for the SVR-02 Fixed SFRM Capsule 
The FRM/SFRM is supplied with interconnected cables. These cables must connect to the VDR-
100G2/S through a junction box (not provided with VDR-100G2/S).  The junction box must be 
shielded and connected to the hull of the vessel. The junction box is normally mounted on the 
exterior deck and located near the SFRM and positioned within range of the interconnect cable. 
All hull penetrations for cables must be fitted with waterproof glands (not provided with VDR-
100G2/S). 
 
The L3 HVR/SVR Fixed FRM/SFRM Capsule setup is the same regardless of whether it is set up 
as single or dual mode FRM. 
 

Note! Prior to beginning the set-up of a L3 HVR/SVR Fixed FRM/SFRM Capsule, 
it is necessary to determine if the unit’s series and type: HVR-01, SVR-01, HVR-
02, SVR-02, or SVR-03. 
 

13.2.2.2 L3 HVR/SVR Fixed FRM/SFRM Capsule Partitions Overview 
Due to changes made by the manufacturer, there are two available L3 FRM capsule types 
including the HVR series and the SVR series: 

1. L3 HVR-01 Fixed FRM Capsule 
2. L3 HVR-02 Fixed FRM Capsule 

There are also three available L3 SFRM capsules: 
1. L3 SVR-01 Fixed SFRM Capsule 
2. L3 SVR-02 Fixed SFRM Capsule 
3. L3 SVR-03 Fixed SFRM Capsule 
 

 
NOTE: The  SVR-01 / SVR-02/ SVR-03 and HVR-01 / HVR-02 are physically distinct. 
But there are only two setup processes for these five capsules.  There is one setup 
processes for all FRM capsules. And there is one setup process for all SFRMs. The 
planning, mounting configuring, recording  and testing for all L3 Fixed FRM/SFRM 
capsules  follows exactly the same procedure regardless of whether the capsule 
being installed is an FRM or an SFRM..  
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The table below is provided to clarify the set-up information for the different L3 capsules which 
may be encountered during an installation. The numbers provided below indicate the values 
applicable to the different L3 capsules: 
 
Version Total Granules Bytes per Granule AUDIO Partition VIDEO Partition NMEA Partition 

HVR-01 111990 16384 65925 39474 6591 

HVR-02 15990 131072 9413 5636 941 

SVR-01 111990 16384 65925 39474 6591 

SVR-02 15990 131072 9413 5636 941 

SVR-03 15990 131072 9413 5636 941 

Table 13-6 – L3 capsule partition sizes  

 
Note! A granule is a logical unit of file storage on an L3 FRM/SFRM Capsule.The total 
number of granules added to the ‘Granules’ fields cannot exceed the ‘Partitioning 
Granules in Crash Module’ (listed at the top of the form).  

 

13.2.2.3 Mounting L3 HVR/SVR Fixed FRM/SFRM Capsules 
 

The L3 HVR/SVR Fixed FRM/SFRM Capsules are mounted near the bridge on the external deck 
area of the vessel to increase the probability of its survival and recovery following an incident. As 
outlined in IEC 61996, the capsule shall be positioned clear of rigging and other potential 
obstructions and as near to the centerline of the ship as practically possible.  
 

 
NOTE: Refer to diagrams in the appendix for specific L3 HVR/SVR capsule details. 

 
 
Criteria to be considered when assessing the optimum position shall include but not be limited to 
the following: 

1. Separation from probable sources of mechanical damage.  
2. Separation from fuel or other potential fire sources. 
3. Operational environment for continued serviceability. 
4. Accessibility for copying of recorded data and for routine maintenance. 
5. Facilitation of underwater removal and retrieval by both divers and ROVs. There shall be 

a clear unobstructed space near the capsule to allow an ROV or diver to work. 
 
The L3 HVR/SVR Fixed FRM/SFRM Capsule is supplied with an interconnect cable. This cable 
must connect to the VDR-100G2/S through a junction box (not provided with VDR-100G2/S).  
 
The junction box must be shielded and connected to the hull of the vessel. The junction box is 
normally mounted on the exterior deck and located near the FRM/SFRM and positioned within 
range of the interconnect cable. All hull penetrations for cables must be fitted with waterproof 
glands (not provided with VDR-100G2/S). 
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13.2.2.4 Connecting the L3 HVR/SVR Fixed FRM/SFRM Capsule Fixed SFRM 
 
The wiring of the connections between the VDR-100G2 and the L3 HVR/SVR Fixed FRM/SFRM 
Capsule is via the RJ45 connector (illustrated in Figure 13-7 - RJ45 Connector). 
 
The junction box adjacent to the FRM/SFRM on the vessel’s outside deck is not supplied with the 
VDR-100G2/S.  It connects the cables provided with the FRM to the cables connecting to the 
VDR-100G2/S.   
 
This junction box can be located inside, but must be located within the cable distance of the 
SFRM cables. It must also be fully screened and connected to the vessel’s hull. If mounted 
outside, it must also be waterproof. 

 
Figure 13-7 - RJ45 Connector 

 
Rutter uses the 568B standard for all straight-thru Ethernet cables.  
Rutter uses the crossover standard noted below for all cross-over Ethernet cables. 
 

Straight through 568B 
Connector 1 Connector 2 

1 Tx+ white/orange 1 Tx+ white/orange 
2 Tx- orange 2 Tx- orange 
3 Rx+ white/green 3 Rx+ white/green 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- green 
7 N/A 7 N/A 
8 N/A 8 N/A 
Table 13-7 Straight-through Ethernet cable set ups 

Crossover 
Connector 1 Connector 2 

1 Tx+ white/orange 1 Tx+ white/green 
2 Tx- orange 2 Tx- green 
3 Rx+ white/green 3 Rx+ white/orange 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- orange 
7 N/A 7 N/A 
8 N/A 8 N/A 
Table 13-8 – Cross-over Ethernet cable set ups 

 
 
 

Note! It is highly recommended that cabling connecting the FRM/SFRM to the VDR-
100G2/S is installed through a gooseneck conduit (see Figure 5-19 - Sample VDR-
100G2S SFRM Installation for a sample FRM installation.) 
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13.2.2.5 VDR-100G2 with L3 HVR-01 Fixed FRM Capsule Setup 
The partition sizes provided in this section are applicable only to the L3 HVR-01 Fixed FRM 
Capsule.  (For more information on the L3 HVR-02 Fixed FRM Capsule partition sizes, refer to 
Section  13.2.2.2: L3 HVR/SVR Fixed FRM/SFRM Capsule Partitions Overview.): 
 

1. Open Internet Explorer from the VDR desktop; 
2. In the address bar enter <http://192.168.0.2/hvrhome.htm>; and 
3. The HVR HTML Interface will appear; 
 

Note! If the Web page does not appear, ensure the address is not redirected to a 
proxy server. Under ‘Tools’ menu, select ‘Internet Options’, Select Connection’s 
tab and select ‘LAN Settings’. Ensure that “Use a proxy server” is not checked. 
 

4. Select Flash Setup; 
5. Enter L3HVR as the password; 
6. In the Update Devices form, the fields must be edited according to part number: 

a. Position 0, insert 65925 into the granules field and AUDIO for Stream Name field, 
b. Position 1, insert 6591 into the granules field and NMEA for Stream Name field, 
c. Position 2, insert 39474 into the granules field and VIDEO for Stream Name field, 
d. Position 3, insert 0 into the granules field and leave Stream Name blank, 
e. Position 4, insert 0 into the granules field and leave Stream Name blank,and 
f. Position 5, insert 0 into the granules field and leave Stream Name blank, 

7. Select ‘Submit Changes’; and 
8. Close Internet Explorer. 

13.2.2.6 VDR-100G2S with L3 SVR-01 Fixed SFRM Capsule Setup  
The set-up of the L3 SVR-01 Fixed SFRM Capsule can be completed using the procedure and 
information in Section 13.2.2.5: VDR-100G2 with L3 HVR-01 Fixed FRM Capsule Setup 
 

Note! A granule is a logical unit of file storage on an L3 FRM/SFRM Capsule.The total 
number of granules added to the ‘Granules’ fields cannot exceed the ‘Partitioning 
Granules in Crash Module’ (listed at the top of the form).  

 

13.2.2.7 Mounting L3 HVR/SVR Fixed FRM/SFRM Capsules 
 

The L3 HVR/SVR Fixed FRM/SFRM Capsules are mounted near the bridge on the external deck 
area of the vessel to increase the probability of its survival and recovery following an incident. As 
outlined in IEC 61996, the capsule shall be positioned clear of rigging and other potential 
obstructions and as near to the centerline of the ship as practically possible.  
 

 
NOTE: Refer to diagrams in the appendix for specific L3 HVR/SVR capsule details. 

 
 
Criteria to be considered when assessing the optimum position shall include but not be limited to 
the following: 

6. Separation from probable sources of mechanical damage.  
7. Separation from fuel or other potential fire sources. 
8. Operational environment for continued serviceability. 
9. Accessibility for copying of recorded data and for routine maintenance. 
10. Facilitation of underwater removal and retrieval by both divers and ROVs. There shall be 

a clear unobstructed space near the capsule to allow an ROV or diver to work. 
 
The L3 HVR/SVR Fixed FRM/SFRM Capsule is supplied with an interconnect cable. This cable 
must connect to the VDR-100G2/S through a junction box (not provided with VDR-100G2/S).  
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The junction box must be shielded and connected to the hull of the vessel. The junction box is 
normally mounted on the exterior deck and located near the FRM/SFRM and positioned within 
range of the interconnect cable. All hull penetrations for cables must be fitted with waterproof 
glands (not provided with VDR-100G2/S). 
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13.2.2.8 Connecting the L3 HVR/SVR Fixed FRM/SFRM Capsule Fixed SFRM 
 
The wiring of the connections between the VDR-100G2 and the L3 HVR/SVR Fixed FRM/SFRM 
Capsule is via the RJ45 connector (illustrated in Figure 13-7 - RJ45 Connector). 
 
The junction box adjacent to the FRM/SFRM on the vessel’s outside deck is not supplied with the 
VDR-100G2/S.  It connects the cables provided with the FRM to the cables connecting to the 
VDR-100G2/S.   
 
This junction box can be located inside, but must be located within the cable distance of the 
SFRM cables. It must also be fully screened and connected to the vessel’s hull. If mounted 
outside, it must also be waterproof. 

 
Figure 13-7 - RJ45 Connector 

 
Rutter uses the 568B standard for all straight-thru Ethernet cables.  
Rutter uses the crossover standard noted below for all cross-over Ethernet cables. 
 

Straight through 568B 
Connector 1 Connector 2 

1 Tx+ white/orange 1 Tx+ white/orange 
2 Tx- orange 2 Tx- orange 
3 Rx+ white/green 3 Rx+ white/green 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- green 
7 N/A 7 N/A 
8 N/A 8 N/A 
Table 13-7 Straight-through Ethernet cable set ups 

Crossover 
Connector 1 Connector 2 

1 Tx+ white/orange 1 Tx+ white/green 
2 Tx- orange 2 Tx- green 
3 Rx+ white/green 3 Rx+ white/orange 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- orange 
7 N/A 7 N/A 
8 N/A 8 N/A 
Table 13-8 – Cross-over Ethernet cable set ups 

 
 
 

Note! It is highly recommended that cabling connecting the FRM/SFRM to the VDR-
100G2/S is installed through a gooseneck conduit (see Figure 5-19 - Sample VDR-
100G2S SFRM Installation for a sample FRM installation.) 
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13.2.2.9 VDR-100G2 with L3 HVR-02 Fixed FRM Capsule Setup 
The partition sizes provided in this section are applicable only to the L3 HVR-02 Fixed FRM 
Capsule.  For more information on the L3 HVR-01 Fixed FRM Capsule partition sizes, refer to 
Section 13.2.2.2: L3 HVR/SVR Fixed FRM/SFRM Capsule Partitions Overview . 
 

1. Open Internet Explorer from the VDR desktop; 
2. In the address bar type http://192.168.0.2/hvrhome.htm; 
3. Press the “Enter” key;  
4. The HVR HTML Interface will appear; 

 
Note! If the Web page does not appear, ensure the address is not redirected to a 
proxy server. Under ‘Tools’ menu, select ‘Internet Options’, Select Connection’s 
tab and select ‘LAN Settings’. Ensure that “Use a proxy server” is not checked. 
 

5. Select Flash Setup. 
6. Enter L3HVR as the password;  
7. In the Update Devices form, the fields must be edited according to part number: 

a. Position 0, insert 9413 into the granules field and AUDIO for Stream Name field, 
b. Position 1, insert 941 into the granules field and NMEA for Stream Name field, 
c. Position 2, insert 5636 into the granules field and VIDEO for Stream Name field, 
d. Position 3, insert 0 into the granules field and leave Stream Name blank, 
e. Position 4, insert 0 into the granules field and leave Stream Name blank, and 
f. Position 5, insert 0 into the granules field and leave Stream Name blank; 

8. Select ‘Submit Changes’; and 
9. Close Internet Explorer. 

13.2.2.10 VDR-100G2S with L3 SVR-02 Fixed SFRM Capsule Setup  
The set-up of the L3 SVR-02 Fixed SFRM Capsule can be completed using the procedure and 
information in Section 13.2.2.9:  VDR-100G2 with L3 HVR-02 Fixed FRM Capsule Setup. 

13.2.2.11 VDR-100G2S with L3 SVR-03 Fixed SFRM Capsule Setup  
The set-up of the L3 SVR-03 Fixed SFRM Capsule can be completed using the procedure and 
information in Section 13.2.2.9:  VDR-100G2 with L3 HVR-02 Fixed FRM Capsule Setup. 

13.2.2.12 Test the L3 HVR/SVR Fixed FRM/SFRM Capsule Physical Connection 
Confirm the cable connections between the L3 HVR/SVR Fixed FRM/SFRM Capsule and the 
VDR. 

1. Open the Command Prompt from: Start menu>All Programs>Accessories>Command 
Prompt on the VDR; 

2. The Command Prompt window will open; 
3. At the C:\> prompt, type ping 192.168.0.2; 
4. Hit the Enter button on the keyboard; 
5. Observe that 4 replies are received from the FRM/SFRM Capsule; 
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Figure 13-8 - Pinging the L3 HVR-01 or SVR-01 Fixed FRM/SFRM Capsule 

 
NOTE: If the request times out, check the HVR-02 Fixed FRM Capsule cable connections. 
 
6. . Close the Command Prompt window when communication is verified. 

13.2.2.13 Setting the FRM Port’s IP Address—L3 HVR/SVR Fixed FRM/SFRM 
Capsules 

The default IP address of the L3 HVR/SVR Fixed FRM/SFRM Capsules is 192.168.0.2.  The 
VDR’s factory configuration for the FRM Ethernet port IP address is 192.168.0.189. If this 
address is not correctly set, communication between the VDR and the L3 HVR/SVR Fixed 
FRM/SFRM Capsule will not be possible. The FRM port must be in the same range as the L3 
HVR/SVR Fixed FRM/SFRM Capsule, with the last segment different than the VDR (as shown 
below.). To change the IP segment of the VDR’s FRM Ethernet port: 

1. Click the Start menu; 
2. Open the Control Panel;  
3. Double-click the Network Connections icon; 
4. Right-click on the SFRM icon; 
5. Select Properties from the pop-up menu. 
6. In the Local Area Connection Properties window, highlight “Internet Protocol (TCP/IP)”; 
7. Click the “Properties” button directly under the available options; 
8. The “Internet Protocol (TCP/IP) Properties” window will open;  
9. Select the “Use the following IP address” radio button;  
10. Enter 192.168.0.189 (the last number can be any number from 3 to 254.); 
11. Click the “OK” button in the Internet Protocol (TCP/IP) Properties; 
12. Click the “OK” button in the Local Area Connection Properties; and  
13. The connection should now be established. 

 

13.2.2.14 Configuring L3 HVR/SVR Fixed FRM/SFRM Capsules 
 
To begin setting up an L3 HVR/SVR Fixed FRM/SFRM Capsule support:  

1. Log on as administrator; 
2. Locate the <vdrparams.ini> file on the desktop; 
3. Open the file;   
4. Locate the [STORAGE] section of the open file; and   
5. Set the entries as shown below: 

 
[STORAGE] 
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hardenedStorage = 1  // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 1  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free 5=Rutter Fixed 
secondaryHardenedFormat = 4  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5= Rutter Fixed 
L3HVR-compressNMEA = 1  // 0 = disable, 1=enable;  default is 1  
 

NOTE: It is necessary to compress NMEA data when recording to L3 HVR-01 and SVR-
01 Fixed FRM/SFRM capsules. Disable compression in the INI file by changing the value 
of ‘0’. (Setting is in the [STORAGE] section of the <vdrparams.ini> file). 
 

13.2.2.15 Start Recording to the L3 HVR/SVR Fixed FRM/SFRM Capsule 
 

1. Start the VDR_Record application from the desktop; 
2. Observe the following messages are presented in the Log Window: 

a. The L3 HVR/SVR Fixed FRM/SFRM Capsule is ready, 
b. Successfully saved <vdrparams.ini> to the L3 capsule, 
c. Successfully saved vdr-cfg.txt to the L3 capsule; 

3. Minimize the VDR_Record application; 
4. Open the error log; 
5. Observe the following messages are written in the error log: 

a. Stream audio (type AUDIO) connected, 
b. Stream nmea (type NMEA) connected, 
c. Stream video (type VIDEO) connected, 
d. The L3 HVR is ready.  
e. Successfully saved <vdrparams.ini> to the L3 capsule, and 
f. Successfully saved <vdr-cfg.txt> to the L3 capsule; 

4. Allow the VDR to record to the L3 HVR/SVR Fixed FRM/SFRM Capsule for 12 
continuous hours. 

13.2.2.16 Confirm the L3 HVR/SVR Fixed FRM/SFRM Capsule is Recording  
1. Allow the VDR  to record for 12 continuous hours;  
2. Stop recording after 12 hours by deselecting Record under the test menu of the 

VDR_Record application; 
3. Minimize the VDR_Record application; 
4.  Open the FRM download application via the Start menu (Start > Programs > Utilities); 
5. Choose the data stream(s) to download Audio, Video, and NMEA data or individual 

streams.  
For example, to download only the Audio stream, deselect the “Download NMEA” 
and “Download Video” stream options leaving onlyand leave the “Download 
Audio” stream option checked. If all 3 options are checked, all 3 streams will be 
downloaded. 

 

 
Figure 13-9 - Download Stream Options 

 
6. Select “Begin download” under the Download menu;  
7. Enter uppercase VDR for the password;   
8. Select a location to save the downloaded files; 
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Note! The download from the L3 FRM/SFRM may take up to 4 hours to 
complete and the data will be downloaded to the DMM’s internal hard 
drive. 

 
9. From the Technician PC, open the playback application; 
10. Select the FRM_Download data set to playback. 
11. Observe the beginning and end time (system contents) of the data set to 

ensure that 12 hours of data have been recorded to the FRM/SFRM. 
12. Select the beginning of the data set to start playback;  
13. Observe that video, audio and NMEA have been recorded; 
14. Observe that the start time of each stream is in fact 12 hours previous to the 

end time.  
15. Stop playback; 
16. Select the middle of the data set to playback;  
17.  Observe that video, audio, and NMEA have all been recorded. 
18. Select the end of the data set to start playback; 
19. Observe that video, audio and NMEA have all been recorded for 12 hours. 
20. Stop playback; and 
21.  Exit the application. 
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13.3 Float-free SFRM Capsules 
The Float-free SFRM capsule is a buoyant capsule that serves as an FRM and Cospas-Sarsat 
EPIRB. If the buoyant capsule and its bracket are submerged, it automatically floats free and 
activates the EPIRB (Emergency Positioning Indicating Radio Beacon). When activated, the 
EPIRB gives an immediate alarm, transmitting the ship ID and position in a primary alarm for the 
search and rescue authorities.  
 
Only activate the EPIRB in an emergency situation.  For periodic testing, a test function is 
implemented. No emergency signal is transmitted during the self-test. During the test cycle the 
EPIRB does a self-test of the transmitters and the battery status. The battery of the EPIRB will 
last for at least 168 hours after it is activated. 

13.3.1 Rutter-ACR Float-free SFRM Capsule Setup 
The Rutter-ACR Float-free SFRM Capsule contains non-volatile memory (Flash), intended to 
store ship parameters in real time. The storage memory will continually store the last 12 hours 
(minimum) of received data. 
 
The interface between the VDR-100G2 and the memory capsule is a standard 10/100 Base-T 
Ethernet connection using TCP/IP standard protocol. Data is transferred from the DMM to the 
FRM via a 10/100Base-T Ethernet LAN connection via TCP/IP protocol.   
 
Power for the capsule is provided over the same Ethernet cable using PoE (Power Over 
Ethernet). A separate power cable is not required. 
 

13.3.1.1 Planning for the Rutter-ACR Float-free SFRM Capsule  
The Rutter-ACR Float-free SFRM Capsule uses PoE technology, eliminating the requirement for 
a separate junction box. 
 
The Rutter-ACR Float-free SFRM Capsule is connected to the VDR-100G2 via an Ethernet 
interface cable, through a PoE Ethernet connect box (PS-100). The PS-100 is mounted inside the 
DPU, and is connected to the VDR via a DC power cable and an Ethernet interface cable. 
Ethernet cables are 10-base-T/STP (shielded twisted pair), Category 5e with flammability per IEC 
95: 

 The DC power cable connects from the DPU terminal block 24VDC supply to the PS-100. 
 The Ethernet connection is via an RJ45 connector. This is connected from Ethernet port 

3 on the DMM to the PS-100 Ethernet connect box. 
 The connection between the DMM and the PS -100 is straight through. 
 The cable from the PS-100 to the capsule is crossover. 
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Figure 13-10 - Rutter-ACR Float-free SFRM Capsule Cable Connections 

13.3.1.2 Mounting the Rutter-ACR Float-free SFRM Capsule  
The Rutter-ACR Float-free SFRM Capsule shall be located near the bridge on the external deck 
area of the vessel to increase the probability of its survival and recovery following an incident. As 
outlined in IEC 61996, the capsule shall be positioned clear of rigging and other potential 
obstructions and as near to the centre line of the ship as is practically possible.  
 

Criteria to be considered when assessing the optimum position shall include but not be limited to 
the following: 

1. Separation from probable sources of mechanical damage;  
2. Separation from fuel or other potential fire sources; 
3. Operational environment for continued serviceability; 
4. Accessibility for copying of recorded data and for routine maintenance; 
5. Distance from the VDR-100G2 DPU: The maximum distance allowed for PoE is 75 

metres 
 

The Rutter-ACR Float-free SFRM Capsule is supplied with an interconnect cable. All cables 
extending through a ship hull must be fitted with waterproof glands (not provided with VDR-
100G2/S) and must be protected by gooseneck conduit if extending through a deck. 
 
The Rutter-ACR Float-free SFRM Capsule comes with a power/data interface box (PS-100) to 
provide power to the capsule and data to and from the VDR. The PS-100 must be mounted 
vertically inside the DPU with the power source connection at the bottom and the Ethernet RJ45’s 
connections at the top. 
 

13.3.1.3 Connecting the Rutter-ACR Float-free SFRM Capsule 
The wiring of the connections between the VDR-100G2 and the Rutter-ACR Float-free SFRM 
Capsule is via the RJ45 connector (See Figure 13-11 - RJ45 Connector ). 

 
 
 
 
Interconnect 
cable from 
Rutter-ACR 
Float-Free 
Bracket 
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Figure 13-11 - RJ45 Connector 

 

Rutter uses the 568B standard for all straight-thru Ethernet cables.  
Rutter uses the crossover standard noted below for all cross-over Ethernet cables. 
 

Straight through 568B 
Connector 1 Connector 2 

1 Tx+ white/orange 1 Tx+ white/orange 
2 Tx- orange 2 Tx- orange 
3 Rx+ white/green 3 Rx+ white/green 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- green 
7 N/A 7 N/A 
8 N/A 8 N/A 
Table 13-9 Straight-through Ethernet cable set ups 

Crossover 
Connector 1 Connector 2 

1 Tx+ white/orange 1 Tx+ white/green 
2 Tx- orange 2 Tx- green 
3 Rx+ white/green 3 Rx+ white/orange 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- orange 
7 N/A 7 N/A 
8 N/A 8 N/A 
Table 13-10 – Cross-over Ethernet cable set ups 

 
 

Note! It is highly recommended that cabling connecting the Rutter-ACR Float-free 
SFRM Capsule to the VDR-100G2 is installed through a gooseneck conduit (see 
Figure 5-19 - Sample VDR-100G2S SFRM Installation for a sample FRM 
installation.) 
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Figure 13-12 – Rutter-ACR Float-free SFRM Capsule Data and Power 

 

13.3.1.4 Rutter-ACR Float-free SFRM Capsule Power 
PoE technology brings power, as well as data transfer, to the capsule via a standard twisted-pair 
Ethernet cable. The industry standard is 48 VDC as the Injected PoE voltage. Power out from the 
PoE Power Injector (PS-100) is a balanced output. 

• Pins 4 & 5 are positive 
• Pins 7 & 8 are negative  

 

13.3.1.5 Test Rutter-ACR Float-free SFRM Capsule Physical Connection 
1. Confirm the cable connections between the SFRM and the VDR; 
2. Open the command prompt from Start/All Programs/Accessories/Command Prompt on 

the VDR; 
3. At the C:\> prompt, Enter ping 192.168.0.100; 
4. Observe that 4 replies are received from the Rutter-ACR Float-free SFRM Capsule;  
 

 
Figure 13-13 - Pinging the Rutter-ACR Float-free SFRM Capsule 

 
NOTE: If the request times out, check Rutter-ACR Float-free SFRM Capsule cable connections. 
 

5. Once communications has been verified, close the command prompt window. 
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13.3.1.6 Set IP Address for Rutter-ACR Float-free SFRM Capsule  Port 
 
The default IP address of the Rutter-ACR Float-free SFRM Capsule is 192.168.0.100.  The 
VDR’s factory configuration for the FRM Ethernet port IP address is 192.168.0.189. If this 
address is not set correctly, the VDR and the FRM will not communicate. The FRM port must be 
in the same range as the Rutter capsule, with the last segment different than the VDR (as shown 
below.). To change the IP segment of the VDR’s FRM Ethernet port: 

1. Click the Start menu; 
2. Open the Control Panel;  
3. Double-click the Network Connections icon; 
4. Right-click on the SFRM icon; 
5. Select Properties from the pop-up menu. 
6. In the Local Area Connection Properties window, highlight “Internet Protocol (TCP/IP)”; 
7. Click the “Properties” button directly under the available options; 
8. The “Internet Protocol (TCP/IP) Properties” window will open;  
9. Select the “Use the following IP address” radio button;  
10. Enter 192.168.2.189 (last number can be any number from 2 to 254, except 100.); 
11. Click the “OK” button in the Internet Protocol (TCP/IP) Properties; 
12.  Click the “OK” button in the Local Area Connection Properties.  
13. The connection should now be established. 

 

 
Figure 13-14 - Establishing TCP/IP Address 

13.3.1.7 Configuring the Rutter-ACR Float-free SFRM Capsule 
The Rutter ACR Float-free capsule arrives from the factory configured for the ship on which it is 
being installed. The software uses the IP address to automatically locate and stream data to the 
capsule. 

 4 GB (8 GB capacity optional); and 
 No partitions 

 
To set up the Rutter-ACR Float-free SFRM Capsule:  

1. Log on as administrator; 
2. Open <vdrparams.ini> from desktop;  
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3. Locate the [STORAGE] section of the file; and 
4. Ensure entries are as shown below: 

 
[STORAGE] 
 
hardenedStorage = 1  // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 4  // 1=L3 HVR, 2= PMC, 3 = Jotron, 4 = ACR 
secondaryHardenedFormat = 4  // 1=L3 HVR, 2= PMC, 3 = Jotron, 4 = ACR 
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13.3.1.8 Start Recording to the Rutter-ACR Float-free SFRM Capsule 
 

1. Start the VDR_Record application from the desktop; 
2. Observe the following messages are presented in the Log Window: 

a. Hardened Storage module ready, 
b. Configuration saved to the hardened storage. 

3. Minimize the VDR_Record application and open the error log; 
4.  
5. Observe the following messages are written in the error log: 

 Stream audio (type AUDIO) connected, 
 Stream nmea (type NMEA) connected, 
 Stream video (type VIDEO) connected, 
 Hardened Storage module ready, and 
 Configuration saved to the hardened storage; 

6. Allow the VDR to record for 12 continuous hours. 
 

13.3.1.9 Confirm the Rutter-ACR Float-free SFRM Capsule Recording 
 
Once the VDR has recorded for 12 continuous hours the installer can check to confirm that the 
Rutter-ACR Float-free SFRM Capsule is capturing selected data streams: 

1. Deselect Record under the test menu of the VDR_Record application. If downloading 
data on DMM computers, go to Step 3. 

2. Disconnect the Rutter-ACR Float-free SFRM Capsule from the VDR  
3. Connect the Rutter-ACR Float-free SFRM Capsule to a free Ethernet port on the 

Technician PC.  
4. Confirm the Ethernet port on the Technician PC has an IP address on the same 

subnet (192.168.0.x) as the Rutter-ACR Float-free SFRM Capsule’s IP address.  
5. If it is necessary to change the Technician PC Ethernet port address follow these 

steps: 
a. Open the Control Panel via the Start menu, 
b. Double-click the Network Connections icon, 
c. Right-click on the Ethernet port icon,   
d. Select Properties from the pop-up menu, 
e. In the Local Area Connection Properties window, highlight “Internet Protocol 

(TCP/IP)” , 
f. Click the “Properties” button located directly below the available options, 
g. The  Internet Protocol (TCP/IP) Properties window will open,  
h. Select the “Use the following IP address” radio button, 
i. Enter 192.168.0.10 (Last number may be number from 2 to 254, except 100.), 
j. Click the “OK” button in the Internet Protocol (TCP/IP) Properties,  
k. Click the “OK” button in the Local Area Connection Properties, 
l. The connection should now be established; 

6. Launch the FRM Download application;  
7. Use the FRM Download application to download the recorded data from the Rutter-

ACR Float-free SFRM Capsule.  
8. The application will indicate when the  download is completed;  
9. Exit the FRM Download application; 
10. Open the Playback application on the Technician PC;  
11. Select the downloaded FRM data set to playback; 
12. Observe the beginning and end time (system contents) of the data set to ensure that 

12 hours of data have been recorded to the FRM. 
13. Select the beginning of the data set to start playback;  
14. Observe that video, audio and NMEA have been recorded and that the start time of 

each stream is 12 hours previous to the end time;  
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15. Stop playback; 
16. Select the middle of the data set to playback;  
17. Observe that video, audio, and NMEA have all been recorded. 
18. Select the end of the data set to start playback; 
19. Observe that video, audio and NMEA have all been recorded for 12 hours; 
20. Stop playback; and  
21. Exit the application. 
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13.3.2 JoTron Float-free SFRM Capsule Set-Up 
The JoTron Float-free Capsule is a combined SFRM and EPIRB approved for use with the VDR-
100G2S. 
 
The capsule contains a memory module with a standard 1.75GB storage capacity and 10Mb 
Ethernet with TCP/IP interface.  Data is transferred from the DMM to the FRM via a 10/100Base-
T Ethernet LAN connection via TCP/IP protocol. The capsule will store 12 hours of captured data.  
In a situation where a ship may be sinking, the capsule will float free while transmitting both its 
position and MMSI for at least 7 days. 

13.3.2.1 Planning for the JoTron Float-free SFRM Capsule 
 
The SFRM is supplied with an interconnect cable. This cable must connect to the VDR-100G2/S 
through a junction box (supplied with the JoTron capsule).  The junction box is normally 
mounted on the exterior deck and located near the SFRM and positioned within range of the 
interconnect cable.  
 
This junction box can be located inside, but must be located within the cable distance of the 
SFRM cables. It must also be connected to the vessel’s hull.  
 

Note! It is highly recommended that cabling connecting the SFRM to the VDR-
100G2/S is installed through a gooseneck conduit (see Figure 5-19 - Sample VDR-
100G2S SFRM Installation for a sample SFRM installation.) 
 
 

The JoTron Float-free, final recording medium capsule is connected to the VDR-100G2/S via a 
DC power cable and an Ethernet interface cable. The Ethernet cable is a 10-base-T/STP 
(shielded twisted pair), Category 5e with flammability per IEC 95: 

 The DC power cable connects to the terminal block in the DPU terminal block 24 VDC 
supply. 

 The Ethernet connection is via a RJ45 connector. This is connected to Ethernet port 3 on 
the DMM. 

 The connection between the DMM and the SFRM is a crossover cable. 
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Figure 13-15 - JoTron Float-free SFRM Capsule Junction Box Connections 

 
 

 
Table 13-11 -  JoTron Float-free SFRM Capsule Data and Power Connection 

 
Refer to the FRM manufacturer’s installation manual to confirm all FRM installation information. 

 
 
 
 
Interconnect Cable 
from JoTron Float-free 
Bracket 

RJ45 is connected to 
the FRM Port on the 
 VDR-100G2 DMM 

 
To 24V DC Supply 
 (VDR – 100G2 DPU) 
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13.3.2.2 Mounting the JoTron Float-free SFRM Capsule 
 
The JoTron Float-free SFRM protective capsule must be located on the external deck near the 
bridge to increase the probability of its survival and recovery following an incident.    

 
Figure 13-16 - JoTron Float-free SFRM Capsule 

 
Note! The mounting pattern provided in Figure 13-16 - JoTron Float-free SFRM 
Capsule above, is applicable to the VDR-100G2S Simplified FRM only. 

 
 
Criteria to be considered when assessing the optimum position shall include but not be limited to 
the following: 
 

1. Separation from fuel or other potential fire sources; 
2. Separation from probable sources of mechanical damage; 
3. Operational environment for continued serviceability; and 
4. Accessibility for copying of recorded data and for routine maintenance. 

 
The SFRM is supplied with an interconnect cable. This cable must connect to the VDR-100G2/S 
through a junction box that is supplied with the JoTron float free capsule.  
 
The junction box must be connected to the hull of the vessel. The junction box is normally 
mounted on the exterior deck and located near the SFRM and positioned within range of the 
interconnect cable. All hull penetrations for cables must be fitted with waterproof glands (not 
provided with VDR-100G2/S) and should be protected by a gooseneck conduit. 
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13.3.2.3 Connecting the JoTron Float-free SFRM Capsule 
The wiring of the data connection between the VDR-100G2 and the FRM is via the RJ45 
connector (illustrated in Figure 13-17 - RJ45 Connector ). 
 
The junction box adjacent to the JoTron Float-free SFRM connects the cables provided with the 
SFRM to the cables connecting to the VDR-100G2/S.   

 
Figure 13-17 - RJ45 Connector 

Rutter uses the 568B standard for all straight-thru Ethernet cables.  
Rutter uses the crossover standard noted below for all cross-over Ethernet cables. 
 

Straight through 568B 
Connector 1 Connector 2 

1 Tx+ white/orange 1 Tx+ white/orange 
2 Tx- orange 2 Tx- orange 
3 Rx+ white/green 3 Rx+ white/green 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- green 
7 N/A 7 N/A 
8 N/A 8 N/A 
Table 13-12 Straight-through Ethernet cable set ups 

Crossover 
Connector 1 Connector 2 

1 Tx+ white/orange 1 Tx+ white/green 
2 Tx- orange 2 Tx- green 
3 Rx+ white/green 3 Rx+ white/orange 
4 N/A 4 N/A 
5 N/A 5 N/A 
6 Rx- green 6 Rx- orange 
7 N/A 7 N/A 
8 N/A 8 N/A 
Table 13-13 – Cross-over Ethernet cable set ups 

 
Note! It is highly recommended that cabling connecting the JoTron Float-free SFRM 
Capsule to the VDR-100G2 is installed through a gooseneck conduit (see Chapter 5: 
Figure 5-19 - Sample VDR-100G2S SFRM Installation for a sample FRM installation.) 

 

13.3.2.4 Test the JoTron Float–free SFRM  Capsule Physical Connection 
To confirm the cable connections between the FRM and the VDR: 
1. Open the command prompt from Start/All Programs/Accessories/Command Prompt on 

the VDR; 
2. At the C:\> prompt, type ping 192.168.0.37 and hit Enter on the keyboard; 
3. Observe 4 replies are received from the.JoTron Float–free SFRM  capsule; 
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4. If the request times out, check the.JoTron Float –free SFRM  capsule  cable connections 
(see Figure 13-18 - Pinging the JoTron Float-free SFRM Capsule) 

 

 
Figure 13-18 - Pinging the JoTron Float-free SFRM Capsule 

 
5. Once communications has been verified, close the command prompt window. 
 

13.3.2.5 Setting the FRM Port’s IP Address - JoTron Float-free SFRM Capsule 
The default IP address of the JoTron Float-free SFRM Capsule is 192.168.0.37.  The VDR’s 
factory configuration for the FRM Ethernet port IP address is 192.168.0.189. If this address is not 
correctly set, communication between the VDR and the JoTron Float-free SFRM Capsule will not 
be possible. The FRM port must be in the same IP range as the JoTron Float-free SFRM 
Capsule, with the last segment different than the VDR (as shown below.). To change the IP 
segment of the VDR’s FRM Ethernet port: 

1. Open the Control Panel via the Start menu; 
2. Double-click the Network Connections icon; 
3. Right-click on the FRM icon and select Properties from the pop-up menu; 
4. In the Local Area Connection Properties window, highlight “Internet Protocol; 

(TCP/IP)” and click the “Properties” button located directly below the available 
options; 

5. In the subsequent Internet Protocol (TCP/IP) Properties window, select the “Use 
the following IP address” radio button  

6. Enter 192.168.0.189 (the last number can be any number from 2 to 254, except 
37.) 

7. Click the “OK” button in the Internet Protocol (TCP/IP) Properties;  
8. Click the “OK” button in the Local Area Connection Properties; and  
9. The connection should now be established. 
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13.3.2.6 Configuring the JoTron Float-free Capsule 
To set up the JoTron Float-free SFRM: 

1. Log on as administrator; 
2. Open <vdrparams.ini> from the desktop; 
3. Locate the [STORAGE] section of the file;  and 
4. Ensure entries are as shown below: 

 
[STORAGE] 
hardenedStorage = 1  // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 3  // 1=L3 HVR, 2= PMC, 3 = Jotron, 4 = ACR 
secondaryHardenedFormat = 4  // 1=L3 HVR, 2= PMC, 3 = Jotron, 4 = ACR 
 
NetworkHVR-compressNMEA = 1 
 

NOTE: If no video data is being captured then it is  not necessary to compress 
NMEA data. NMEA data must be compressed ONLY if video data is being 
captured.  To enable compression, the above entry in the INI file must be 
changed to a setting of 1. (This setting is found in the [STORAGE] section of the 
<vdrparams.ini> file) 

 
The JoTron Float–Free capsule does not require the set-up of partitions.  For complete physical 
installation information, please refer to the JoTron SVDR Technical Manual. 
 

13.3.2.7 Start Recording to the JoTron Float–free SFRM  Capsule 
 

1. Start the VDR_Record application from the desktop; 
2. Observe the following messages are presented in the Log Window: 

a. The JoTron Float–free SFRM  Capsule is ready; 
b. Configuration saved to the hardened storage 

3. Minimize the VDR_Record application and open the error log. 
4. Observe the following messages are written in the error log: 

a. Stream audio (type AUDIO) connected 
b. Stream nmea (type NMEA) connected 
c. Stream video (type VIDEO) connected 
d. Hardened Storage module ready 
e. Configuration saved to the hardened storage 

4. Allow the VDR to record for 12 continuous hours. 
 

13.3.2.8 Confirm JoTron Float-free Recording 
To confirm that the JoTron Float-free SFRM Capsule has successfully saved 12 continuous hours 
of data, the data must be downloaded and reviewed using the Plaback application. To download 
data recorded with record application version 4.07 and later see Section 13.3.2.8.1.  To download 
data recorded with record application version 4.06 and earlier, see Section 13.3.2.8.2.  
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13.3.2.8.1. For Data Recorded with Record App. Ver. 4.07.00 and later 
1. Once the VDR has recorded for 12 continuous hours, deselect Record under the test 

menu of the VDR_Record application to stop recording; 
2. If downloading via the DMM computer go to Step 3 
3. Disconnect the JoTron Float-free SFRM Capsule from the VDR and connect it to a free 

Ethernet port on the Technician PC. The Ethernet port on the Technician PC must be 
configured to have an IP address on the same subnet (192.168.0.x) as the JoTron Float-
free SFRM Capsule IP address. To change the Technician PC Ethernet port address 
follow these steps: 

a. Open the Control Panel via the Start menu. 
b. Double-click the Network Connections icon. 
c. Right-click on the Ethernet port icon; 
d. Select Properties from the pop-up menu. 
e. In the Local Area Connection Properties window, highlight “Internet Protocol 

(TCP/IP)”: 
f. Click the “Properties” button located directly below the available options; 
g. The Internet Protocol (TCP/IP) Properties window will open;  
h. Select the “Use the following IP address” radio button;  
i. Enter 192.168.0.10 (for last number enter any number from 2 to 254, except 37.) 
j. Click the “OK” button in the Internet Protocol (TCP/IP) Properties,  
k. Click the “OK” button in the Local Area Connection Properties, 
l. The connection should now be established; 
 

1. Launch the FRM Download application;  
2. Use the FRM Download application to download the recorded data from the Rutter-ACR 

Float-free SFRM Capsule.  
3. The application will indicate when the  download is completed;  
4. Exit the FRM Download application; 
5. Open the Playback application on the Technician PC;  
6. Select the downloaded FRM data set to playback; 
7. Observe the beginning and end time (system contents) of the data set to ensure that 12 

hours of data have been recorded to the FRM. 
8. Select the beginning of the data set to start playback;  
9. Observe that video, audio and NMEA have been recorded and that the start time of each 

stream is 12 hours previous to the end time;  
10. Stop playback; 
11. Select the middle of the data set to playback;  
12. Observe that video, audio, and NMEA have all been recorded. 
13. Select the end of the data set to start playback; 
14. Observe that video, audio and NMEA have all been recorded for 12 hours; 
15. Stop playback; and  
16. Exit the application. 
 

13.3.2.8.2. For Data Recorded with Record App. Ver. 4.06.00 and earlier 
When the VDR connects to the Jotron SFRM, the FRM storage is normally automatically mapped 
as the “X:\” drive on the VDR.  In some cases, this mapping does not appear in Windows 
Explorer.  Both cases are outlined below: 
 

1. If the “X:\” drive appears in Windows Explorer, copy the contents of the drive to the 
technician’s PC;  

2. If the “X:\” drive does not appear on the VDR, the data must then be mapped to the VDR. 
 

To map the Jotron capsule as a new drive, choose ‘Map Network Drive’ from the Tools 
menu of Windows Explorer. The drive will have to be mapped as follows: 
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\\192.168.0.37\VDR 
username: ‘vdr’ 
password: ‘jotvdr’ 
 
Once the mapped drive has been established, copy the contents of the drive to the E:\ 
drive of the VDR or directly to the technician’s PC.  
 

 NOTE: If X is not available choose a new network drive letter—See the example below which 
uses W:\.  

 

 
Figure 13-19 - Map Network Drive (JoTron) 

 
 

3. Once the contents have been copied, check the <vdrparams.ini> file to ensure the 
downloaded NMEA data is not compressed.  As outlined in Error! Reference source not 
found.2 Error! Reference source not found.:  

 <NetworkHVR-compressNMEA = 1> indicates that the NMEA data is being 
compressed,   

 <NetworkHVR-compressNMEA = 0> indicates that the NMEA data is not 
being compressed: 

4. To decompress NMEA data, run the <decompressNMEA.exe> file in the C:\VDRApps 
folder; 

5. The data will be decompressed in the directory where it is stored—it will not be copied to 
a different directory; 

6. From the Technician PC, open the Playback application and select the data set for play 
back; 

7. Observe the beginning and end time (system contents) of the data set to ensure that 12 
hours of data have been recorded to the FRM; 

8. Select the beginning of the data set to start playback;  
9. Check to ensure that video, audio and NMEA have been recorded; 
10. Check to ensure that the start time of each stream is 12 hours previous to the end time;  
11. Stop playback; 
12. Select the middle of the data set in play back;  
13. Check to ensure that video, audio, and NMEA have all been recorded; 
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14. Select the end of the data set to start play back; 
15. Check to ensure that that video, audio and NMEA have all been recorded for 12 hours; 
16. Stop playback; and 
17. Exit the application. 
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13.4 Dual Capsule FRM/SFRM  
 
The Rutter Technologies VDR100-G2 supports the use of 2 FRM devices at the same time.  This 
configuration currently supports the use of the L3 HVR-/02 Fixed FRM Capsule or Rutter FRM 
(RUT-02447) Capsule as a fixed device and the JoTron Float-free SFRM Capsule or the Rutter-
ACR Float-free SFRM Capsules as a Float-free device.  Additional capsules may be added in the 
future.  Support for 3 devices simultaneously is not supported. 
 

13.4.1 Planning for Dual Capsule Setup 
As of version 4.05.00 of the <VDR_Record.exe> application, the Rutter Technologies VDR100-
G2 will support the use of 2 FRM devices at the same time.  The FRM capsule should be installed 
according to the guidelines and specific FRM mounting instructions. 
 

13.4.2 Install Capsule on Download Hub 
When using a secondary capsule, a second hub must be provided in the DPU cabinet. The hub is 
mounted in the best accessible location that allows for passage of Ethernet cabling in the cabinet.   
 
The download hub allows for connection of the following items simultaneously: 
 

1. Rutter-ACR Float-free SFRM Capsule or JoTron Float-free SFRM Capsule 
2. VDR Data port 
3. Remote Storage Module 
4. Download PC 

 
Connect the secondary capsule to a free port on the download hub and confirm communication is 
available again using the ping command. 

13.4.3 Setting up the Primary FRM 
The Primary FRM in a dual capsule configuration is always set up on the FRM port.  There is no 
special setup for this capsule. Depending on the selected primary FRM, refer to the appropriate 
sections in this chapter to configure, connect and test the primary FRM. 
 

13.4.4 Set up Secondary Capsule 
As of version 4.07.00 of the VDR_Record application, only the JoTron Float-free SFRM Capsule 
or the Rutter-ACR Float-free SFRM Capsule may be used as a secondary capsule.  There are 
several steps to configuring the capsule to function as a secondary unit.  
 

13.4.5 Connecting and Testing the Secondary FRM 
Depending on the selected secondary capsule, refer to the appropriate sections in this chapter to 
configure, connect and test the secondary FRM: Section 13.3.2: Rutter-ACR Float-free SFRM 
Capsule Setup and Section 13.3.1: JoTron Float-Free SFRM Capsule Set-Up.
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13.4.6 Configuring the VDR For Dual FRM Operation 
To begin setting up the Dual FRM support, first locate the file <C:\Windows\vdrparams.ini> and 
open it using Notepad.  Once open, locate the [STORAGE] section of the file.   
 
To configure an L3 HVR-01/02 Fixed FRM Capsule as primary with a Rutter-ACR Float-free 
SFRM Capsule as secondary, use: 
 
[STORAGE] 
 
hardenedStorage = 2  // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 1  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5=Rutter Fixed 
secondaryHardenedFormat = 4  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5=Rutter Fixed 
  
To configure a Rutter FRM (RUT-02447) Capsule with a Rutter-ACR Float-free SFRM Capsule, 
use: 
 [STORAGE] 
 
hardenedStorage = 2  // 0=disable, 1=enable, 2 = Dual FRM,  default is 0 
hardenedFormat = 5  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5=Rutter Fixed 
secondaryHardenedFormat = 4  // 1=L3 HVR/SVR, 2=PMC, 3=Jotron, 4=Rutter-ACR Float-free, 5= Rutter Fixed 
 
Note:  

 A fixed capsule is ALWAYS connected as the primary FRM on the FRM port. 
 A second hub must be installed and connected to download port. 
 The Secondary FRM must be in 200.200.200.x IP segment and connected to download 

hub. 
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13.4.7 Changing the IP of the Rutter-ACR Float-free SFRM Capsule 
The secondary FRM, it is installed on the download hub. The download hub may still be in use for 
RSM operations and for download PC operations.   
 
The IP address on the Rutter-ACR Float-free SFRM Capsule must be changed to be in the same 
IP segment as the download port of the VDR.  To change the IP address of the Rutter-ACR Float-
free SFRM Capsule: 
 

1. Disconnect the primary capsule from the FRM port—this  will be replaced later. 
2. Confirm the IP of the FRM Ethernet port on the DMM to be in the same segment as the 

default IP address of the Rutter-ACR Float-free SFRM Capsule (i.e. 192.168.0.189). The 
last number can be any number from 2 to 254 except 100. 

3. Connect the Rutter-ACR Float-free SFRM Capsule to the FRM Ethernet port and confirm 
that communication is available via the ping command in a DOS prompt window 
(Start>All Programs>Accessories>Command Prompt) – ping 192.168.0.100; 

4. Press Enter on the keyboard;.  
5. Ensure communication is established;  
6. Open the Rutter Float-free IP Config Utility via the Start-Utilities menu or by double 

clicking the utility file  in the VDRApps folder.   
7. Set the new IP address to 200.200.200.100 for the Rutter-ACR Float-free SFRM 

Capsule.  
8. Once the IP is changed, communication is no longer be possible from the FRM port; 
9. Recycle the power on the Rutter-ACR Float-free SFRM Capsule   

 
 

 
Figure 13-20 - Rutter Float-free  IP Config Utility 

 
10. Move the Ethernet cable to the Download port;  
11. Confirm that communication with the capsule is available using the DOS command to 

ping 200.200.200.100. 
12. Return the fixed capsule’s Ethernet cable to the FRM port.  

13.4.8 Changing the IP of the JoTron Float-free SFRM Capsule 
The IP address on the JoTron Float-free SFRM Capsule must, therefore, be changed to be in the 
same IP segment as the download port of the VDR.  To change the IP address of the JoTron 
Float-free SFRM Capsule: 
 

1. Disconnect the primary capsule from the FRM port – this will be replaced later. 
2. Confirm the IP of the FRM Ethernet port on the DMM is in the same segment as the 

default IP address of the JoTron Float-free SFRM Capsule (i.e. 192.168.0.189) The last 
number can be any number from 2 to 254 except 37; 
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3. Connect the JoTron Float-free SFRM Capsule to the FRM Ethernet port and confirm that 
communication is available via the ping command in a DOS prompt window: (Start>All 
Programs>Accessories>Command Prompt) – ping 192.168.0.37; 

4. Press Enter on the keyboard;.  
5. From Windows Internet Explorer, type in the address http://192.168.0.37 and hit the 

Config button; 
6. To change the IP address of the JoTron Float-free SFRM Capsule enter the Admin 

password “jotadmin”; 
7. Click “Login” 
8. In the “Select IP address to use” field’ enter the new IP address 200.200.0.37; 
9. Click OK 
10. Click the “Save and Reboot” button to save these settings 

 

 
Figure 13-21 - JoTron Float-free SFRM Capsule Web Interface 

 
 
Alternatively, the installer can use Windows Explorer to change the JoTron Float-free SFRM 
Capsule’s IP address: 
1. Type in \\192.168.0.37 and hit enter. 
2. Right click on the “Admin” Box. 
3. Click “Connect to network station”. 
4. Select a free station letter. 
5. Click” Connecting using a different user name”. 
6. In user name field enter ‘admin’, and in the password field enter ‘jotadmin’. 
7. Press “Finished” key. 
8. Open and change the “config.txt” file in “Word PAD” to match your configuration. 
9. Store the changes. The JoTron Float-free SFRM Capsule will reboot with the new 

settings. 
10. From “My Computer” right click and remove new letters used by SAMBA. 
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13.5 Using the FRM Download Application 

13.5.1 Downloading Data Using the FRM Download Application 
The following steps outline the procedure to use the FRM Download Application to retrieve data 
from an FRM/SFRM: 
 

Note! This section is not applicable to downloading data from a JoTtron Float-free 
SFRM Capsule connected to VDR-100G2 systems running VDR Record 
Application 4.06.00 and earlier. To download Jotron data recorded using VDR 
Record Application 4.06.00 and earlier directly to the VDR-100G2, refer to Section 
13.3.2.8.2: For Data Recorded with Record App. Ver. 4.06.00 and earlier 
 

1. Logon as Administrator on the VDR-100G2 and use the FRM Download Application to 
download data directly from the FRM/SFRM; 

 
2. Start the FRM Download Application by clicking:  

Start>All Programs>Rutter>VDR>FRM Download 
(OR locate the FRM <Download.exe> file in the VDR-100G2 <C:\VDRApps\> folder, and 
double-click to start the application.) 

 

 
Figure 13-22 – VDR FRM Download Application 

 
 

3. Select Download Menu>Download Wizard>FRM/SFRM type;  
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Figure 13-23 – Download Wizard FRM Setup Page 

 
3. Select “Use default settings to connect to FRM” and click next. 
 

 
Figure 13-24 Download Wizard FRM Connection Settings Page 

 
4. Select the data types you wish to download (Ensure all are selected). 
 
5. Use the ‘Browse’ button to select a suitable location to extract the contents of the FRM/SFRM 

to. When downloading directly to the VDR-100G2, it is recommended that the data be 
downloaded to the ‘E:\’ drive. This directory is ‘shared’ and is accessible to a Playback PC via 
the download port on the VDR-100G2. Alternatively, data may be copied directly to an 
attached RSM or Download USB Drive. 

 
 

Note! In either case, there must be sufficient free memory space to accommodate 
the entire downloaded data set. For some FRM/SFRM, 4GB of free memory space. 
may be required. 

 
 



Chapter 13: Final Recording Medium Setup 
 

 
VDR-100G2/G2S Installation Manual  186  
RUT-TD-02-001, Rev 2.1 

 
Figure 13-25 - Download Wizard Data Management Page 

6. Enter the password to begin the download process. The default password is ‘VDR’ (case 
sensitive). 

 
 

Note! Depending on the FRM/SFRM design, the download process may take 
anywhere from 15 minute up to 4 hours. 

 
 

 
Figure 13-26 – Download in Progress 

7. When the download has completed successfully, a message will appear in the log window of 
the FRM Download application indicating the download has completed along with the elapsed 
download time and the average speed of the download. 
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Figure 13-27  – Download Complete. 

 
8. When the download is complete, disconnect from the FRM/SFRM by selecting”File Menu” 

and then clicking  “Exit” ; 
 

9. The downloaded data may now be moved to a Playback PC running the Rutter Playback 
software for review. See Section Copying the Downloaded Data to a Playback PC for details. 

13.5.2 JoTron Float-free SFRM Capsule (version 4.06.00 and 
earlier) 

This section is applicable to the JoTron Float-free SFRM Capsule only, to retrieve data recorded 
using VDR-100G2 Record Application versions 4.06.00 and earlier  
 

1. Logon as Administrator; 
2. Copy the contents of the X:\ drive to the E:\ drive on the VDR-100G2.  
 

NOTE: This directory is ‘shared’ and is accessible to a Playback PC via the 
download port on the VDR-100G2. Alternatively, data may be copied directly to 
an attached RSM or Download USB Drive. 

 
3. Open < vdrparams.ini > file and check  NetworkHVR-compressNMEA. 

a.  If the entry is set to  = 1 go to step 4 below.  
b. If the entry is set to =0 then go to step 5 below; 

 
4. If the NMEA data is compressed, run the <decompressNMEA.exe>file located in the 

C:\VDRApps folder in order to decompress the data. 
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5. The downloaded data may now be moved to a Playback PC running the Rutter Playback 
software for review. See Section 13.5.3: Copying the Downloaded Data to a Playback PC 
for details. 

13.5.3 Copying the Downloaded Data to a Playback PC  
Data may be moved to a Playback PC running the Rutter Playback Application for review. See 
Chapter 18 - Error! Reference source not found. for details of installing and using the Rutter 
Playback software. 
 

13.5.3.1 Copying the Downloaded Data via Drive Mapping 
With data downloaded to the VDR-100G2’s E:\ drive, connect the Playback PC to the VDR-
100G2’s Download Ethernet port to retrieve the data. The following steps illustrate this procedure: 
 
1. The Playback PC must be in the same IP segment as the VDR-100G2’s Download Ethernet 

port. The VDR-100G2’s Download Ethernet port occupies IP address 200.200.200.200. The 
Playback PC must be in the same range, with the last segment different than the VDR-
100G2 (as shown below.) To change the IP segment: 

a) Open the Control Panel via the Start menu. 
b) Double-click the Network Connections icon. 
c) Right-click on the Local Area Connection icon and select Properties from the 

pop-up menu. 
d) In the Local Area Connection Properties window, highlight “Internet Protocol 

(TCP/IP)” and click the “Properties” button located directly below the available 
options. 

e) In the subsequent Internet Protocol (TCP/IP) Properties window, select the “Use 
the following IP address” radio button and enter 200.200.200.2 (the last number 
can be any number from 2 to 254, except 200 and 100.) 

f) Click the “OK” button in the Internet Protocol (TCP/IP) Properties and the Local 
Area Connection Properties.  

 

 
Figure 13-28- Establishing TCP/IP Address 

 

2. Locate the VDR Data Port, a RJ45 wall jack, mounted on the bridge. 
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Figure 13-29 - VDR Data Port 

 

 
3. Connect the Playback PC to the VDR Data Port via a straight-through Ethernet cable. 
4. Open Windows Explorer;  
5. Select Tools; 
6. Select Map Network Drive; 
7. Select a drive letter not in use by the Playback PC; 
8. Enter ‘\\200.200.200.200\Secured Data’ in the ‘Folder’ text box; and  
9. Select Finish. 
 

 
Figure 13-30 – Mapping the Secured Data Drive 

 
 

10. At the prompt, enter ‘MyUser’ for the user name and ‘Rutter’ for the password.  
 
 

NOTE: These entries are case-sensitive. 
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Figure 13-31 – Enter Password and User name 

 
NOTE: When the Playback PC connects to the ‘Secured Data’ drive on the VDR-
100G2, it will appear in Windows Explorer. 

 

 
Figure 13-32 – The Mapped Secured Data Drive 

 
11. Select the downloaded data set of interest, and copy it to the Playback PC. 
 

13.5.3.2 Copying the Downloaded Data Via RSM/Download USB Drive 
If data was downloaded to the VDR-100G2’s RSM or Download USB Drive, the data can be 
copied directly to the Playback PC. 
 
Remove the device containing the downloaded data from the VDR-100G2, and connect it to the 
Playback PC. When connected, the downloaded data may be copied off of the device, or the 
Playback software may be used to play back the data directly off of the device. (See Sections 
15.1.4 Disconnecting the RSM and 15.2 Error! Reference source not found. for details on 
disconnecting the RSM from the VDR-100G2and connecting it to the Playback PC. 

13.5.3.3 Downloading FRM/SFRM Data Directly to the Playback/Client PC 
It may be preferred to download the FRM/SFRM data directly to the Client/Playback PC instead 
of to the VDR-100G2.  To download data directly from the FRM/SFRM to a Client PC, the Client 
PC must have the following: 

 A 100 Base-TX Ethernet Interface (RJ45). 
 Rutter Technologies Inc. proprietary FRM Download Application software. 

 
Note! The following information is only applicable to the Rutter FRM (RUT-02447) 
Capsule, the L3 HVR/SVR Fixed FRM/SFRM Capsule and the Rutter-ACR Float-
free SFRM Capsule.  For information on connecting to the JoTron Float-free SFRM 
Capsule, refer to the manufacturer’s technical manual.  
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13.5.3.4 Connecting to a Rutter FRM (RUT-02447) Capsule or L3 HVR/SVR Fixed 
FRM/SFRM 

 
 
1. Remove the power and Ethernet cable from the Junction Box. 
2. Connect the Ethernet cable to the Client PC. 
 

13.5.3.5 Connecting to a Rutter-ACR Float-free SFRM Capsule 
The Rutter-ACR Float-free SFRM Capsule uses PoE technology to provide power and data 
connectivity between it and the VDR-100G2. The following steps illustrate how to connect the 
Rutter-ACR Float-free SFRM Capsule directly to a Client PC: 
1. Locate the Rutter-ACR Float-free SFRM Capsule and its associated PoE Power Injector (PS-

100). The PoE Power Injector is located inside the DPU; 
2. Remove the Ethernet cable between PoE Power Injector and the DMM; 
3. Connect the Ethernet cable to the Client PC. The Ethernet connection may be made with the 

existing Ethernet cable. It is not necessary to change either of the Ethernet cables from 
straight-through to cross-over or from cross-over to straight-through. 

 

13.5.3.6 Connecting to a JoTron Float-free SFRM Capsule 
For information on connecting to the JoTron Float-free SFRM Capsule to a Client PC, refer to the 
manufacturer’s technical manual. 

13.5.3.7 Installing the FRM Download Application 
Prior to downloading data from the FRM/SFRM directly to the Client PC, the FRM Download 
Application must be installed on the Client PC. The FRM Download Application will be installed to 
C:\Program Files\Rutter\FRM Download\ by default. There will be a shortcut added to the Start 
menu upon completion of the installation. 
 
To complete the installation of the FRM Download Application, complete the steps listed below: 
 
1. Copy the FRM Download Application installer (FRM Download Setup.exe) from the VDR 

Data Recovery CD supplied by Rutter Technologies Inc. to the desktop of the Client PC. 
2. Once copied, locate the file entitled ‘FRM Download Setup.exe’ and double-click it. 
 

 
Figure 13-33 – Installation Executable File 

3.  Read the information on the welcome page of the setup wizard and click ‘next’. 
 



Chapter 13: Final Recording Medium Setup 
 

 
VDR-100G2/G2S Installation Manual  192  
RUT-TD-02-001, Rev 2.1 

 
Figure 13-34 – Setup Wizard Welcome Page 

2. At the ”Choose Components” window ensure ”Windows  Services for Unix” is checked if the 
FRM Download Application will be used with a Rutter Fixed Capsule;  

 

 
Figure 13-35 - Setup Wizard Component Selection Page 

  
3. Choose the directory to which the FRM Download Application will be installed.  Click ‘Install’ 

to proceed with the installation. 
 

Note! Due to limitations with the installation process of ‘Windows Services for 
Unix’, this component will be installed to “C:\SFU” by default. 
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Figure 13-36  – Setup Wizard Install Location Page 

 
4. Installation will proceed until the process is completed 
 

 
Figure 13-37 – Installing the Application Files 

 
5. Once the FRM Download Application setup wizard has completed, click ‘Finish’ to complete 

the installation process. 
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Figure 13-38 – Setup Completed 

13.5.3.8 Copy <vdrparams.ini> 
Copy the <vdrparams.ini>file to the ‘C:\WINDOWS’ folder from the VDR Data Recovery Software 
CD supplied by Rutter Technologies Inc. 

13.5.3.9 Setting the Client PC IP Address 
The IP address of the Client PC must be altered to match the IP of the FRM/SFRM (excluding the 
last segment). The FRM/SFRM IP is provided in the vdrparams.ini file.  

 To change the Client PC’s IP address, open the ‘Control Panel’ > ‘Network and Dial-up 
Connections’ > ‘Local Area Connection’ and click the ‘Properties’ button. 

 In the subsequent ‘Local Area Connection Properties’ window select ‘Internet Protocol 
(TCP/IP) in the ‘Components checked are used by this connection:’ selection area and 
click the ‘Properties’ button. 

 In the subsequent ‘Internet Protocol (TCP/IP) Properties’ window, select the ‘Use the 
following IP address’ radio button and enter the appropriate FRM/SFRM IP address in the 
‘IP Address:’ field. 

 The last segment will have to be changed to a number between 3 and 255, but cannot 
be the same number as the FRM/SFRM IP address (i.e., if the FRM/SFRM IP address is 
192.168.0.2, the Client PC address may be entered as 192.168.0.3). 

  

 
Figure 13-39 – TCP/IP Configuration
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14 USER GUIDE 
 
 
The following section provides a user guide for operating the VDR-100G2/S. All user-level 
operation occurs via the OAU. The OAU provides the ability to secure data as well as offering 
audible alarms that alert the user to potential problems with the unit and/or component 
connections. 
 

 
Figure 14-1 - OAU Menu Pad 

 
 

14.1 Securing Data 
To secure data to the DMM, complete the following steps: 
 

1. Press the “Emrg Backup” button on the OAU menu pad. The following message will 
appear on the OAU’s LCD: 

 
“Perform Emergency Backup of VDR Data” 
“> Enter to Confirm” 

 
2. Press the “Enter” button on the OAU menu pad. The following message will appear: 
 

“Downloading Data” 
“Please Wait…” 

 
3. Allow the download to complete. A progression message may appear (i.e., “20% 

Complete”) dependant upon the size of the download. 
 
 

14.2 Viewing Secured Data 
To view previously secured data sets, complete the following steps: 
 

1. Press the “View Data” button on the OAU menu pad. 
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2. Secured data sets appear two (2) per screen. If more than two (2) secured data sets 
exist, press the “Prev” and/or “Next” buttons on the menu pad to scroll through all sets 
available. Data sets appear from oldest to newest and are recorded with the following 
time format: yyyy-mm-dd-hr-mt (where yyyy=year, mm=month, dd=day, hr=hour, and 
mt=minute). 

 

14.3 Securing Data to the Remote Storage Module 
For instructions on securing data to the RSM, see Section 15 - Remote Storage Module. 
 

14.4 Muting Audible Alarm 
To mute the audible alarm, press the “Mute” key on the OAU menu pad. 
 

14.5 Dimming the Display 
To dim or brighten the LCD display, press the “Dim” key on the OAU menu pad.  
 
There are four (4) LCD brightness levels ranging from off to bright. 
 

14.6 Test Screen 
To obtain the VDR Record software version number or the unique DMM Hardware ID, press the 
“Test” key on the OAU menu pad. 
 
An example of the information provided via the “Tests” menu, is as follows: 
 
**Test Screen** 
Version: 4.02.00 
ID: 55N5SS5S55X21 
 
 
 

Note! It is essential to record the DMM Hardware ID correctly, as an incorrect ID 
could cause a loss of features in various VDR software applications. 

 
 
 
Press the “Cancel” button to return to the main screen. 
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14.7 Alarm Code Description 
Listed below are the alarm codes that may appear on the OAU LCD display: 
 

Alarm Code Description 

System Error Communication with the Record Application has been lost 

Video Error Communication with the Video Module has been lost 

Audio Error Communication with the Audio Module has been lost 

FRM Error Communication with the Final Recording Medium has been lost 

Power Fail Loss of utility power 

PCM Error Communication has been lost with the Power Control Module 

Remote Error Communication has been lost with the Remote Storage Module 

Serial Error Communication has been lost with the NMEA Module 

Mic Error Communication has been lost with one of the microphones 

Disk Error Failure to secure a data set 

GPS Error Failure to record GPS data 

Table 14-1 - Alarm Code Description 

 
Pressing the “Mute” button acknowledges the alarm code and silences the alarm. 
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15 RSM AND USB MEMORY STICK 
 
 
The primary means of removing data recorded by the VDR-100G2 is via the USB Memory Stick 
(version 4.05.00 of the vdr_record.exe application and later).  Each VDR from Serial No. 
2010702820 forward includes a USB Memory Stick.  For units built prior to this time, the primary 
means of removing data is via the RSM.  Refer to Table 15-1 - USB Memory Stick vs. RSM below 
for a comparison of versions for copying data. 
 
There are no changes in OAU functionality between these units and versions: 
 

 Where a unit is fitted with a USB Memory Stick and version 4.05.00 of the software, 
data copied using the RSM menu will be copied to the USB Memory Stick.  Where a 
unit has no USB Memory Stick, data is copied to the RSM (if fitted).  

 A VDR with a USB Memory Stick may also have an optional Remote Storage Module 
(RSM) for the purposes of automatic archiving.   

 
Unlike the FRM, which contains only data required by IMO regulations, the USB Memory Stick 
and/or RSM, dependant upon customer requirements, may contain a much larger and highly 
detailed data set.  
 
For units without a USB drive, read this section to understand that the RSM will perform the same 
data copying functionality without need for software or hardware changes. 
 

Comparison of VDR-100G2 Units with USB Memory Stick vs. RSM 

VDR Fitted with Data Copy Destination (when using OAU) Auto Archive 

USB Memory Stick Only USB Memory Stick RSM 

RSM Only RSM RSM 

Both RSM & USB Memory Stick USB Memory Stick RSM 

Table 15-1 - USB Memory Stick vs. RSM 

 
 

Important! The configuration (Vdr-cfg.txt) and parameters (vdrparams.ini) files, 
which may be used to correctly interpret playback information, are stored and 
located in the root directory of the removable drive.  

 
 
A portable copy of the recorded data can be obtained by copying data from the DMM internal 
hard drive to the USB Memory Stick or RSM.  Copying data to the USB Memory Stick (or RSM) 
does not affect the normal recording operation of the VDR-100G2. 
 
The OAU is used to initiate copying of data to the USB Memory Stick (or RSM) for removal and 
analysis purposes. 
 
To playback the data from the USB Memory Stick, a PC will require the following: 

 
 The minimum requirements for a PC outlined in Section 16.1 - Optional Client Download 

PC. 
 Rutter Technologies’ playback software.
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Important! The configuration (Vdr-cfg.txt) and parameters (vdrparams.ini) files, 
which may be used to correctly interpret playback information, are stored and 
located in the root directory of the removable drive. 

 
 

15.1 Copying Data to the USB Memory Stick/RSM 
To retrieve data using the OAU, it is necessary to ensure the USB Memory Stick/RSM is 
connected and recognized by the G2 system.  Complete the following steps: 
 

2. If not already connected, insert the USB Memory Stick into the available USB port or 
attach the Ethernet and power cable from the RSM to the DPU. 

 
3. Press the “RSM” button on the OAU menu pad. 

 
4. At the main menu screen of the OAU, two (2) options are displayed: 

 
 “Copy Data” 
 “RSM Archiving” 

 
 

Note! The RSM cannot be simultaneously connected via Ethernet to the VDR 
while connected to the Client PC via a USB connection. 
 

 
 

4. Ensure the “Copy Data” option is highlighted (blinking cursor is adjacent to the option.) 
Once highlighted, press the “Enter” button on the OAU menu pad. 
 

5. Three (3) options are now displayed: 
 

 “Copy Current Data”: allows a user to retrieve a full 24-hour data set. See 
Section 15.1.1 - Copy Current Data. 

 “Copy Secured Data”: allows a user to retrieve specific segments that have been 
previously secured and may range in length of time. See Section 15.1.2 - 
Copying Secured Data. 

 “Copy Extended NMEA”: allows a user to retrieve extended NMEA data. See 
Section 15.1.3 - Copying Extended NMEA Data. 

 
 
 

Important! If Auto Archiving is enabled, do not physically disconnect the Remote 
Storage Module before disconnecting it from the system via the OAU. See Section 
15.1.4 - Disconnecting the RSM for instructions on disconnecting via the OAU. 
 
It is also recommended to power off the unit prior to physically disconnecting it. 
 
Once the RSM is physically disconnected from the DMM, it will take approximately 
one (1) minute for the system to recognize this disconnect. DO NOT reconnect the 
RSM before this one (1) minute wait period has elapsed, as it will not be 
recognized by the system. If the RSM is accidentally reconnected before the one 
(1) minute wait period has elapsed, physically disconnect the RSM from the DMM 
and wait one (1) minute before physically reconnecting. Once the RSM is 
physically connected, connect to the DMM software via the OAU. 
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15.1.1 Copy Current Data 
To copy the current data from the internal drive of the DMM to the RSM, the following steps must 
be completed: 
 

 Press the “RSM” key on the OAU menu pad 
 Highlight ‘Copy Data’ and press ‘Enter’ on the OAU menu pad 
 Highlight ‘Copy Current Data’ and press ‘Enter’ on the OAU menu pad 

 
The full data set residing on the internal drive of the DMM will be copied to the RSM. As the data 
is copied, the OAU display may indicate the percentage of data that has been copied dependant 
upon the size of the download. To cancel the download, simply press “Cancel” on the OAU menu 
pad. 
 

15.1.2 Copying Secured Data 
Data sets can be secured on the internal drive of the DMM at any time via the OAU menu pad.  If 
sufficient space does not exist on the internal drive to secure a data set, the oldest secure data 
set will be automatically deleted.  Therefore, it is convenient to copy any one of these secure data 
sets to the USB Memory Stick/RSM.  
 
Secured data sets can be copied to the USB Memory Stick/RSM for longer term storage or for 
portability to shore side facilities.  To copy a secured data set to the USB Memory Stick/RSM, the 
following steps must be completed: 
 

 Press the “RSM” key on the OAU menu pad. 
 Highlight ‘Copy Data’ and press ‘Enter’ on the OAU menu pad. 
 Highlight ‘Copy Secured Data’ and press ‘Enter’ on the OAU menu pad. 
 All available secured data sets (displayed in yyyy-mm-dd-hr-mt format) will become 

visible. Secured data sets appear two (2) per screen. If more than two (2) secured data 
sets exist, press the “Prev” and/or “Next” buttons on the menu pad to scroll through all 
sets available. The total number of data set screens available is shown on the screen (for 
example, “Page 3/21”). 

 Once the desired data set is highlighted, press the “Enter” key on the OAU keypad. Press 
the “Enter” key again to confirm the download. 

 
The selected secured data set will be copied to the USB Memory Stick/RSM.  As the data is 
copied, the OAU display will indicate the percentage of data that has been copied. To cancel the 
download, simply press “Cancel” on the OAU menu pad. 
 

15.1.3 Copying Extended NMEA Data 
The VDR100G2 can optionally store up to 185 days of NMEA data. This data can then be copied 
to the USB Memory Stick/RSM by the following steps: 
 

1. Press the “RSM” key on the OAU menu pad. 
2. Highlight ‘Copy Data’ and press ‘Enter’ on the OAU menu pad. 
3. Highlight ‘Copy Extended NMEA Data’ and press ‘Enter’ on the OAU menu pad. 

 
All Extended NMEA data will then be copied to the USB Memory Stick/RSM.  As the data is 
copied, the OAU display will indicate the percentage of data that has been copied. To cancel the 
download, simply press “Cancel” on the OAU menu pad. 
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15.1.4 Disconnecting the RSM 
When Auto Archiving is enabled, it is important to disconnect via the OAU keypad prior to 
physically disconnecting from the VDR.  To check if Auto Archiving is enabled, press the “RSM” 
key on the OAU keypad; if “RSM Archiving” appears as a menu option, it is enabled. 
 
To disconnect the RSM: 
 

1. Press the “RSM” key on the OAU menu pad. 
2. Press the down (↓) arrow to select the “RSM Archiving” option on the OAU LCD display 

and press the “Enter” key. 
3. Select “Disable Extended Archiving” and press the “Enter” key on the OAU menu pad. 
4. Power off the RSM (switch RSM Power Switch to “Off” position). 
5. Remove all cable connections from the RSM. 

 
 

 
Figure 15-1 - Rear View of RSM Unit 

 
 
 

Important!  Do not disconnect the USB Memory Stick during data transfer.  If data 
is being transferred to the Memory Stick the blue light located on the body of the 
Memory Stick will flash rapidly.  Once data transfer is complete the blue light will 
stay solid. 

 
  
 

15.2 Connecting Client PC to RSM 
To retrieve data from the RSM using the Client PC, complete the following steps: 
 

1. Physically disconnect the RSM Ethernet cable and connect it to the Client PC using an “A 
to B mini” USB cable. 

2. The RSM will be visible on the Client PC as a connected hard drive. 
 
 

Power Input 

Ethernet Port 

USB Port 

Power Switch 
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16 DATA RETRIEVAL 
 
 
The VDR-100G2 is supplied with several options for accessing and replaying data in order to 
reconstruct voyages: 
 

 The primary method of retrieving data is via the 4GB USB Memory Stick.  The 
copying of data to the USB memory stick is initiated at the OAU via the RSM button 
(see Section 16.4 - Remote Storage Module)  

 The Remote Storage Module (RSM). The download is initiated at the OAU (see 
Section 16.4 - Remote Storage Module). 

 An alternate method is to download data via a client PC connected to the VDR by a 
LAN connection. All necessary software is optional and resident on the client PC (see 
Section 16.2 - Installation of Download Software on Client PC). 

 
 

16.1 Optional Client Download PC 
If the customer should choose to make use of the optional download client PC, additional copies 
of the playback software are supplied. The Download/Playback client PC should be a Pentium 
class or equivalent, and IEC 60945 certified if installed on the Bridge. The computer system 
should, as a minimum, include:  
 

 Pentium III or higher processor 
 256 MB of memory 
 SVGA Video port and monitor (it is recommended that the monitor be 15” or  

larger and supports a non-scrollable resolution of 1024x768 or greater) 
 Audio hardware with PC speakers or headphones 
 100 Base-TX Ethernet Interface 
 USB 2.0 Port 
 Serial data port (if external ECDIS display support is required) 
 16X DVD-R/DVD-RW drive 
 80 GB or larger internal Hard Disk Drive 
 USB, AT or PS/2 mouse and keyboard 
 Power Supply: Dual Input Voltage: 115V at 60 Hz; or 220V at 50 Hz 
 English O/S Edition: Windows 2000 or Windows XP (recommended) 

 
 

16.2 Installation of Download Software on Client PC 
There are two (2) steps necessary to install the Download application onto the client PC: 
 

1. Copy the Download application (VDR_Download.exe) from the supplied media to the 
desktop of the download computer, or if an install file is supplied, double-click the “Install 
VDR Download.exe” file. 

2. Configure the download computer as a ‘Client’ for the ‘Download Application’ to connect 
to the VDR-100G2 and retrieve the recorded data. To do this, the download PC must be 
in the same IP segment as the download port on the VDR. The VDR’s download port 
occupies IP address 200.200.200.200. The client PC must be in the same range, with 
the last segment different than the VDR (as shown below.) To change the IP segment: 

 Open the Control Panel via the Start menu. 
 Double-click the Network Connections icon.
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 Right-click on the Local Area Connection icon and select Properties from the 

pop-up menu. 
 In the Local Area Connection Properties window, highlight “Internet Protocol 

(TCP/IP)” and click the “Properties” button located directly below the available 
options. 

 In the subsequent Internet Protocol (TCP/IP) Properties window, select the “Use 
the following IP address” radio button and enter 200.200.200.2 (the last number 
can be any number from 2 to 254, except 200.) 

 Click the “OK” button in the Internet Protocol (TCP/IP) Properties and the Local 
Area Connection Properties.  

 

 
Figure 16-1 - Establishing TCP/IP Address 
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16.2.1 Starting the Download Process 
Start the download utility by double-clicking the download.exe icon located on the Windows 
desktop. See Figure 16-2 - Download Software Main Screen for an example of the download 
utility. 
 

 
Figure 16-2 - Download Software Main Screen 

 

16.2.2 Begin the Download 
Complete the following steps to begin the download of the current data set: 
 

6. Select ‘Start download’ from the ‘Download Controls’ menu. 
 

 
Figure 16-3 - Download Controls Menu 

 
 

7. Enter a password when prompted. 
8. Once prompted with the ‘Download Settings’ window (see Figure 16-4 - Download 

Settings Window), choose from the following available settings: 
 ‘Download complete data set’. 
 ‘Download partial data set’ – once this option has been chosen, ‘Start’ and ‘Stop’ 

times become available. Using the appropriate slide-bar, set the time frame that 
will begin and end the downloaded data set. 

 ‘Normal data set’. 
 ‘Extended NMEA data set’ – this option allows for the download of the extended 

NMEA data set only. 
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Figure 16-4 - Download Settings Window 

 
 

4. Confirm that the stated download destination is correct. If it is not, press the ‘Change 
Destination’ button, select the correct destination from the file window, and press ‘OK’. 

5. Press the ‘Start Download’ button. 
6. Confirm all settings are correct in the confirmation window and press ‘OK’ (if they are 

not, press ’Cancel’ and make the appropriate changes in the ‘Download Settings’ 
window). 

 
 

 
Figure 16-5 - Sample Download Directory 

 
 
Once a download is complete, “MainAudio”, “MainNMEA”, and “MainVideo” folders are visible.  
The vdrparams.ini and vdr-cfg.txt files are also downloaded and saved to the specified download 
directory.  See Figure 16-5 - Sample Download Directory for an example of a typical download 
directory. 
 

16.2.3 Download Secured Data Set 
Complete the following steps to download one (1) of multiple secured data sets from the DMM’s 
internal hard drive: 
 

1. Select ‘Download Secured Dataset’ from the ‘Download Controls’ menu. 
2. A download progress window will appear indicating that the application is receiving 

information from the DMM. 
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3. In the subsequent ‘Download Secured Datasets’ window, all available secured datasets 
will be visible. Each dataset shows the date it was initially secured, file size, and start and 
end time. 

 

 
Figure 16-6 - Download Secured Datasets 

4. Select the appropriate dataset from the list. 
5. To download a complete dataset, choose the “Download complete data set” radio button 

under ‘Download duration’. To download a partial dataset, choose “Download partial data 
set”. 

6. If choosing to download a partial dataset, a window will appear from which the time range 
to be downloaded must be chosen. The associated scroll bar is used to select a start 
and/or end time (the exact time may also be entered directly in to the time fields.) 

 

 
Figure 16-7 - Partial Download Window 

7. To choose a directory to which the datasets will be downloaded, other than the one listed 
under ‘Destination’, press the “Change Destination” button and follow standard Windows 
procedure for selecting a desired directory. 

8. Once the duration and destination are correct, press ‘Start Download’. 
9. Enter a password and press ‘OK’. 
10. A “Download Settings” dialog will appear providing confirmation information for the 

dataset to be downloaded. If all information is correct, press ‘OK’ to begin the download. 
 

 
Figure 16-8 - Confirm Download Settings 
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16.2.4 Extended NMEA Download 
The Extended NMEA data set is a VDR-100G2 option, which supports the recording of up to 185 
days of NMEA data to the DMM. When an extended NMEA download occurs, no video or audio 
data is included in the download. To select the extended NMEA download, check the ‘Extended 
NMEA Download’ located in the ‘Download Settings’ window (see Figure 16-4 - Download 
Settings Window). 
 
 

Important! The extended NMEA data set must be purchased as an option and 
configured on the VDR-100G2 during installation. If the VDR-100G2 is not 
configured for the extended NMEA data set, this option will not function in the 
download software. 

 
 

16.2.5 Complete vs. Partial Download 
A ‘complete’ download is the process of downloading a full 24-hour data set from the DMM. As a 
user may want only a ‘partial’ download, a ‘Download partial data set’ option is available. Select 
either ‘Download complete data set’ or ‘Download partial data set’ in the ‘Download Settings’ 
window (see Figure 16-4 - Download Settings Window) to download the desired data set. 
 
 

 
Figure 16-9 - Completed Download 

 

16.2.6 Error Log and Battery Log 
To download the error log or battery log file, select the applicable item (‘Download Error Log’ or 
‘Download Battery Log’) from the ‘Download Controls’ menu (see Figure 16-3 - Download 
Controls Menu).  The system will prompt the user to select a location to save the log file. 
 

16.2.7 Disconnecting from the VDR 
To disconnect, simply choose ‘Exit’ from the ‘File’ menu. 
 



Chapter 16: Data Retrieval 

 
VDR-100G2/G2S Installation Manual  210  
RUT-TD-02-001, Rev 2.1 

 

16.3 USB Memory Stick 
The USB Memory Stick is the primary means of retrieving a secure data set recorded by the 
VDR. 
 
The method for initiating a download to the USB Memory Stick is the same as the method for 
initiating a data download to the RSM.  See Section 15 - R for information on downloading to the 
USB Memory Stick. 
 
 

16.4 Remote Storage Module 
If installed, the Removable Storage Module (RSM) provides a means of copying data recorded by 
the VDR.  
 
See Section 15 - R for information on downloading to the RSM. 
 
 

16.5 Retrieving Secured Data via Download Port 
To retrieve data from the secured directory, the retrieval PC must, as a minimum, conform to the 
following features/settings: 
 

 XP Professional Operating System or higher 
 Computer name must not be “VDR” 
 Within the IP range of 200.200.200.x (where ‘x’ can be any IP other than 200) 
 Workgroup name must be WORKGROUP 

 
Once the above listed conditions have been met, the secured data download can begin. To do 
so: 
 

1. Connect a crossover Ethernet cable from the PC to the download port of the VDR. 
2. Click Start > Run… on the Windows desktop of the retrieval PC, type \\VDR, and click 

‘OK’. 
3. If prompted, enter MyUser as a username and Rutter as a password. 
4. Double-click the “Secured Data” directory icon which appears in the “VDR” window. 
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Figure 16-10 – “Secured Data” Directory Icon 

 
 

 
Figure 16-11 - Secured Data 

 
 

5. Select all data available and copy it to the retrieval PC. 
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17 SYSTEM CONFIGURATION FILE 
 
Rutter Technologies’ VDR Configuration Utility is an application tool designed to help in the 
creation of configuration and parameter files during the installation of the Rutter Voyage Data 
Recorder (VDR). By entering the correct installation parameters into the fields provided, the 
Configuration Utility will produce both a vdrcfg.txt and vdrplayback.ini file. 
 
The utility takes advantage of standard Windows-type functionality. A menu bar and tool bar are 
available to help the user carry out all basic program functions including file saving. 
 
 

17.1 Installation 
There is no installation process for this utility. To access the executable file: 
 Locate and decompress (or “unzip”) the VDRConfig.zip file to a desired folder. 
 Locate and double-click the VDRConfig.exe file now visible to open the Configuration 

program. 
 
The program will open with the contents of the ‘General’ tab visible (see Figure 17-1 - Genera 
below). The title bar will read “Untitled – VDR Configuration Utility v1.0” until information has been 
saved, after which time the saved file name will appear in place of “Untitled”. 
 

17.2 General 
The ‘General’ tab requires the input of general information regarding various aspects of the 
installation including ship and VDR data.  
 

 
Figure 17-1 - General
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The following fields must be completed: 
 
Software Version & Software Date 
Enter the version number and date of the VDR Record application software. Both the version 
number and date can be found by opening the VDR Record software interface 
 
VDR Model 
From the accompanying drop-down box, select the VDR model applicable to the installation. 
Options available for selection are VDR-100, VDR-100G2, Simplified VDR, and DRS. 
 
VDR S/N 
Enter the VDR’s serial number, which can be found on the VDR identification plate located at the 
side of the unit in the lower right corner. An example of a VDR serial number is RT1981651973 
 
Ship 
Enter the name of the ship on which the VDR is being installed. 
 
Customer 
Enter the name of the customer for whom the VDR is being installed. 
 
Installer 
Enter the name of the person carrying out the installation of the VDR. 
 
IMO Vessel ID# 
Enter the International Maritime Organization (IMO) identification number specific to the vessel on 
which the VDR is being installed. 
 
MMSI# 
Enter the Maritime Mobile Service Identity (MMSI) radio identification number specific to the 
vessel on which the VDR is being installed. 
 
Call Sign 
Enter the Call Sign specific to the vessel on which the VDR is being installed. 
 
Approval Authority 
From the options available in the accompanying drop-down box, select the approval authority 
applicable to the installation. The “BSH Nr. 6543/080304/2003” is the default option. Dependant 
upon the instructions of the Classification Society involved in certifying the installation it may be 
necessary to select one of the other six (6) options available. 
 
Classification Society 
Enter the name of the Classification Society responsible for final inspection of the VDR 
installation. 
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Number of EPFS Present 
Select the radio button which represents the correct number (1, 2, 3, or 4) of Electronic Position 
Fixing System(s) (EPFS) present on the ship. If more than one EPFS is selected, the software will 
make the applicable number of rows available for data entry (see Figure 17-2 – EPFS below). 
 

 
Figure 17-2 – EPFS 

 
For each EPFS present the user must: 
 Enter its “Distance from Bow” in meters 
 Enter its “Distance from Centerline” in meters 
 Select either the Port or Starboard radio button to indicate its “Direction from Centerline” 
 Enter the Deck number and, if necessary, name on which it is located 

 
Other Comments 
This text field allows the user to enter any additional information deemed important in achieving a 
complete configuration file. 

17.3 Primary Storage 
The ‘Storage’ tab requires the input of information specific to the Final Recording Medium (FRM) 
unit (see Figure 17-3 – Primary Storage below). 
 

 
Figure 17-3 – Primary Storage 
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The following fields must be completed: 
 
Type 
From the accompanying drop-down box, select the FRM model and manufacturer applicable to 
the installation. Options available are L3 HVR (default), Litton PMC, Jotron SVDR, Rutter FRM 
(RUT-02447) Fixed, Rutter-ACR Float-Free ,or Not Installed. 
 
If the “Litton PMC” option is chosen, a Model field will become visible below the Serial Number 
field. Enter the Litton model number, which can be found on the FRM identification plate at the 
top of the unit. 
 
Part Number 
Enter the FRM’s part number, which can be found on the FRM identification plate located at the 
top of the unit. An example of a L3 HVR part number is HVR00-000-00 
 
Serial Number 
Enter the FRM’s serial number, which can be found on the FRM identification plate located at the 
top of the unit. An example of a L3 FRM serial number is 000199364 
  
Date of Manufacture 
Enter the FRM’s date of manufacture, which can be found on the FRM identification plate located 
at the top of the unit. 
 
Beacon Serial Number and Battery Expiry Date 
Enter the beacon serial number and battery expiry date, both of which can be found on the 
beacon (located at the top of the unit on the L3 HVR or bottom of the unit on the Litton PMC). 
 
Distance from Bow 
Enter the distance of the FRM unit from the ship’s bow. 
 
Distance from Centerline 
Enter the distance of the FRM unit from the ship’s centerline. 
 
Direction from Centerline 
Select either the Port or Starboard radio button to indicate the FRM unit’s direction from the ship’s 
centerline. 
 
Deck 
Enter the Deck number and, if necessary, name on which the FRM unit is located. 
 
FRM IP Address 
Enter the IP address of the FRM unit. The IP address of the L3 HVR is 192.168.0.2. 
 
FRM Subnet Address 
Enter the subnet address of the FRM unit. The subnet address of the L3 HVR is 255.255.255.0. 
 
Default Gateway IP 
Enter the default gateway IP of the FRM unit. The default gateway IP address of the L3 HVR is 
192.168.0.1. 
 
Memory Partition Information 
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This section is only visible for the L3 HVR unit. If another FRM type is in use, the user can skip 
the following three entries. 
 
Total Bytes in Crash Module / Number of Bytes per Granule / Currently Unassigned 
Granules 
To access this information, follow the instructions provided below: 
 
 Open an Internet Explorer browser on the VDR desktop. 
 In the address bar at the top of the browser interface type 192.168.0.2/hvrhome.htm and 

press the Enter key. 
 Select the “Flash Setup” button located on the left side of the screen. 
 Enter L3HVR as the password. 

 
 
Unit Allocations and Stream Names 
Enter the Number of Granules (or Number of Bytes if referring to the Litton PMC unit) and 
Stream Name for each applicable position (see Figure 17-4 - Unit Allocations and Stream Names 
below for an example of information added for this section). 
 

 
Figure 17-4 - Unit Allocations and Stream Names 

 
For the L3 HVR unit this information can be obtained using the steps provided in the Memory 
Partition Information section above. 
 
For the Litton PMC unit locate and open the console.exe file/application. Once open, select 
Display from the file menu and PMC Partition Directory from the subsequent list. 
 
Other Comments on Storage for Configuration File 
Enter any additional comments relevant to the storage aspect of the configuration/installation. 
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17.4 Secondary Storage 
If the VDR is equipped with a secondary FRM, the ‘Secondary FRM’ tab will require the input of 
information specific to the secondary FRM unit (see Figure 17-5 - Secondary Storage below). 
 

 
Figure 17-5 - Secondary Storage 

 
The following fields must be completed: 
 
Type 
From the accompanying drop-down box, select the FRM model and manufacturer applicable to 
the installation. Options available are L3 HVR, Litton PMC, Jotron SVDR, Rutter Fixed, Rutter 
Float-Free or Not Installed (default). 
 
If the “Litton PMC” option is chosen, a Model field will become visible below the Serial Number 
field. Enter the Litton model number, which can be found on the FRM identification plate at the 
top of the unit. 
 
Part Number 
Enter the FRM’s part number. 
 
Serial Number 
Enter the FRM’s serial number. 
  
Date of Manufacture 
Enter the FRM’s date of manufacture. 
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Beacon Serial Number and Battery Expiry Date 
Enter the beacon serial number and battery expiry date, both of which can be found on the 
beacon. 
 
Distance from Bow 
Enter the distance of the FRM unit from the ship’s bow. 
 
Distance from Centerline 
Enter the distance of the FRM unit from the ship’s centerline. 
 
Direction from Centerline 
Select either the Port or Starboard radio button to indicate the FRM unit’s direction from the ship’s 
centerline. 
 
Deck 
Enter the Deck number and, if necessary, name on which the FRM unit is located. 
 
FRM IP Address 
Enter the IP address of the FRM unit. 
 
FRM Subnet Address 
Enter the subnet address of the FRM unit.  
 
Default Gateway IP 
Enter the default gateway IP of the FRM unit.  
 
Memory Partition Information 
This section is only visible for the L3 HVR unit. If another FRM type is in use, the user can skip 
the following three entries. 
 
Total Bytes in Crash Module / Number of Bytes per Granule / Currently Unassigned 
Granules 
To access this information, follow the instructions provided below: 
 
 Open an Internet Explorer browser on the VDR desktop. 
 In the address bar at the top of the browser interface type 192.168.0.2/hvrhome.htm and 

press the Enter key. 
 Select the “Flash Setup” button located on the left side of the screen. 
 Enter L3HVR as the password. 

 
 
Unit Allocations and Stream Names 
Enter the Number of Granules (or Number of Bytes if referring to the Litton PMC unit) and 
Stream Name for each applicable position (see Figure 17-6 - Unit Allocations and Stream Names 
below for an example of information added for this section). 
 

 
Figure 17-6 - Unit Allocations and Stream Names 



Chapter 17: System Configuration File 

 
VDR-100G2/G2S Installation Manual  219  
RUT-TD-02-001, Rev 2.1 

 
For the L3 HVR unit this information can be obtained using the steps provided in the Memory 
Partition Information section above. 
 
For the Litton PMC unit locate and open the console.exe file/application. Once open, select 
Display from the file menu and PMC Partition Directory from the subsequent list. 
 
Other Comments 
Enter any additional comments relevant to the storage aspect of the configuration/installation.
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17.5 Video 
The ‘Video’ tab requires the input of information specific to the video configuration (see Figure 
17-7 - Video below). 
 

 
Figure 17-7 - Video 

 
 
The followings fields must be completed: 
 
Number of Video Displays Connected 
Select the radio button (1, 2, 3, or 4) appropriate to the number of video displays connected to the 
VDR. If more than one Video Display is selected, the software will make the applicable number of 
rows available for data entry (see Figure 17-8 - Video Channel Information below). 
 

 
Figure 17-8 - Video Channel Information 
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Manufacturer 
Enter the name of the video capture component’s manufacturer. 
 
Model 
Enter the name of the model name of the video capture component. 
 
Type 
From the drop down box select the type of video capture component in relation to the channel 
number. Options available for selection are S-Band Radar, X-Band Radar, ECDIS, and CCTV. 
 
Location of Display 
Enter the location on the ship where the video capture component is located. 
 
Saved to FRM 
If the video capture is saved to the FRM, this checkbox must be checked. 
 
Interlaced or Interleaved 
Checking either the “Interlaced” or “Interleaved” checkbox disables the other and makes Image 
“Start” text boxes available. These “Start” fields correspond to the start point of the odd and even 
lines of an interlaced or interleaved image. This information is available via the Rutter 
Technologies Video Configuration software (see Section 10.3 - Video Diagnostics 
(VideoConfigSuite) Application for further information on this software). 
 

 
Figure 17-9 - Image Start Points 

Static 
Enter the onscreen name of the video capture component. 
 
Capture Frequency for each Video Channel 
Enter the number of seconds between the capture of each image. This number is dependant 
upon the number of video sources present. One (1) source will have a capture interval of 15 
seconds, two (2) sources will be 7.5 seconds, three (3) sources will be 5 seconds, and four (4) 
sources will be 3.75 seconds. 
 
Other Comments 
Enter any additional comments relevant to the video capture aspect of the 
configuration/installation. 
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17.6 Proprietary Strings 
Various systems may output data strings which must be manually interpreted. The Proprietary tab 
allows a user to enter these data strings which are broadcast from proprietary data sources.  
 

 
Figure 17-10 - Proprietary Strings 

 
 
If proprietary strings are entered, the following fields must be completed: 
 
Number of Proprietary Systems 
Select the radio button (1 or 2) which represents the number of Proprietary Systems from which 
strings will be entered. 
 
Proprietary Page Name 
Enter a name for the tab that will be created for each Proprietary system. It will be necessary to 
enter two (2) names if two (2) systems are specified. 
 
Number of Strings 
Use the available drop-down to select the number of strings available from the associated 
proprietary system. The number of strings selected will cause the same number of text boxes to 
appear to the right of the drop-down box.  Enter the strings in these available text boxes (one per 
box).
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17.7 Audio 
The ‘Audio’ tab requires the input of information specific to the audio configuration (see Figure 
17-11 – Audio below). 
 

 
Figure 17-11 – Audio 

 
The followings fields must be completed: 
 
Number of Audio Output Channels 
Select the radio button (1, 2, 3, 4, 5, 6, 7, or 8) appropriate to the number of audio channels 
connected to the VDR. If more than one Audio Channel is selected, the software will make the 
applicable number of Channel tabs available for data entry (see Figure 17-12 - Audio Channel 
Information below). 
 

 
Figure 17-12 - Audio Channel Information 
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The following fields are all contained within individual Audio Channel tabs. After entering all 
relevant information for the first Channel, click the ‘Channel 2’ tab and complete all fields. This 
information will have to be entered for each Audio Channel connected. 
 
Short Onscreen Name 
Enter a name for the mixer which will be utilized by the Playback program. It is recommended to 
use a name that denotes the location of the mixer. 
 
Number of Microphones Connected to this Channel 
Select the radio button (1, 2, 3, or 4) appropriate for the number of microphones connected to the 
audio channel. If more than one microphone is selected, the software will make the applicable 
number of “Microphone Number” rows available for data entry (see Figure 17-12 - Audio Channel 
Information above). 
 
Location of Microphone 
Enter a brief description of the microphone. It is recommended to include such descriptors as 
location and type. 
 
Type 
From the drop down box select the type of microphone used. Options available for selection are 
Interior, Exterior, UHF, VHF, PABX, Telephone, Intercom, and ECR Audio.  
 
Enter a Summary 
Enter a complete description of the Channel and all connected microphones. 
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17.8 Navigation 
The ‘Navigation’ tab requires the input of configuration information for the Wind Device, Depth 
Device, Heading Device, and Speed Device. It is also necessary to enter configuration 
information for the Global Positioning System (GPS). Each Device (and GPS) has its own button 
(see Figure 17-13 – Navigation below). To enter configuration information, the user must press 
the appropriate button to open a data entry window. 
 

 
Figure 17-13 – Navigation 

 
Configure GPS 
By clicking the ‘Configure GPS’ button the user will open the ‘Configure GPS Device’ window 
(see Figure 17-14 - Configure GPS Device below). This window requires the input of GPS 
parameters including date, time, latitude, longitude, ship’s speed, ship’s course, and GPS mode. 
 
GPS Manufacturer 
Enter the name of the manufacturer of the configured GPS device. 
 
GPS Model 
Enter the model name/number of the configured GPS device. 
 
GPS Location 
Enter the location of the configured GPS device onboard the ship. 
 
Talker ID 
The first two alphanumeric characters of the NMEA sentence’s Address Field identify the Talker. 
When entering the Talker ID for a GPS device, these two letters will always be “GP”. 
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Input Channel on VDR 
In most instances, the GPS will be connected directly to COM1 on the DMU. However, there are 
instances where this may not be the case. Options available for selection are Channel1, 
Channel2, Channel3, Channel4, and DataMux Channel. 
 
DataMux Channel 
If the “DataMux Channel” option is selected in the “Input Channel on VDR” field, it will be 
necessary to enter the MUX channel to which the DataMux is connected. 
 

 
Figure 17-14 - Configure GPS Device 

 
For each of the available NMEA sentence drop-down fields (Date, Time, Latitude, Longitude, 
Course over Ground, GPS Mode, and Datum), select the appropriate string type and enter a 
sample string in the adjacent text field. 
 
The following options are available in the various drop-down fields: 
 ZDA – Time & Date 

 $--ZDA,hhmmss.ss,xx,xx,xxxx,xx,xx*hh<CR><LF> 
 
 RMC – Recommended Minimum Specific GNSS Data 

 $--RMC,hhmmss.ss,A,llll.ll,a,yyyyy.yy,a,x.x,x.x,xxxxxx,x.x,a,a*hh<CR><LF> 
 
 GGA – Global Positioning System Fix Data 

 $--GGA,hhmmss.ss,llll.ll,a,yyyyy.yy,a,x,xx,x.x,x.x,M,x.x,M,x.x,xxxx*hh<CR><LF> 
 
 GLL – Geographic Position – Latitude/Longitude 

 $--GLL,llll.ll,a,yyyyy.yy,a,hhmmss.ss,A,a*hh<CR><LF> 
 
 VTG – Course Over Ground and Ground Speed 

 $--VTG,x.x,T,x.x,M,x.x,N,x.x,K,a*hh<CR><LF> 
 
 DTM – Datum Reference 

 $--DTM,ccc,a,x.x,a,x.x,a,x.x,ccc*hh<CR><LF> 
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Configure Wind Device 
By clicking the ‘Configure Wind Device’ the user will open the ‘Configure Wind Device’ window 
(see Figure 17-15 - Configure Wind Device below). This window requires the input of information 
relevant to the recording of wind speed and direction. 
 

 
Figure 17-15 - Configure Wind Device 

 
 
Wind Information 
From the drop down box select the device or string from which wind information is collected. 
Options available for selection are MWV, VWR, NavAnalog, DataAnalog, or DataSynchro. 
 
 MWV – Wind Speed and Angle 

 $--MWV,x.x,a,x.x,a,A*hh<CR><LF> 
 
 VWR – Relative (Apparent) Wind Speed and Angle 

 $--VWR,x.x,a,x.x,N,x.x,M,x.x,K*hh<CR><LF> 
 
 
Talker ID 
The first two alphanumeric characters of the NMEA sentence’s Address Field identify the Talker. 
When entering the Talker ID for a GPS device, these two letters will always be “GP”. 
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Configure Depth Device 
By clicking the ‘Configure Depth Device’ the user will open the ‘Configure Depth Device’ window 
(see Figure 17-16 - Configure Depth Device below). This window requires the input of information 
relevant to ship depth. 
 

 
Figure 17-16 - Configure Depth Device 

 
Depth Device Manufacturer 
Enter the name of the manufacturer of the depth device. 
 
Device Location 
Enter the ship location of the depth device. 
 
Talker ID 
The first two alphanumeric characters of the NMEA sentence’s Address Field identify the Talker. 
When entering the Talker ID for a depth device, these two letters will typically be “SD”. 
 
DataMux Channel 
Enter the DataMux channel to which the heading device is connected. 
 
String to Use for Depth 
From the drop down box select the string from which depth information is collected. Options 
available for selection are DBT (Depth Below Transducer) or DPT (Depth). 
 
 DBT – Water depth referenced to the transducer  

 $--DBT,x.x,f,x.x,M,x.x,F*hh<CR><LF> 
 If DBT is selected from the drop-down box, the user must enter the appropriate Field 

for Value and Field for Units 
 
 DPT – Water depth relative to the transducer and offset of the measuring transducer. Positive 

offset numbers provide the distance from the transducer to the waterline. Negative offset 
numbers provide the distance from the transducer to the part of the keel of interest. 

 $--DPT,x.x,x.x,x.x*hh<CR><LF> 
 If DPT is selected from the drop-down box, the user must enter the appropriate Field 

for Depth to Transducer and Field for Depth below Transducer 
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Sample of Depth String 
Enter a sample of the depth string. See the DBT and DPT string formats provided in String to 
Use for Depth provided above. 
 
 
Configure Heading Device 
By clicking the ‘Configure Heading Device’ the user will open the ‘Configure Heading Device’ 
window (see Figure 17-17 - Configure Heading Device below). This window requires the input of 
information relevant to ship heading. 
 

 
Figure 17-17 - Configure Heading Device 

 
Heading Device Manufacturer 
Enter the name of the manufacturer of the depth device. 
 
Device Location 
Enter the ship location of the heading device. 
 
Talker ID 
The first two alphanumeric characters of the NMEA sentence’s Address Field identify the Talker. 
When entering the Talker ID for a heading device, these two letters will typically be “HC”. 
 
DataMux Channel 
Enter the DataMux channel to which the heading device is connected. 
 
String to Use for Heading 
From the drop down box select the string from which heading information is collected. Options 
available for selection are HDT (Heading, True) or HDG (Heading, Deviation & Variation). 
 
 HDT – Actual vessel heading in degrees True produced by any device or system producing 

true heading.  
 $--HDT,x.x,T*hh<CR><LF> 
 If HDT is selected from the drop-down box, the user must enter the appropriate Field 

for Value and Field for Units 
 
 HDG – Heading (magnetic sensor reading), which if corrected for deviation, will produce 

Magnetic heading, which is offset by variation will provide True heading. 
 $--HDG,x.x,x.x,a,x.x,a*hh<CR><LF> 
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 If HDG is selected from the drop-down box, the user must enter the appropriate Field 
for Value 

 
Sample of Heading String 
Enter a sample of the depth string. See the HDT and HDG string formats provided in String to 
Use for Depth provided above. 
 
 
Configure Speed Device 
By clicking the ‘Configure Speed Device’ the user will open the ‘Configure Speed Source’ window 
(see Figure 17-18 - Configure Speed Device below). This window requires the input of 
information relevant to ship speed. 
 

 
Figure 17-18 - Configure Speed Device 

 
Speed Source on Ship 
From the drop down box select the device from which ship speed information is collected. 
Options available for selection are GPS, Speed Log, or Both. The option selected will determine 
the information which will need to be entered in this window. 
 
GPS is the default selection and will require the following information: 
 

Speed String 
From the drop down box select the appropriate speed string. Options available for selection 
are: 

 RMC – Recommended Minimum Specific GNSS Data 
 $--RMC,hhmmss.ss,A,llll.ll,a,yyyyy.yy,a,x.x,x.x,xxxxxx,x.x,a,a*hh<CR><LF> 

 
 VBW – Dual Ground/Water Speed 

 $--VBW,x.x,x.x,A,x.x,x.x,A,x.x,A,x.x,A*hh<CR><LF> 
 

 VDR – Set and Drift 
 $--VDR,x.x,T,x.x,M,x.x,N*hh<CR><LF> 
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 VHW – Water Speed and Heading 
 $--VHW,x.x,T,x.x,M,x.x,N,x.x,K*hh<CR><LF> 

 
 VTG – Course Over Ground and Ground Speed 

 $--VTG,x.x,T,x.x,M,x.x,N,x.x,K,a*hh<CR><LF> 
 
 

Sample String 
Enter a sample of the speed string. See the RMC, VBW, VDR, VHW, and VTG string 
formats provided in Speed String provided above. 

 
If Speed Log is chosen from the ‘Speed Source’ drop-down box, a Speed Log section becomes 
visible in the ‘Configure Speed Source’ window (see Figure 17-19 - Speed Log below). The 
following information must be entered: 
 
 

 
Figure 17-19 - Speed Log 

 
Speed Log Manufacturer 
Enter the name of the speed log manufacturer. 
 
Speed Log Location 
Enter the ship location of the speed log device. 
 
Talker ID 
The first two alphanumeric characters of the NMEA sentence’s Address Field identify the 
Talker. When entering the Talker ID for a speed log device, these two letters will typically 
be “VD”, “VM”, or “VW”. 
 
DataMux Channel 
Enter the DataMux channel to which the speed log device is connected. 
 
String to Use for Speed 
From the drop down box select the string from which speed log information is collected. 
Options available for selection are VDR, VTG, VBW, VHW, or RMC (see Speed String 
above for format information on each of these strings). 
 
Sample of Speed String 
Enter a sample of the speed string. See the RMC, VBW, VDR, VHW, and VTG string 
formats provided in Speed String provided above. 

 
 
If Both is chosen from the ‘Speed Source’ drop-down box, both the GPS and Speed Log section 
becomes visible in the ‘Configure Speed Source’ window. Both sections must be completed 
following the outline provided for GPS and Speed Log above. 
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17.9 Fire Doors 
The ‘Fire Doors’ tab requires the input of configuration information for the ship’s Fire Doors (see 
Figure 17-20 - Fire Doors below). 
 

 
Figure 17-20 - Fire Doors 

 
 
Add Discrete or Add MTPT 
To add a Discrete or MultiPoint device click the appropriate button provided (‘Add Discrete’ or 
‘Add MTPT’).  
 
Once the appropriate device has been added a “Configure Device” button becomes visible (this 
occurs for each “Add Discrete” or “Add MTPT” button-press). To configure the device, press the 
associated button. 
 
If a Discrete or MultiPoint button is added incorrectly, it can be removed by selecting the number 
of the incorrect device from the “Remove Device Number” drop-down box and clicking the 
“Remove Device Number” button. In Figure 17-20 - Fire Doors above, device number 2 has been 
selected in the drop-down box for removal; once the “Remove Device Number” button is clicked 
in this example, the “Configure MTPT 2” will be removed. 
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Configure Device 
Enter information specific to the DataDiscrete or NavMultiPoint device, dependant upon which 
device you have chosen to add (see Figure 17-21 - Configure DataDiscrete Device below). The 
following information must be entered: 

 

 
Figure 17-21 - Configure DataDiscrete Device 

 
 
MUX Channel 
Enter the MUX channel to which the DataDiscrete or NavMultiPoint is connected. 
 
Full NMEA Identifier 
Enter the NMEA identifier for the device being configured. For example, the first 
DataDiscrete would have a DIS01 identifier. Note that ‘$’ should not be entered as a part of 
the identifier into these text fields as it is added automatically in the INI file. 
 
Field(s) to be Configured 
Check the appropriate number of checkboxes to indicate which fields must be configured 
(are connected to fire doors). 
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Description of Value 
For each checkbox (Field(s) to be Configured) marked with a check, a description of the 
value associated with that field should be entered. For example, a user may enter “Firedoor 
#1” as a value description. 
 
Onscreen Name 
Enter an onscreen name for the field being configured. For example, a user may enter 
“Firedoor #1” as an onscreen name. This name will be used for the door in the playback 
software and is limited to 15 characters. 
 
Type of Control 
From the drop down box select the type of control associated with the appropriate field. 
Options available for selection are ON/OFF (ON=0), ON/OFF (ON=1), Open/Closed 
(Open=0), or Open/Closed (Open=1). 
 
Once all necessary information has been entered press the ‘OK’ button to save and close 
the Configure Device window. 

 
To add and configure more than one device, select the appropriate device radio button and press 
the “Configure Device x” (where ‘x’ represents the device number) that becomes visible. Repeat 
the steps provided above to configure the device. 
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17.10 Water Doors 
The ‘Water Doors’ tab requires the input of configuration information for the ship’s Watertight 
Doors (see Figure 17-22 - Water Doors below). 
 

 
Figure 17-22 - Water Doors 

 
Add Discrete or Add MTPT 
To add a Discrete or MultiPoint device click the appropriate button provided (‘Add Discrete’ or 
‘Add MTPT’).  
 
Once the appropriate device has been added a “Configure Device” button becomes visible (this 
occurs for each “Add Discrete” or “Add MTPT” button-press). To configure the device, press the 
associated button. 
 
If a Discrete or MultiPoint button is added incorrectly, it can be removed by selecting the number 
of the incorrect device from the “Remove Device Number” drop-down box and clicking the 
“Remove Device Number” button. In Figure 17-22 - Water Doors above, device number 3 has 
been selected in the drop down box for removal; once the “Remove Device Number” button is 
clicked in this example, the “Configure MTPT 3” will be removed. 
 
Configure Device 
Enter information specific to the DataDiscrete or NavMultiPoint device, dependant upon which 
device you have chosen to add (see Figure 17-21 - Configure DataDiscrete Device above). For a 
description of the information to be entered in the device configuration window, refer to the 
Configure Device section of the Fire Doors section above. 
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17.11 Hull Openings 
The ‘Hull Openings’ tab requires the input of configuration information for the ship’s Hull 
Openings (see Figure 17-23 - Hull Openings below). 
 

 
Figure 17-23 - Hull Openings 

 
Add Discrete or Add MTPT 
To add a Discrete or MultiPoint device click the appropriate button provided (‘Add Discrete’ or 
‘Add MTPT’).  
 
Once the appropriate device has been added a “Configure Device” button becomes visible (this 
occurs for each “Add Discrete” or “Add MTPT” button-press). To configure the device, press the 
associated button. 
 
If a Discrete or MultiPoint button is added incorrectly, it can be removed by selecting the number 
of the incorrect device from the “Remove Device Number” drop-down box and clicking the 
“Remove Device Number” button. In Figure 17-23 - Hull Openings above, device number 4 has 
been selected in the drop down box for removal; once the “Remove Device Number” button is 
clicked in this example, the “Configure Discrete 4” will be removed. 
 
Configure Device 
Enter information specific to the DataDiscrete or NavMultiPoint device, dependant upon which 
device you have chosen to add (see Figure 17-21 - Configure DataDiscrete Device above). For a 
description of the information to be entered in the device configuration window, refer to the 
Configure Device section of the Fire Doors section above. 
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17.12 Alarms 
The ‘Alarms’ tab requires the input of configuration information for the ship’s alarms (see Figure 
17-24 – Alarms below). 
 

 
Figure 17-24 – Alarms 

 
Add Discrete or Add MTPT 
To add a Discrete or MultiPoint device click the appropriate button provided (‘Add Discrete’ or 
‘Add MTPT’). 
 
Once the appropriate device has been added a “Configure Device” button becomes visible (this 
occurs for each “Add Discrete” or “Add MTPT” button-press). To configure the device, press the 
associated button. 
 
If a Discrete or MultiPoint button is added incorrectly, it can be removed by selecting the number 
of the incorrect device from the “Remove Device Number” drop-down box and clicking the 
“Remove Device Number” button. 
 
Configure Device 
Enter information specific to the DataDiscrete or NavMultiPoint device, dependant upon which 
device you have chosen to add (see Figure 17-21 - Configure DataDiscrete Device above). For a 
description of the information to be entered in the device configuration window, refer to the 
Configure Device section of the Fire Doors section above. 
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Selecting Alarms to Display 
When selecting alarms to display, consideration should be given to the nature of the alarm. For 
example, many ships have a bridge alarm indicating engine start air pressure low. While this is an 
important piece of information, it is not a crucial alarm because it is often always active while a 
ship is sailing. If this alarm is selected in the VDR Configuration Utility, a constant alarm will be 
apparent during the playback of data. Therefore, alarms should be limited to items such as fire 
alarms, equipment failures, and items that indicate some type of emergency. All other lesser 
alarm indicators can be recorded in the information section at the bottom of the Alarms tab. 
 

17.13 Propulsion 
The ‘Propulsion’ tab requires the input of configuration information for the ship’s propulsion 
system (see Figure 17-25 - Propulsion below). The entered information also configures Shafts, 
Azipods, and Waterjets. 
 

 
Figure 17-25 - Propulsion 

 
 
This Ship Has 
From the drop down box(es) select the type of propulsion system in use. Options available for 
selection in the first drop-down box are Shafts, Azipods, and Waterjets.  
 
Dependant on the propulsion system available aboard a particular ship and the number of 
systems chosen (via the “Number of Systems” radio buttons), information will need to be added 
for the components of that system in the tabbed sections at the bottom of the window. 
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Number of Control Locations 
The number of control locations refers only to the engine RPM or pitch order and will need to be 
provided only if more than one signal appears in the data for a single engine order. For example, 
if an analog device supplies 3 different fields for Port Wing, Stbd Wing and bridge engine order, 
then 3 control locations will be needed.  If the engine order is taken from the same field for all 
locations, then only a single control location needs to be specified.  If this pull-down box is not 
used, then it is assumed that there is only single signal denoting engine order.  An example of 
this is as follows:  

 
Engine Data is on 13$ANL02 

Channel 1 Pitch Order (Stbd Wing)  
Channel 2 Pitch Order (Bridge) 
Channel 3 Pitch Order (Port Wing) 

 
In the above example, 3 locations are needed.  The control location is normally specified via a 
DataDiscrete and is setup by clicking on the “Setup” button found to the right of the pull down box 
(for specifying number of control locations.) 
 
The “Setup” button located next to the “# of Control Locations” pull down box and is used to 
provide discrete information for control locations.  At this time, only a DataDiscrete device can be 
used to indicate the location of control.  Clicking the button will cause a “Configure DataDiscrete” 
window to appear (see Figure 17-21 - Configure DataDiscrete Device). 
 
The control locations are configured in order, i.e, the first point configured on the DataDiscrete will 
correspond to control location 1, the second corresponds to control location 2, etc. 
 
Engine Description 
In the tabbed sections, enter information relevant (for example, Order and Response) to the 
propulsion system chosen. Provide a descriptive name for the engine in question that will allow a 
Playback software user to recognize it. For example, the first Starboard Engine could be named 
Stbd Engine 1. 
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17.13.1 NMEA Engine Data on Conditional Sentence – Example 1 
The following example illustrates a sample setup for a ship with engines that broadcast NMEA 
data sentences. The example uses a Rolls-Royce KaMeWa system, which broadcasts a number 
sentence with the $PRRS message. To understand the setup, the sentence format must first be 
understood. In this example, the sentence appears as follows: 
 
$PRRS,no,val1,val2,val3,val4,val5,val6,val7,val8,val9,val10,val11,*hh<CR><LF>  
 
Note that the string number field (“no”) specifies the equipment from which the sentence is 
broadcast.  The interpretation of each string value field (“valX”) is dependant upon the string 
number field. For example, the value in the first string value field (“val1”) is interpreted as a Lever 
Command only if a “6” appears in the string number field. As a result, this string is called a 
conditional sentence.  
 
This example illustrates how to complete the Engine #1 tab if the sentence is broadcast from the 
port propeller. 
 

Message Item Format Range Unit Usage 

Header $PRRS $PRRS  $P = Proprietary data 
RRS = Rolls Royce Sweden 

No 6 6  

1 = Outer water jets 
2 = Water jet rpm commands 

3 = Inner water jets 
4 = Bow tunnel thruster 
5 = Stern tunnel thruster 
6 = Port main propeller 
7 = Stbd main propeller 

Val1 Real -100 … +100 % Lever Command 

Val2 Real -100 … +100 % Pitch Response 

Val3 Real -100 … +100 % RPM command 

Val4 Real -100 … +100 % RPM response 

Val5     

Val6     

..     

..     

Table 17-1 - $PRRS String Values - Example 

 
1. In the “Pitch Order” section, choose the data type from the associated (“Type”) drop-down 

box. For this example, select “NMEA data”. 
 

 
Figure 17-26 - Engine Description - Example 
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2. Setup the Lever Command. Click the adjacent “Setup” button and enter the values as 

shown in Figure 17-27 - Lever Command Setup - Example below. In the “Configure NMEA 
Device” window shown in this figure the target value is specified to read from field 2 if a “6” 
appears in field 1. Then press the “OK” button. 

3. The remaining items (RPM Order, Pitch Response, and RPM Response) are set up in the 
same manner as “Pitch Order” in Step 2 above. 

 

 
Figure 17-27 - Lever Command Setup - Example 

 

17.13.2 NMEA Data from XDR Sentence – Example 2 
This second example for configuring a NMEA 0183 sentence will use the XDR sentence. This is a 
common sentence defined in both the IEC61162 and NMEA 0183 standards. It makes use of tags 
or identifiers to broadcast multiple pieces of information using the same sentence. For example, 
in a XDR sentence, 4 fields (a, x.x, a, c-c) identify the Transducer Type, Measurement, Units of 
Measurement, and Transducer ID. These four (4) fields may be repeated up to 6 times (for a total 
of 24 fields) in 1 string. 
 
$--XDR,a, x.x, a, c—c,………………..,a, x.x, a, c—c,*hh<CR><LF> 
  |     |   |      | 
  |     |   |       ------------ Transducer ID (Tag) 
  |     |    ------------ Units of measurement 
  |       --------  Measurement 
   ---------  Transducer Type, Transducer #1 
 
In this case, the XDR sentence can be broadcast multiple times from the same system to display 
values. For example: 
 
11$ERXDR,T,78.0,R,MC042,T,78.1,R,MC043*58 
 
In this case, view the groups of 4.  
T – transducer type = Tachometer 
0 – measurement = 78.0 
R – units = R = RPM 
MC042 – Transducer ID tag identifying engine actual RPM (this will vary between systems). 
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A second measurement appears in the second group of 4 fields, possibly indicating engine 
ordered RPM.  Now we can set up the values for playback. This example will be similar to the 
example in Section 17.13.1 - NMEA Engine Data on Conditional Sentence – Example 1 in that 
NMEA data is specified. 
 
Once the Setup button to configure the applicable NMEA device is pressed, information as 
illustrated in Figure 17-28 - XDR String - Example should be entered.  In the figure below, the 
playback will look in field 4 to find the string ‘MC042’, if it is found, it will display the measurement 
found in field 2. If the string ‘MC042’ is not found in field 4, then the playback will assume that the 
string does not indicate the engine RPM, but another value. 
 

 
Figure 17-28 - XDR String - Example 
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17.14 Thrusters 
The ‘Thrusters’ tab requires the input of configuration information for the ship’s thrusters (see 
Figure 17-29 - Thrusters below). If there are no thrusters in use on the vessel, it is only necessary 
to select the ‘0’ radio button associated with ‘Number of Thrusters’. 
 

 
Figure 17-29 - Thrusters 

 
 
 
Number of Thrusters 
Dependant on the number of thrusters selected (via the “Number of Thrusters” radio buttons), 
information will need to be added for those thrusters in the tabbed sections at the bottom of the 
window. 
 
# of Control Locations 
See the “# of Control Locations” section under the Propulsion heading above for a description of 
the use of control locations and their setup.  Note that while the control information may be the 
same, it must be entered separately for engines and thrusters. 
 
Thruster Description 
In the tabbed sections, enter information relevant (for example, Order and Response) to the 
applicable thruster. In the ”Short Thruster Description” field, provide a descriptive name for the 
engine in question that will allow a Playback software user to recognize it (for example, Bow 
Thruster 1). 
 
Order and Response information (as well as, in some cases, Fixed Information) will need to be 
added, including the “Type” of input device recording that information. It will be necessary to 
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configure the entered input device. Click the ‘Setup’ button and enter the relevant information in 
the configure device window. 
 
Where more than one (1) control location is specified, a location must be selected prior to 
selecting an input device. For example, the following steps would be completed to configure a 
ship with three (3) control locations on the thruster order. 
 

1. Select the number of thrusters via the radio buttons. 
2. Select Thruster 1 via the tab selection. 
3. Select the number of control locations (3). 
4. On the Thruster 1 tab: 

a. Select Control location 1. 
b. Select the input device type. 
c. Click Setup and enter the order data. 
d. Repeat A, B and C for control locations 2 & 3. 
e. Select an input device for response. 
f. Click Setup to enter response data. 

5. Repeat step 4 for All additional thrusters. 
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17.15 Steering 
The ‘Steering’ tab requires the input of configuration information for the ship’s steering system 
(see Figure 17-30 – Steering below). 
 
Number of Rudders 
Select the appropriate radio button in order to indicate the ‘Number of Rudders’. If azipods are the 
propulsion method, ‘Number of Azipods’ will appear in place of ‘Number of Rudders’ and the radio 
button selection will default to the number of azipods selected earlier under the Propulsion tab. 
That number will also be represented in the number of Rudder/Azipod information tabs visible. 
 

 
Figure 17-30 – Steering 

 
 
Short Rudder Description 
Provide a descriptive name for the applicable rudder/azipod that will allow a Playback software 
user to recognize it. For example, the first Starboard Rudder could be named Stbd Rudder. 
 
Order and Response information will need to be added, including the type of input device 
recording that particular information. It will be necessary to configure the entered input device. 
Click the ‘Configure Rudder/Azipod x Input Device(s)’ button and enter the relevant information in 
the configure device window.  Refer to “How to Input Thruster Data” in the Thrusters section for 
instructions on setting up control locations and the input of data for each location. 
 
Additional Steering Notes 
Note that “# of control locations” does not refer to the setting up of steering modes (i.e., FU, NFU, 
trackpilot, Override, Autopilot, etc.).  This only refers to instances where more than 1 signal is 
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used to specify a single rudder order, and the Discrete interfaces specified are used to determine 
which signal is the correct one to use.  
 
 

17.15.1 Two Rudders with Two Steering Locations – Example 1 
This example is for a ship that has two (2) rudders controlled from two (2) locations (port and stbd 
control locations). Signals for the rudders are independent, which makes it necessary to specify 
both control locations (if the signals were available at a common location, there would be no need 
to specify control locations). 
 
In a situation where there are two (2) control locations, the station in command must be indicated 
(normally via a data discrete device).  For example, data from the port control station could be 
provided on Data Analog 01 ($ANL01) in field 1 and data from the stbd control location on 
$ANL01 in field 3. In this case, a separate signal must be present which indicates which station is 
in command.  
 

1. To set up control locations, first indicate the number of control locations (in this case, two) 
on the pull-down box on the main rudders tab. 

2. Press the setup button to open a data discrete setup window.  
 

 
Figure 17-31 - Control Locations - Example 

 
 

3. In this situation the DataDiscrete is set up in the same manner as any other application 
of the data discrete device. The first entry in the discrete contact list corresponds to 
control location #1 by default; the second belongs with #2, and so on. The Onscreen 
Name is not used in this page. Press “OK” to return to the rudder setup page. 

 

 
Figure 17-32 - DataDiscrete Configuration - Example 

 
4. It is now necessary to set the number of rudders. Select the number of rudders using 

the available “Number of Rudders” radio buttons. 
5. A number of tabs will appear corresponding to the number of rudders selected.  For the 

first rudder, in the “Order Information” section, select “1” from the “Control” drop down 
box. Select the data source in the adjacent ‘Type’ drop down box (in most situations, 
the data source will be a Data Analog device). 
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6. Press the “Setup” button to input the data for the Data Analog device. This setup is 
standard for propulsion, rudder, and thruster data provided by a Data Analog device.  

 

 
Figure 17-33 - Control Type - Example 

 
 

7. When the ‘Configure a DataAnalog Device’ window appears, the Mux channel and 
NMEA Identifier should be specified as shown below. The field in which the data 
appears must also be specified. 

8. Once this data field has been selected, pressing the “Configure Data Points” button will 
open an additional window that allows the installation technician to specify what values 
on the DataAnalog correspond to exact rudder positions. In each case, it is important to 
specify the extreme range of the rudder and also include the midship or ‘0’ position.  

9. Once all the rudder position data has been entered for rudder # 1 order, select “Control 
Location” number “2” from the Order Information box and repeat the above steps to 
enter all pertinent order information for the second (STBD) control station. 

 

 
Figure 17-34 - DataAnalog Configuration - Example 
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Figure 17-35 - Analog Field Values - Example 

 
 

17.16 Extra Information 
The text box provided under the ‘Extra Information’ tab allows an area for the user to enter any 
additional information regarding the ship’s configuration which he/she feels may be relevant to the 
VDR installation in question. 
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18 PLAYBACK SOFTWARE 
 
The playback module accompanies the base model VDR and is resident on the download client 
PC. Additional playback software is available for use in shore-side offices. This additional 
software is necessary for the playback of data on the RSM or other media once it has been 
removed from the ship and transported to the office environment. 
 

Important! The computer on which the Playback application is being 
installed must have its regional and language options adjusted to English. 
This may be done by double clicking the ‘Regional Options’ icon in the Control 
Panel window and selecting ‘English’ from the language drop down list. It is 
recommended that either ‘English (United States)’ or ‘English (Canada)’ is 
selected. However, any of the available English options are acceptable. 

 
 
The Playback application has two modes of operation. In Playback mode, the user can replay 
saved data sets. In Real Time Display mode, the Playback application will replay real time Audio 
and NMEA data that is received from the VDR. Audio data is not available during Real Time 
Display mode. 

18.1 Playback Installation - Client/Standalone PC 
The installation of playback software is automated and requires little interaction. The install is 
performed via a self-extracting executable file and is automatically installed to the C:\Program 
Files\Rutter\VDR directory, with a shortcut placed on the Windows desktop. The install file will 
normally be named “Install VDR Playback.exe”. 
 
To begin the installation, complete the steps listed below: 
 

1. On the installation CD, double click the file ‘Install VDR Playback.exe’. 
 

 
Figure 18-1 - Installation Executable File 

 

 
 

2. Choose the directory to which the executable will be installed. 
 

 
Figure 18-2 - Choose Installation Directory 
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3. A prompt will appear asking the user to clarify creating the install directory.  Click Yes to 
create it.  If No is chosen the user will be prompted to choose an alternative directory. 

 

 
Figure 18-3- Choose Installation Directory 

After clicking “yes” to create the installation directory the following prompt will appear 
indicating the status of the installation. 

 
 

 
Figure 18-4 - Installing Message Window 

 
 

Note! To stop the installation, click the ‘Abort’ button on the ‘Installing…’ 
message window. 

 
 
 
 

4. Click Yes to reboot computer to finish the VDR Playback installation.  Clicking No will 
allow a reboot at a later time. 

 

 
Figure 18-5 - Reboot warning 

 
When the installation is complete, a shortcut to VDR Playback will be placed on the Windows 
desktop. 
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18.2 Starting the Playback Application 
To start the playback application, double click the playback icon located on the desktop (as 
mentioned in step 4 of the installation process above). The application will look similar to Figure 
18-6 - Playback Software shown below.   
 
Please note the playback application interprets information provided in the ship’s vdr-cfg.txt file.  
Therefore, the playback interface may contain elements and controls different from what appears 
below. 
 

 
Figure 18-6 - Playback Software 

18.2.1 Configuration File 
The vessel information displayed in the Playback application is automatically configured via the 
ship’s configuration file.  This file is created by the installation technician during the installation of 
the VDR and should be stored in an easily accessed location on the local hard drive of the 
playback PC. 
 
Upon start-up of the Playback application, the configuration file can be loaded using the File | 
Configure menu item. 
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Figure 18-7 - Configuration File Selection - Menu Item 

 
A dialog window will appear allowing the user to select the applicable file. Once the file has been 
selected the Playback application will prompt the user as seen in Figure 18-8 – Restart Warning 
below.  Clicking OK will restart VDR Playback and automatically load the selected configuration 
file. If desired, the configuration file can be changed at any time, simply select the File | Configure 
menu item, as above, and choose an alternative file. 
 
 

 
Figure 18-8 - Restart Warning  

 
 
With the VDR-100G2, the ship’s configuration file will accompany every available data set. When 
a data set is selected the configuration file will be automatically reloaded as necessary. 
 

18.3 Choosing Data for Playback 
Follow the instructions below to select a data set for playback: 
 

1. From the File menu choose Select Data Set. A dialog box will appear.  
 

2. Locate the folder containing the downloaded data.  The Playback application will 
automatically search for and select the <AudioDir.vdr> index file as seen below. Click 
Open to proceed. 
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Figure 18-9- Locating downloaded data 

 
The .vdr files accompany every download and act as an “index” to the actual data files. These 
files are named according to the data items they reference: AudioDir.vdr for audio, NMEADir.vdr 
for NMEA data and VideoDir.vdr for video data. Select All Files from the Files of Type drop 
down box to view all .vdr index files.  Selecting any one of these three files will open a data set for 
playback. 

 
Note! If the download directory does not display 3 files with extensions of “.vdr”, 
it is possible that the Microsoft operating system is treating them as hidden files.  

 
 
 
To ensure that the .vdr files are being displayed and not hidden by the operating system, follow 
these steps: 
 

1. Open Windows Explorer; 
2. Select Folder Options from the Tools menu; 
3. Select the View tab; 
4. Ensure that Show Hidden Files and Folders is selected; 
5. Press the OK button; 
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Figure 18-10 - Choose a .vdr File 

 
If Playback cannot locate the vdr-cfg.txt file a prompt will appear as seen in Figure 18-11 – 
Playback Configuration File Not Found below.  If the configuration file has already been pre-
selected using Configure from the File menu then click Cancel.  Otherwise, click OK to select 
the configuration file contained on the local hard drive or other media. 
 
 

 
Figure 18-11 - Playback Configuration File Not Found 

18.3.1 Unarchive Extracted Data 
Data for playback can also be chosen from a previously extracted data archive.  If a portion of 
data has been previously extracted and archived it can be opened for playback via the File | 
Unarchive Extracted Data file menu option. 
 

 
Figure 18-12 - Unarchive Extracted Data 

 
To playback the archived data after selecting the Unarchive Extracted Data file menu option, 
locate the .rfa (archive) file and select a folder to which the data can be extracted.  Once 
extracted, an applicable configuration file will need to be selected in order to continue playback. 



Chapter 18: Playback Software 

 
VDR-100G2/G2S Installation Manual  256  
RUT-TD-02-001, Rev 2.1 

18.4 Enabling Ethernet Broadcasts 
To enable the Playback software and Client PC to broadcast data across a network for use with a 
separate Electronic Charting System (ECS) or other software, select Output | Enable Ethernet 
Broadcast from the main menu. If a checkmark appears adjacent to this option, broadcasting is 
currently enabled. To disable this option, ensure no checkmark appears adjacent to this selection. 
 

 
Figure 18-13 - Enabling Ethernet Broadcasting 

 
The broadcast will occur on UDP Port 4450 and 4451. Refer to the relevant ECS manual to 
properly enable a PC to receive an Ethernet broadcast from Rutter Technologies’ Playback 
software. 
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18.5 Starting Data Playback 
To start the data playback, complete the following steps: 
 

1. Ensure Real Time Display mode is disabled.  Select Mode from the main menu. If a 
checkmark appears adjacent to the “Real Time Display” option, Real Time Display mode 
is currently enabled.  To disable this option, ensure no checkmark appears adjacent to 
this selection by clicking it.  A prompt will appear indicating Playback mode is enabled 

2. Select a data set for playback. 
 

To view the current dataset selected, select Playback | System Contents from the main 
menu. 

 
3. To begin playback of the selected data set, choose Playback | Start from the main 

menu. 
4. A dialog box will appear asking for a password. The default password is “VDR”. Click OK  

and a second dialog box will appear asking for a start time. 
 
 
 

 The password is case sensitive. It must be typed in the text box  as “VDR”  
 
 
 

5. Use the scroll bar (or enter a time in the text boxes) to select a playback start time.  
6. Click OK to begin the playback. 

 
 

 
Figure 18-14 - Choose Start Time For Playback 

 
 

Start Time Scrollbar 
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18.6 Configuring the Client to Receive Real Time Data 
Configure the Client PC for the VDR Playback application to connect to the VDR-100G2 and 
receive the recorded data. To do this the Client PC must be in the same IP segment as the 
download port on the VDR. The VDR’s download port occupies IP address 200.200.200.200. The 
client PC must be in the same range, with the last segment different than the VDR (as shown 
below.) To change the IP segment: 

1. Open the Control Panel via the Start menu. 
2. Double-click the Network Connections icon. 
3. Right-click on the Local Area Connection icon, and select Properties from the pop-up 

menu. 
4. In the Local Area Connection Properties window, highlight Internet Protocol (TCP/IP) 

and click the Properties button located directly below the available options. 
5. In the subsequent Internet Protocol (TCP/IP) Properties window, select the Use the 

following IP address radio button and enter 200.200.200.2 (the last number can be any 
number from 2 to 254, except 200.) 

6. Click the OK button in the Internet Protocol (TCP/IP) Properties and the Local Area 
Connection Properties.  

 
 

 
Figure 18-15 - Establishing TCP/IP Address 

18.7 Enabling Real Time Display Mode 
The Playback application has two modes of operation. In playback mode, the user can replay 
saved data sets. In Real Time Display mode (RTD), the Playback application will replay real time 
Video and NMEA data received from the VDR. Audio data is not available during Real Time 
Display Mode. 
 

Note! Prior to enabling Real Time Display on the Playback application, the Client 
PC must be connected to the VDR’s download port (or the Ethernet switch that 
may be attached to the VDR’s download port) via Ethernet. Refer to Section 18.6 
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Configuring the Client to Receive Real Time Data for details. 
 
To activate the Real Time Display mode of the Playback Application, select Mode | Real Time 
Display from the main menu. If a checkmark appears adjacent to this option, Real Time Display 
mode is currently enabled. To disable this option, ensure no checkmark appears adjacent to this 
selection. 
 

 
Figure 18-16 - Enabling Real Time Display Mode 

 
When Real Time Display mode is enabled, a pop-up window will appear indicating that Real Time 
Display has been enabled. 

 
Figure 18-17 - Real Time Display Mode Confirmation 

 
Many of the normal Playback mode options are disabled when operating in Real Time Display 
mode, as they are not applicable. All disabled options will be gray in colour, such that they are still 
visible but not available for selection. 

18.8 Starting the Playback in Real Time Display Mode 
To start the playback of real time data, complete the following steps: 
 

1. Refer to section 18.2.1 Configuration File to select a valid configuration file. 
2. Choose Playback | Start from the main menu or press the ‘Play’ button located on the 

‘Controls’ toolbar. 
 
 

 
Figure 18-18 - Controls Toolbar 

 

 
3. A dialog box will appear asking for a password. The default password is “VDR”. The 

password is case sensitive. Type the password in the text box provided and click OK.  
Upon entering the correct password Real Time Display playback will begin. 

18.9 Passwords 
There are 2 passwords required to playback data. The first password is necessary to playback a 
selected data set or to playback real time data.  The default password is “VDR” (case sensitive).  

Play 
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It is supplied with the software and can be changed by choosing Set Password from the 
Playback menu. A dialog box will appear asking for the old and new passwords. 
 
The second password is for playback of recorded audio data. The default password is “VDR” 
(case sensitive).  It can be changed by choosing Set Password from the Audio menu.  

 
Figure 18-19 - Change Password 

18.10 Playback Controls 
Playback can be controlled via the Playback menu items or by using the buttons located on the 
Controls toolbar. Both options offer a full range of controls, including the ability to run the 
playback in fast time (with the additional option of choosing replay speed). Error! Reference 
source not found. Figure 18-20 – Controls Toolbar provides an illustration of the toolbar. If 
available for use, buttons will appear blue in colour. If unavailable for use, buttons will be gray in 
colour . 
 
 
 
 
 

 
Figure 18-20 - Controls Toolbar 

 
 
A description of each of the buttons on the Controls toolbar are listed below. 
 
Open: Opens a dialog prompting the user to select a new data set for playback. 
 
Stop: Stops the playback of the current data set or stops the playback of real time data. 
 
Play: Begins the playback of the selected data set or begins the playback of real time data. 
 
Pause:  Pauses the playback of the current dataset.  Press the pause button again to continue 
playback. 
 
Fast Forward: Used to speed up or fast forward the playback of the current data set.  To return 
the playback to normal operation, press the “Fast Forward” button a second time. 
 
 

Note! The ‘Fast Forward Rate’ drop down box cannot be manipulated once a 
playback has started. 

 

Stop 

Play Pause Fast Forward 

Open 

Fast Forward Rate 

Playback Data Rewind Time 

Playback Data Rewind 
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Fast Forward Rate: Specify the rate at which to fast forward the playback of the current data set. 
 
 
Playback Data Rewind: When clicked, rewinds playback to the interval specified in the Playback 
Data  Rewind Time drop down. 
 
Playback Data Rewind Time: Select the time interval to rewind the playback of the current data 
sett when the Playback Data Rewind button is clicked. 
 
 
 

Note! Many of the controls available during Playback mode are not applicable 
during Real Time Display mode therefore they are disabled (grayed). 

 
 
 
Select Playback | Set Playback Rate from the main menu to adjust the speed of the replay.  A 
dialog box will appear requiring a time compression rate. Enter any integer from 2 to 24 
(inclusive) in the text box provided and click OK (see Figure 18-21 - Set Fast Forward Rate). 
 
 

 
Figure 18-21 - Set Fast Forward Rate 

 
 
The Controls toolbar can be hidden by deselecting Controls from the View menu. By default it is 
visible therefore a check will appear adjacent to this option. Deselecting it will remove this check 
mark. 

18.11 Audio Volume & Channel Selection 
Audio data includes continuous bridge audio and radio communications. The configuration of 
audio will differ between ships but is generally arranged in 2 to 4 banks. 
 
Individual channels contain audio data corresponding to an area of the bridge, bridge wings, or 
radio communications. Each channel may be reviewed individually or in conjunction with other 
channels during playback. For example, a user may wish to play back audio data recorded in the 
centre of the bridge while turning off external microphones where wind noise may be present. 
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Figure 18-22 - Audio Interface 

 
To activate the audio portion of a playback, choose Unlock Audio from the Audio menu (see 
Figure 18-23 – Audio Menu).  A prompt will appear requiring a password.  The default password 
supplied with the VDR-100G2 is “VDR”.  Enter the password in the text box provided and click 
OK to activate audio and make each channel in the Audio menu selectable.   
 
Once unlocked, audio data will be available for the remainder of the time VDR Playback is open.  
Audio can be adjusted by opening the Audio Volume window (see Figure 18-22 - Audio 
Interface) via the “Audio Volume” option from the Audio menu. 
 

 
Figure 18-23 – Audio Menu 

 
There are 2 ways to activate an available audio channel: 
 

1. Select the appropriate audio channel from the Audio menu; or, 
2. Open Audio | Adjust Volume… and click the ‘Active’ checkbox below the appropriate 

channel.  The Audio must be unlocked first to manipulate the checkboxes. 
 
Also, if required, it is possible to print the audio status to the ‘Log’ Tab Screen by selecting 
‘Status’ from the ‘Audio’ file menu. 
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To silence a playback, simply uncheck each channel either on the ‘Audio’ menu or via the ‘Active’ 
checkbox. 
 
 

Note! Audio data is not available during Real Time Display mode, thus all Audio 
options are disabled, including all audio options under the ‘Audio’ file menu. 

 

18.12 Conning Page 
The Conning Page is the default information page available upon start-up.  Use the VDR Config 
Utility to configure VDR Playback to display information in the fields provided on this page.  Refer 
to Section 17: System Configuration File for instructions on using the VDR Config Utility.  The 
Conning Data Tab contains the following information: 
 

 Date – Date of playback information 
 Time – Time of playback information 
 Latitude – Ship’s latitude 
 Longitude – Ship’s longitude 
 GPS Mode – Global Positioning System: SPS, DGPS (Differential GPS), PPS, RTK (Real 

Time Kinematic), FRTK (Float Real Time Kinematic), and DRM (Dead Reckoning Mode) 
 Heading – Ship’s heading 
 Autopilot – Indicates the presence or non-presence of a heading control system (On/Off) 
 COG – Ship’s Course Over Ground 
 SOG – Ship’s Speed Over Ground 
 Depth – Depth of ship 
 ROT – Ship’s Rate Of Turn 

18.12.1 Depth Graph 
The Depth Graph provides an illustration, in meters (m), of the ship’s depth. 
 

 
Figure 18-24 - Depth Graph 
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18.13 Wind Information 
The Wind Information pane contains data regarding the wind’s True and Relative Direction (Dir) 
and Speed (Sp).  
 
A compass is also provided in order to illustrate wind direction based on ship’s heading. The red 
arrow indicates True wind direction while the green arrow indicates Relative wind direction. The 
ship graphic indicates the ship’s heading. 
 

 
Figure 18-25 - Wind Information 

18.14 Propulsion Tab 
The Propulsion Tab is custom designed for each individual ship according to propulsion systems, 
bow thruster configuration and NMEA strings broadcast by bridge electronics. These displays are 
dependant upon the vdr-cfg.txt file created for a particular ship. 
 

 
Figure 18-26 – Sample Propulsion Tab 

 
 

Red Arrow – True Wind Direction 

Ship Graphic – Ship Heading 
Green Arrow – Relative Wind Direction 
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18.15 Video Channel Display Tab(s) 
Radar data is captured at 15-second intervals. If multiple radar images are available for video 
capture, capture times will be staggered but still allow for individual captures at 15-second 
intervals. 
 
There are a number of options available when viewing the radar data: 
- To display the radar data in its own window, choose View > Full Size Video > Video Channel.  
- To close this window, click the ‘x’ in the top right corner. 
- To move the radar image (once in its own window) in order to make a particular section visible 
without adjusting the window dimensions, click and drag by placing the mouse pointer over a 
section of the image, pressing the left mouse button and moving the mouse; 
- To view the whole radar image available in its own window select View > Fit to Window > 
Video Channel; 
- To save the radar image as a .bmp file, select File > Save > Video Channel. A dialogue will 
open allowing a save location to be chosen. 
 

 
Figure 18-27 – MultiPilot Tab 

 
 
The images are captured directly from the radar display.  Therefore, any radar supporting ECDIS 
or chart displays will have the ECDIS or chart image recorded. 
 

18.16 Proprietary Tab 
If proprietary data is present in the data playback, a “Proprietary” conning tab may appear. This 
tab window will present the available proprietary data in sentence format. 
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18.17 AIS Playback Tab  
The ‘AIS Playback’ Tab Screen displays information captured from the ship’s AIS. 
 

 
Figure 18-28 - AIS Playback Tab 

 
 
There are a number of features available within the AIS Playback tab screen that allows a user to 
better interpret the downloaded information. 

18.17.1 Targets 
The Targets section of the AIS Playback tab screen provides a range of information about all 
targets visible in the playback window. 
 

 Targets Tab – provides a list of all targets available within the AIS view screen.  If a 
target’s information becomes unavailable it remains in the list but a line is drawn through 
its name (it is also added to the “Lost” tab list (see below)). 

 Activated Tab – provides the name of the target selected by the user in the AIS view 
screen. 

 Lost Tab – provides a list of targets for which information is no longer available. 
 Dangerous Tab – provides a list of all targets that are currently on a dangerous course 

relative to ownship.  
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Figure 18-29 - Targets Information Section 

 
Specific target information is also available in the following tabs (located below the above 
mentioned tabs): 
 

 Collision Info – provides information specific to a selected target’s navigational course. 
 Target Info – provides registered information (e.g., MMSI, IMO, etc.) specific to a 

selected target. 
 Own Ship – provides registered and navigational information for ownship regardless of 

what target is selected. 
 

18.17.2 View Settings 
The View Settings section allows a user a high level of control over the AIS playback view screen. 
 

 
Figure 18-30 - View Settings Section 

 
 Viewing Range – It is possible to increase or decrease the viewing range of the AIS 

playback view screen by pressing the “+” and “-“ buttons located in the upper right of the 
View Settings section.  Note that if using a wheel mouse the viewing range can also be 
increased/decreased by moving the wheel while the pointer is located in the view screen.  
The viewing range is listed in nautical miles. 

 Location – The latitude and longitude of the selected target is listed. 
 Center on Selected Target – If this checkbox is selected the view screen will center on 

the selected target in the Target List. 
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 Set Center Button – To set the center point of the view screen, press the “Set Center” 
button, position the mouse pointer on a location on the view screen and left-click.  This 
point will now be the center point of the view screen.  Turning on the “Center on Selected 
Target” checkbox overrides this control. 

 Full Screen – Opens a dedicated AIS Playback window. 
 AIS Display Settings – The “Settings” button located in the View Settings section opens 

an “AIS Display Settings” window.  The settings in this window allow the user to adjust 
the AIS Playback display. 

 

 
Figure 18-31 - AIS Display Settings Window 

 
 CPA (Closest Point of Approach) 
 TCPA (Time to Closest Point of Approach) 
 COG (Course Over Ground) 
 LOA (Length Over All) 
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18.17.3 GuardZone 
The GuardZone section allows a user to create a guard zone in the view screen.  To create a 
guard zone press the “Create” button, place the mouse cursor in the view screen area and left-
click in the locations required to create a guard zone shape.  Double-click to complete the guard 
zone formation. 
 
The guard zone can be enabled or disabled by checking or unchecking the “Enabled” checkbox. 
 

 
Figure 18-32 – GuardZone enable/disable 

18.18 Log Tab  
The ‘Log’ Tab Screen displays the size of each type of data block and the time it was recorded. 
When viewed in compressed time (fast forward), the size of data blocks written at each time-
period is displayed, but the actual NMEA strings are not. When played back in normal time, the 
‘Log’ Tab Screen will also display the NMEA strings. 
 
‘Log’ information can be controlled via the Controls toolbar. To scroll illustrated information, press 
the ‘Pause’ button on the Controls toolbar and use the ‘Log’ scrollbar to navigate. 
 

 
Figure 18-33 - Log Window 
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18.18.1 Error Codes 
The following table provides a list of error codes and descriptions that may be observed in the 
Log Window of the Playback application: 
 

Error Code Alarm Message Binary Bit Position 

99$0 Status Clear 0000000000 

99$1 Storage Error 0000000001 

99$2 Video Error 0000000010 

99$4 Audio Error 0000000100 

99$8 NMEA Error 0000001000 

99$16 Power Error 0000010000 

99$32 Microphone Error 0000100000 

99$64 FRM Error 0001000000 

99$128 Lyngso Error 0010000000 

99$256 Power Comms Error 0100000000 

99$512 Remote Error 1000000000 

99$1024 GPS Error 10000000000 

Table 18-1 - Playback Log Window 

 
In the event of simultaneous errors, it will be necessary to convert the displayed error code to its 
binary counterpart. A multiple error will display multiple 1-bits in the binary string, which can then 
be interpreted. For example, the error code 99$17 converts to a binary string of 0000010001, 
representing a simultaneous Storage and Power error. 
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18.19 Fire Doors Tab  
The Fire Doors Tab Screen displays information regarding the status of the ship’s fire doors. The 
colour of the light adjacent to the door name, dependant upon the configuration, indicates an 
active (often indicated with the colour red) or non-active (often indicated with the colour green) 
door or opening. 
 
Should the number of fire doors exceed the initial screen space, a scroll bar will become visible 
allowing a user to view all available. 
 

 
Figure 18-34 - Fire Doors Tab 
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18.20 Water Doors Tab  
The Water Doors Tab Screen displays information regarding the status of the ship’s water doors. 
The colour of the light adjacent to the door name, dependant upon the configuration, indicates an 
active (often indicated with the colour red) or non-active (often indicated with the colour green) 
door or opening. 
 
Should the number of water doors exceed the initial screen space, a scroll bar will become visible 
allowing a user to view all available. 
 

 
Figure 18-35 - Water Doors Tab 
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18.21 Hull Openings Tab  
The Hull Openings Tab Screen displays information regarding the status of the ship’s hull 
openings. The colour of the light adjacent to the door name, dependant upon the configuration, 
indicates an active (often indicated with the colour red) or non-active (often indicated with the 
colour green) door or opening. 
 
Should the number of hull openings exceed the initial screen space, a scroll bar will become 
visible allowing a user to view all available. 
 

 
Figure 18-36 - Hull Openings Tab 

 

18.22 Alarms Tab  
An alarm is an “on” event, only displaying when triggered. When an alarm occurs, the word 
“ALARM” will display in the lower left corner of the Playback interface. The Alarms tab allows a 
user to view information pertaining to all triggered alarms. 

18.23 Data Extraction 
The volume of data contained in downloaded VDR data sets can be very large.  In many 
instances it may be desirable to access smaller portions of the data without downloading the 
entire data set.  As a result it is possible to copy only a specific portion of a data set, which can 
then be easily removed to a separate location for analysis or e-mailed to a third party. 
 

Note! The Data Extraction option is not available during Real Time Display mode. 
The ‘Data Extraction’ option under the ‘Data’ file menu is disabled while the 
Playback application is operating in Real Time Display mode. 
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18.23.1 Opening Data Extraction Window 
To extract a specific portion of data, begin the playback of captured data.   Once data is in active 
playback mode allow it to play until the beginning point of the portion desired for extraction is 
reached: 
 

Select “Data Extraction” option from the “Data” file menu. 
 

 
Figure 18-37 - Data Extraction Option 

 
The Data Extraction window will open (see Figure 18-38 - Data Extraction Window below).  
This may take a number of seconds.  The start time will automatically appear as the point in 
the playback where the Data Extraction window was opened. 

 

 
Figure 18-38 - Data Extraction Window 
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18.23.2 Selecting Data for Extraction 
With the Data Extraction window open select a segment of data to extract and an extraction 
destination. 
 

1. Three data stream options (Video, Audio, and NMEA) are available for download.  Check 
the adjacent checkbox to select the desired data stream.  If no data stream is selected 
the Start and End scroll bars will not be available. 

 
 

 
Figure 18-39 – Available data Streams 

 
2. When the “Video” checkbox is selected additional options will appear.  The Data 

Extraction utility may take several seconds to display this information. The user will have 
the option to download individual Video channels as required (if available).   

 
3. There is also an option to select 1 to 4 video images per minute i.e. selecting “1” allows a 

user to reduce the size of the Video data extraction to one image capture per minute. 
 

 
Figure 18-40 - Data Stream Options w/ Video Selected 

 
4. Select a destination directory by clicking the ”Browse” button adjacent to the “Destination” 

textbox.  Alternatively, choose “Choose Destination Dir” from the “Data” menu.   
 

NOTE: The destination directory MUST NOT be the same directory as the 
source directory and MUST NOT contain any other files. 
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5. Select a Start and End time for the extracted segment.  As mentioned above, the Start 

time automatically appears as the time when the Data Extraction window was opened.  
However, this can be changed.  

 
To adjust either the Start or End time, move the applicable scroll bar.  The file size of the 
extracted segment will appear to the right of the End scroll bar.  This is particularly useful, 
for example, when attempting to extract a segment to copy to a recordable Compact 
Disc. 

 
6. To create an archived file of the extracted data at the same time as the extracted data is 

being copied to the selected destination folder, select the “Archive Extracted Data” 
checkbox. 

 
7. To start the data extraction, press the “Start” button located in the lower right of the Data 

Extraction window.  A progress bar will appear at the bottom of the window to indicate the 
progress of the extraction. 

 
8. Once completed, the Data Extraction window can be closed via the “Exit” option from the 

“File” menu. 
 
 

18.24 Closing the Playback Application 
The application cannot be closed while a voyage playback is running. To close the application 
follow these instructions: 
 

1. Stop the playback by selecting Stop from the Playback menu, or by pressing the ‘Stop’ 
button in the Controls toolbar. 

2. Press the ‘Close’ (x) button in the upper right hand corner of the application’s main 
window, or choose Exit from the File menu. 

 
When the VDR Playback application is restarted, it will restart in the mode in which it was 
operating when closed. For example, if the VDR Playback application was in Real Time Display 
mode when it was closed, on the next restart it will open in Real Time Display mode. 
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19 GENERAL AND CORRECTIVE MAINTENANCE 
 
 

19.1 General Inspection Procedures 
The VDR-100G2 is designed to require a very low level of maintenance. However, the VDR and 
its peripheral devices should undergo a regular inspection to verify all connections are intact. If 
necessary, a few general maintenance tasks may be required.  
 
It is necessary to inspect the VDR-100G2 and all of its peripheral devices. This includes the Data 
Processing Unit (DPU), Data Acquisition Unit (DAU – if applicable), the Operation and Alarm Unit 
(OAU), Remote Storage Module (RSM - if applicable), Interfaces (if applicable) and Microphones.  
 
On first inspection, the DPU should be locked to prevent tampering. Once the DPU is opened, the 
following items will indicate normal system operation: 
 

 The Data Management Module (DMM) is operational with its fan spinning and LAN port 
LEDs blinking. 

 All LAN, serial, and power cables are firmly attached to the DMM. 
 Battery wires are firmly attached to the battery terminals. 
 All circuit breakers with load are in the closed (no white showing, button depressed) 

position. 
 The DPU fan is operational. The air filter should be inspected and replaced if 

necessary.  
 
The DAU should be covered with six (6) screws. Once removed, the Audio, Video, and NMEA 
Module (and the Hub) should have power and blinking LEDs to indicate data. All modules should 
be firmly attached to the DAU DIN-Rail and all cables should be firmly attached. 
 
The OAU should have no alarms, indicating “Status: Clear”.  Also, a test should be executed to 
verify that the display, LED, and buzzer function normally.  To do so, press the OAU’s “TEST” 
button then, after verification, press the “CANCEL” button.  For alarm code descriptions, refer to 
Section 19.2.1 - Alarm Code Description. 
 
The RSM and Interfaces (if applicable), should be firmly mounted, have all cables securely 
attached, and have blinking LEDs.  
 
 All Microphones should be securely attached and appear to be functional.  
 
 

19.1.1 Air Flow Check 
It is essential that proper airflow is maintained within the DPU.  There is one (1) fan system, 
accessible via the top hatch of the DPU, which provides an air intake and exhaust. 
 
The air intake fan located at the top corner of the DPU draws air into the unit to cool internal 
components.  This fan intake should be cleaned at least once every three (3) months.  Similarly, 
the fan exhaust is located at the bottom corner opposite the intake fan and expels warm air away 
from the unit.  It also should be cleaned at least once every three (3) months.  
 
A thermostat located near the intake fan controls the temperature at which the fan will begin 
operation. The default setting is 10° C.
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19.1.2 FRM Maintenance 
It is necessary to visually inspect the FRM unit in order to ensure it has not been tampered with 
and has maintained integrity. As a minimum, follow the steps provided below during visual 
inspection: 
 

1. Ensure the capsule is undamaged in any way. 
2. Check to ensure the integrity of the securing brackets. There should be no signs of 

tampering. 
3. Check to ensure the exterior paint and labeling are fully visible and in excellent condition. 

There should be no signs of chipping or flaking. 
 
 

19.1.3 Battery Beacon Voltage Test 
The Acoustic Location Beacon of the FRM consists of a self-contained battery, an electronic 
module, and a transducer. It is housed in a cylindrical watertight aluminum case capable of 
withstanding high-G impact shock and deep-water immersion. 
 
The beacon is a battery-powered device, which radiates a pulsed acoustic signal into the 
surrounding water upon activation by its water-sensitive switch.  
 
 

Note! The beacon shall be tested on a yearly basis to ensure both it and the 
battery are in good working condition. The Install Date of the beacon’s battery must 
be recorded in the Rutter Technologies’ Annual Recertification Checklist. 

 
 
The beacon manufacturer’s manual should be used as the chief reference point when performing 
the yearly checks mentioned in the note above.  
 

19.1.3.1 Dukane 42A12D Beacon Test Set 
The Dukane 42A12D Beacon Test Set can perform an operational test on the L3HVR Acoustic 
Underwater Beacon. 
 

 
Figure 19-1 - Dukane 42A12D Beacon Test Set 

 
 

Microphone 

Gain Control 

Tuning 
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The 42A12D unit can perform an operational test on a beacon without removing the beacon from 
its mount. The steps below outline the unit’s operation procedure: 
 

1. Turn the GAIN control to a fully clockwise position. A pronounced background noise 
should be present. Lack of noise may indicate a dead battery. 

2. Set the TUNING control to approximately mid-scale. Rubbing fingers in front of the 
microphone should produce a “rushing” noise from the speaker. 

3. Actuate a beacon under test by immersing the water switch in tap water, or by shorting 
the water switch terminal to the case by means of a shorting tab. 

4. Set the GAIN control at a comfortable listening level. 
5. Point the microphone of the Test Set towards the water switch end of the Beacon for best 

results. If the Beacon is mounted, position the Test Set for maximum unobstructed signal. 
Beacon operation will be indicated by an audible pulsing tone. 

6. The tuning control permits reception of an acoustic signal operating anywhere within the 
30 to 45 kHz frequency range. The audio response is peaked at approximately 3200Hz; 
therefore, the test set should be tuned to produce an output signal of approximately this 
frequency to achieve greatest sensitivity. 

 
Additionally, the use of a high impedance voltmeter (input impedance of 10M ohms) is required to 
test the battery voltage. The steps below outline this procedure: 
 

1. For the L3 HVR unit: Place the positive probe of the high impedance voltmeter on the 
Water Switch Primary and the negative probe on the Water Switch Battery (the beacon 
does not have to be opened). 

 
 

 
Figure 19-2 - L3 HVR Beacon 

 
 

2. Measure the battery voltage. The beacon battery voltage is acceptable if it has a range of 
2.97V or greater. 

3. If the battery voltage is below the minimum acceptable voltage (2.97V), the beacon 
should be replaced (or the battery must be changed in the beacon). 

 
For 42A12D maintenance procedures refer to the manufacturer’s documentation. 

Water Switch Primary 
Water Switch Battery
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19.2 Corrective Maintenance 

19.2.1 Alarm Code Description 
Listed below are the alarm codes that may appear on the OAU LCD display: 
 

Alarm Code Description 

System Error Communication with the Record Application has been lost 

Video Error Communication with the Video Module has been lost 

Audio Error Communication with the Audio Module has been lost 

FRM Error Communication with the Final Recording Medium has been lost 

Power Fail Loss of utility power 

PCM Error Communication has been lost with the Power Control Module 

Remote Error Communication has been lost with the Remote Storage Module 

Serial Error Communication has been lost with the NMEA Module 

Mic Error Communication has been lost with one of the microphones 

Disk Error Failure to secure a data set 

GPS Error Data is failing to record on TimeMuxID parameters entry 
Table 19-1 - Alarm Code Description 

 
Pressing the “Mute” button acknowledges the alarm code and silences the alarm. 
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19.2.2 Error Codes 
The following table provides a list of error codes and descriptions that may be observed in the 
Log Window of the Playback application: 
 

Error Code Alarm Message Binary Bit 
Position 

99$0 Status Clear 0000000000 
99$1 Storage Error 0000000001 
99$2 Video Error 0000000010 
99$4 Audio Error 0000000100 
99$8 NMEA Error 0000001000 
99$16 Power Error 0000010000 
99$32 Microphone Error 0000100000 
99$64 FRM Error 0001000000 
99$128 Lyngso Error 0010000000 
99$256 Power Comms Error 0100000000 
99$512 Remote Error 1000000000 
99$1024 GPS Error 10000000000 

Table 19-2 - Error Code - Playback Log Window 

 
In the event of simultaneous errors, it will be necessary to convert the displayed error code to its 
binary counterpart. A multiple error will display multiple 1-bits in the binary string, which can then 
be interpreted. For example, the error code 99$17 converts to a binary string of 0000010001, 
representing a simultaneous Storage and Power error. 

19.2.3 NMEA Error Codes 
The error codes in the NMEA data from the NMEA Module identify the NMEA module and it’s port 
that has the error. These errors occur when either the data format or speed does not match the 
received data, or the received data is corrupted.  
 
The error message is in the format NerrorXX, where N is the NMEA ID and XX is the code as 
listed below.  

Code 8-Port NMEA Module 4-Port NMEA Module 
A 232/422 Output 232/422 Output 
B 422 Input 422 Input 
C Input 1 Input 1 
D Input 2 Input 2 
E Input 3 Input 3 
F Slave/Master Link Input 4 
SA Output to Slave NA 
SB Input Port 4 NA 
SC Input Port 5 NA 
SD Input Port 6 NA 
SE Input Port 7 NA 
SF Input Port 8 NA 

Table 19-3 - NMEA Error Codes 

For example, error message 1errorSD on an 8 Channel NMEA Module would indicate that the 
data on input Port 6 has the wrong data format or speed or is corrupt. 
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19.2.4 Retrieving Secured Data via Remote Desktop 
Refer to Section 16.5 - Retrieving Secured Data via Download Port for instructions on retrieving 
data from the secured directory using a Remote Desktop connection. 
 

19.2.5 Upgrade of DMM Operating System 
An upgrade to the Operating System (O/S) can be loaded to the DMM via a Compact Flash card 
and the DMM’s Compact Flash Card Connection port.  An image of the O/S is loaded to the 
Compact Flash card which, in turn, is inserted into the DMM’s Compact Flash Card Connection 
port.  Once inserted, the O/S must then be further configured for use.  The following sections offer 
a detailed guide for upgrading and configuring the O/S. 
 

Note! If connecting a PS2 keyboard and/or mouse to the DMM but it does not 
work, it may be necessary to pull power from the DMM and power up with 
keyboard connected. 

 

19.2.5.1 Removing the Compact Flash Card 
To remove the Compact Flash card from the DMM, follow the steps provided below: 
 

1. Via the VDR-100G2’s Windows desktop, log on to the Administrator account (if currently 
logged into the MyUser account, log off via Start > Log Off). 

2. Shut down the DMM (Start > Shut Down). 
3. Open the top hatch of the DPU (this will require VDR-100G2 keys). 
4. Remove the power cable from the DMM. 
5. Remove the front panel of the DMM (the front panel contains USB connections). 
6. The Compact Flash card is located on the underside of the DMM motherboard. Gently 

pull the card outward. 
 

19.2.5.2 Compact Flash 
The O/S is copied to the Compact Flash card using a Compact Flash Card Reader. In a sample 
situation, the O/S image may be contained on a CD provided by Rutter Technologies. To transfer 
this image from the provided CD to the Compact Flash card: 
 

1. Insert the CD into a PC. 
2. Insert the Compact Flash card (with a 512MB NTFS file system) into a Compact Flash 

Card Reader and connect to the PC using an available USB port. 
3. Transfer the O/S image from the CD to the Compact Flash card. 

 

19.2.5.3 Installation of Operating System 
Once the Compact Flash card has been modified to contain the required O/S image, it is 
necessary to reinstall the card into the DMM. To do so, follow the steps provided below: 
 

1. Plug the updated Compact Flash card into the Compact Flash Card Connection port 
located on the underside of the DMM. 

2. Once the Compact Flash card has been securely connected, reattach the DMM front 
panel and close the DPU top hatch. 

3. To reboot the DMM, reattach the power cable. 
 
 

Note! Prior to rebooting the DMM ensure all PS2 devices (i.e., keyboard and/or 
mouse) are connected. 
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19.2.5.4 Adjusting BIOS Settings 
If the storage size of the Compact Flash card being installed is different than that of the card 
being removed (for example, a 256MB card is being removed to install a 512MB card), the BIOS 
settings must be adjusted. 
 
Follow the steps provided below to adjust the BIOS settings for the installation of a new Compact 
Flash card of differing storage size: 
 

Note! These settings only need to be adjusted if the card being installed is a 
different storage size than the one being removed (i.e., when removing a 256MB 
card and replacing it with a 512MB card). 

 
 

1. Power on the DMM (connect power). 
2. At the Operating System select screen, press CTRL + ALT + DEL to cause the system to 

restart. 
3. Press the Delete key <DEL> to enter the BIOS Setup blue screen. 
4. Select “Basic CMOS Configuration” and press <Enter>. 
5. Using the down arrow key, scroll down to highlight the “Ide 0 : > 1” line of the “ATA DRV 

Assignment” section (located in the lower portion of the BIOS screen). 
6. Press the right arrow key to highlight the Sector column (Sec). Once highlighted, use the 

<Page Up> or <Page Down> keys to decrease or increase the highlighted number. 
 

Compact Flash Card Storage Size Sectors 

512MB 63 

256MB 32 

 
 

7. Once the correct Sector number has been selected, press the right arrow key to highlight 
the Heads column (Hds). Once highlighted, use the <Page Up> or <Page Down> keys to 
decrease or increase the highlighted number. 

 
Compact Flash Card Storage Size Heads 

512MB 16 

256MB 16 

 
8. Once the correct Heads number has been selected, press the right arrow key to highlight 

the Cylinders column (Cyls). Once highlighted, use the <Page Up> or <Page Down> 
keys to decrease or increase the highlighted number. 

 
Compact Flash Card Storage Size Cylinders 

512MB 993 

256MB 980 

 
9. Once the above changes have been made, press the <Esc> key. Scroll down the 

subsequent screen and select “Write to CMOS and exit”. 
10. A “Save changes and exit” message box will appear. Press the <Y> key to save all 

changes and exit. 
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11. The DMM will reboot with updated BIOS settings. 
 

19.2.5.5 Setting Security Features 
Once the updated O/S has been booted, it is necessary to set various security features. To do so, 
follow the steps provided below: 
 

1. Once the DMM has booted with the updated O/S installed, a logon screen will be visible. 
Log in using the Administrator account. 

2. Wait approximately five (5) minutes to allow the O/S to auto-install new hardware 
settings. Once the hardware settings are installed, restart the O/S if prompted. 

3. Upon reboot, log in using the Administrator account. 
 

19.2.5.6 Set MyUser AutoLogon and Permissions 
1. Type ewfmgr c: in the Run command line (Start > Run…) to verify the Enhanced Write 

Filter (EWF) was installed. A DOS window will appear and disappear quickly. If an error 
message occurs, contact Rutter Support. 

2. Open the Control Panel (Start > Control Panel) and double-click the “Tweak UI” icon. 
3. Select the “Logon” tab, check the “Log on automatically at system startup” checkbox, 

ensure the logon name is MyUser, set the password to “Rutter”, and click “OK”. 
4. Right-click the Windows ‘Start’ button and select ‘Explore’ from the subsequent pop-up 

list. 
5. Right-click the VDR_DATA_MR drive and select Properties. 
6. Select the Sharing tab and click the “New Share” button at the bottom of the Properties 

window. 
7. Set the Share Name to be “Secured Data”. 
8. Click the “Permissions” button, verify all users have Read Only access, and click “OK”. 
9. Click “OK” when finished and “OK” again to close the Properties window. 

 

19.2.5.7 Set Security Features for VDR_DATA_MR Drive 
1. In Windows Explorer, right-click the VDR_DATA_MR: drive and select ‘Properties’. 
2. Select the ‘Security’ tab and click the ‘Advanced’ button on the bottom left corner. 
3. In the Advance Security Settings window, click the ‘Add’ button. 
4. Type ‘MyUser’ into the “Enter object name to select” text field and click ‘OK’. 
5. Ensure the following Deny checkboxes are selected:  

 Create Files/Write Data 
 Create Folders/Append Data 
 Write Attributes 
 Write Extended Attributes 
 Delete Subfolders and Files 
 Delete 

6. Ensure the following Allow checkboxes are selected:  
 List Folder Read Data 
 Read Attributes 
 Read Extended Attributes 
 Read Permissions 

7. Click “OK” to close the “Permission Entry” window, “OK” to close the “Advanced Security 
Settings” window, and “OK” to close the “Properties” window. 

 

19.2.5.8 Set Security Features for VDR_DATA 
1. In Windows Explorer, right-click the VDR_DATA drive and select Properties. 
2. Select the “Security” tab and click the “Advanced” button. 
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3. In the “Advanced Security Settings” window, click the “Add” button. 
4. Type “MyUser” into the “Enter object name to select” text field and click “OK”. 
5. Select the top “Deny” check box in the “Permissions” list field to ensure all permissions 

are denied and click “OK”. 
6. Click “OK” to close the “Permission Entry” window, “OK” to close the “Advanced Security 

Settings” window, and “OK” to close the “Properties” window. 
 

19.2.5.9 Set Security Features for C:\ Drive Folders 
1. Open Windows Explorer and select the C:\ drive so that all folders contained on the drive 

are visible in the right window pane. 
2. Select all folders except the VDRApps folder (pressing the CTRL key while clicking each 

individual folder allows a user to highlight multiple folders at one). 
3. Right-click and select Properties. 
4. Select the Security tab and click the “Advanced” button. 

 
 

Note! When selecting the Security tab a message may appear indicating that the 
selected folders do not currently have similar security settings. Select “Yes” to 
allow the O/S to coordinate the security settings for these folders. 

 
 

5. In the “Advanced Security Settings” window, click the “Add” button. 
6. Type MyUser in the “Enter the object name to select” text field, and click “OK”. 
7. Ensure the following Deny checkboxes are checked (selected): 

 Create Files/Write Data 
 Create Folders/Append Data 
 Write Attributes 
 Write Extended Attributes 
 Delete Subfolders and Files 
 Delete 

 
8. Click “OK” to close the “Permission Entry” window, “OK” to close the “Advanced Security 

Settings” window, and “OK” to close the “Properties” window. 
 

19.2.5.10 Set Security for VDRApps Folder 
1. Open Windows Explorer, select the C:\ drive, right-click the VDRApps folder, and select 

Properties. 
2. Select the Security tab and click the “Advanced” button. 
3. In the “Advanced Security Settings” window, click the “Add” button. 
4. In the Advanced Security Settings window, click the “Add” button, type MyUser in the 

“Enter the object name to select” text field, and click “OK”. 
5. Set all files to “Deny” except the following (which must be set to “Allow”): 

 Traverse Folder / Execute File 
 List Folder / Read Data 

 
6. Click “OK” to close the “Permission Entry” window and “OK” to close the “Properties” 

window. 
 

19.2.5.11 Set Restrictions for Files 
1. In Windows Explorer, access C:\WINDOWS\system32\ 
2. In the Tools menu of Explorer, select “Folder Options”. 
3. Select the “View” tab and in the “Advanced settings” selection box: 

 Select the “Show hidden files and folders” radio button 
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 Ensure the “Hide protected operating system files (Recommended)” check box is 
not checked 

 Click “OK” 
 

4. Arrange the files by ‘Type’ (right click anywhere in the window and, in the pop-up list, 
select ‘Arrange Icons By’ > ‘Type’) and select the following files (holding the CTRL key 
while clicking the file names allows a user to select multiple items): 

 
Executable (.exe) Files 

cmd odbcad32 sndvol32 

cliconfig  packager syncapp 

cscript rasphone sysedit 

drwatson regedt32 taskmgr 

eventvwr regsvr32 winhelp 

grpconv rsmui winlogon 

mmc rundll32 wscript 

mplay32 runonce  

msdtc shrpubw  
 
 
 
 
 
 
 

Control Panel (.cpl) Applications 

appwlz main powercfg 

desk mmsys sysdm 

inetcpl ncpa timedate 

intl nusrmgr telephon 
 

5. Once selected, right-click the above files and select Properties. 
6. Select the “Security” tab and click the “Advanced” button. 
7. In the “Advanced Security Settings” window, click the “Add” button. 
8. Type “MyUser” into the “Enter object name to select” text field and click “OK”. 
9. Select the top “Deny” check box in the “Permissions” list field to ensure all permissions 

are denied and click “OK”. 
10. In Windows Explorer, access C:\ and select the following files: 

 
C:\ Files 

io.sys ntdetect.com msdos.sys 

 ntldr  
 

11. Once selected, right-click the above files and select Properties. 
12. Select the “Security” tab and click the “Advanced” button. 
13. In the “Advanced Security Settings” window, click the “Add” button. 
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14. Type “MyUser” into the “Enter object name to select” text field and click “OK”. 
15. Select the top “Deny” check box in the “Permissions” list field to ensure all permissions 

are denied and click “OK”. 
16. Click “OK” to close the “Permission Entry” window, “OK” to close the “Advanced Security 

Settings” window, and “OK” to close the “Properties” window. 
17. In Windows Explorer, access C:\WINDOWS and select the following files: 

 
C:\WINDOWS Files 

notepad.exe regedit.exe  
 

18. Once selected, right-click the above files and select Properties. 
19. Select the “Security” tab and click the “Advanced” button. 
20. In the “Advanced Security Settings” window, click the “Add” button. 
21. Type “MyUser” into the “Enter object name to select” text field and click “OK”. 
22. Select the top “Deny” check box in the “Permissions” list field to ensure all permissions 

are denied and click “OK”. 
23. Click “OK” to close the “Permission Entry” window, “OK” to close the “Advanced Security 

Settings” window, and “OK” to close the “Properties” window. 
24. Open the Run command line (Start > Run…) 
25. Type ewfmgr c: -enable and click “OK”. 
26. Reopen the Run command line and type ewfmgr c: -commit and click “OK”. 

 
 
Once each of the above sections is completed, reboot the DMM via Start > Turn Off Computer > 
Restart. 
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20 SPARE PARTS LIST 
 
 

20.1 Spares Kit 
  

 1A fuse - Qty: 1 
 25A fuse - Qty: 1 
 10A fuse - Qty: 1 
 Red LED - Qty: 1 
 Air filter - Qty: 1 

 
 

20.2 Installation Kits 
The following kits are specific to particular VDR-100G2 components: 

20.2.1 DPU Install Kit 
  

 M8 screw - Qty: 4 
 M8 washer - Qty: 4 
 PS/2 splitter - Qty: 1 (supplied with DMM) 
 RJ-45 wall jack - Qty: 1 
 Label - Qty: 1 
 RJ-45 plugs - Qty: 12 
 Operation Manual - Qty: 1 
 Grommets - see Table 20-1 - Grommets Required below for grommet information. 
 Cardboard box - Qty: 1 
 Software - Qty: 1 

  

20.2.2 DAU Install Kit 
  

 M8 screw - Qty:4 
 M8 washer - Qty: 4 
 Grommets - see Table 20-1 - Grommets Required below for grommet information. 

  
  

20.2.3 RSM (RSM 120/160) Kit 
  

 RSM AC power supply 
 Ethernet cable 
 USB cable 
 RSM (120G or 160G) 
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20.2.4 RSM (RSMA 120/160) Kit 
  

 Straight Ethernet cable for hub (same as the cable used to connect existing hub to 
DMM) 

 Hub with mushroom lock attached to back 
 Power Cable with ferrules and labels for hub (same as the cable used to connect 

existing hub to power) 
 RSM AC power supply 
 RSM DC power supply 
 Ethernet cable 
 USB cable 
 RSM (120G or 160G) 

 
 

Grommets Required Unit Entry Glands 
Blank 6 mm 12 mm 15 mm 

DPU 10 + 4 6 6 6 6 
DAU 30 + 4 12 6 16 12 

Table 20-1 - Grommets Required 
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Installation Checklist 
 
It is required that the technician implementing this procedure mark the boxes located to the right of the items to 
indicate acceptance of the item.   
 
If the item has been completed the technician must mark the YES column in order to indicate compliance with 
associated item (non-compliance should be indicated by marking the NO column).   
 
Once all items in each section have been checked, the technician should then initial and date his/her findings 
directly below the items. 
 
The ship can be dockside for this procedure. 
 

Please print technician name:   
 
 

Installation 
 
Test Conditions 
 

 None Applicable 
 
 
1a. VDR & Component Mounting 

 YES NO N/A 

All bolts are tightened.    

There is easy access to cable entries and hatches.    

There is space from all sides of the DPU (as outlined in Rutter 
Technologies VDR-100G2/G2S Installation & Maintenance Manual).    

There is space from all sides of the DAU if applicable (as outlined in 
Rutter Technologies VDR-100G2/G2S Installation & Maintenance 
Manual). 

   

OAU is mounted correctly in an easily accessible position at the 
bridge.    

VDR Data Port is mounted in proximity to a computer workspace.    

Microphones are oriented to provide best audio coverage of all work 
spaces.    

 
 

Technician Initialed: ______________________     Date: __________ 
 
 
1b. Mounting of FRM Capsule 

Capsule is installed in accordance with IEC requirements.    

All bolts are tightened.    

Cables are connected securely and are watertight.    

 
 

Technician Initialed: ______________________     Date: __________ 
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1c. Cable Installation 

Cables from each Audio Junction Box to Audio Module are installed.    

Cables from each external interface (i.e., DataAnalog, DataGyro, etc) 
are installed.    

Cables from each NMEA source are installed.    

Cables from the radar/video source (if applicable) are installed.    

Cables from the FRM are installed.    

Ship’s emergency power cable is installed.    

Cable from OAU is installed.    

Any optional cables are installed.    

Cables are marked with number and/or source designation according 
to the cable plan.    

Ensure for each cable terminated at the VDR that the source end is 
connected to the proper output.    

Ensure that each interface power cable is connected to the required 
power supply terminal of the VDR.    

The power cable from the FRM capsule is connected to a 24VDC 
power supply.    

Ship’s emergency cable is connected inside DPU.    

Ensure the ship’s breaker is switched off.    

 
 

Technician Initialed: ______________________     Date: __________ 
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Additional Comments / Observations:  
 
 

 
 
Please strike out any lines left empty above.
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Set to Work & Commissioning 
 
Test Conditions 
 

 VDR is powered on. 
 VHF source is powered on. 
 Radar(s) is (are) powered on. 
 Sensors / Data sources are transmitting data. 
 Ship at sea or engines operational (as required). 

 
 
2a. Bridge & VHF Audio is configured for recording 

 YES NO N/A 

Detection threshold has been set.    

Microphone test is passing successfully for all microphones.    

Audio is clear during data playback on all recorded channels.    

Both transmit and receive of VHF is being recorded properly.    

VHF audio is clear upon playback of data.    

 
 

Technician Initialed: ______________________     Date: __________ 
 
 
2b. Video sources are configured for recording 

Video Channel 1 testing is passing successfully.    

Video Channel 1 appears correctly during playback.    

Video Channel 2 testing is passing successfully.    

Video Channel 2 appears correctly during playback.    

Video Channel 3 testing is passing successfully.    

Video Channel 3 appears correctly during playback.    

Video Channel 4 testing is passing successfully.    

Video Channel 4 appears correctly during playback.    

 
 

Technician Initialed: ______________________     Date: __________ 
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2c. All NMEA data sources are available and configured 

Ensure breakers in DPU are switched ON.    

Ensure that the following NMEA data is being recorded and configuration is reflected correctly (mark the 
applicable ‘YES’, ‘NO’, or ‘N/A’ box): 

Data Notes YES NO N/A 

Date and time     

Ship’s position and datum used     

Speed (water and/or ground)     

Heading (true)     

Depth (echosounder)     

All IMO-mandatory Bridge 
Alarms     

AIS     

Rudder Order/Response     

Engine Order/Response     

Thruster Order/Response     

Hull openings / watertight doors     

Accelerations and hull stresses     

Wind speed and direction     
 
 

Technician Initialed: ______________________     Date: __________ 
 
 
2d. OAU is functioning properly 

Audible alarm is functioning correctly.    

All keypad buttons are functioning correctly.    

LCD Display is displaying appropriate alarms.    

Alarm display shows status clear when alarm clears.    

Download to DMM internal drive is working via appropriate keypad press and 
confirmation of the download.    

 
 

Technician Initialed: ______________________     Date: __________ 
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2e. FRM Recording is configured 

Check that breaker is switched on.    

The FRM is formatted as described in the Installation manual.    

The FRM is enabled and set to correct capsule type in the VDRPARAMS.INI 
file.    

Configuration file is being sent to the capsule.    

Data can be downloaded from the capsule using the download software.    

All 12 hours of required IMO data is present.    

 
 

Technician Initialed: ______________________     Date: __________ 
 
 
2f. Power Subsystem is functioning properly 

All devices powered from Power Supply are operating.    

When power is removed a power failure alarm is generated in the log 
window.    

When power is restored a power restore message will appear in the log 
window.    

Activate an “Emergency Download” to secure the data for later inspection.    

 
 

Technician Initialed: ______________________     Date: __________ 
 
 
2g. VDR Data Port and RSM (if installed) is functioning properly 
Connect laptop PC to VDR Data Port to check for confirm communication 
with VDR.    

If applicable, download to the RSM from OAU functions correctly.    

 
 

Technician Initialed: ______________________     Date: __________ 
 
 
2h. VDRPARAMS.INI Configuration Test 

The STORAGE section has correct video channel being sent to the capsule.    

The AUDIO section should have proper number of mixers, microphones, and 
VHF set.    

The VIDEO section should have the number of sources, the transfer rate and 
the number of blocks set correctly.    

 
 

Technician Initialed: ______________________     Date: __________ 
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2i. Final Pre-Commissioning Steps 

VDR-CFG.TXT is edited to reflect installation.    

Five (5) minutes of data consisting of information from all source equipment 
connected to VDR.    

Download client computer, if provided, is configured for download and 
playback.    

 
 

Technician Initialed: ______________________     Date: __________ 
 
 
2j. Commissioning Complete 

Commissioning Form is complete.    

All papers have been signed by Service Supplier.    

Copies of Type Approval Certificate(s) have been provided to Ship.    

Operation manual(s) are provided to Ship.    

Keys provided to Owner.    

 
 

Technician Initialed: ______________________     Date: __________ 
 
 
2k. Final Preparations for Recording 

Windows OS Recycle Bin is empty.    

Copy of VDRApps folder is copied and sent to Rutter Technologies (includes 
VDR Configuration file and VDR Parameters file).    

Sample 5 minute data capture has been sent to Rutter Technologies.    

VDR is set to normal operation.    

 
 

Technician Initialed: ______________________     Date: __________ 
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Additional Comments / Observations:  
 
 

 
 
Please strike out any lines left empty above. 
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FRM Maintenance Sheet 
 

The following items should be completed (where applicable) for the Final Recording Medium (FRM) unit installed during the installation. 
 

FRM Type 

 Fixed Capsule  Float-Free Capsule 

 

Part No.:       Capsule Serial No.:       

Software Version No.:       Model No.:       

Beacon Serial No. (if applicable):       Beacon Date (if applicable):       

Float-Free Capsule Mounting Bracket Serial No. (if applicable):       

Float-Free Hydrostatic Release Serial No. (if applicable):       

 
 
Network Parameters 

FRM IP Address       

FRM SubNet       

Default Gateway IP       

 
 
FRM Memory Partition Configuration (L3 Units Only) 

Total Granules in Crash Module       

Number of Bytes Per Granule       

Currently Unassigned Granules       

 
 
Granule/Byte Allocation and Stream Names 

Position Number of Granules (L3) Stream Name 

0             

1             

2             

3             

4             
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APPENDIX B: VDR-100G2/G2S COMMISSIONING 
FORM 
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VDR-100G2 / G2S Installation Commissioning Form 

 
 
Complete all relevant sections.  Data items must be marked with a “ ”  or “X” in the “OK” field to indicate satisfactory inspection.   If a data item is not 
applicable to the particular installation, the “Comments” field must be marked “N/A”.  Dates should be in the dd-mmm-yyyy format (day-month-year, e.g. 
12-Nov-2006). 
 
A satisfactory operational status means that all major operating facilities and requirements of the equipment or unit have been tested and found to 
function in accordance with the relevant SOLAS regulations and associated IMO performance standards.  

Ship Name:   IMO Number:   

VDR Model:   VDR Serial No:   

FRM Model:   FRM Serial No:   
 
 
Data Items 

Items YES NO N/A Comments 

Date and time (A.861/5.4.1)     

Ship’s position (A.861/5.4.2)     

Speed (A.861/5.4.3)     

Heading (A.861/5.4.4)     

Bridge audio (A.861/5.4.5)     

Communications audio (A.861/5.4.6)     

Radar data (A.861/5.4.7)     

Echo sounder (A.861/5.4.8)     

Main alarms (A.861/5.4.9)     

Rudder order & response (A.861/5.4.10)     

Engine order & response (A.861/5.4.11)     

Hull openings (doors) status (A.861/5.4.12)     

Watertight & fire door status (A.861/5.4.13)     

Wind speed & direction (A.861/5.4.15)     

 
For further information, please refer to IEC 61996: Shipborne Voyage Data Recorder (VDR) Performance Requirements – Methods of testing and 
required test results and/or IEC 61996-2: Part 2 - Simplified voyage data recorder (S-VDR). 
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Additional Comments * 
 
 

* Please strike out any space left empty above. 
 
 
Representative Acceptance 
Reference documents: IMO Resolution A.861(20) / MSC 163 (78) 
This is to certify that a survey of the voyage data recorder / simplified voyage data recorder has been carried out in accordance with the relevant 
regulations of the Convention and as described above: 
 
Service Supplier 

Technician Name  

Location  

Date  

Signature 

 
Classification Society / Flag Authority 

Surveyor Name  

Society  

Location  

Date  

Signature 

 
Ship Owner 

Representative Name  

Location  

Date  

Signature 
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APPENDIX C: DATA INTERFACE DOCUMENTATION 
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DataAnalog – 8 Channel Analog to Digital Converter 
The DataAnalog interface monitors the status of 8 analog input signals, and indicates the voltage or current on each input 
channel via an NMEA-0183/IEC 61162 format data sentence transmitted once per second. Using a 12-bit A/D converter, 
the interface represents the signal level measured at the input with a value between -4096 and +4094 in the output data 
sentence. The DataAnalog inputs are arranged in four isolated groups of two, which share a common return. This 
arrangement provides the ability to simultaneously monitor signals from four separate systems while maintaining electrical 
isolation between those systems. It is ideally suited to measure the electrical indications for order and response from 4 
shipboard systems (i.e., Rudder Order/Response, ME RPM Order/Response, Pitch Order/Response, Bow Thruster Order 
and Response). The internal voltage divider circuit on the inputs can be configured to measure bi-polar (+/- 5V or +/- 10V), 
uni-polar (0 to 5V or 0 to 10V), and current (4 to 20 mA) indicators. The RS232/422 output baud rate is also configurable. 
In addition to the 8-channel DataAnalog interface described above, a 4-channel version is also available. 
 
The DataAnalog is certified by the Canadian Standards Association as meeting the rigorous EMC and environmental 
resistance criteria defined by IEC 60945. The inputs are high impedance, output ports are opto-isolated, and the power 
input is DC/DC isolated. This will ensure the safe, reliable operation of the DataAnalog and all devices connected to it. It is 
easily installed and will provide dependable, uninterrupted service in the extreme environments typically found aboard 
vessels. 
 
Features include: 
 

 Output channel activity LED indicators; 
 Power LED indicator; 
 Configurable input voltage ranges, and output baud rates; 
 Configurable NMEA-0183/IEC 61162 sentence identifiers (up to 64 unique 
 ID's); 
 19" inch rack or DIN rail mountable (mounting brackets available); 
 Max wire size for smaller gauge Phoenix plug connectors, used on interface front panel connectors, is 20 AWG 

or 0.5 sq. mm. Max wire size for the larger Phoenix connectors, used on interface rear panel connectors, is 18 
AWG or 0.75 sq mm; 

 Power and data output connectors on both front and back panels. 
 
 
Technical Specifications 
 
Power Required: 12VDC to 24VDC 
Current Draw: 12VDC @ 300mA (over voltage and reverse polarity protected) 
Dimensions: 38.1mm X 134.1mm X 190.5mm 
Weight: 0.60 KG 
Input: Unipolar: 0 to 5V, 0 to 10V Bipolar: +/- 5V, +/- 10V Current: 4 to 20 mA 
Output: RS-232, RS-422 and Current Loop. Baud rates of 4800, 9600, 19.2k, and 57.6k baud (8N1), (DIP switch 
selectable) 
 
 
Connection Information  

 
DataAnalog Front (Top) and Back (Bottom) View 
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Front panel connection info: 
 
Connector Description 
V+ 12VDC Input power (Also Available on the back panel) * see below 
Vo 12VDC Input power common (Also Available on the back panel) * see below 
Tx- RS422 Data Output (neg) (Also Available on the back panel) 
Tx+ RS422 Data Output (pos) (Also Available on the back panel) 
 
Back panel connection info **see below: 
 
Connector Description 
A1- System A input, Channel 1 (neg) 
A1+ System A input, Channel 1 (pos) 
A2- System A input, Channel 2 (neg) 
A2+ System A input, Channel 2 (pos) 
B1- System B input, Channel 1 (neg) 
B1+ System B input, Channel 1 (pos) 
B2- System B input, Channel 2 (neg) 
B2+ System B input, Channel 2 (pos) 
C1- System C input, Channel 1 (neg) 
C1+ System C input, Channel 1 (pos) 
C2- System C input, Channel 2 (neg) 
C2+ System C input, Channel 2 (pos) 
D1- System D input, Channel 1 (neg) 
D1+ System D input, Channel 1 (pos) 
D2- System D input, Channel 2 (neg) 
D2+ System D input, Channel 2 (pos) 
Tx- RS422 Data Output (neg) 
Tx+ RS422 Data Output (pos) 
Tx0 RS232 Data Output (neg) 
GND RS232 Data Output (pos) 
+ (12VDC) 12VDC Input power 
- (12VDC) 12VDC Input power common 
 
* Warning! Connect power to either the front OR rear of the interface. Only one power input is required. 
 
** Note! Like-lettered system inputs share a common ground. For example, input A1 shares a common ground with input 
A2. Likewise, B1 shares a common ground with B2, C1 with C2, and D1 with D2. 
 
 
Input Configuration 

 
The internal voltage divider circuits, on the inputs, can be configured to measure bipolar (+/- 5V or +/- 10V), unipolar (0 to 
5V or 0 to 10V), and current (4 to 20 mA) indicators.  
 
Note! Both the bipolar and unipolar settings apply to groups of channels (i.e., if channel 1 is set to measure bipolar, 
channel 2 is automatically set to measure bipolar as well; the same is true of the unipolar setting). 
 
Switch SW2 is used to change each 2 input group between bipolar and unipolar mode. Positions 1 to 4 set the channel 
pairs to unipolar or bipolar mode (i.e., SW2 pos 1 'ON' sets channels A1 and A2 to bipolar mode). Switches S2 to S9 
control the internal input voltage divider settings. Switches S2, S3, S4, and S5 are used to include/short the resistors on 
the inputs. Switches S6, S7, S8 and S9 are used to include/short the pull down resistors between the inputs and 
grounds.To access these switches: 
 

 Unplug the input connectors; 
 Unscrew the two screws located on the front panel of the DataAnalog enclosure in order to remove it; 
 Slide the circuit board out of the enclosure. 

 
 
See DataAnalog PCB below for further information regarding switch location. 
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DataAnalog PCB 

 
To configure each DataAnalog input channel, the switches should be set according to the following tables. The subscripts 
on the switch labels indicate which switch position is applicable. 
 
 
High Impedance Settings 
 
If switches S2 to S5 are closed (on), and switches S6 to S9 are open (off), the input impedances will be very high 
(approximately 3.3M Ohms), however in this mode it can only measure +/- 5V or 0-5V. These switches do not have to be 
made collectively. Channel A may be set for high impedance, meanwhile Channel B may be set for +/-10V(low 
impedance). 
 
Note! It is important to note that the source equipment is to be checked to ensure the analog does not affect the source 
equipment during power off on the analog. If the source equipment is affected, the addition of a 1M Ohm resister added in 
series to the input of the channel will increase the input impedance, thus reducing the likelihood of affecting the source 
equipment. 
 
To measure beyond the 5V range with the high impedance setting, an external voltage divider with high resistance values 
is necessary. For example, to measure +/- 30V on channels A1 and A2 with a 1M ohm input impedance, close (Turn On) 
S5, open (Turn Off) S9, and close SW2(1) (these changes set the analog channel for +/-5V); place an 850K resistor in 
series with the input channel, and a 150K resistor between the input channel and the common. Such changes should 
only be instituted if the voltage is above 5V. 
 
In order to support voltage and current ranges below the specifications given above, additional amplifying isolators may 
need to be incorporated into the interfacing plan. Please contact Rutter Technologies’ Product Support Department for 
further information on obtaining applicable amplifying isolators.
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 Channel A1 Channel A2 
 SW21 S51 S94 S93 SW21 S52 S92 S91 
0-5V OFF ON ON OFF OFF ON ON OFF 
0-10V OFF OFF ON OFF OFF OFF ON OFF 
+/-5V ON ON ON OFF ON ON ON OFF 
+/-10V ON OFF ON OFF ON OFF ON OFF 
4-20mA OFF ON OFF ON OFF ON OFF ON 
+/-5V (HI*) ON ON OFF OFF ON ON OFF OFF 
0-5V (HI*) OFF ON OFF OFF OFF ON OFF OFF 
         
 Channel B1 Channel B2 
 SW22 S41 S84 S83 SW22 S42 S82 S81 
0-5V OFF ON ON OFF OFF ON ON OFF 
0-10V OFF OFF ON OFF OFF OFF ON OFF 
+/-5V ON ON ON OFF ON ON ON OFF 
+/-10V ON OFF ON OFF ON OFF ON OFF 
4-20mA OFF ON OFF ON OFF ON OFF ON 
+/-5V (HI*) ON ON OFF OFF ON ON OFF OFF 
0-5V (HI*) OFF ON OFF OFF OFF ON OFF OFF 
         
 Channel C1 Channel C2 
 SW23 S31 S74 S73 SW23 S32 S72 S71 
0-5V OFF ON ON OFF OFF ON ON OFF 
0-10V OFF OFF ON OFF OFF OFF ON OFF 
+/-5V ON ON ON OFF ON ON ON OFF 
+/-10V ON OFF ON OFF ON OFF ON OFF 
4-20mA OFF ON OFF ON OFF ON OFF ON 
+/-5V (HI*) ON ON OFF OFF ON ON OFF OFF 
0-5V (HI*) OFF ON OFF OFF OFF ON OFF OFF 
         
 Channel D1 Channel D2 
 SW24 S21 S64 S63 SW24 S22 S62 S61 
0-5V OFF ON ON OFF OFF ON ON OFF 
0-10V OFF OFF ON OFF OFF OFF ON OFF 
+/-5V ON ON ON OFF ON ON ON OFF 
+/-10V ON OFF ON OFF ON OFF ON OFF 
4-20mA OFF ON OFF ON OFF ON OFF ON 
+/-5V (HI*) ON ON OFF OFF ON ON OFF OFF 
0-5V (HI*) OFF ON OFF OFF OFF ON OFF OFF 
 
* HI represents high impedance settings 
 
Warning! Incorrect switch settings and exceeding the selected range can damage the DataAnalog. 
 
 
Output Format 
 
DataAnalog: 
 
$ANLXX,[A1],[A2],[B1],[B2],[C1],[C2],[D1],[D2] *AA 

 
where: 
 

 XX is set between 00 to 63 (see NMEA-0183/IEC 61162 String Identifier Configuration section below)  
 

 A1-2, B1-2, C1-2, D1-2 are values between –4096 and +4094 that represent the voltage or current on the 
corresponding input channel  

 
 AA is the checksum. 

 
Example: $ANL12,1234,2344,-3456,-4094,1234,2344,-3456,-4094*F5 
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Output Baud Rate Configuration  
 
The DataAnalog output baud rate can be configured using the DIP Switch SW1 located on the DataAnalog circuit board. 
To access these switches: 
 

 Unplug the front panel input connector; 
 Unscrew the two screws located on the front panel of the DataAnalog enclosure in order to remove the panel; 
 The DIP Switches are accessible at the front of the circuit board. 

 
See DataAnalog PCB above for further information on the location of the DIP Switch for baud rate selection. 
 
 

Output Baud 
Rate SW17 SW18 

4800 OFF OFF 
9600 ON OFF 
19200 OFF ON 
57600 ON ON 

 
 
 
NMEA-0183/IEC 61162 String Identifier Configuration 
 
Should more than one DataAnalog be required, it is necessary to program a unique string identifier for each. The 
DataAnalog identifier can be programmed using the DIP Switch located on the DataAnalog circuit board. To access this 
switch: 
 

 Unplug the front panel input connector(s); 
 Unscrew the two screws located on the front panel of the DataAnalog enclosure in order to remove the panel; 
 Slide the circuit board out of the enclosure. 

 
The DIP Switch for configuring the string identifier is labelled SW1, located as shown above (DataAnalog PCB above). 
The following table provides information on the switch settings necessary for programming the DataAnalog String 
Identifier: 

 
ID SW16 SW15 SW14 SW13 SW12 SW11 
00 OFF OFF OFF OFF OFF OFF 
01 OFF OFF OFF OFF OFF ON 
02 OFF OFF OFF OFF ON OFF 
03 OFF OFF OFF OFF ON ON 
04 OFF OFF OFF ON OFF OFF 
05 OFF OFF OFF ON OFF ON 
06 OFF OFF OFF ON ON OFF 
07 OFF OFF OFF ON ON ON 
08 OFF OFF ON OFF OFF OFF 
09 OFF OFF ON OFF OFF ON 
10 OFF OFF ON OFF ON OFF 
11 OFF OFF ON OFF ON ON 
12 OFF OFF ON ON OFF OFF 
13 OFF OFF ON ON OFF ON 
14 OFF OFF ON ON ON OFF 
15 OFF OFF ON ON ON ON 
16 OFF ON OFF OFF OFF OFF 
17 OFF ON OFF OFF OFF ON 
18 OFF ON OFF OFF ON OFF 
19 OFF ON OFF OFF ON ON 
20 OFF ON OFF ON OFF OFF 
21 OFF ON OFF ON OFF ON 
22 OFF ON OFF ON ON OFF 
23 OFF ON OFF ON ON ON 
24 OFF ON ON OFF OFF OFF 
25 OFF ON ON OFF OFF ON 
26 OFF ON ON OFF ON OFF 
27 OFF ON ON OFF ON ON 
28 OFF ON ON ON OFF OFF 
29 OFF ON ON ON OFF ON 
30 OFF ON ON ON ON OFF 
31 OFF ON ON ON ON ON 
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32 ON OFF OFF OFF OFF OFF 
33 ON OFF OFF OFF OFF ON 
34 ON OFF OFF OFF ON OFF 
35 ON OFF OFF OFF ON ON 
36 ON OFF OFF ON OFF OFF 
37 ON OFF OFF ON OFF ON 
38 ON OFF OFF ON ON OFF 
39 ON OFF OFF ON ON ON 
40 ON OFF ON OFF OFF OFF 
41 ON OFF ON OFF OFF ON 
42 ON OFF ON OFF ON OFF 
43 ON OFF ON OFF ON ON 
44 ON OFF ON ON OFF OFF 
45 ON OFF ON ON OFF ON 
46 ON OFF ON ON ON OFF 
47 ON OFF ON ON ON ON 
48 ON ON OFF OFF OFF OFF 
49 ON ON OFF OFF OFF ON 
50 ON ON OFF OFF ON OFF 
51 ON ON OFF OFF ON ON 
52 ON ON OFF ON OFF OFF 
53 ON ON OFF ON OFF ON 
54 ON ON OFF ON ON OFF 
55 ON ON OFF ON ON ON 
56 ON ON ON OFF OFF OFF 
57 ON ON ON OFF OFF ON 
58 ON ON ON OFF ON OFF 
59 ON ON ON OFF ON ON 
60 ON ON ON ON OFF OFF 
61 ON ON ON ON OFF ON 
62 ON ON ON ON ON OFF 
63 ON ON ON ON ON ON 

 
 

Replacing the Input Power Fuse 
 
To access the DataAnalog’s circuit board: 
 

 Unplug the front panel input connectors; 
 Unscrew the two screws located on the front panel of the DataAnalog enclosure in order to remove the panel; 
 Slide the circuit board out of the enclosure. 

 
Refer to DataAnalog PCB above for fuse location. The input power fuse is a 500mA fast-blow glass cartridge fuse, 5 X 20 
mm size. When replacing the fuse, ensure the fuse clips are secured to the new fuse. If in doubt, squeeze the clips prior 
to insertion of the new fuse to tighten the grip. 
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DataDiscrete Input Module 
The DataDiscrete interface monitors the status of 24 discrete input signals, and indicates the on/off status of each channel 
via an NMEA-0183/IEC 61162 format data sentence. For applications where more than 24 discrete signals need to be 
monitored, up to ten DataDiscrete modules can be connected together, indicating the status of up to 240 input points in a 
single data stream. 
 
When discrete signals need to be monitored from multiple systems, the DataDiscrete inputs are arranged in four (4) 
groups of six (6) with each group having a common return. This arrangement provides the ability to simultaneously 
monitor voltages from four (4) separate systems while maintaining electrical isolation between those systems. The 
DataDiscrete can detect both AC and DC sources, and can be configured for high or low input voltages. 
  
The DataDiscrete is certified by the Canadian Standards Association as meeting the rigorous EMC and environmental 
resistance criteria defined by IEC 60945. The input and output ports are opto-isolated and the power input is DC/DC 
isolated. This will ensure the safe, reliable operation of the DataDiscrete and all devices connected to it. It is easily 
installed and will provide dependable, uninterrupted service in the extreme environments typically found aboard vessels. 
 
Features include: 
 

 Input/output channel activity LED indicators; 
 Power LED indicator; 
 Configurable input voltage ranges; 
 Configurable NMEA-0183/IEC 61162 sentence identifiers (up to 64 unique ID's); 
 19" inch rack or DIN rail mountable (Mounting brackets available); 
 Phoenix plug connectors (the maximum wire size on front and rear connectors is 20 AWG or 0.5mm2); 
 Power and data output connectors on both front and back panels. 

 
 

Technical Specifications  
 
Power Required: 12 or 24 VDC (reverse polarity and over voltage protected) 
Current Draw: 180 mA @ 12 VDC 
Dimensions: 38.1mm X 134.1mm X 190.5mm  
Weight: 0.60 KG 
Input: Low voltage: 3 to 50 V; High voltage: 25 to 140 V  
Output: RS-422 at 4800 (8N1) 
 
 
Connection Information 
 

 
DataDiscrete Front (Top) and Back (Bottom) View 
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Front panel connection info: 
 
Connector Description 
V+ 12VDC Input power (Also Available on the back panel) * see below 
Vo 12VDC Input power common (Also Available on the back panel) * see below 
Rx- RS422 Data Input (neg) 
Rx+ RS422 Data Input (pos) 
Tx- RS422 Data Output (neg) (Also Available on the back panel) 
Tx+ RS422 Data Output (pos) (Also Available on the back panel) 
 
Back panel connection info: 
 
Connector Description 

ACOM System A Common (neg) 
RXA1 System A input, Channel 1 (pos) 
RXA2 System A input, Channel 2 (pos) 
RXA3 System A input, Channel 3 (pos) 
RXA4 System A input, Channel 4 (pos) 
RXA5 System A input, Channel 5 (pos) 
RXA6 System A input, Channel 6 (pos) 
BCOM System B Common (neg) 
RXB1 System B input, Channel 1 (pos) 
RXB2 System B input, Channel 2 (pos) 
RXB3 System B input, Channel 3 (pos) 
RXB4 System B input, Channel 4 (pos) 
RXB5 System B input, Channel 5 (pos) 
RXB6 System B input, Channel 6 (pos) 
CCOM System C Common (neg) 
RXC1 System C input, Channel 1 (pos) 
RXC2 System C input, Channel 2 (pos) 
RXC3 System C input, Channel 3 (pos) 
RXC4 System C input, Channel 4 (pos) 
RXC5 System C input, Channel 5 (pos) 
RXC6 System C input, Channel 6 (pos) 
DCOM System D Common (neg) 
RXD1 System D input, Channel 1 (pos) 
RXD2 System D input, Channel 2 (pos) 
RXD3 System D input, Channel 3 (pos) 
RXD4 System D input, Channel 4 (pos) 
RXD5/TX- System D input, Channel 5 (pos) / RS422 Data Output (neg) ** 
RXD6/TX+ System D input, Channel 6 (pos) / RS422 Data Input (pos) ** 
+ (12VDC) 12VDC Input power 
- (12VDC) 12VDC Input power common 
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* Warning! Connect power to either the front OR rear of the interface. Only one power input is required. Power 
connections are parallel. 
 
** These connection points can be used as either a discrete input channel, or optionally, as a RS422 data output, 
depending on the position of jumpers JP25 and JP26 on the circuit board. When JP25 and JP26 are in positions 1 and 2, 
the connectors are RXD5 and RXD6 (default setting). When JP25 and JP26 are set to positions 2 and 3, the connectors 
are TX- and TX+. 
 

 
Jumper Positions 

 
 
 
Input Configuration  
 
Each DataDiscrete input channel can be configured to monitor high or low voltage signals by placing or removing jumpers 
on the DataDiscrete circuit board. Each input channel has an associated jumper, which changes the input impedance 
according to the voltage to be monitored. To access these jumpers: 
 

 Unplug the front panel input connectors; 
 Unscrew the two (2) screws located on the front panel of the DataDiscrete enclosure in order to remove the 

panel; 
 Slide the circuit board out of the enclosure. See DataDiscrete PCB above for location of the input voltage 

range selection jumpers. 
  

 
DataDiscrete PCB 
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The jumpers for input range are labelled JP1 to JP24 on the DataDiscrete input circuit board.  
 
Note! The jumpers are located in line with each channel. Numbering is not consecutive. 
 
The input voltage range is configured as follows: 
  
Jumpers On: Low Voltage input (3 to 50V) 
Jumpers Removed: High Voltage input (25 to 140V) 

 
Warning! Exceeding the selected voltage range will damage the DataDiscrete.  

 
Note! The DataDiscrete will not indicate the presence of voltages below the low end of the selected range. Exceeding the 
selected voltage range will damage the DataDiscrete. 
 
 
Output Format  
 
The format of the NMEA-0183/IEC 61162 output sentence is as follows: 
  
$DISXX,A1A2A3A4A5A6,B1B2B3B4B5B6,C1C2C3C4C5C6,D1D2D3D4D5D6*AA 
 
where: 
  

 XX is set between 00 to 63 (see NMEA-0183/IEC 61162 String Identifier Configuration below); 
 A1-6, B1-6, C1-6, D1-6 indicate the status of input channels (1 for 'ON', 0 for 'OFF'); 
 AA is the checksum. 

 
Example: $DIS12,000100,111101,000000,001100,*F7 
 
 
Onboard DIP-Switch Settings 
An 8-switch dip-switch is located on the front of the input circuit board adjacent to the power switch. 

 Positions 1 through 6 change the output designation number from 0 to 63 in binary format (see String Identifier 
table in NMEA-0183/IEC 61162 String Identifier Configuration section below), without restarting (i.e., all 6 in the 
ON position would give an output of $DIS63). 

 Switches 7 and 8 control the output repetition rate, as follows (Code version 09/03): 
 

Switch 7 8 Maximum No of DataDiscrete: 
Daisy-Chaining 

1 Hz OFF OFF 3 
1/3 Hz ON OFF 4 
1/6 Hz OFF ON 5 
1/10 Hz ON ON 10 

 
 Changes to the output repetition rate can also be made without restarting the device. 

 
 
Note! The above provided daisy-chain settings allow for a maximum string return. 
 
 
Discrete Input Voltage Levels 
 
 Minimum Voltage Levels (V) Maximum Voltage Levels (V) 

Low Voltage Input (Jumpers ON) 3 60 

High Voltage Input (Voltage OFF) (130K res 23.0 VDC) 170 

AC Input (130K res 18 VDC) 120 
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Front 8-Pin Phoenix Connector Pin-Out 
Refer to the following table for pin-out information: 
 

Front 8-Pin Pin-Out 

Pin 1 – Vin 

Pin 2 – PGND 

Pin 3 – TX0 

Pin 4 – GND 

Pin 5 – RX0 

Pin 6 – RX0RET 

Pin 7 – TX0- 

Pin 8 – TX0+ 

 
NMEA-0183/IEC 61162 String Identifier Configuration 
 
Up to ten DataDiscrete modules may be connected together to monitor up to 240 discrete signals. In order for the 
equipment to correctly identify and monitor each input channel, it is necessary to program a unique string identifier for 
each DataDiscrete module. The DataDiscrete identifier can be programmed using the DIP Switch located on the 
DataDiscrete circuit board. To access these switches: 
 

 Unplug the front panel input connectors; 
 Unscrew the two (2) screws located on the front panel of the DataDiscrete enclosure in order to remove the 

panel; 
 Slide the circuit board out of the enclosure. 

 
The DIP Switch for string identifier configuration selection is located as shown above (see DataDiscrete PCB above). 

  
The table on the next page provides information on the switch settings necessary for programming the DataDiscrete 
String Identifier: 

 



Appendix 

 321

ID S16 S15 S14 S13 S12 S11 
00 OFF OFF OFF OFF OFF OFF 
01 OFF OFF OFF OFF OFF ON 
02 OFF OFF OFF OFF ON OFF 
03 OFF OFF OFF OFF ON ON 
04 OFF OFF OFF ON OFF OFF 
05 OFF OFF OFF ON OFF ON 
06 OFF OFF OFF ON ON OFF 
07 OFF OFF OFF ON ON ON 
08 OFF OFF ON OFF OFF OFF 
09 OFF OFF ON OFF OFF ON 
10 OFF OFF ON OFF ON OFF 
11 OFF OFF ON OFF ON ON 
12 OFF OFF ON ON OFF OFF 
13 OFF OFF ON ON OFF ON 
14 OFF OFF ON ON ON OFF 
15 OFF OFF ON ON ON ON 
16 OFF ON OFF OFF OFF OFF 
17 OFF ON OFF OFF OFF ON 
18 OFF ON OFF OFF ON OFF 
19 OFF ON OFF OFF ON ON 
20 OFF ON OFF ON OFF OFF 
21 OFF ON OFF ON OFF ON 
22 OFF ON OFF ON ON OFF 
23 OFF ON OFF ON ON ON 
24 OFF ON ON OFF OFF OFF 
25 OFF ON ON OFF OFF ON 
26 OFF ON ON OFF ON OFF 
27 OFF ON ON OFF ON ON 
28 OFF ON ON ON OFF OFF 
29 OFF ON ON ON OFF ON 
30 OFF ON ON ON ON OFF 
31 OFF ON ON ON ON ON 
32 ON OFF OFF OFF OFF OFF 
33 ON OFF OFF OFF OFF ON 
34 ON OFF OFF OFF ON OFF 
35 ON OFF OFF OFF ON ON 
36 ON OFF OFF ON OFF OFF 
37 ON OFF OFF ON OFF ON 
38 ON OFF OFF ON ON OFF 
39 ON OFF OFF ON ON ON 
40 ON OFF ON OFF OFF OFF 
41 ON OFF ON OFF OFF ON 
42 ON OFF ON OFF ON OFF 
43 ON OFF ON OFF ON ON 
44 ON OFF ON ON OFF OFF 
45 ON OFF ON ON OFF ON 
46 ON OFF ON ON ON OFF 
47 ON OFF ON ON ON ON 
48 ON ON OFF OFF OFF OFF 
49 ON ON OFF OFF OFF ON 
50 ON ON OFF OFF ON OFF 
51 ON ON OFF OFF ON ON 
52 ON ON OFF ON OFF OFF 
53 ON ON OFF ON OFF ON 
54 ON ON OFF ON ON OFF 
55 ON ON OFF ON ON ON 
56 ON ON ON OFF OFF OFF 
57 ON ON ON OFF OFF ON 
58 ON ON ON OFF ON OFF 
59 ON ON ON OFF ON ON 
60 ON ON ON ON OFF OFF 
61 ON ON ON ON OFF ON 
62 ON ON ON ON ON OFF 
63 ON ON ON ON ON ON 

 



Appendix 

 322

Connecting Multiple DataDiscrete Modules 
 
Up to ten DataDiscrete modules may be connected together to monitor up to 240 discrete signals. To connect multiple 
modules: 
 

 Ensure all DataDiscrete modules are configured with unique NMEA-0183/IEC 61162 String Identifiers 
(described above); 

 Connect the output of the first DataDiscrete (pins TX+ and TX-, located on the front of the module) to the data 
input of the second DataDiscrete (pins RX+ and RX-, located on the front of the panel); 

 The output of the second module is connected to the input of the third, third to the fourth, etc., until all required 
DataDiscrete modules are connected (to a maximum of ten). 

 Warning! If more than 10 DataDiscrete modules are connected, data will be lost! 
 
The output of the connected DataDiscrete modules is available via the output of the last module in the chain. As noted in 
the Onboard DIP-Switch Settings section above, 10 DataDiscretes can be daisy-chained at a 1/10 Hz broadcast rate, 5 at 
1/6 Hz, 4 at 1/3 Hz, and 3 at 1 Hz. 

 
 

Replacing the Input Power Fuse 
 
To access the DataDiscrete’s circuit board: 
 

 Unplug the front panel input connectors; 
 Unscrew the two (2) screws located on the front panel of the DataDiscrete enclosure in order to remove the 

panel; 
 Slide the circuit board out of the enclosure. 

 
Refer to DataDiscrete above for fuse location. The input power fuse is a 500mA fast-blow glass cartridge fuse, 5 X 20 mm 
size. When replacing the fuse, ensure the fuse clips are secured to the new fuse. If in doubt, squeeze the clips prior to 
insertion of the new fuse to tighten the grip. 
 
 

NMEA Input Module 
 
For information on the NMEA Input Module (Navigation Sensor Multiplexor) see Section 11 - 
NMEA SETUP. 
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APPENDIX D: SOFTWARE DOWNLOAD (FTP)
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Rutter Technologies may require, from time-to-time, approved technicians to download updated 
software via a Rutter FTP site.  Access to this site will require a Rutter Technologies provided 
password. 
 
The following instructions are provided as a step-by-step procedure for downloading software via 
this FTP site: 
 

1. Open an Internet browser, enter the following address: ftp://www.ruttertech.com in 
the “Address” field, and press “Enter”. 

2. When prompted, enter a Rutter Technologies provided User Name and Password 
combination.  Note that both User Name and Password are case sensitive. 

3. To download, right-click the applicable file and select “Copy” from the pop-up list. 
4. Select a location on the PC’s local hard drive where the file should be downloaded, 

right-click in this space, and select “Paste” from the pop-up list. 
 
 
 
 
 
 
 
 
 

ftp://www.ruttertech.com/�
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APPENDIX E: APPROVAL DRAWING PACKAGE 
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VDR-100G2 Specifications 
RUT-TD-02-006 Rev1.3 
 

VDR-100G2 
The VDR-100G2 is a modular, Ethernet-based data acquisition and storage system.  It is 
designed to collect and maintain a secure, retrievable record of information related to the position, 
movement, physical status, and command/control of a marine vessel.  This unit is designed to 
meet all requirements of the International Maritime Organization (IMO). 
 

Data Processing Unit (DPU) 
The Data Processing Unit (DPU) receives and processes information provided from the various 
Audio, Video, and NMEA Modules.  This information is processed in the Data Management 
Module (DMM) for archiving on the DMM’s internal hard drive, the Remote Storage Module (RSM 
– optional), and the Final Recording Medium (FRM).  The DPU also houses the Power Control 
Module (PCM). 
 

Data Acquisition Unit (DAU) *Optional 
The Data Acquisition Unit (DAU) is an optional component that may house the main data 
acquisition modules: 
 

 Audio Module 
 Video Module 
 NMEA Module. 

 
The modules are used to capture ship information and output acquired data through an Ethernet 
port, transmitting it to the DPU for processing and storage. The DAU also contains an Ethernet 
switch which provides the ability to combine video and NMEA data into a single Ethernet link. 
 

Video 
The Video Module is a standalone video capture and broadcast device. The module digitizes 
incoming video signals and outputs the video data through an Ethernet port. It has one (1) input 
port for capturing images from a dedicated buffered output port of the primary radar. Two (2), 
three (3), and four (4) input video modules are also available for capturing images from additional 
video displays. 
 

Audio 
The base unit VDR-100G2 includes an Audio Module which allows connection of six (6) surface-
mountable microphones and audio test sources, including audio junction boxes. The audio 
system may be easily expanded to six (6) or eight (8) audio channels as required. 
 
Two (2) radio inputs are provided for continuous recording of transmit and receive audio from 
either VHF or HF radio (line level input). These inputs may be easily expanded as required. 
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NMEA-0183 / IEC 61162 Data 
The NMEA Module(s) provide connection to all IMO-required data items in both NMEA 0183/IEC 
61162 and limited ASCII data formats. NMEA modules multiplex up to eight (8) NMEA-0183 data 
streams from shipboard systems and output simultaneously onto a single RS-232/422 serial data 
channel and an Ethernet connection (UDP). 
 

Operation & Alarm Unit (OAU) 
The Operation & Alarm Unit (OAU) provides a visible and audible alarm in the event of a VDR-
100G2 error condition. Using an output connection to a vessel’s central bridge alarm system, the 
OAU alerts to any potential VDR-100G2 system failures or error conditions. The alarm unit is also 
used to initiate the securing of IMO required datasets on the VDR-100G2. 
 

Remote Storage Module (RSM) 
The Remote Storage Module (RSM) is an optional data storage device which provides the ability 
to archive longer periods of recorded data, or a means to transport copies of secured datasets. 
When the RSM is supplied as a data retrieval device, a universal AC adapter is included. When 
supplied with the extended archiving software module, universal AC and 24VDC power supplies 
are included. 
 

Final Recording Medium (FRM) 
The Final Recording Medium (FRM) is a solid-state storage unit capable of storing 12 hours of 
VDR-100G2 data in compliance with IMO resolution A.861(20.). The VDR-100G2 will support the 
VDR FRM or the S-VDR FRM. 
 

Recording Duration 
The minimum recording duration is 24 hours, based on the sample intervals required by IMO. 
 

Soft Downloading 
An optional client PC connected to the DMM via an Ethernet connection may be used for two (2) 
purposes: 
 
 Downloading data from the VDR. 
 Data playback. 

 
When the Playback PC is connected to the VDR-100G2 via an Ethernet connection, previously 
recorded data may be downloaded at any time during normal system operation without 
interrupting the VDR-100G2 recording process. This downloaded data may then be replayed via 
the playback software. 
 

Playback Software 
Playback software is supplied to allow immediate play back of downloaded data. NMEA data is 
available on a serial port for output to electronic chart / ECDIS systems or a simulator. 
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Weight & Dimensions 
 

DPU Specifications 

Weight 43.2Kg 

Dimensions 350 x 400 x 400mm (H x W x D) 

 

DAU (Optional) Specifications 

Weight 16.8Kg 

Dimensions 400 x 600 x 150mm (H x W x D) 

 

OAU Specifications 

Weight 1.4Kg 

Dimensions With front mounting plate: 144 x 144 x 52.3mm 
Without front mounting plate: 136.6 x 136.6 x 50mm 

 

Indoor Microphone Assembly Specifications 

Weight 0.75Kg 

Dimensions Mic: 64 x 92mm Box: 149 x 119 x 50mm 

 

Outdoor Microphone (Optional) Specifications 

Weight 1.2Kg 

Dimensions 138 x 166.2 x 50mm 

 

RSM (Optional) Specifications 

Weight 1.36Kg 

Dimensions 35 x 127 x 214mm 
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MSC 163(78) Sensor signals / S-VDR Part Numbers System / 
Equipment Designation Model/Manufacturer Connected to Location Cable No. Cable Type Signal type /

IEC 61162-sentence 

5.4.1
5.4.2 Time, Date & Position (primary GPS) NMEA Input Module VDR - 057 2x2x0,5 IEC-61162/ZDA

5.4.3 Speed (SOG or STW) from Ship's Speed Log NMEA Input Module VDR - 074 2x2x0,5 IEC-61162/VBW

5.4.4 Heading from (Gyro) Compass NMEA Input Module VDR - 076 4x2x0,5 IEC-61162/HDT

5.4.5 Microphone #1 Audio Input Module Bridge VDR - 001 CAT 5e Analogue audio

5.4.5 Microphone #2 Audio Input Module Bridge VDR - 002 CAT 5e Analogue audio

5.4.5 Microphone #3 Audio Input Module Bridge VDR - 003 CAT 5e Analogue audio

5.4.5 Microphone #4 Audio Input Module Bridge VDR - 004 CAT 5e Analogue audio

5.4.5 Microphone #5 Audio Input Module Bridge VDR-005 CAT 5e Analogue audio

5.4.5 Microphone #6 Audio Input Module Bridge Wing VDR - 006 CAT 5e Analogue audio

5.4.5 Microphone #7 Audio Input Module Bridge Wing VDR - 007 CAT 5e Analogue audio

5.4.6 Communication from Primary VHF Audio Input Module VDR - 017 CAT 5e Analogue audio

5.4.6 Communicatin from Secondary VHF Audio Input Module VDR - 017 CAT 5e Analogue audio

5.4.7 Main Radar Video Video Input Module Standard cable BNC / VGA VGA

5.4.7 Secondary Radar Video Video Input Module Standard cable BNC / VGA VGA

5.4.8 Other Radar Video Video Input Module Standard cable BNC / VGA VGA

5.4.8 AIS NMEA Input Module VDR - 230 2x2x0,5 IEC-61162/VDM, OSD

5.4.9 Echo Sounder NMEA Input Module VDR - 072 2x2x0,5 IEC-61162/DPT

5.4.9 Wind Speed & Direction NMEA Input Module VDR - 070 2x2x0,5 IEC-61162/MWV













































































 

 

Scope of Supply 
 

 
 

Date : 2006 Project Name: NB XXXX 
 Owner:  

 
 

 
 

QTY UNIT DESCRIPTION 

 1 RT-2600 

Data Acquisition Unit c/w: 
3  RT-2604  NMEA Input Modules (16 input channels total) 

1  RT-2603  8 Channels Audio Input Module 

1  RT-2632  Video Input Module 

 1 RT-2700 Data Processing Unit 

1 RT-2150 Alarm and Operation Module 

1 RT-2151 Remote Storage Module  

3 RT-333 DataDiscrete – DIN rail mounted 

1 RT-323 DataAnalog – DIN rail mounted 

1 RT-940 Final Recording Medium (FRM) Capsule, 1.75 GB capacity,                               

1 RT-916 FRM Junction Box 

8 RT-2100 Indoor Audio Kits 

2 RT-930 Outdoor Audio Kits 

2 RT-2302 VDR-100G2 Operation Manual  

 



Spare Parts List 
 

Rutter Part No Description Qty Location Used 

RT-7510 LED (RED) 10mm 5V 1 Alarm Module 

RT-7519 Fuse (1A) 1 Fan Fuse Block 

RT-7526 Fuse (25A) 1 Power Supply 

RT-7120 Intake Filter 1 DPU 
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